
Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Tento sprievodca popisuje konfiguráciu a prevádzku Interchangeable Lens Digital Camera ILME-FR7 / ILME-FR7K.

Podľa potreby si pozrite tohto sprievodcu a návody na obsluhu súvisiacich zariadení.

Prehľad

Typické aplikácie použitia

Konfigurácia systému

Ovládanie jednej jednotky pomocou dodávaného infračerveného diaľkového ovládača

Ovládanie jednej jednotky pomocou tabletu alebo počítača

Ovládanie jednej jednotky pomocou externého diaľkového ovládača

Ovládanie viacerých jednotiek pomocou externého diaľkového ovládača

Umiestnenie a funkcia dielov

Čelný pohľad

Zadný pohľad

Pripojovací blok

Bočný pohľad

Pohľad zhora

Pohľad zdola

Podpera objektívu

Umiestnenie a funkcia častí infračerveného diaľkového ovládača (súčasť dodávky)

Obrazovka webovej aplikácie

Prehľad obrazovky webovej aplikácie

Štruktúra spoločnej oblasti obrazoviek

Štruktúra živej prevádzkovej obrazovky

Štruktúra prevádzkovej obrazovky prehrávania

Štruktúra obrazovky nastavení
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Príprava

Ponuka kamery

Obrazovka kamery

Montáž jednotky

Zvislá montáž na pevnom mieste

Montáž vo vzpriamenej polohe na vyvýšenom, pevnom mieste

Montáž na strop

Pripojenie/odpojenie objektívu

Preventívne opatrenia pri nasadzovaní/demontáži objektívu

Kontrola prepínačov objektívu

Preventívne opatrenia pri používaní objektívu s transfokáciou

Nasadenie objektívu

Demontáž objektívu

Pripojenie káblov

Pripojenie jednotky k sieťovému zariadeniu pomocou káblového pripojenia

Pripojenie napájania

Používanie sieťového napájania

Používanie napájania PoE++

Resetovanie otáčania/nakláňania

Konfigurácia pred snímaním

Inicializácia jednotky pomocou webovej aplikácie

Prístup k webovej aplikácii z webového prehliadača

Inicializácia jednotky

Konfigurácia základnej činnosti

Príprava pamäťových kariet

Podporované pamäťové karty

Vloženie pamäťových kariet

Vysunutie pamäťovej karty
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Snímanie

Formátovanie (inicializácia) pamäťových kariet

Kontrola zostávajúceho času záznamu

Obnova pamäťových kariet

Základná činnosť

Spustenie/zastavenie nahrávania

Prepínanie medzi pamäťovými kartami

Kontrola zvuku

Zadanie časových údajov

Kontrola záznamu (Rec Review)

Úprava orámovania

Obrazovka úpravy orámovania

Úprava smeru snímania

Úprava smeru snímania pomocou webovej aplikácie

Nastavenie prevádzkovej rýchlosti otáčania/nakláňania

Nastavenie prevádzkového zrýchlenia otáčania/nakláňania

Nastavenie smeru snímania pomocou dodávaného infračerveného diaľkového ovládača

Úprava transfokácie

Nastavenie typu transfokácie

Úprava transfokácie pomocou webovej aplikácie

Nastavenie prevádzkovej rýchlosti transfokácie

Nastavenie transfokácie pomocou dodávaného infračerveného diaľkového ovládača

Uloženie/obnovenie polohy otočenia/naklonenia/transfokácie kamery (predvoľba polohy)

Kalibrácia objektívu s bajonetom E

Uloženie/obnovenie otáčania/nakláňania, polohy transfokácie a nastavenia zaostrenia pomocou webovej aplikácie

Premenovanie predvolieb polôh pomocou webovej aplikácie

Nahradenie uloženej predvoľby polohy novou polohou pomocou webovej aplikácie

Odstránenie uloženej predvoľby polohy pomocou webovej aplikácie

Synchronizácia otočenia/naklonenia a transfokácie/zaostrenia pri obnovení predvoľby polohy
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Zmena rýchlosti prechodu (otáčanie/nakláňanie/transfokácia/zaostrovanie) pri obnovení predvoľby polohy

Uloženie/obnovenie polohy otáčania/nakláňania a transfokácie pomocou dodávaného infračerveného diaľkového ovládača

Nahrávanie/prehrávanie zarámovaní kamery (sledovanie PTZ)

Nahrávanie zarámovaní kamery pomocou webovej aplikácie

Prehrávanie zarámovaní kamery pomocou webovej aplikácie

Odstránenie zaznamenaného zarámovania kamery pomocou webovej aplikácie

Nahrávanie zarámovaní kamery pomocou dodaného infračerveného diaľkového ovládania

Prehrávanie zarámovaní kamery pomocou dodaného infračerveného diaľkového ovládania

Úprava zaostrenia

Obrazovka nastavenia zaostrenia

Ručné nastavenie zaostrenia (Manual Focus)

Manuálne nastavenie pomocou webovej aplikácie

Manuálne nastavenie pomocou dodávaného infračerveného diaľkového ovládača

Zaostrenie určením polohy zaostrenia (bodové zaostrenie)

Dočasné použitie automatického zaostrenia (Push Auto Focus (AF))

Použitie automatického zaostrenia na jeden záber (Push Auto Focus (AF-S))

Automatické nastavenie zaostrenia (Auto Focus)

Automatické nastavenie pomocou webovej aplikácie

Automatické nastavenie pomocou dodávaného infračerveného diaľkového ovládača

Nastavenie oblasti/polohy automatického zaostrenia (Focus Area)

Rýchla zmena oblasti zaostrenia (Focus Setting)

Posunutie rámčeka oblasti zaostrenia pomocou dotykového ovládania (Touch Focus Area)

Úprava činnosti automatického zaostrenia (rýchlosť prechodu AF, citlivosť na prepínanie medzi objektmi AF)

Manuálne nastavenie automatického zaostrenia (AF Assist) pomocou webovej aplikácie

Manuálne zaostrenie počas automatického zaostrenia pomocou dodávaného infračerveného diaľkového ovládača

Dočasné použitie manuálneho zaostrenia počas automatického zaostrenia (Push Manual Focus)

Sledovanie pomocou detekcie tváre a očí (Face/Eye Detection AF)

Sledovanie konkrétneho subjektu (Realtime Tracking AF)

Úprava jasu
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Užitočné funkcie

Obrazovka nastavenia jasu

Nastavenie základnej citlivosti

Nastavenie cieľovej úrovne pre automatické nastavenie jasu

Úprava clony

Automatická úprava clony

Manuálna úprava clony

Úprava zosilnenia

Automatická úprava zosilnenia

Manuálna úprava zosilnenia

Úprava uzávierky

Automatická úprava uzávierky

Manuálna úprava uzávierky

Úprava úrovne svetla (ND Filter)

O ND filtri

Úprava v prednastavenom režime

Automatická úprava vo variabilnom režime

Manuálna úprava vo variabilnom režime

Úprava pre prirodzené farby (White Balance)

Obrazovka nastavenia vyváženia bielej

Automatické nastavenie vyváženia bielej

Ručné nastavenie vyváženia bielej

Spustenie automatického vyváženia bielej

Konfigurácia zvuku na záznam

Obrazovka konfigurácie zvuku

Výber zvukového vstupného zariadenia

Automatická úprava úrovne záznamu zvuku

Manuálna úprava úrovne záznamu zvuku

Funkcie priamej ponuky
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Priraditeľné tlačidlá

Slow & Quick Motion

Prerušované nahrávanie videa (Interval Rec)

Nahrávanie obrázkov vo vyrovnávacej pamäti (Picture Cache Rec)

Súčasné nahrávanie na pamäťové karty A a B. (2-slot Simul Rec)

Monitor videosignálu

Označenie klipu

Kompenzácia dýchania

Zástupné nahrávanie

Prehľad zástupného nahrávania

Nahrávanie zástupného súboru

Snímanie s požadovaným vzhľadom

Prehľad vzhľadu

Výber vzhľadu

Import požadovaného základného vzhľadu

Prispôsobenie vzhľadu

Uloženie vzhľadu

Odstránenie základného vzhľadu

Snímanie s úpravou vzhľadu v postprodukcii

Snímanie s úpravou vzhľadu v postprodukcii

Použitie LUT na HDMI výstup a streamovanie

Zmena LUT

Zmena rozloženia tmavých a svetlých oblastí v zaznamenanom videu

RAW záznam

Záznam RAW videa

Nahrávanie videa RAW v režime Slow & Quick Motion

Úprava bokehu (funkcia ovládania bokehu)

Zapnutie/vypnutie funkcie ovládania bokehu
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Sieťové funkcie

Obrazovka s miniatúrami

Ponuka kamery a podrobné nastavenia

Nastavenie stupňa bokehu

Uloženie a načítanie konfiguračných údajov

Prehľad ukladania a načítania konfiguračných údajov

Ukladanie súboru ALL

Načítanie súboru ALL

Prenos súborov

O prenose súborov

Registrácia cieľovej adresy pre prenos súborov

Výber súboru a nahratie

Nahranie zástupného súboru na pamäťovú kartu z obrazovky miniatúr

Nahranie pôvodného súboru na pamäťovú kartu z obrazovky miniatúr

Kontrola stavu prenosu súborov

Nahrávanie pomocou zabezpečeného FTP

Konfigurácia streamovania

O streamovaní

Nastavenie formátu streamovania

Nastavenie video kodeku pre streamovanie

Nastavenie zvukového kodeku pre streamovanie

Spustenie/zastavenie streamovania

Obrazovka s miniatúrami

Prehrávanie klipov a iné operácie s klipmi

Prehrávanie nahraných klipov

Operácie s nahratými klipmi

Konfigurácia ponuky kamery

Ovládanie ponuky kamery

Ovládanie ponuky kamery
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Zadanie znakového reťazca

Ponuka User

User

Ponuka Edit User

Edit User

Ponuka Shooting

ISO/Gain/EI

ND Filter

Shutter

Iris

Auto Exposure

White

White Setting

Offset White

Focus

S&Q Motion

LUT On/Off

Noise Suppression

Flicker Reduce

SteadyShot

Ponuka Project

Base Setting

Rec Format

Cine EI/Flex.ISO Set

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec
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SDI/HDMI Rec Control

Assignable Button

Ponuka Paint/Look

Scene File

Base Look

Reset Paint Settings

Black

Knee

Detail

Matrix

Multi Matrix

Ponuka Pan-Tilt

P/T Acceleration

Ponuka TC/Media

Timecode

TC Display

Users Bit

HDMI TC Out

Clip Name Format

Update Media

Format Media

Media Life

Ponuka Monitoring

Output Format

Display On/Off

Video Signal Monitor

Marker

Ponuka Audio
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Audio Input

Audio Output

Ponuka Thumbnail

Display Clip Properties

Set Clip Flag

Lock/Unlock Clip

Delete Clip

Transfer Clip

Transfer Clip (Proxy)

Filter Clips

Customize View

Ponuka Technical

Color Bars

Genlock

Tally

Rec Review

Zoom

Lens

APR

Ponuka Network

Wired LAN

File Transfer

Ponuka Maintenance

Language

Clock Set

Hours Meter

Nastavenia ponuky Shooting a predvolené hodnoty

Nastavenia ISO/Gain a predvolené hodnoty

10



Webová ponuka a podrobné nastavenia

Nastavenia AGC Limit a predvolené hodnoty

Nastavenia kvality obrazu uložené pre každý režim snímania

Konfigurácia webovej ponuky

Funkcie webovej ponuky

Ponuka Shooting

Focus

Ponuka Project

Base Setting

Rec Format

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

All File

Ponuka Paint/Look

Base Look

Ponuka Pan-Tilt

P/T Speed

P/T Acceleration

P/T Range Limit

P/T Direction

P/T Preset

Ponuka Monitoring

Output Format

Output Display

Ponuka Audio

Audio Input
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Audio Output

Ponuka Technical

Tracking Data Output

Tally

IR Remote

RCP/MSU

Lens Controller

Ponuka Network

Camera Name

User

Wired LAN

File Transfer

FTP Server 1 až 3

SSL

Referer Check

Brute Force Attack Protection

Ponuka Stream

Stream

Video Stream

Audio Stream

Ponuka Maintenance

Language

Accessibility

Clock Set

Reset

Information

System Log

HTTP Access Log
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Pripojenie externého zariadenia

Príloha

Service

EULA

Software

Pripojenie externých monitorov a záznamových zariadení

Pripojenie RCP/MSU (voliteľné)

Pripojenie pomocou RCP/MSU

Jednostranné spojenie medzi jednotkou a RCP

Používanie jednotky v prostredí s viacerými kamerami so softvérom na diaľkové ovládanie MSU/Camera

Zoznam podporovaných funkcií

Ovládanie pomocou diaľkového ovládača RM-IP500 (voliteľné príslušenstvo)

O prevádzke pomocou diaľkového ovládača RM-IP500 (voliteľné príslušenstvo)

Pripojenie diaľkového ovládača RM-IP500

Synchronizácia s externým zariadením

O synchronizácii s externým zariadením

Synchronizácia fázy video signálu (Genlock)

Uzamknutie časového kódu na iné zariadenia

Pripojenie externého mikrofónu alebo externého zvukového zariadenia

Správa/úprava klipov pomocou počítača

Výstup signálu z optického vlákna

Pripojenie záznamového signálu

Výstup monitorovacích údajov (free-d)

Pripojenie ovládača objektívu

Úprava transfokácie pomocou ovládača objektívu

Opatrenia pre používanie

Výstupné formáty a obmedzenia

Riešenie problémov

Chybové/varovné správy
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Zoznam položiek ponuky

Prednastavená poloha uložených položiek

Blokové schémy

Aktualizácia softvéru objektívu s bajonetom E

Pripojenie krytu uvoľňovacieho tlačidla objektívu

Licencie

Technické parametre

Ochranné známky

14



Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Konfigurácia systému

Táto jednotka môže byť kombinovaná s periférnymi zariadeniami na vytvorenie rôznych systémových konfigurácií.

Objektív s bajonetom E1.

Adaptér s bajonetom A LA-EA3 / LA-EA42.

Infračervené diaľkové ovládanie (súčasť dodávky)3.

Pamäťové karty CFexpress Type A / Pamäťové karty SDXC4.

Čítačka kariet CFexpress Type A / Čítačka SD kariet5.

Mikrofón ECM-680S, ECM-678*, ECM-674*6.
Vyžaduje sa EC-0.5X3F5M 3-kolíkový → 5-kolíkový XLR adaptérový kábel.*

Sieťový adaptér (súčasť dodávky)7.

Video monitor8.

Diaľkový ovládač RM-IP5009.
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Ovládanie jednej jednotky pomocou dodávaného infračerveného diaľkového ovládača

Jednu jednotku môžete ovládať diaľku pomocou dodávaného infračerveného diaľkového ovládača.

 Video signál
 Tok signálu

5-041-959-13(1) Copyright 2022 Sony Corporation

Infračervené diaľkové ovládanie (súčasť dodávky)1.

Video monitor2.
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Ovládanie jednej jednotky pomocou tabletu alebo počítača

K jednotke môžete pripojiť tablet alebo počítač a následne jednotku ovládať pomocou webového prehliadača.

 Video signál
 Signál diaľkového ovládania

  Tok signálu

5-041-959-13(1) Copyright 2022 Sony Corporation

Video monitor1.

Tablet2.

Počítač3.

Prístupový bod4.
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Ovládanie jednej jednotky pomocou externého diaľkového ovládača

Jednotku môžete diaľkovo ovládať pomocou diaľkového ovládača.

 Video signál
 Signál diaľkového ovládania

  Tok signálu

5-041-959-13(1) Copyright 2022 Sony Corporation

Video monitor1.

Diaľkový ovládač RM-IP5002.
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Ovládanie viacerých jednotiek pomocou externého diaľkového ovládača

Pomocou jedného diaľkového ovládača môžete na diaľku ovládať až 100 jednotiek.

 Video signál
 Signál diaľkového ovládania
 Záznamový/kontaktný signál

  Tok signálu

5-041-959-13(1) Copyright 2022 Sony Corporation

Video monitor1.

Prepínač videa2.

Ethernetový rozbočovač3.

Diaľkový ovládač RM-IP5004.

20



Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Čelný pohľad

Táto téma popisuje umiestnenie a funkciu dielov na prednej strane jednotky.

Rada

Tento popis sa vzťahuje na ilustráciu jednotky bez nasadeného objektívu.

Hlava kamery

Poznámka

Nevystavujte hlavu kamery silným nárazom.

1.

Kontrolka nahrávania/záznamu
Pri konfigurácii ako kontrolka nahrávania sa kontrolka pri nahrávaní na pamäťovú kartu rozsvieti načerveno.
Kontrolka bliká, keď je málo voľného miesta na záznamovom médiu alebo keď sa vyskytne chyba.

2.
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Podrobnosti nájdete v časti „Chybové/varovné správy“.

Pri konfigurácii ako kontrolka záznamu sa kontrolka rozsvieti na červeno alebo na zeleno podľa externého
záznamového signálu.

Podrobnosti nájdete v časti „Pripojenie záznamového signálu“.
Obrazový snímač

Poznámka

Nedotýkajte sa priamo rukami.

3.

Uvoľňovacie tlačidlo objektívu
Stlačením odstránite objektív.

Podrobnosti nájdete v časti „Demontáž objektívu“.

4.

Signálne kontakty objektívu

Poznámka

Nedotýkajte sa priamo rukami.

5.

Kontrolka POWER6.

Kontrolka NETWORK
Stav jednotky je indikovaný kombináciou farby displeja a stavu rozsvietenia (svieti, bliká, nesvieti) kontrolky POWER
a kontrolky NETWORK.

7.

Kontrolka
POWER

Kontrolka
NETWORK Stav prístroja

Svieti zelená
*1

Svieti zelená Zapnutie (pripojená sieť)

Nesvieti Zapnutie (sieť nie je pripojená)

Blikajúca
zelená

Nesvieti Prebieha proces zapnutia

Svieti
oranžová

Nesvieti Pohotovostný stav napájania

Blikajúca žltá Nesvieti Prebieha aktualizácia softvéru

Pomaly bliká
oranžovo*2

Pomaly bliká
zeleno*2

Jednotka nemôže normálne fungovať. Podrobnosti nájdete v systémovom
denníku. Ak problém pretrváva aj po prepnutí jednotky do pohotovostného
režimu alebo po vypnutí a opätovnom zapnutí napájania, obráťte sa na
servisného zástupcu spoločnosti Sony.

Rýchlo bliká
oranžovo*3

Rýchlo bliká
zeleno*3

V jednotke sa vyskytla porucha. Obráťte sa na servisného zástupcu spoločnosti
Sony.

Blikajúca zelená znamená, že sa prijíma príkaz z dodaného infračerveného diaľkového ovládača.*1

Pomalé blikanie: Bliknutie raz za sekundu*2

Rýchle blikanie: Bliknutie štyrikrát za sekundu*3

Infračervený senzor diaľkového ovládania
Prijíma riadiaci signál z dodávaného infračerveného diaľkového ovládača.

8.

22



Súvisiaca téma

Chybové/varovné správy

Pripojenie záznamového signálu

Demontáž objektívu

5-041-959-13(1) Copyright 2022 Sony Corporation

Prívod vzduchu

Poznámka

Nezablokujte prúdenie vzduchu. Môže to spôsobiť poruchu.

9.
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Zadný pohľad

Táto téma popisuje umiestnenie a funkciu dielov na zadnej strane jednotky.

Súvisiaca téma

Bočný pohľad

5-041-959-13(1) Copyright 2022 Sony Corporation

Zaisťovacia páčka hlavy kamery
Zaistí pohyb hlavy kamery dopredu/dozadu.

Poznámka

Ak nemeníte objektív, vždy ho nastavte do polohy uzamknutia.

Pri preprave jednotky vždy odstráňte objektív a nastavte ho do uzamknutej polohy.

Pred použitím zaisťovacej páčky vypnite napájanie jednotky a zaistite hlavu kamery vodorovne pomocou zaisťovacej páčky
otáčania/nakláňania, aby ste predišli zraneniu v dôsledku privretých prstov. Podrobnosti o zaisťovacej páčke
otáčania/nakláňania nájdete v časti „Zaisťovacia páčka otáčania/nakláňania“ v kapitole „Bočný pohľad“.

1.

Posuvná základňa2.
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Pripojovací blok

Táto téma popisuje umiestnenie a funkciu dielov na pripojovacom bloku jednotky.

 (uzemnenie) pripojenie
Pripojte k zemi pripojením k uzemňovacej svorke elektrickej zásuvky alebo k uzemňovacej tyči.

1.

Konektor DC IN (štandardný jednosmerný konektor)
Pripojte na sieťový adaptér.

Poznámka

Nepoužívajte iný sieťový adaptér ako ten, ktorý je súčasťou dodávky. Pripojenie iného adaptéra môže spôsobiť požiar alebo
poruchu.

2.

 LAN (sieťový) konektor (RJ-45)
Pripojte sieťový kábel (kategória 5e alebo vyššia) pre sieťovú komunikáciu a napájanie PoE++* .

LED zobrazenie rýchlosti
Oznamuje rýchlosť sieťového pripojenia.

3.

PoE++: Napájanie cez Ethernet Plus Plus. Vyhovuje IEEE802.3bt (Typ 4 Trieda 8). Podrobnosti o pripojení nájdete v návode na obsluhu
napájacieho zariadenia.

*
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Link/ACT LED zobrazenie stavu
Oznamuje stav sieťového pripojenia.

Poznámka

Ak pripájate tento výrobok na Internet, pripájajte sa prostredníctvom systému, ktorý poskytuje funkciu ochrany, napríklad
smerovač alebo firewall. Ak sa pripojíte bez takejto ochrany, môžu nastať problémy so zabezpečením.

Displej  Rýchlosť pripojenia

Nesvieti
Pripojenie 10 Mbps

Pripojenie 100 Mbps

Svieti oranžová Pripojenie 1000 Mbps

Displej  Stav pripojenia

 Nesvieti Žiadne pripojenie

Blikajúca zelená Spojenie vytvorené, údaje aktívne

Svieti zelená Aktívne spojenie

Konektor TC IN
Zadajte signál externého referenčného časového kódu.

Podrobnosti nájdete v časti „Uzamknutie časového kódu na iné zariadenia“.

4.

HDMI konektor
Výstup videa z jednotky ako signál HDMI.

Podrobnosti nájdete v časti „Konektor HDMI (konektor typu A)“ v časti „Pripojenie externých monitorov
a záznamových zariadení“.

5.

Montážna skrutka prídržnej doštičky kábla HDMI
Ak chcete zabrániť odstráneniu kábla HDMI, pripevnite dodanú prídržnú doštičku kábla HDMI pomocou dodanej
montážnej skrutky (M2.6×6) a pripevnite kábel HDMI pomocou komerčne dostupnej káblovej svorky alebo pásky.

Podrobnosti o pripevnení prídržnej doštičky kábla HDMI nájdete v časti „Pripojenie káblov“.

6.

OPTION konektor
Slúži na pripojenie záznamového signálu z externého zariadenia alebo ovládača objektívu.

Podrobnosti nájdete v častiach „Pripojenie záznamového signálu“ a „Pripojenie ovládača objektívu“.

7.

Svorka na šnúry
Používa sa na zaistenie kábla sieťového adaptéra.

8.

RESET spínač
Stlačte aspoň na 5 sekúnd pomocou hrotu pera alebo podobného zariadenia, aby ste obnovili nastavenia jednotky na
predvolené výrobné hodnoty.
Pomocou prepínača SETUP 1 si môžete vybrať, či chcete obnoviť iba nastavenia sieťového pripojenia alebo všetky
nastavenia.

9.

OPTICAL výstupný konektor
Výstup signálu SDI konvertovaný na optický formát, keď je pripojený modul SFP+ (voliteľné).

10.
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Podrobnosti nájdete v časti „Výstup signálu z optického vlákna“.
SETUP prepínače

Nakonfigurujte nasledujúce nastavenia.
Prepínač 1: Nastavuje, ktoré nastavenia sa resetujú po stlačení spínača RESET.

Prepínač 2: Nastavuje, či sa po pripojení vstupného audio zariadenia zapne/vypne napájanie +48 V (fantómové
napájanie). Nastavenie sa použije okamžite.
Táto funkcia je povolená, keď [Audio] > [Audio Input] > [AUDIO IN Select] je nastavené na [MIC] v ponuke kamery.

Poznámka

Nastavenie prepínača 2 do polohy ON a pripojenie mikrofónu, ktorý nie je kompatibilný so zdrojom +48 V, môže poškodiť
pripojené zariadenie. Pred pripojením zariadenia skontrolujte nastavenie.

Prepínač 3: Zapína/vypína komunikáciu VISCA over IP. Nastavenia sa použijú pri zapnutí kamery.
Ak chcete jednotku používať pri pripojení k diaľkovému ovládaču (RM-IP500), nastavte do polohy ON.

Poznámka

Ak heslo správcu nebolo nakonfigurované, komunikácia VISCA over IP je zakázaná bez ohľadu na nastavenie prepínača.
Podrobnosti o konfigurácii hesla správcu nájdete v časti „Inicializácia jednotky“.

Prepínač 4: Mení rýchlosť príkazov otáčania a nakláňania odosielaných z infračerveného diaľkového ovládača.
Nastavenie sa použije okamžite.

11.

Nastavenie Popis

OFF
(predvolené)

Obnoví iba nastavenia sieťového pripojenia. Nastavenia siete, bezpečnostné nastavenia
a informácie o používateľovi (meno používateľa a heslo) jednotky sa vynulujú.

ON Obnoví všetky nastavenia na pôvodné hodnoty z výroby.

Nastavenie Popis

OFF
(predvolené)

Nenapája sa +48 V (fantómové napájanie). Toto nastavenie nakonfigurujte, keď používate
externé zvukové zariadenie (napríklad mixér), dynamický mikrofón alebo mikrofón so vstavanou
batériou.

ON
Napájanie +48 V (fantómové napájanie) mikrofónu kompatibilného s fantómovým napájaním
pripojeného ku konektoru AUDIO IN (CH-1 alebo CH-2).

Nastavenie Popis

OFF (predvolené) Neodpovedá na príkazy VISCA over IP.

ON Prijíma príkazy VISCA over IP.
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Súvisiaca téma

Uzamknutie časového kódu na iné zariadenia

Pripojenie externých monitorov a záznamových zariadení

Pripojenie káblov

Pripojenie záznamového signálu

Pripojenie ovládača objektívu

Výstup signálu z optického vlákna

Inicializácia jednotky

Synchronizácia fázy video signálu (Genlock)

Pripojenie externého mikrofónu alebo externého zvukového zariadenia

5-041-959-13(1) Copyright 2022 Sony Corporation

Nastavenie Popis

OFF (predvolené) Funguje pri normálnej rýchlosti.

ON Funguje pri maximálnej rýchlosti.

SDI OUT konektor
Výstup videa z jednotky ako signál 12G/6G/3G/HD-SDI.
Jednotku je možné nakonfigurovať aj na výstup signálu RAW.

Podrobnosti nájdete v časti „Konektor SDI OUT (typ BNC)“ v kapitole „Pripojenie externých monitorov
a záznamových zariadení“.

12.

 Infračervený senzor diaľkového ovládania (zadný)
Infračervený senzor pre dodávaný infračervený diaľkový ovládač.

13.

Ventilátor/výstup vzduchu
Odvádza teplo zvnútra jednotky.

Poznámka

Nezakrývajte výstup vzduchu. Môže to spôsobiť poruchu.

Všimnite si, že oblasť v blízkosti výstupu vzduchu môže byť horúca.

14.

GENLOCK konektor
Používa sa na vstup externého synchronizačného signálu.

Podrobnosti nájdete v časti „Synchronizácia fázy video signálu (Genlock)“.

15.

AUDIO IN konektor (XLR typ 5-kolíkový konektor)
Používa sa na vstup signálu z externého mikrofónu alebo zvukového zariadenia.
Funguje ako konektor AUDIO IN CH-1 alebo AUDIO IN CH-2.

Podrobnosti nájdete v časti „Pripojenie externého mikrofónu alebo externého zvukového zariadenia“.

16.
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Bočný pohľad

Táto téma popisuje umiestnenie a funkciu dielov na bočnej strane jednotky.

Rada

Tento popis sa vzťahuje na ilustráciu jednotky bez nasadeného objektívu.

Zaisťovacia páčka otáčania/nakláňania
Zaistí mechanizmus otáčania/nakláňania jednotky. Použite v nasledujúcich prípadoch.

Pri preprave alebo balení jednotky.
Pri nasadzovaní alebo vyberaní objektívu. Podrobnosti nájdete v časti „Nasadenie objektívu“ alebo „Demontáž
objektívu“.
Pri použití objektívu, ktorý nepodporuje funkciu otáčania a nakláňania (napríklad objektívy Sony SEL100400GM /
SEL200600G / SEL400F28GM / SEL600F40GM).
Pri preprave jednotky vždy odstráňte objektív a nastavte ho do uzamknutej polohy.

1.
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Súvisiaca téma

Nasadenie objektívu

Demontáž objektívu

Vloženie pamäťových kariet

Prístup k webovej aplikácii z webového prehliadača

5-041-959-13(1) Copyright 2022 Sony Corporation

Rada

Pohyb otáčania alebo nakláňania je možné zaistiť v nasledujúcich uhloch.

Posuvná základňa2.

Skrutkové otvory pre externé zariadenia (4 miesta)
Pre skrutky M3 do dĺžky 6 mm.

Poznámka

Nepoužívajte skrutky dlhšie ako 6 mm. Môže to spôsobiť poruchu.

3.

Kontrolka prístupu A4.

Kontrolka prístupu B
Kontrolka svieti alebo bliká, keď je vložené záznamové médium.

Podrobnosti nájdete v časti „Vloženie pamäťových kariet“.

5.

Zásuvka na kartu CFexpress Type A/SD (A)6.

Zásuvka na kartu CFexpress Type A/SD (B)
Používa sa na vkladanie záznamového média.

Podrobnosti nájdete v časti „Vloženie pamäťových kariet“.

7.

QR kód pre pripojenie k sieti
Použite pri konfigurácii počiatočných nastavení.

Podrobnosti nájdete v časti „Prístup k webovej aplikácii z webového prehliadača“.

8.
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Pohľad zhora

Táto téma popisuje umiestnenie a funkciu dielov na hornej strane jednotky.

Rada

Tento popis sa vzťahuje na ilustráciu jednotky bez nasadeného objektívu.

5-041-959-13(1) Copyright 2022 Sony Corporation

Skrutkové otvory pre externé zariadenia (2 miesta)
Kompatibilné so skrutkami 1/4-20 UNC pre statív.
Maximálna dĺžka 6 mm.

1.

ɸ (značka zobrazovača)
Značka zobrazovača je v rovnakej rovine ako obrazový snímač.
Ak chcete presne zmerať vzdialenosť medzi jednotkou a predmetom, použite túto značku zobrazovača ako
referenčný bod.

2.
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Pohľad zdola

Táto téma popisuje umiestnenie a funkciu dielov na spodnej strane jednotky.

Rada

Tento popis sa vzťahuje na ilustráciu jednotky bez nasadeného objektívu.

Otvory pre skrutky na upevnenie stropného držiaka (6 miest, efektívna hĺbka závitu 5,5 mm (7/32 palca))
Pri montáži jednotky na strop alebo policu vo vysokej polohe pripevnite držiak telesa (voliteľné príslušenstvo)
k základni jednotky pomocou šiestich montážnych skrutiek držiaka telesa v týchto otvoroch pre skrutky.

Podrobnosti o montáži nájdete v časti „Montáž vo vzpriamenej polohe na vyvýšenom, pevnom mieste“ a „Montáž
na strop“.

1.

Upevňovacie skrutky statívu (2 miesta)
Používa sa pri montáži jednotky na statív kamery (voliteľné príslušenstvo, skrutky 1/4-20 UNC s dĺžkou do 5,5 mm
(7/32 palca)).

2.
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Súvisiaca téma

Montáž vo vzpriamenej polohe na vyvýšenom, pevnom mieste

Montáž na strop

5-041-959-13(1) Copyright 2022 Sony Corporation

Poznámka

Nepoužívajte skrutky dlhšie ako 5,5 mm (7/32 palca). Môže to spôsobiť poruchu.
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Podpera objektívu

Táto téma popisuje umiestnenie a funkciu častí podpery objektívu jednotky.

Rada

Tento popis sa vzťahuje na ilustráciu jednotky bez nasadeného objektívu.

Podperná tyč objektívu (2)
Podopiera objektív.
Možno použiť aj na montáž všeobecného príslušenstva s tyčou Ø15.

1.
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Podperná jednotka objektívu
Podpera objektívu sa môže posúvať dopredu/dozadu podľa objektívu a potom sa zaistí.

2.

Pripevňovacia skrutka podstavca podpery objektívu
Pripevnite k podstavcu podpery objektívu. Skrutku môžete nastaviť nahor/nadol tak, aby zodpovedala výške podpery
objektívu.

3.

Upínacia páčka podpernej tyče objektívu (2 miesta)
Zaisťuje prednú/zadnú polohu jednotky podpery objektívu .

4.

Pripevňovacia skrutka upínacej páčky podstavca podpery objektívu
Zaisťuje vertikálnu polohu pripevňovacej skrutky podstavca podpery objektívu.

Rada

Ak je upínacia páčka v polohe, ktorá sťažuje otáčanie, uvoľnite upínaciu páku a otočte ju do uhla, ktorý zjednoduší obsluhu.
Keď je v požadovanej polohe, zatvorte upínaciu páčku.

A: Pripevňovacia skrutka upínacej páčky podstavca podpery objektívu
B: Upínacia páčka podpernej tyče objektívu

Poznámka

Ak chcete zabrániť tomu, aby podpera objektívu prekážala pri ovládaní otáčania a nakláňania, posuňte podperu objektívu
hore k hlave kamery, keď nepoužívate podperu objektívu, a posuňte pripevňovaciu skrutku podstavca podpery objektívu do
najvyššej polohy (najbližšie k objektívu).

5.
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Umiestnenie a funkcia častí infračerveného diaľkového ovládača (súčasť dodávky)

Táto téma popisuje umiestnenie a funkciu častí infračerveného diaľkového ovládača (súčasť dodávky).

Tlačidlo REC● (záznam START/STOP)
Stlačením spustíte alebo zastavíte nahrávanie.

1.

Tlačidlo MENU
Stlačením zobrazíte alebo skryjete ponuku kamery.

2.

Ovládacie tlačidlá GUI
Stlačením vykonáte operácie v ponuke kamery, v dialógových oknách so správami, ktoré obsahujú tlačidlá, a ďalšie
funkcie zobrazenia na obrazovke.

3.

Tlačidlo CANC./BACK
Stlačením zrušíte nastavenie alebo sa vrátite na predchádzajúcu obrazovku ponuky kamery.

4.
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Batéria pre infračervené diaľkové ovládanie

Infračervené diaľkové ovládanie vyžaduje dve batérie AA (LR6).
Vložte batérie do infračerveného diaľkového ovládača, ako je znázornené na nasledujúcom obrázku.

Ovládacie tlačidlá otáčania a nakláňania
Stláčaním tlačidiel šípok ovládate otáčanie/nakláňanie kamery. Stlačením tlačidla HOME obnovíte orientáciu kamery
tak, aby smerovala dopredu.

5.

Ovládacie tlačidlá prednastavenej polohy
Stlačte a podržte tlačidlo PRESET a stlačením jedného z tlačidiel 1 až 3 uložte smer kamery, transfokáciu
a nastavenie zaostrenia do stlačeného číselného tlačidla.
Stlačením číselného tlačidla s uloženými nastaveniami vyvoláte uložený stav.

6.

Ovládacie tlačidlá zaostrenia
Použite na úpravu zaostrenia.
Ak chcete zaostriť automaticky, stlačte tlačidlo AF.
Ak chcete zaostriť manuálne, stlačte tlačidlo MF a potom stlačte tlačidlo F (Ďaleko) na zaostrenie na vzdialené
objekty alebo tlačidlo N (Blízko) na zaostrenie na blízke objekty.

7.

Priraditeľné tlačidlá 1 až 3
Vykonáva funkcie priradené priraditeľným tlačidlám pomocou ponuky kamery.
Ak priradíte funkciu [Direct Menu] priraditeľnému tlačidlu, môžete upraviť expozíciu, vyváženie bielej a iné nastavenia
pomocou ovládacích tlačidiel GUI.

Podrobnosti o priradení pomocou ponuky kamery nájdete v časti „Priraditeľné tlačidlá“.

Podrobnosti o priamej ponuke nájdete v časti „Funkcie priamej ponuky“.

8.

 (hlavný) vypínač
Stlačením zapnete jednotku alebo prepnete napájanie do pohotovostného stavu.

9.

Tlačidlo THUMBNAIL
Zobrazí obrazovku s miniatúrami zobrazujúcimi klipy zaznamenané na pamäťovej karte zariadenia.

Podrobnosti o obrazovke s miniatúrami nájdete v časti „Obrazovka s miniatúrami“.

Pomocou ovládacích tlačidiel GUI môžete vyberať klipy a ovládať prehrávanie na obrazovke miniatúr.

Podrobnosti o výbere klipov a ovládaní prehrávania nájdete v časti „Prehrávanie nahraných klipov“ a „Operácie
s nahratými klipmi“.

10.

Tlačidlo SLOT SEL (výber zásuvky pre pamäťovú kartu (A)/(B))
Keď sú vložené dve pamäťové karty, stlačením tlačidla prepínate medzi pamäťovými kartami na nahrávanie.
Stlačením tohto tlačidla počas zobrazenia obrazovky s miniatúrami môžete prepínať medzi pamäťovými kartami,
ktoré chcete zobraziť.

11.

Tlačidlo P/T RESET (restovanie otáčania/nakláňania)
Resetuje funkcie otáčania a nakláňania. Stlačte tlačidlo, keď kontrolky POWER a NETWORK súčasne blikajú alebo
keď sa [Execute Pan-Tilt Reset] zobrazí na ovládacom paneli orámovania vo webovej aplikácii.

12.

Ovládacie tlačidlá transfokácie
Ak chcete priblížiť, stlačte tlačidlo T (teleobjektív).
Ak chcete oddialiť, stlačte tlačidlo W (širokouhlý).

13.
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Poznámka

Nepoužívajte žiadne iné batérie ako mangánové alebo alkalické batérie, pretože môžu prasknúť.

Použité batérie zlikvidujte v súlade so zákonmi a predpismi danej krajiny alebo regiónu.

Súvisiaca téma

Priraditeľné tlačidlá

Funkcie priamej ponuky

Obrazovka s miniatúrami

Prehrávanie nahraných klipov

Operácie s nahratými klipmi

5-041-959-13(1) Copyright 2022 Sony Corporation
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Prehľad obrazovky webovej aplikácie

Pripojením tabletu alebo počítača môžete otáčať/nakláňať, približovať, nahrávať, prehrávať nahrané video a konfigurovať
jednotku z webového prehliadača (ďalej sa táto funkcia označuje ako „webová aplikácia“).

Podrobnosti o spustení webovej aplikácie nájdete v časti „Prístup k webovej aplikácii z webového prehliadača“.

Poznámka

Webová aplikácia nepodporuje zvukový výstup kamery.

Po spustení webovej aplikácie sa zobrazí nasledujúca živá prevádzková obrazovka.

Živá prevádzková obrazovka

Podrobnosti o živej prevádzkovej obrazovke nájdete v časti „Štruktúra živej prevádzkovej obrazovky“.
V hornej časti obrazovky sa zobrazujú tlačidlá a ikony spoločné pre živú prevádzkovú obrazovku a prevádzkovú
obrazovku prehrávania.

Podrobnosti o spoločnej oblasti obrazoviek nájdete v časti „Štruktúra spoločnej oblasti obrazoviek“.
Medzi obrazovkami môžete prepínať stlačením prepínacích kariet obrazoviek v spoločnej oblasti.
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Prevádzková obrazovka prehrávania

Stlačením karty [Playback] zobrazíte prevádzkovú obrazovku prehrávania.

Podrobnosti o prevádzkovej obrazovke prehrávania nájdete v časti „Štruktúra prevádzkovej obrazovky prehrávania“.

Obrazovka nastavení

Stlačením karty [Settings] zobrazíte obrazovku nastavení (ďalej len webová ponuka).
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Poznámka

Vo webovej ponuke sa nastavenia nepoužijú, kým nestlačíte tlačidlo [OK]. Ak zmeníte nastavenia na stránke, ktorá má tlačidlo
[OK], nezabudnite stlačiť tlačidlo [OK].

Podrobnosti o obrazovke nastavení nájdete v časti „Štruktúra obrazovky nastavení“.
V tomto sprievodcovi s nápovedou sa obrazovka s nastaveniami webovej aplikácie označuje ako webová ponuka.

Súvisiaca téma
Prístup k webovej aplikácii z webového prehliadača

Štruktúra živej prevádzkovej obrazovky

Štruktúra spoločnej oblasti obrazoviek

Štruktúra prevádzkovej obrazovky prehrávania

Štruktúra obrazovky nastavení

5-041-959-13(1) Copyright 2022 Sony Corporation
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Štruktúra spoločnej oblasti obrazoviek

Táto téma popisuje štruktúru spoločnej oblasti obrazoviek.

Názov kamery
Zobrazuje názov kamery.
Názov môžete zmeniť pomocou položky [Network] > [Camera Name] vo webovej ponuke.
Farba pozadia sa mení podľa externého záznamového signálu.

1.

Hlavný vypínač
Keď je jednotka zapnutá, zobrazí sa [Power ON]. Stlačením vypínača a výberom položky [Power Standby] nastavíte
napájanie jednotky do pohotovostného stavu.
Keď sa zobrazí [Power Standby], môžete stlačením vypínača a zvolením [Power ON] zapnúť napájanie jednotky.

2.

Prepínacie karty prevádzkovej obrazovky
Stlačením karty zobrazíte príslušnú prevádzkovú obrazovku.
[Live] karta: Zobrazí živú prevádzkovú obrazovku.
[Playback] karta: Zobrazí prevádzkovú obrazovku prehrávania.
[Settings] karta: Zobrazí obrazovku nastavení (webová ponuka).

3.

Značka upozornení
Keď príde správa, označenie značky sa zmení, ako je znázornené nižšie.

 (Upozornenia sú zapnuté)
Vykonajte potrebné kroky podľa správy zobrazenej na obrazovom paneli kamery.

Poznámka

Správy sa nezobrazujú, keď [Monitoring] > [Output Display] > [HDMI/Stream] je nastavené na [Off] vo webovej ponuke.
Nastavte na [On] na kontrolu obsahu správ.

4.

Tlačidlo  (stav kamery)
Stlačením tlačidla zobrazíte na samostatnej obrazovke informácie o zaznamenanom obraze/výstupnom obrazovom
signále kamery, informácie o objektíve a stave ovládača objektívu (voliteľné príslušenstvo).

5.

42



5-041-959-13(1) Copyright 2022 Sony Corporation

Keď sa objaví oznámenie súvisiace s ovládačom objektívu (voliteľné príslušenstvo), indikácia sa zmení, ako je
uvedené nižšie.

Spínač uzamknutia prevádzkovej obrazovky
 (Funkcie odomknuté): Ak chcete ovládať funkcie na živej prevádzkovej obrazovke a na prevádzkovej

obrazovke prehrávania, nastavte prepínač do ľavej polohy.
 (Funkcie zamknuté): Nastavte prepínač do pravej polohy, aby ste uzamkli funkcie na živej prevádzkovej

obrazovke a na prevádzkovej obrazovke prehrávania, aby ste predišli náhodnej chybnej činnosti.

6.
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Štruktúra živej prevádzkovej obrazovky

Táto téma popisuje štruktúru živej prevádzkovej obrazovky.

Ovládací panel prednastavenej polohy
Zobrazuje zaregistrovanú polohu predvoľby pomocou miniatúry. Dvojitým klepnutím na miniatúru sa vrátite do polohy
uloženej v predvoľbe.

Podrobnosti o prednastavenej polohe nájdete v časti „Uloženie/obnovenie otáčania/nakláňania, polohy
transfokácie a nastavenia zaostrenia pomocou webovej aplikácie“.
Podrobnosti o sledovaní PTZ nájdete v časti „Nahrávanie zarámovaní kamery pomocou webovej aplikácie“.

1.

Obrazový panel kamery
Zobrazuje aktuálny obraz kamery a stav jednotky.
Zobrazuje rovnaký obraz ako výstup HDMI.
Nad obrazom sa zobrazí nasledujúci stav. Okolo obrazu sa tiež zobrazí červený alebo zelený rámček podľa prijatého
externého záznamového signálu.

2.
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Tlačidlo [Display]
Stlačením tohto tlačidla zobrazíte na obraze informácie o kamere.
Opätovným stlačením pri zobrazených informáciách o kamere tieto informácie skryjete.

Okrem značiek sa podľa stavu zobrazujú aj niektoré indikátory a správy súvisiace s automatickým zaostrovaním,
ktoré nemožno skryť stlačením tlačidla [Display].

Podrobnosti o zobrazených informáciách o kamere nájdete v časti „Obrazovka kamery“.

Tlačidlo zastavenia pre režim AF so sledovaním v reálnom čase

Č. Displej Popis

2-
1

Indikátor režimu zaostrenia
Pozrite si časť „Indikátor režimu zaostrenia“ v časti „Obrazovka
kamery“.

2-
2

Režim nahrávania, zásuvka A/B,
indikátor intervalu nahrávania
Interval Rec

Pozrite si časť „Režim nahrávania, zásuvka A/B, indikátor intervalu
nahrávania Interval Rec“ v časti „Obrazovka kamery“.

2-
3

Indikátor stavu streamovania
Zobrazuje sa počas streamovania (len keď je [Stream Setting]
nastavené na [RTMP] alebo [SRT-Caller]).

2-
4

Indikátor stavu prevádzky výstupu
RAW

Zobrazuje výstupný stav signálu RAW. Podrobnosti o RAW nájdete
v časti „Záznam RAW videa“.

2-
5

Indikátor zostávajúcej kapacity
média

Pozrite si časť „Indikátor zostávajúcej kapacity média“ v časti
„Obrazovka kamery“.

2-
6

Indikátor polohy transfokácie

Pozrite si časť „Indikátor polohy transfokácie“ v časti „Obrazovka
kamery“.
Keď je pripojený ovládač objektívu (voliteľné príslušenstvo), zobrazí
sa . Ak sa vyskytne chyba v ovládači objektívu (voliteľné
príslušenstvo), zobrazí sa .

2-
7

Indikátor režimu AE/úrovne AE
Pozrite si časť „Indikátor režimu AE/úrovne AE“ v časti „Obrazovka
kamery“.
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Stlačením tlačidla zastavíte sledovanie objektu.

Podrobnosti nájdete v časti „Sledovanie konkrétneho subjektu (Realtime Tracking AF)“.
Tlačidlo nahrávania START/STOP
Stlačením tlačidla spustíte nahrávanie. Počas nahrávania tlačidlo START/STOP nahrávania svieti načerveno.
Stlačením počas nahrávania nahrávanie zastavíte.
Prepínač Hold môžete nastaviť do stavu deaktivácie, aby ste predišli nesprávnej činnosti tlačidla nahrávania
START/STOP.

3.

Panel základnej konfigurácie kamery
Zobrazuje nastavenia základných funkcií potrebných na snímanie pomocou tlačidiel. Stlačením tlačidla zobrazíte
príslušnú obrazovku nastavenia pre každú funkciu na paneli úprav základnej konfigurácie kamery nižšie (5).

4-1 [FPS]
4-2 [ISO/Gain / Exposure Index]
4-3 [Shutter]
4-4 [Iris]
4-5 [ND Filter]
4-6 [Scene File / Base Look/LUT]
4-7 [White Balance]

Podrobnosti nájdete v popise každej funkcie.

4.

Funkcia Referencia

FPS „Slow & Quick Motion“

ISO/Gain
„Nastavenie základnej citlivosti“, „Automatická úprava zosilnenia“ a „Manuálna úprava zosilnenia“
v „Úprava zosilnenia“

Exposure
Index

„Nastavenie základnej citlivosti“ a „Zmena rozloženia tmavých a svetlých oblastí
v zaznamenanom videu“

Shutter „Automatická úprava uzávierky“ a „Manuálna úprava uzávierky“ v „Úprava uzávierky“

Iris „Automatická úprava clony“ a „Manuálna úprava clony“ v „Úprava clony“

ND Filter „O ND filtri“ v „Úprava úrovne svetla (ND filter)“

Scene File „Prehľad vzhľadu“ a ďalšie témy v „Snímanie s požadovaným vzhľadom“

Base
Look/LUT

„Snímanie s úpravou vzhľadu v postprodukcii“
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Funkcia Referencia

White
Balance

„Obrazovka nastavenia vyváženia bielej“

Priraditeľné tlačidlá/Panel nastavenia základnej konfigurácie kamery
Zobrazuje priraditeľné tlačidlá počas bežnej prevádzky. Stlačením tlačidiel na paneli základnej konfigurácie kamery
(4. položka) zobrazíte príslušné položky nastavenia. Stlačením tlačidla [X] alebo opätovným stlačením tlačidla
nastavovacieho panela kamery sa vrátite na zobrazenie priraditeľných tlačidiel.

Podrobnosti o priraditeľných tlačidlách nájdete v časti „Priraditeľné tlačidlá“.
Podrobnosti o paneli úprav základnej konfigurácie kamery nájdete v popise jednotlivých funkcií.

5.

Ovládací panel orámovania / ovládací panel GUI
Prepínajte medzi ovládacím panelom orámovania / ovládacím panelom GUI pomocou kariet v hornej časti.
Stlačením tlačidla  (Zatvoriť) v pravom hornom rohu obrazovky skryjete ovládací panel, aby ste zabránili
neúmyselnej činnosti. Ak sa ovládací panel nezobrazí, zobrazíte ho stlačením tlačidla  (Otvoriť).
Pomocou ovládacieho panela orámovania upravte orámovanie. Stlačením 
(otáčanie/nakláňanie/transfokácia) zobrazíte ovládací panel zarámovania.

Podrobnosti o funkcii nájdete v časti „Úprava orámovania“.

Rada

Joysticková časť ovládacieho panela orámovania sa zobrazí, ako je znázornené nižšie, keď je funkcia otáčania/nakláňania
deaktivovaná a keď je potrebná inicializácia otáčania/nakláňania.

Keď je funkcia otáčania a nakláňania zablokovaná pomocou zaisťovacej páčky otáčania/nakláňania

Keď nie je inicializovaná funkcia otáčania/nakláňania

6.
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Keď je potrebné resetovať funkciu otáčania a nakláňania

Keď je funkcia otáčania/nakláňania deaktivovaná

Keď funkcia otáčanie/nakláňanie nie je inicializovaná alebo je potrebné ju resetovať, môžete rýchlo získať prístup k tlačidlu
 (otáčanie/nakláňanie reset) v ovládacom paneli kamery stlačením správy zobrazenej pod joystickom.

Na ovládanie ponuky kamery, prehrávania klipov a ďalších funkcií použite ovládací panel GUI. Stlačením karty
 (GUI kamery) obrazíte ovládací panel GUI.

Podrobnosti o ovládaní nájdete v časti „Ovládanie ponuky kamery“ a „Prehrávanie nahraných klipov“.
Ovládací panel kamery
Používa sa na konfiguráciu funkcií potrebných na ovládanie kamery.
Prepínajte medzi obrazovkami, ktoré sa majú zobraziť, pomocou kariet v hornej časti.
Stlačením tlačidla  (Zatvoriť) v pravom hornom rohu obrazovky skryjete ovládací panel, aby ste zabránili
neúmyselnej činnosti. Ak sa ovládací panel nezobrazí, zobrazíte ho stlačením tlačidla  (Otvoriť).

7.
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Podrobnosti nájdete v popise každej funkcie.

Karta  (Main)
Zobrazuje položky nastavenia pre často používané funkcie.
Funkciu horného a spodného posúvníka je možné zmeniť stlačením tlačidla [▼] a výberom zo zobrazeného
zoznamu. Je možné zvoliť nasledujúce funkcie.

ND Filter
Iris
ISO*

Gain*

Exposure Index*

AE Level
Zoom Speed
Pan-Tilt Speed

Karta  (Focus)
Zobrazuje položky nastavenia súvisiace so zaostrením.

Karta  (Audio)

Zobrazuje položky nastavenia súvisiace so zvukom.

Zobrazuje sa podľa nastavení ponuky.*
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Karta  (Stream)
Zobrazuje položky nastavenia súvisiace so streamovaním.
Zobrazené položky sa budú líšiť v závislosti od nastavenia formátu streamovania.
Pri nastavení na [RTMP] alebo [SRT-Caller] je možné spustiť/zastaviť streamovanie na tejto obrazovke.

Podrobnosti nájdete v časti „O streamovaní“ a ďalšie témy v časti „Konfigurácia streamovania“.
Ak dôjde k zlyhaniu pripojenia, zobrazia sa informácie o chybe. Podrobnosti o chybových informáciách nájdete
v časti „Chybové/varovné správy“.

Karta  (Others)
Zobrazuje položky nastavenia súvisiace s inými funkciami.
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Súvisiaca téma

Uloženie/obnovenie otáčania/nakláňania, polohy transfokácie a nastavenia zaostrenia pomocou webovej aplikácie

Nahrávanie zarámovaní kamery pomocou webovej aplikácie

Obrazovka kamery

Záznam RAW videa

Sledovanie konkrétneho subjektu (Realtime Tracking AF)

Slow & Quick Motion

Nastavenie základnej citlivosti

Automatická úprava zosilnenia

Manuálna úprava zosilnenia

Zmena rozloženia tmavých a svetlých oblastí v zaznamenanom videu

Automatická úprava uzávierky

Manuálna úprava uzávierky

Automatická úprava clony

Manuálna úprava clony

O ND filtri

Prehľad vzhľadu

Snímanie s úpravou vzhľadu v postprodukcii

Obrazovka nastavenia vyváženia bielej

Priraditeľné tlačidlá

Prehrávanie nahraných klipov

Ovládanie ponuky kamery

O streamovaní

Chybové/varovné správy

5-041-959-13(1) Copyright 2022 Sony Corporation

Stlačením tlačidla [Full Screen Display] sa otvorí nová karta vo webovom prehliadači a zobrazí sa obraz
z obrazového panela kamery na celej obrazovke.
Dochádza len k zobrazeniu obrazu; dotykový AF a ďalšie funkcie nie sú dostupné.

Poznámka

Obrazovka živej prevádzky na pôvodnej karte naďalej funguje. Ak nie je potrebná žiadna operácia, odporúčame zatvoriť
kartu, aby sa znížil počet súčasných pripojení.

Stlačením tlačidla  (Inicializovať ovládač objektívu) inicializujte ovládač objektívu (voliteľné
príslušenstvo tretej strany). Táto funkcia je povolená, keď [Technical] > [Lens Controller] > [Zoom] > [Setting] je
nastavené na [On] v ponuke kamery.
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Štruktúra prevádzkovej obrazovky prehrávania

Táto téma popisuje štruktúru prevádzkovej obrazovky prehrávania.

Obrazový panel kamery
Zobrazuje prehrávaný obraz a súvisiace informácie. Po zastavení prehrávania sa zobrazí obrazovka s obrazom
kamery.

1.
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1-1 Dátum a čas snímania
1-2 Indikátor stavu prehrávania
1-3 Indikátor formátu prehrávania (veľkosť obrazu)
1-4 Indikátor formátu prehrávania (kodek)
1-5 Zobrazenie názvu klipu
1-6 Číslo klipu/celkový počet klipov
1-7 Zobrazenie názvu LUT
1-8 Indikátor stavu streamovania
1-9 Indikátor formátu prehrávania (snímková frekvencia a metóda skenovania)
1-10 Indikátor vzhľadu nahrávania

Ovládací panel prehrávania

Zobrazuje ovládacie tlačidlá prehrávania.

Tlačidlo [Display]
Stlačením prepínate medzi zobrazením na obrazovke.
Tlačidlo [Thumbnail]
Zobrazuje klipy zaznamenané na pamäťovej karte na obrazovom paneli kamery ako miniatúry.

2.

Tlačidlo Funkcia

Tlačidlo  (Prehrávanie/Pauza) Prehrá klip. Počas prehrávania pozastaví klip.

Tlačidlo  (Rýchly posun dopredu), tlačidlo
 (Rýchly posun dozadu)

Prehráva klip vysokou rýchlosťou. Po stlačení tlačidla sa
rýchlosť prehrávania zmení v troch krokoch.

Tlačidlo  (Nasledujúci), tlačidlo 
(Predchádzajúci)

Preskočí na začiatok klipu alebo predchádzajúci/nasledujúci
klip.

Tlačidlo  (Stop) Zastaví prehrávanie.
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Súvisiaca téma

Obrazovka s miniatúrami

Priraditeľné tlačidlá

Prehrávanie nahraných klipov

5-041-959-13(1) Copyright 2022 Sony Corporation

Stlačením tlačidla [Thumbnail] počas zobrazenia obrazovky miniatúr zatvoríte obrazovku s miniatúrami a vrátite sa
k obrazu kamery.

Podrobnosti o obrazovke s miniatúrami nájdete v časti „Obrazovka s miniatúrami“.

Tlačidlo [Slot Select]
Prepína medzi cieľovým prehrávaným médiom.

Priraditeľné tlačidlá
Zobrazuje priraditeľné tlačidlá priradené funkciám jednotky.

Podrobnosti o priraditeľných tlačidlách nájdete v časti „Priraditeľné tlačidlá“.

3.

Ovládací panel GUI
Na ovládanie ponuky kamery, prehrávania klipov a ďalších funkcií použite ovládací panel GUI.

Podrobnosti o ovládaní nájdete v časti „Ovládanie ponuky kamery“ a „Prehrávanie nahraných klipov“.

4.
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Štruktúra obrazovky nastavení

Obrazovku nastavení použite na konfiguráciu rôznych položiek nastavenia jednotky vrátane úvodných nastavení,
sieťových nastavení, nastavení snímania/prehrávania pomocou webovej ponuky.

Poznámka

Vo webovej ponuke sa nastavenia spravidla nepoužijú, kým nestlačíte tlačidlo [OK]. Ak zmeníte nastavenia na stránke, ktorá má
tlačidlo [OK], nezabudnite stlačiť tlačidlo [OK].

Podrobnosti o obrazovke nastavení nájdete v časti „Webová ponuka a podrobné nastavenia“.

5-041-959-13(1) Copyright 2022 Sony Corporation
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Ponuka kamery

Stlačením tlačidla [Menu] v ovládacom paneli GUI na živej prevádzkovej obrazovke alebo na prevádzkovej obrazovke
prehrávania zobrazíte ponuku kamery na obrazovom paneli kamery.

Nastavenia potrebné na snímanie a prehrávanie môžete nakonfigurovať pomocou ponuky kamery.
Stlačením tlačidla [Menu] počas zobrazenia ponuky kamery skryjete ponuku kamery.
Ponuka kamery sa ovláda pomocou ovládacieho panela GUI.

Podrobnosti o ponuke kamery nájdete v časti „Ponuka kamery a podrobné nastavenia“.

Poznámka

Ak je [Monitoring] > [Output Display] > [HDMI/Stream] nastavené na Off vo webovej ponuke (vypne prekrytie informácií na
displeji), ponuka kamery sa už na obrazovom paneli kamery nezobrazuje. Majte však na pamäti, že operácie s ponukami
v ovládacom paneli GUI sú stále aktívne. Aby ste predišli neúmyselnej operácii, dávajte pozor, aby ste nevykonávali žiadne
operácie ponuky pomocou ovládacieho panela GUI, ak je [HDMI/Stream] nastavené na Off.

5-041-959-13(1) Copyright 2022 Sony Corporation
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Obrazovka kamery

Môžete zobraziť stav a nastavenia jednotky prekryté výstupným obrazom z kamery. Môžete nastaviť výstupy, pre ktoré je
povolené zobrazovanie na obrazovke, pomocou [Monitoring] > [Output Display] vo webovej ponuke.
Informácie môžete zobraziť/skryť pomocou tlačidla [Display]. Aj keď sú skryté, zobrazia sa pri vykonávaní funkcií priamej
ponuky.
Jednotlivé položky môžete zobraziť/skryť pomocou [Monitoring] > [Display On/Off] v ponuke kamery.

Informácie zobrazené na obrazovke počas snímania

Indikátor nahrávania/kontrolka zostávajúcich súborov

Podrobnosti o prenose súborov nájdete v časti „O prenose súborov“ a ďalšie témy v časti „Prenos súborov“.

1.

Indikátor oblasti zaostrenia
Zobrazuje oblasť zaostrenia pri automatickom zaostrení.

Podrobnosti o automatickom zaostrovaní nájdete v časti „Automatické nastavenie pomocou webovej aplikácie“
a ďalšie témy v časti „Automatické nastavenie zaostrenia (Auto Focus)“.

2.

Režim nahrávania, zásuvka A/B, indikátor intervalu nahrávania Interval Rec

Podrobnosti o Interval Rec nájdete v časti „Prerušované nahrávanie videa (Interval Rec)“.

3.

Displej Význam

●Rec Nahrávanie

Stby Pohotovostný režim nahrávania

Indikátor hĺbky ostrosti4.

Indikátor režimu snímania kamery5.
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Značka  (nesúlad) sa zobrazí, ak existuje nesúlad medzi veľkosťou obrazového kruhu objektívu a efektívnou
veľkosťou obrazu nastavenia režimu snímania kamery.
Keď je Imager Scan Mode nastavený na FF, v režimoch s užším uhlom pohľadu (orezané) sa zobrazí značka „C“.
K orezávaniu dochádza v nasledujúcich režimoch.

Keď je formát záznamu 3840×2160 a snímková frekvencia S&Q Motion je 100 snímok za sekundu alebo 120
snímok za sekundu
Keď je [Codec] nastavený na RAW alebo RAW & XAVC-I a výstupný formát RAW je 3840×2160
Podrobnosti o režime snímania kamery nájdete v časti „Nastavenie režimu snímania kamery“ v časti
„Konfigurácia základnej činnosti“.

Indikátor stavu prevádzky výstupu RAW
Zobrazuje výstupný stav signálu RAW.

Podrobnosti o RAW nájdete v časti „Záznam RAW videa“.

6.

Indikátor snímkovej frekvencie snímania pri pomalom a rýchlom pohybe

Podrobnosti o pomalom a rýchlom pohybe nájdete v časti „Slow & Quick Motion“.

7.

Indikátor polohy zaostrenia

Zobrazuje polohu zaostrenia.

8.

Indikátor režimu zaostrenia

AF detekcie tváre/očí

Podrobnosti o automatickom zaostrovaní s detekciou tváre/očí nájdete v časti „Sledovanie pomocou detekcie
tváre a očí (Face/Eye Detection AF)“.

9.

Displej Význam

Focus Hold Režim Focus Hold

MF Režim MF

AF Režim AF

 (Režim AF so sledovaním v reálnom čase) Režim AF so sledovaním v reálnom čase

Displej Význam

 (AF detekcie tváre/očí) Oznamuje, že AF detekcie tváre/očí je aktívne

 (AF iba tvár/oči) Označuje, že je aktívne automatické zaostrenie iba na tvár/oči

 (uložená sledovaná tvár) Oznamuje, že sledovaná tvár bola uložená

 (AF pozastavené) Označuje, že AF bolo pozastavené*

Zobrazuje sa, keď nie je uložená žiadna tvár s detekciou a tvár nie je rozpoznaná, alebo keď existuje uložená tvár s detekciou, ale cieľová
tvár sa nezistila.

*

Indikátor polohy transfokácie
Zobrazuje polohu transfokácie v rozsahu 0 (širokouhlý) až 99 (teleobjektív) (ak je pripojený objektív podporujúci
zobrazenie polohy transfokácie).
Indikátor môžete zmeniť aj na pruhový displej alebo zobrazenie ohniskovej vzdialenosti pomocou nastavenia
[Technical] > [Lens] > [Zoom Position Display] v ponuke kamery.

10.
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Nasledujúce položky sa pridajú na displej, keď je povolené Clear Image Zoom.

Podrobnosti o transfokácii nájdete v časti „Nastavenie typu transfokácie“ a ďalšie témy v časti „Úprava
transfokácie“.

Displej Význam

 (Clear Image Zoom je povolené) Clear Image Zoom je povolené

Hodnota zväčšenia Pri používaní Clear Image Zoom

Indikátor režimu stabilizácie obrazu11.

Indikátor stavu výstupu SDI/HDMI Indikátor stavu Rec Control
Zobrazuje výstupný stav riadiaceho signálu REC.

Podrobnosti nájdete v časti „Pripojenie externých monitorov a záznamových zariadení“.

12.

Indikátor zaostrenia

Podrobnosti nájdete v časti „Použitie automatického zaostrenia na jeden záber (Push Auto Focus (AF-S))“ v časti
„Úprava zaostrenia“.

13.

Indikátor zostávajúcej kapacity média
Ak je pamäťová karta chránená proti zápisu, zobrazí sa ikona  (ochrana).

14.

Indikátor režimu vyváženia bielej15.

Displej Význam

 (ATW) Automatický režim

 (ATW Hold) Automatický režim pozastavený

W:P Prednastavený režim

W:A Režim pamäte A

Indikátor externého zámku časového kódu/zobrazenie časových údajov
Keď je uzamknutý na časový kód externého zariadenia, zobrazuje „EXT-LK“.

Podrobnosti o časovom kóde nájdete v časti „Zadanie časových údajov“.

16.

Indikátor ND filtra

Podrobnosti o ND filtroch nájdete v časti „Úprava úrovne svetla (ND filter)“.
Podrobnosti o ovládaní bokehu nájdete v časti „Úprava bokehu (funkcia ovládania bokehu)“.

17.

Displej Význam

 (A) Automatický režim

 (B) Režim ovládania bokehu

Indikátor súboru scény18.
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Podrobnosti o súboroch scén nájdete v časti „Prehľad vzhľadu“ a ďalšie témy v časti „Snímanie s požadovaným
vzhľadom“.

Indikátor clony
Zobrazuje polohu clony (hodnota F) (ak je nasadený objektív, ktorý podporuje zobrazenie nastavenia clony).

Podrobnosti o clone nájdete v časti „Automatická úprava clony“ a „Manuálna úprava clony“.

19.

Výstražný indikátor úrovne videa20.

Indikátor zosilnenia
Zobrazuje hodnotu EI v režime Cine EI/Cine EI Quick.

Podrobnosti o zosilnení nájdete v časti „Automatická úprava zosilnenia“ a „Manuálna úprava zosilnenia“.
Podrobnosti o režime Cine EI/Cine EI Quick nájdete v časti „Nastavenie režimu snímania“ v časti „Konfigurácia
základnej činnosti“.

21.

Displej Význam

 (A) Automatický režim

L Prednastavený režim L

 (Režim dočasného nastavenia) Režim dočasného nastavenia

 (B) Režim ovládania bokehu

Zobrazenie názvu klipu
Zobrazuje názov klipu, ktorý sa nahráva alebo sa má nahrávať ako ďalší.
Ak bliká, došlo k nezrovnalosti medzi posledným klipom na záznamovom médiu a nastaveniami [Camera ID] alebo
[Reel Number]. Podrobnosti nájdete v popise [Clip Name Format] > [Auto Naming].

22.

Indikátor uzávierky

Podrobnosti o uzávierke nájdete v časti „Automatická úprava uzávierky“ a „Manuálna úprava uzávierky“.

23.

Indikátor režimu AE/úrovne AE

Podrobnosti o automatickej expozícii (AE) nájdete v časti „Nastavenie cieľovej úrovne pre automatické nastavenie
jasu“.

24.

Indikátor vodováhy
Zobrazuje vodorovnú úroveň v krokoch ± 1 ° až do ± 15 °.

25.

Merač úrovne zvuku
Zobrazuje úroveň zvuku každého kanála.

26.

Monitor videosignálu
Zobrazuje krivku, vektory a histogram.
Oranžová čiara označuje nastavenú hodnotu značky úrovne jasu.
V zázname režimov snímania sa nad displejom zobrazí typ cieľového LUT monitora.

Podrobnosti nájdete v časti „Monitor videosignálu“.
Podrobnosti o zázname režimov snímania nájdete v časti „Nastavenie režimu snímania“ v časti „Konfigurácia
základnej činnosti“.

27.

Kontrolka Base Sensitivity /kontrolka Base ISO28.
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Informácie zobrazené na obrazovke počas prehrávania

Nasledujúce informácie sú vložené do prehrávaného obrazu.

V režime Custom, zobrazuje základnú citlivosť nastavenú pomocou tlačidla [ISO/Gain / Exposure Index] na paneli
základnej konfigurácie kamery resp. [Shooting] > [ISO/Gain/EI] > [Base Sensitivity] v ponuke kamery.
V zázname režimov snímania zobrazuje citlivosť Base ISO nastavenú pomocou tlačidla [ISO/Gain / Exposure Index]
na paneli základnej konfigurácie kamery alebo [Shooting] > [ISO/Gain/EI] > [Base ISO] v ponuke kamery.

Podrobnosti o základnej citlivosti nájdete v časti „Výber základnej citlivosti“.
Podrobnosti o zázname režimov snímania nájdete v časti „Nastavenie režimu snímania“ v časti „Konfigurácia
základnej činnosti“.

Indikátor monitorovania vzhľadu
V zázname režimov snímania zobrazuje LUT nastavenie monitora.

Podrobnosti o nastavení LUT nájdete v časti „Snímanie s úpravou vzhľadu v postprodukcii“ a príslušných témach.
Podrobnosti o zázname režimov snímania nájdete v časti „Nastavenie režimu snímania“ v časti „Konfigurácia
základnej činnosti“.

29.

Indikátor základného vzhľadu/záznamu vzhľadu
Zobrazuje základné nastavenie vzhľadu.
V zázname režimov snímania zobrazuje videosignál pre nahrávanie na pamäťové karty.

Podrobnosti o základnom vzhľade nájdete v časti „Prehľad vzhľadu“ v kapitole „Snímanie s požadovaným
vzhľadom“.
Podrobnosti o zázname režimov snímania nájdete v časti „Nastavenie režimu snímania“ v časti „Konfigurácia
základnej činnosti“.

30.

Indikátor zástupného stavu31.

Indikátor formátu záznamu (kodek)
Zobrazuje názov formátu pre záznam na pamäťové karty.
Nastavte formát záznamu (kodek) pomocou [Project] > [Rec Format] > [Codec] vo webovej ponuke alebo ponuke
kamery.

32.

Indikátor formátu záznamu (snímková frekvencia a metóda skenovania)33.

Indikátor formátu záznamu (veľkosť obrazu)
Zobrazuje veľkosť obrazu pre záznam na pamäťové karty.
Nastavte formát záznamu (veľkosť obrazu) pomocou [Project] > [Rec Format] > [Codec] vo webovej ponuke alebo
ponuke kamery.

34.

Indikátor záznamu
Zobrazí červený alebo zelený rámček okolo obrazu podľa prijatého externého záznamového signálu.

35.
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Súvisiaca téma

O prenose súborov

Automatické nastavenie pomocou webovej aplikácie

Prerušované nahrávanie videa (Interval Rec)

Konfigurácia základnej činnosti

Záznam RAW videa

Slow & Quick Motion

Indikátor nahrávania/kontrolka zostávajúcich súborov1.

Číslo klipu2.

Indikátor stavu prehrávania3.

Indikátor formátu prehrávania (snímková frekvencia a metóda skenovania)4.

Indikátor formátu prehrávania (veľkosť obrazu)5.

Indikátor formátu prehrávania (kodek)6.

Indikátor médií
Ak je pamäťová karta chránená proti zápisu, zobrazí sa ikona  (ochrana).

7.

Zobrazenie časových údajov8.

Zobrazenie názvu klipu9.

Indikátor asistencie zobrazenia gama10.

Merač úrovne zvuku
Zobrazuje úroveň zvuku pri prehrávaní.

11.

Indikátor základného vzhľadu/záznamu vzhľadu12.

Indikátor záznamu13.
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Sledovanie pomocou detekcie tváre a očí (Face/Eye Detection AF)

Nastavenie typu transfokácie

Pripojenie externých monitorov a záznamových zariadení

Použitie automatického zaostrenia na jeden záber (Push Auto Focus (AF-S))

Zadanie časových údajov

Prehľad vzhľadu

Automatická úprava clony

Manuálna úprava clony

Automatická úprava zosilnenia

Manuálna úprava zosilnenia

Automatická úprava uzávierky

Manuálna úprava uzávierky

Nastavenie cieľovej úrovne pre automatické nastavenie jasu

Monitor videosignálu

Snímanie s úpravou vzhľadu v postprodukcii

Clip Name Format

5-041-959-13(1) Copyright 2022 Sony Corporation
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Zvislá montáž na pevnom mieste

Táto téma popisuje montáž jednotky na stôl alebo statív.

Poznámka k inštalácii
Aby ste chránili objektív a pripojovací blok objektívu na jednotke, ponechajte nasadené veko a kryt jednotky, kým
nenasadíte objektív.
Aby ste predišli poškodeniu objektívu, nedržte časti objektívu počas práce.
Aby ste predišli poškodeniu jednotky, nedržte hlavu kamery počas práce.

Skontrolujte montážny priestor.

Pri montáži na pracovnú plochu
Namontujte túto jednotku na rovný povrch, pričom berte do úvahy priestor potrebný na otáčanie objektívu a kabeláž
na zadnej strane jednotky.

Poznámka

Namontujte ju na stabilné miesto, ktoré nie je vystavené vibráciám. Miesta vystavené vibráciám môžu spôsobiť vibrácie
v obraze.

Ak musí byť jednotka namontovaná na naklonený povrch, udržujte ju v rozmedzí ±15° od horizontály a urobte opatrenia,
aby ste zabránili pádu jednotky.

Pri montáži na statív
Pripevnite statív k otvoru pre montážnu skrutku statívu na spodnej strane.
Použite montážnu skrutku statívu s nasledujúcim prečnievaním z montážnej plochy a dotiahnite ju ručným
skrutkovačom.

A: Montážne skrutky statívu 1/4-20 UNC, ISO 1222 (6,35 mm)

1
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Potom nasaďte objektív. Pozrite si časť „Nasadenie objektívu“, pričom zohľadnite informácie v časti „Preventívne
opatrenia pri nasadzovaní/demontáži objektívu“, „Kontrola prepínačov objektívu“ a „Preventívne opatrenia pri používaní
objektívu s transfokáciou“.

Súvisiaca téma

Preventívne opatrenia pri nasadzovaní/demontáži objektívu

Kontrola prepínačov objektívu

Preventívne opatrenia pri používaní objektívu s transfokáciou

Nasadenie objektívu

5-041-959-13(1) Copyright 2022 Sony Corporation

B: Prečnievanie (4,5 mm až 5,5 mm)

Na montáž jednotky vo vyvýšenej polohe nepoužívajte statívové skrutky.

Poznámka

Vyberte si statív, ktorý sa neprevráti ani pri otáčaní objektívu.
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Montáž vo vzpriamenej polohe na vyvýšenom, pevnom mieste

Táto téma popisuje postup montáže jednotky vo zvislej polohe na vyvýšené miesto pomocou stropného držiaka (CIB-
PCM1 (voliteľné príslušenstvo)).

Ak chcete jednotku namontovať na vyvýšené miesto, požiadajte o pomoc profesionálneho dodávateľa.
Pri montáži vo vyvýšenej polohe sa uistite, že montážny povrch a montážny materiál (okrem príslušenstva) unesie
200 kg (440 lb 15 oz) alebo viac, a namontujte jednotku podľa popisu v sprievodcovi s nápovedou. Ak upevnenie nie
je dostatočne pevné, jednotka môže spadnúť a spôsobiť vážne zranenie.
Pripevnite dodané oceľové lanko zabraňujúce pádu k stropnom držiaku CIB-PCM1 (voliteľné príslušenstvo), aby ste
zabránili pádu jednotky.
Keď je jednotka namontovaná na vyvýšenom mieste, raz za rok skontrolujte, či sa upevnenie neuvoľnilo. Skráťte
interval kontroly podľa podmienok používania.

Poznámka k inštalácii
Aby ste chránili objektív a pripojovací blok objektívu na jednotke, ponechajte kryt objektívu a kryt nasadený, kým
objektív nenasadíte.
Aby ste predišli poškodeniu objektívu, nedržte časti objektívu počas práce.
Aby ste predišli poškodeniu jednotky, nedržte hlavu kamery počas práce.

Skontrolujte vysoko umiestnené montážne príslušenstvo a montážny priestor.

Súprava stropného držiaka CIB-PCM1 (voliteľné príslušenstvo)
Skôr ako začnete, skontrolujte, či máte nasledujúce diely.

Konzola telesa (1)
Stropný držiak (1)
Kryt tlačidla uvoľnenia objektívu (1)
Oceľové lanko zabraňujúce pádu (1)
Skrutky +PSW M3×8 (9)
Nerezová skrutka +PSW M4×8 pre oceľové lanko zabraňujúce pádu (1)

1
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Poznámka

Oceľové lanko zabraňujúce pádu je navrhnuté tak, aby zabezpečovalo jednotku, keď je zavesená. Nevyvíjajte naň žiadnu
inú záťaž ako záťaž jednotky.

Montážny priestor
Pri určovaní miesta a smeru montáže sa riaďte nasledujúcim nákresom, pričom berte do úvahy priestor potrebný na
otáčanie objektívu a kabeláž na zadnej strane jednotky.

A: Rozsah pohybu hlavy kamery (napr. SEL70200GM2 (s pripojeným SEL20TC): Ø370)
B: Stropný držiak (otvor na strane montážneho povrchu (Ø150))
C: Montážny zarovnávací otvor

Poznámka

Namontujte ju na stabilné miesto, ktoré nie je vystavené vibráciám. Miesta vystavené vibráciám môžu spôsobiť vibrácie
v obraze.

Ak musí byť jednotka namontovaná na naklonený povrch, udržujte ju v rozmedzí ±15° od horizontály a urobte opatrenia,
aby ste zabránili pádu jednotky.

Posuňte zaisťovaciu páčku otáčania/nakláňania do polohy LOCK, aby ste uzamkli otáčanie/nakláňanie
hlavy kamery.

2
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Poznámka

Ak sa otáčanie/nakláňanie hlavy kamery nezablokuje, keď je zaisťovacia páčka v polohe LOCK, posuňte hlavu kamery
manuálne, kým sa nezablokuje.

Pripevnite konzolu telesa k spodnej časti jednotky pomocou šiestich dodaných skrutiek (M3×8).3
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Použite dodané skrutky. Použitie iných ako dodaných skrutiek môže poškodiť vnútro jednotky.

Pripevnite oceľové lanko zabraňujúce pádu ku konzole telesa.4
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A: Dodávané oceľové lanko　
B: Dodávaná krížová skrutka (M4×8)
C: Kovová slučka oceľového lanka

Použite dodanú skrutku. Použitie inej ako dodanej skrutky môže znížiť účinnosť funkcie oceľového lanka.

Pripevnite stropný držiak k povrchu, ako je polica, kde bude jednotka namontovaná.5
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A: Stena　
B: Značka △ (smer kamery dopredu)
C: Otvor pre pripojovacie káble
D: Polica alebo iná montážna plocha

Pripevnite oceľové lanko zabraňujúce pádu k bodu blízko montážneho povrchu.

Použite skrutku M5 (3/16 palca) so šesťhrannou hlavou (voliteľné príslušenstvo) a pripevnite ju k predmetu
v blízkosti police alebo povrchu, ku ktorému je pripevnený stropný držiak.

6
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A: Oceľové lanko　
B: Skrutka so šesťhrannou hlavou (M5, 3/16 palca)

Zarovnajte otvor pre skrutku 〇 v prednej časti konzoly telesa s otvorom ◇ v stropnom držiaku, vložte
jednotku a dočasne upevnite konzolu telesa do stropného držiaka otáčaním jednotky v smere hodinových
ručičiek.

7
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A: 〇 otvor
B: ◇ otvor

Pripevnite konzolu telesa a stropný držiak pomocou troch dodaných skrutiek na zaistenie otáčania (M3×8).8
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Potom nasaďte objektív. Pozrite si časť „Nasadenie objektívu“, pričom zohľadnite informácie v časti „Preventívne
opatrenia pri nasadzovaní/demontáži objektívu“, „Kontrola prepínačov objektívu“ a „Preventívne opatrenia pri používaní
objektívu s transfokáciou“.

Poznámka

Po nasadení objektívu skontrolujte, či je objektív bezpečne nasadený.
Objektív nemá žiadnu ochranu proti pádu. Spoločnosť Sony nenesie žiadnu zodpovednosť za vypadnutie objektívu zo zariadenia.

Súvisiaca téma

Preventívne opatrenia pri nasadzovaní/demontáži objektívu

Kontrola prepínačov objektívu

Preventívne opatrenia pri používaní objektívu s transfokáciou

Nasadenie objektívu

Skontrolujte stav montáže.

Konkrétne skontrolujte nasledujúce položky. 

Montážne skrutky sú správne pripevnené.
Oceľové lanko zabraňujúce pádu je správne pripevnené a nie je skrútené.
Jednotka je namontovaná vodorovne (bez nakláňania alebo kolísania).
Jednotka sa pri otáčaní voľne neotáča.

9
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Montáž na strop

Táto téma popisuje postup montáže jednotky na strop pomocou stropného držiaka (CIB-PCM1 (voliteľné príslušenstvo)).

Ak chcete jednotku namontovať na strop, požiadajte o pomoc profesionálneho dodávateľa.
Pri montáži na strop sa uistite, že montážny povrch a montážny materiál (okrem príslušenstva) unesie 200 kg (440 lb
15 oz) alebo viac, a namontujte jednotku podľa popisu v sprievodcovi s nápovedou. Ak upevnenie nie je dostatočne
pevné, jednotka môže spadnúť a spôsobiť vážne zranenie.
Pripevnite dodané oceľové lanko zabraňujúce pádu k stropnom držiaku CIB-PCM1 (voliteľné príslušenstvo), aby ste
zabránili pádu jednotky.
Keď je jednotka namontovaná na strop, raz za rok skontrolujte, či sa upevnenie neuvoľnilo. Skráťte interval kontroly
podľa podmienok používania.

Poznámka k inštalácii
Aby ste chránili objektív a pripojovací blok objektívu na jednotke, ponechajte kryt objektívu a kryt nasadený, kým
objektív nenasadíte.
Aby ste predišli poškodeniu objektívu, nedržte časti objektívu počas práce.
Aby ste predišli poškodeniu jednotky, nedržte hlavu kamery počas práce.

Skontrolujte príslušenstvo na montáž na strop a montážny priestor.

Súprava stropného držiaka CIB-PCM1 (voliteľné príslušenstvo)
Skôr ako začnete, skontrolujte, či máte nasledujúce diely.

Konzola telesa (1)
Stropný držiak (1)
Kryt tlačidla uvoľnenia objektívu (1)
Oceľové lanko zabraňujúce pádu (1)
Skrutky +PSW M3×8 (9)
Nerezová skrutka +PSW M4×8 pre oceľové lanko zabraňujúce pádu (1)

1
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Poznámka

Oceľové lanko zabraňujúce pádu je navrhnuté tak, aby zabezpečovalo jednotku, keď je zavesená. Nevyvíjajte naň žiadnu
inú záťaž ako záťaž jednotky.

Montážny priestor
Pri určovaní miesta a smeru montáže sa riaďte nasledujúcim nákresom, pričom berte do úvahy priestor potrebný na
otáčanie objektívu a kabeláž na zadnej strane jednotky.

A: Rozsah pohybu hlavy kamery (napr. SEL70200GM2 (s pripojeným SEL20TC): Ø370)
B: Stropný držiak (otvor na stropnej strane (Ø150))
C: Montážny zarovnávací otvor

Poznámka

Namontujte na strop (napríklad betón) s dostatočnou pevnosťou.

Ak chcete jednotku namontovať na strop s nedostatočnou pevnosťou, zabezpečte dostatočné vystuženie.

Namontujte ju na stabilné miesto, ktoré nie je vystavené vibráciám. Miesta vystavené vibráciám môžu spôsobiť vibrácie
v obraze.

Ak musí byť jednotka namontovaná na naklonený povrch, udržujte ju v rozmedzí ±15° od horizontály a urobte opatrenia,
aby ste zabránili pádu jednotky.

Strana oproti otvoru △ na stropnom držiaku je smer snímania (predná strana kamery).

Posuňte zaisťovaciu páčku otáčania/nakláňania do polohy UNLOCK, čím odblokujete otáčanie/sklápanie
a otočíte hlavu kamery o 180° v smere naklonenia.

2

Posuňte zaisťovaciu páčku otáčania/nakláňania do polohy LOCK, aby ste uzamkli otáčanie/nakláňanie
hlavy kamery.

3
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Hlava kamery otočená o 180°

Poznámka

Ak sa otáčanie/nakláňanie hlavy kamery nezablokuje, keď je zaisťovacia páčka v polohe LOCK, posuňte hlavu kamery
manuálne, kým sa nezablokuje.

Pripevnite konzolu telesa k spodnej časti jednotky pomocou šiestich dodaných skrutiek (M3×8).4
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Použite dodané skrutky. Použitie iných ako dodaných skrutiek môže poškodiť vnútro jednotky.

Pripevnite stropný držiak k montážnej doske (voliteľné príslušenstvo) a potom pripevnite dosku k stropu.5
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A: Stropný držiak
B: Strop
C: Montážna doska
D: △ otvor
Pripevnite držiak podľa orientácie stropného držiaka
Všimnite si, že pri montáži na strop je predná časť kamery na opačnej strane stropného držiaka v porovnaní
s bežnou zvislou montážou. Správne namontujte podľa schémy označujúcej smer montáže.

A: Predná časť pre zvislú montáž (orientácia otvoru △)
B: Predná časť pre stropnú montáž

Poznámka

Materiál montážnej plochy je na zodpovednosti zákazníka.

Pripevnite oceľové lanko k stropu pre zabránenie pádu.6
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A: Stropný držiak
B: Skrutka so šesťhrannou hlavou (M5, 3/16 palca)
C: Oceľové lanko (súčasť dodávky)
D: Montážna doska
E: Strop

Pretiahnite oceľové lanko zabraňujúce pádu cez otvor v strede stropného držiaka a pripevnite ho ku
konzole telesa.

Veďte oceľové lanko zabraňujúce pádu cez kovovú slučku oceľového lana konzoly telesa a bezpečne ho pripevnite
ku konzole pomocou dodanej skrutky z nehrdzavejúcej ocele (M4×8).

A: Dodávané oceľové lanko
B: Dodávaná krížová skrutka (M4×8)
C: Kovová slučka oceľového lanka

7
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Použite dodanú skrutku. Použitie inej ako dodanej skrutky môže znížiť účinnosť funkcie oceľového lanka.

Poznámka

Odporúčame, aby jednotku držala jedna osoba, ako je znázornené na nasledujúcom obrázku, zatiaľ čo iná osoba bude
jednotku montovať.

Pri montáži jednotky nedržte hlavu kamery ani podperu objektívu. Ak jednotka spadne, hrozí nebezpečenstvo poškodenia
alebo zranenia.

Pri zapájaní dávajte pozor, aby sa elektrické konektory a káble neskratovali oceľovým lankom pre zabránenie pádu.

Konzola dokáže uniesť zavesenú tiaž až do 8,8 kg (vrátane objektívu). Aby ste zabránili pádu jednotky, neprekračujte
maximálnu predpokladanú hmotnosť.

Zarovnajte otvor na skrutku (A) na konzole telesa s otvorom ◇ (B) na stropnom držiaku, vložte jednotku
a otočte ju asi o 60 stupňov v smere hodinových ručičiek, kým nebudú otvor na skrutku (A) a otvor na
skrutku (C) zarovnané.

8
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A: Otvor na skrutku na konzole telesa
B: Otvor na skrutku na stropnom držiaku (otvor ◇)
C: Otvor na skrutku
D: Strop
E: Montážna doska

Pripevnite konzolu telesa a stropný držiak pomocou troch dodaných skrutiek na zaistenie otáčania (M3×8).9
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Potom nasaďte objektív. Pozrite si časť „Nasadenie objektívu“, pričom zohľadnite informácie v časti „Preventívne
opatrenia pri nasadzovaní/demontáži objektívu“, „Kontrola prepínačov objektívu“ a „Preventívne opatrenia pri používaní
objektívu s transfokáciou“.

Poznámka

Ak chcete správne ovládať otáčanie/sklápanie, keď je jednotka namontovaná na strope, nastavte [Pan-Tilt] > [Direction] >
[Ceiling] na [On] vo webovej ponuke.

Po nasadení objektívu skontrolujte, či je objektív bezpečne nasadený.
Objektív nemá žiadnu ochranu proti pádu. Spoločnosť Sony nenesie žiadnu zodpovednosť za vypadnutie objektívu zo zariadenia.

Súvisiaca téma
Preventívne opatrenia pri nasadzovaní/demontáži objektívu

Skontrolujte stav montáže.

Konkrétne skontrolujte nasledujúce položky.

Montážne skrutky sú správne pripevnené.
Oceľové lanko zabraňujúce pádu je správne pripevnené a nie je skrútené.
Jednotka je namontovaná vodorovne (bez nakláňania alebo kolísania).
Jednotka sa pri otáčaní voľne neotáča.

10
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Kontrola prepínačov objektívu

Preventívne opatrenia pri používaní objektívu s transfokáciou

Nasadenie objektívu

5-041-959-13(1) Copyright 2022 Sony Corporation
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Preventívne opatrenia pri nasadzovaní/demontáži objektívu

Nenechávajte objektív otočený smerom k slnku. Priame slnečné svetlo môže preniknúť cez objektív, zaostriť na jednotku
a spôsobiť požiar.

Poznámka

Pripájajte/odpájajte objektív, keď je jednotka vypnutá.

Objektív je presný komponent. Neumiestňujte objektív na povrch s bajonetom objektívu smerom dole. Nasaďte dodaný kryt na
bajonet objektívu.

Rada

Podrobnosti o objektívoch podporovaných jednotkou získate od vášho servisného zástupcu spoločnosti Sony.

5-041-959-13(1) Copyright 2022 Sony Corporation
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Kontrola prepínačov objektívu

V závislosti od typu objektívu sú potrebné nasledujúce kontroly a nastavenia.

Pre objektív s prepínačom režimu transfokácie

Nastavte prepínač do polohy AF/MF alebo AF.
Keď je prepínač nastavený na MF alebo Full MF, zaostrenie je možné upraviť iba pomocou krúžku objektívu.

Poznámka

Pri použití objektívu s bajonetom A nemusí byť dostupné manuálne nastavenie z diaľkového ovládača.

Pre objektív s prepínačom transfokácie

Nastavte prepínač na SERVO.
Ak je prepínač v polohe MANUAL, transfokáciu je možné nastaviť iba pomocou krúžku transfokácie. Ovládanie
transfokácie z jednotky nemá žiadny účinok.

Pre objektív s prepínačom automatickej clony

Nastavte prepínač na AUTO.
Keď nie je nastavené na AUTO, clonu je možné nastaviť len pomocou krúžku objektívu. Ovládanie clony z jednotky nemá
žiadny účinok.

Pre objektív s prepínačom stabilizácie obrazu

Nastavte prepínač na OFF.
Ak je prepínač v polohe ON, počas prevádzky otáčania/nakláňania sa môže vyskytnúť neočakávané správanie.

SELP28135G

A: Posuňte zaostrovací krúžok do prednej polohy (režim AF/MF).
B: Nastavte prepínač ZOOM do polohy SERVO.
C: Nastavte krúžok clony do polohy „A“ a prepínač IRIS LOCK do polohy LOCK.
D: Nastavte prepínač stabilizátora obrazu na OFF.
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Preventívne opatrenia pri používaní objektívu s transfokáciou

Pri použití iného objektívu s transfokáciou ako objektívu s motorickou transfokáciou sa poloha transfokácie môže meniť
v závislosti od montážneho prostredia. Zaistite krúžok transfokácie v polohe pomocou pásky podľa účelu použitia.

Plastová páska: 471 BLA 50 alebo ekvivalent

5-041-959-13(1) Copyright 2022 Sony Corporation
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Nasadenie objektívu

Táto téma popisuje, ako pripojiť objektív s bajonetom E alebo A.

Poznámka

Jednotku neprepravujte s nasadeným objektívom.

Pri použití objektívu s bajonetom A sa clona nastaví manuálne a zaostrenie sa nastaví na MF.

Posuňte zaisťovaciu páčku otáčania/nakláňania do polohy LOCK, aby ste uzamkli otáčanie/nakláňanie
hlavy kamery.

Poznámka

Ak sa otáčanie/nakláňanie hlavy kamery nezablokuje, keď je zaisťovacia páčka v polohe LOCK, posuňte hlavu kamery
manuálne, kým sa nezablokuje.

1

Otočte zaisťovaciu páčku pripevňovacej skrutky podstavca podpery objektívu proti smeru hodinových
ručičiek, aby ste uvoľnili zaistenie, a potom posuňte pripevňovaciu skrutku podstavca podpery objektívu
do polohy, ktorá objektívu neprekáža.

2
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A: Správne
B: Nesprávne

Otočte zaisťovaciu páčku hlavy kamery v smere šípky, aby ste odomkli hlavu kamery.

Poznámka

Kým nie je hlava kamery opäť zablokovaná, existuje riziko, že sa hlava kamery môže pohnúť vlastnou tiažou. Pri
vykonávaní úlohy podoprite hlavu kamery rukou.

3

Posuňte hlavu kamery do najprednejšej polohy.4
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Otočte zaisťovaciu páčku hlavy kamery v smere šípky, aby ste uzamkli hlavu kamery.

Poznámka

Dbajte na to, aby sa zaisťovacia páčka hlavy kamery nedostala do kontaktu s inými časťami, aby nedošlo k obmedzeniu
nakláňania.

5

Odstráňte veko a kryt z jednotky a objektívu.6

Zarovnajte značku uchytenia objektívu (biela) s jednotkou, opatrne vložte objektív do hlavy kamery a potom
otočte objektívom v smere hodinových ručičiek, kým sa nezacvakne do uzamknutej polohy.

A: Montážne značky (biele)

Poznámka

Ak chcete použiť objektív s bajonetom A, pripojte adaptér na bajonet (voliteľné príslušenstvo) na jednotku a potom nasaďte
objektív s bajonetom A.

7

Otočte zaisťovaciu páčku hlavy kamery v smere šípky, aby ste odomkli hlavu kamery.8
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Poznámka

Kým nie je hlava kamery opäť zablokovaná, existuje riziko, že sa hlava kamery môže pohnúť vlastnou tiažou. Pri
vykonávaní úlohy podoprite hlavu kamery rukou.

Udržujte vyváženie hlavy kamery dopredu/dozadu tak, aby bola posuvná základňa vodorovná.

Ak používate jeden z nasledujúcich objektívov, môžete približne vyvážiť jednotku a objektív podľa stupnice na
posuvnej základni.

9

Poloha mierky Názov objektívu

0,5 SEL70200GM (s pripojeným SEL20TC)

1,7 SEL70200GM

2,0 SEL70200GM2 (s pripojeným SEL20TC)

3,0 SELP28135G, SEL70200GM2

3,5 SELP18110G

3,6 SELC1635G

4,3 SEL70200G
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Poznámka

Použite posuvnú základnú stupnicu ako referenciu pre hrubé vyváženie.

Počas nasadzovania objektívu vykonajte príslušné úpravy vyváženia, aby sa prístroj nenakláňal dopredu a dozadu.

Upravte vyváženie na vodorovnom povrchu.

Pri používaní SELC1635G odstráňte podpernú jednotku objektívu.

Poloha mierky Názov objektívu

5,0 alebo viac SEL1224GM, SEL1635GM, SELP1635G, SELP18105G, SELP1020G

Otočte zaisťovaciu páčku hlavy kamery v smere šípky, aby ste uzamkli hlavu kamery.

Poznámka

Dbajte na to, aby sa zaisťovacia páčka hlavy kamery nedostala do kontaktu s inými časťami, aby nedošlo k obmedzeniu
nakláňania.
Spôsob potvrdenia: Posuňte zámok otáčania/nakláňania do polohy UNLOCK, rukou otočte blok kamery tak, aby smeroval
nahor, a vizuálne skontrolujte, či nie je v kontakte s inými časťami. Ak dôjde ku kontaktu, znova otočte zaisťovaciu páčku
hlavy kamery v smere šípky.

10

Otočte upínacie páčky podpery objektívu proti smeru hodinových ručičiek, aby ste uvoľnili podperu
objektívu.

11
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A: Upínacia páčka podpernej tyče objektívu (2 miesta)
B: Podperná jednotka objektívu

Posuňte podperu objektívu tak, aby bol podstavec podpery objektívu zarovnaný s pripevňovacou skrutkou
podstavca podpery objektívu, potom otočte skrutku v smere hodinových ručičiek, aby ste podstavec
podpery objektívu zaistili.

Poznámka

Uistite sa, že podstavec podpery objektívu je kolmý na pripevňovaciu skrutku podstavca podpery objektívu a potom ho
utiahnite.

12

Otočte upínaciu páčku pre pripevňovaciu skrutku podstavca podpery objektívu v smere hodinových
ručičiek, aby ste zaistili upevňovaciu skrutku podstavca podpery objektívu.

A: Pripevňovacia skrutka podstavca podpery objektívu
B: Otvor pre upevňovaciu skrutku
C: Pripevňovacia skrutka upínacej páčky podstavca podpery objektívu

Rada

Ak je upínacia páčka v polohe, ktorá sťažuje otáčanie, uvoľnite upínaciu páku a otočte ju do uhla, ktorý zjednoduší obsluhu.
Keď je v požadovanej polohe, zatvorte upínaciu páčku.

13
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Súvisiaca téma

Kalibrácia objektívu s bajonetom E

5-041-959-13(1) Copyright 2022 Sony Corporation

A: Pripevňovacia skrutka upínacej páčky podstavca podpery objektívu
B: Upínacia páčka podpernej tyče objektívu

Otočte dve upínacie páčky podpernej tyče objektívu v smere hodinových ručičiek, aby ste zaistili podperu
objektívu.

14

Skontrolujte, či sú obe páčky dotiahnuté a nie uvoľnené, či je objektív správne nasadený a či sú spínače
objektívu správne nastavené.

Ak je páčka uvoľnená alebo objektív nie je nasadený správne, môže spadnúť a poškodiť sa.
Pri použití objektívu s motorovou transfokáciou s bajonetom E je potrebné objektív kalibrovať aj samostatne,
aby sa presne obnovili polohy transfokácie uložené v kamere ako predvolené polohy. Podrobnosti nájdete
v časti „Kalibrácia objektívu s bajonetom E“.

15
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Demontáž objektívu

Odstráňte objektív opačným postupom ako pri nasadzovaní objektívu.

Poznámka

Uchopte objektív pevne do ruky, aby ste zabránili jeho spadnutiu.

Ak iný objektív nebude nasadený okamžite, vždy použite kryt.

Súvisiaca téma

Nasadenie objektívu

5-041-959-13(1) Copyright 2022 Sony Corporation

Skontrolujte, či je otáčanie/nakláňanie zaistené.1

Otočte upínaciu páčku pre pripevňovaciu skrutku podstavca podpery objektívu proti smeru hodinových
ručičiek, aby ste uvoľnili zaistenie.

2

Odstráňte pripevňovaciu skrutku podstavca podpery objektívu na jednotke podpery objektívu a posuňte ju
do polohy, ktorá nezasahuje do objektívu.

3

Odomknite hlavu kamery a posuňte hlavu kamery do najprednejšej polohy.

Podrobnosti nájdete v krokoch 3 až 5 v časti „Nasadenie objektívu“.

4

Stlačte a podržte uvoľňovacie tlačidlo objektívu a pootočte objektív proti smeru hodinových ručičiek.5

Po zarovnaní montážnych značiek (bielych) na kamere a objektíve vytiahnite objektív smerom dopredu.6
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Pripojenie káblov

Táto téma popisuje káblové pripojenia.

5-041-959-13(1) Copyright 2022 Sony Corporation

Zapojte potrebné káble do konektorov na zadnom paneli.

Ak chcete zabrániť odstráneniu kábla HDMI, odstráňte upevňovaciu skrutku prídržnej doštičky kábla HDMI (M2.6×6,
čierna) z pripojovacieho bloku a pomocou upevňovacej skrutky pripevnite dodanú prídržnú doštičku HDMI kábla.
Pripevnite kábel HDMI k prídržnej doštičke kábla HDMI pomocou komerčne dostupnej viazacej pásky alebo pásky.

A: Montážna skrutka prídržnej doštičky kábla HDMI (M2.6×6, čierna)
B: Komerčne dostupná viazacia páska alebo páska
C: Prídržná doštička kábla HDMI (súčasť dodávky)

1
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Pripojenie jednotky k sieťovému zariadeniu pomocou káblového pripojenia

Táto téma popisuje pripojenie jednotky k sieťovému zariadeniu prostredníctvom káblového pripojenia.

5-041-959-13(1) Copyright 2022 Sony Corporation

Pripojte jednotku k sieťovému zariadeniu (ako je prístupový bod Wi-Fi alebo prepínací rozbočovač)
pomocou kábla LAN kategórie 5e alebo vyššej.

1
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Používanie sieťového napájania

Táto téma popisuje postup napájania jednotky pomocou striedavého prúdu.

Posuňte zaisťovaciu páčku otáčania/nakláňania do polohy LOCK, aby ste uzamkli otáčanie/nakláňanie
hlavy kamery.

1

Pripojte sieťový adaptér (súčasť dodávky) ku konektoru DC IN na jednotke a napájací kábel (súčasť
dodávky) pripojte k zdroju napájania.

A: Konektor DC IN
B: Napájací kábel
C: Sieťový adaptér

2

Ak chcete zabrániť odpojeniu kábla, zaistite kábel sieťového adaptéra pomocou svorky na kábel.

Odistite svorku kábla, veďte kábel cez svorku podľa obrázka nižšie a zaistite svorku.

3
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Poznámka

Nepoužívajte žiadny iný sieťový adaptér alebo napájací kábel okrem tých, ktoré boli dodané s jednotkou. Pripojenie iného
adaptéra alebo napájacieho kábla môže spôsobiť požiar alebo poruchu.

Nepripájajte a nepoužívajte sieťový adaptér v obmedzenom priestore, napríklad medzi stenou a nábytkom.

Neskratujte kovové časti zástrčky sieťového adaptéra. Môže to spôsobiť poruchu.

Pripojte sieťový adaptér k najbližšiemu zdroju napájania. Ak sa počas prevádzky vyskytne problém, okamžite odpojte napájací
kábel od napájacieho zdroja.

A: Svorka kábla
B: Zaistenie svorky kábla
C: Kábel sieťového adaptéra

Skontrolujte, či sa kontrolka POWER na prednej strane jednotky zmení z blikajúcej zelenej na
neprerušovanú zelenú a či je spustenie dokončené.

Keď sa jednotka normálne spustí a pripojí k sieti, kontrolka NETWORK sa rozsvieti na zeleno.

Ak používate objektív, ktorý nepodporuje ovládanie otáčania a nakláňania, zaistite zaisťovaciu páčku otáčania
a nakláňania a preskočte nasledujúce kroky. Podrobnosti o objektívoch, ktoré podporujú otáčanie/nakláňanie,
vám poskytne predajca alebo servisný zástupca Sony.

4

Posuňte zaisťovaciu páčku otáčania/nakláňania do polohy UNLOCK, aby ste odomkli otáčanie/nakláňanie
hlavy kamery.

5

Resetujte otáčanie/nakláňanie.

Podrobnosti nájdete v časti „Resetovanie otáčania/nakláňania“.

6
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Pri odpájaní sieťového adaptéra od prístroja uchopte zástrčku a vytiahnite ju priamo von. Ťahanie za kábel môže spôsobiť
poruchu.

Súvisiaca téma

Resetovanie otáčania/nakláňania

5-041-959-13(1) Copyright 2022 Sony Corporation
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Používanie napájania PoE++

Keď je jednotka pripojená k napájaciemu zariadeniu kompatibilnému s PoE++, napájanie sa do jednotky dodáva
prostredníctvom komerčne dostupného sieťového kábla.
Táto metóda umožňuje napájanie jednotky bez potreby napájacej kabeláže v prostrediach, kde v blízkosti miesta
montáže nie je napájacia zásuvka.

Posuňte zaisťovaciu páčku otáčania/nakláňania do polohy LOCK, aby ste uzamkli otáčanie/nakláňanie
hlavy kamery.

1

Pripojte jednotku a napájacie zariadenie kompatibilné s PoE++ pomocou komerčne dostupného sieťového
kábla.

A: Sieťový kábel
B: Napájacie zariadenie kompatibilné s PoE++

2

Skontrolujte, či sa kontrolka POWER na prednej strane jednotky zmení z blikajúcej zelenej na
neprerušovanú zelenú a či je spustenie dokončené.

Keď sa jednotka normálne spustí a pripojí k sieti, kontrolka NETWORK sa rozsvieti na zeleno.

3
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Poznámka

Prístroj vyhovuje IEEE802.3bt Typ 4 Trieda 8. Podrobnosti o overených kompatibilných zariadeniach na napájanie PoE++ vám
poskytne váš predajca alebo servisný zástupca Sony.

Jednotka je kompatibilná so softvérovou autentifikáciou (LLDP), ale môže byť potrebné nakonfigurovať sieťové zariadenia
(v súlade s IEEE802.3bt).

Nepripájajte sieťový adaptér, keď používate napájanie PoE++ so zapnutou softvérovou autentifikáciou (LLDP).

Ak sú súčasne pripojený sieťový adaptér a napájacie zariadenie PoE++, napájanie sa dodáva zo sieťového adaptéra.

Pri napájaní cez PoE++ použite sieťový kábel kategórie 5e alebo vyššej.

Po opätovnom zapnutí jednotky pri napájaní cez PoE++ počkajte asi 10 sekúnd.

Pri použití napájania PoE++ pripojte uzemňovaciu svorku k zemi.

Pri pripájaní cez napájanie PoE++ neveďte káble zvonku.

Súvisiaca téma

Resetovanie otáčania/nakláňania

5-041-959-13(1) Copyright 2022 Sony Corporation

Poznámka

Keď je napájanie dodávané pomocou PoE++, počiatočná autentifikácia sa vykonáva počas intervalu, kým sa nedokončí
spustenie.

Ak používate objektív, ktorý nepodporuje ovládanie otáčania a nakláňania, zaistite zaisťovaciu páčku otáčania a nakláňania
a preskočte nasledujúce kroky. Podrobnosti o objektívoch, ktoré podporujú otáčanie/nakláňanie, vám poskytne predajca
alebo servisný zástupca Sony.

Posuňte zaisťovaciu páčku otáčania/nakláňania do polohy UNLOCK, aby ste odomkli otáčanie/nakláňanie
hlavy kamery.

4

Resetujte otáčanie/nakláňanie.

Podrobnosti nájdete v časti „Resetovanie otáčania/nakláňania“.

5
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Resetovanie otáčania/nakláňania

Otočenie a nakláňanie môžete resetovať napríklad pri výmene objektívu pomocou nasledujúceho postupu.

5-041-959-13(1) Copyright 2022 Sony Corporation

Posuňte zaisťovaciu páčku otáčania/nakláňania do polohy UNLOCK a skontrolujte, či je
posúvanie/nakláňanie hlavy kamery odomknuté.

1

Vykonajte reset otáčania/nakláňania.

Resetovanie otáčania/nakláňania je možné vykonať pomocou infračerveného diaľkového ovládača, webovej
aplikácie alebo diaľkového ovládača RM-IP500 (voliteľné príslušenstvo).

Ovládanie pomocou infračerveného diaľkového ovládača: Stlačte tlačidlo P/T RESET.
Ovládanie pomocou webovej aplikácie: Stlačte tlačidlo  (otáčanie/nakláňanie) na karte  (Others)
v ovládacom paneli kamery na živej prevádzkovej obrazovke.
Ovládanie pomocou RM-IP500: Pozrite si návod na obsluhu RM-IP500.

Poznámka

Vykonanie resetovania otáčania/nakláňania spôsobí otočenie hlavy kamery a objektívu. Pred vykonaním skontrolujte, či
objektív nie je zablokovaný.

Jednotka má funkciu, ktorá obmedzuje rozsah otáčania/nakláňania, ale táto funkcia je deaktivovaná, keď je jednotka
zapnutá alebo je vykonaný reset otáčania/nakláňania.

Rada

Keď je reset otáčania/nakláňania dokončený, jednotka sa vráti do polohy pred vykonaním.

2
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Prístup k webovej aplikácii z webového prehliadača

Pripojením jednotky k tabletu alebo počítaču môžete jednotku ovládať a konfigurovať z webového prehliadača.

Skontrolujte, či váš tablet alebo počítač podporuje operácie webovej aplikácie.

Poznámka

Ak požadované prostredie nie je splnené, alebo v závislosti od používania tabletu/počítača môže byť prehrávanie videa vo
webovom prehliadači nepriaznivo ovplyvnené.

Webová aplikácia tejto jednotky používa JavaScript. Ak na svojom tablete/počítači používate antivírusový softvér, webová
stránka sa nemusí zobraziť správne.

1

Položka Požiadavka

Displej

Odporúčame rozlíšenie 1080×810 pixelov alebo
vyššie
Veľkosť displeja tabletu: odporúčaná veľkosť 10
palcov alebo väčšia

Podporovaný OS a webový
prehliadač

Windows

OS Windows 10 alebo novší

Webový
prehliadač

Google Chrome

Mac

OS macOS 10.15 alebo novší

Webový
prehliadač

Google Chrome
Safari

iPad

OS iPadOS 15 alebo novší

Webový
prehliadač

Google Chrome
Safari

Android

OS Android 12 alebo novší

Webový
prehliadač

Google Chrome

Skontrolujte, či sú jednotka, tablet alebo počítač a periférne zariadenia zapnuté.2

Skontrolujte, či sú jednotka a tablet alebo počítač prepojené cez Wi-Fi alebo káblové lokálne pripojenie
LAN.

3

Pripojte sa k jednotke z webového prehliadača vášho tabletu alebo počítača.

Pripojenie pomocou QR kódu
Pomocou kamery tabletu naskenujte QR kód vytlačený na kryte média na bočnej strane jednotky.

4
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Poznámka

Ak sa číslo portu HTTP zmenilo z hodnoty 80, zadajte do panela s adresou „http://IP adresa jednotky:Číslo portu“.

Pri pripájaní pomocou QR kódu alebo zadaním adresy URL do panela s adresou webového prehliadača použite zariadenie, ktoré
podporuje mDNS*.

Rada

Následne môžete rýchlo pristupovať k jednotke pomocou funkcie záložiek webového prehliadača.

5-041-959-13(1) Copyright 2022 Sony Corporation

Otvorte odkaz zobrazený na tablete.
Webový prehliadač načíta a zobrazí obrazovku webovej aplikácie jednotky.

Pripojenie zadaním adresy URL do panela s adresou webového prehliadača
Spustite webový prehliadač na tablete alebo počítači a zadajte adresu URL vytlačenú na kryte média na bočnej
strane jednotky.
Webový prehliadač by mal zobraziť obrazovku webovej aplikácie jednotky.

Pripojenie zadaním IP adresy jednotky do panela s adresou webového prehliadača
Spustite webový prehliadač na vašom tablete alebo počítači a do panela s adresou zadajte „http://IP adresa
jednotky“.
Webový prehliadač by mal zobraziť obrazovku webovej aplikácie jednotky.

mDNS: Komunikačný protokol používaný na určenie IP adresy z názvu hostiteľa v lokálnej sieti.*
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Inicializácia jednotky

Pri prvom použití jednotky nezabudnite nakonfigurovať jednotku podľa nasledujúceho postupu.

Rada

Ak sa záložná batéria úplne vybije, budete musieť znova nakonfigurovať počiatočné nastavenie.

Pripojte sa k jednotke z tabletu alebo počítača a spustite webovú aplikáciu.

Pri prvom použití jednotky budete vyzvaní na zadanie používateľského mena a hesla do webového prehliadača.
Zadajte nasledujúce nastavenia.

Používateľské meno: admin
Heslo: (nechajte prázdne)

Pri konfigurácii úvodného nastavenia postupujte podľa pokynov na obrazovke.

1

Zadajte používateľské meno administrátora (Administrator) a heslo a klepnite na tlačidlo [OK].

1: Zadajte meno používateľa administrátora.
2: Nastavte heslo správcu.
3: Pre potvrdenie zadajte rovnaké heslo znova.

Poznámka

V používateľskom mene a hesle je možné použiť nasledujúce znaky. Heslo musí obsahovať aspoň jedno veľké písmeno,
jedno malé písmeno, jednu číslicu a musí mať 8 až 64 znakov.

Alfanumerické znaky

2
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Zobrazí sa živá obrazovka pre operácie snímania. Pokračujte v konfigurácii základnej činnosti jednotky podľa
prevádzkového režimu.

Rada

V niektorých prípadoch, napríklad pri použití jednotky s tabletom v páre, môže byť jednoduchšie použiť pevnú IP adresu jednotky.

Symboly (!$%`*+-./<=>?@[]^_{|}~)

Váš webový prehliadač sa znova načíta a zobrazí sa výzva na zadanie používateľského mena a hesla.

Zadajte meno používateľa a heslo, ktoré ste nakonfigurovali v 2. kroku.

Zobrazí sa obrazovka nastavenia jazyka a hodín.

3

Zadajte nasledujúce položky a stačte tlačidlo [OK].

[Language]
Vyberte jazyk, ktorý sa má použiť na zobrazenie webovej aplikácie a obrazovky kamery. Zmenou jazyka sa zmení
jazyk zobrazenia webovej aplikácie.
[Date & Time Format]
Vyberte formát zobrazenia dátumu a času z nasledujúcich možností.
[yyyy-mm-dd hh:mm:ss], [mm-dd-yyyy hh:mm:ss], [dd-mm-yyyy hh:mm:ss]
„yyyy“ označuje rok, „mm“ označuje mesiac, „dd“ označuje deň, „hh“ označuje hodinu, „mm“ označuje minútu a „ss“
označuje sekundu.
[12 h/24 h]
Pre zobrazenie času vyberte [12 h] (12-hodinové hodiny) alebo [24 h] (24-hodinové hodiny).
[Time Setting]
Vyberte spôsob nastavenia dátumu/času.
[Synchronize with PC]: Synchronize sa s dátumom/časom počítača alebo tabletu.
[Manual setting]: Nastaviť manuálne. Po výbere tejto metódy sa zobrazia vstupné polia pre dátum a čas.
[Time Zone]
Vyberte časové pásmo.

4
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Ak chcete nastaviť pevnú adresu IP, najprv vypnite vo webovej ponuke [Network] > [Wired LAN] > [IPv4] > [DHCP] (posuvný
prepínač v ľavej polohe).

Zobrazia sa položky nastavenia súvisiace s pevnou IP adresou. Nakonfigurujte položky a potom stlačte tlačidlo [OK] na
obrazovke.

5-041-959-13(1) Copyright 2022 Sony Corporation
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Konfigurácia základnej činnosti

Táto téma popisuje, ako nakonfigurovať jednotku pre základné činnosti.

Nastavenie režimu snímania

Režim snímania jednotky môžete vybrať tak, aby zodpovedal pracovnému postupu.

Režim Custom: Flexibilne vytvárajte snímky počas snímania.
Záznam režimov snímania: Zaznamenáva obsah S-Log.

Režim Flexible ISO: Nastavenia expozície sa nastavujú pomocou úprav hodnoty ISO podľa snímanej scény.
Režim Cine EI/režim Cine EI Quick: S jednotkou sa pracuje podobne ako s filmovou kamerou (pri snímaní sa
nevytvárajú všetky snímky), pričom zábery sa vyvolávajú až v postprodukcii.

V režime Cine EI Quick sa automaticky vyberie základná citlivosť, ktorá je vhodná pre nastavenie indexu expozície.
Nastavte režim snímania pomocou [Project] > [Base Setting] > [Shooting Mode] vo webovej ponuke alebo ponuke
kamery.

Režim Custom
Môžete si vybrať video štandard.
Prepínajte pomocou [Project] > [Base Setting] > [Target Display] vo webovej ponuke alebo ponuke kamery.

[SDR(BT.709)]: Snímanie podľa vysielacej normy HD
[HDR(HLG)]: Snímanie podľa vysielacej normy 4K novej generácie

Podrobnosti nájdete v časti „Prehľad vzhľadu“ a ďalšie témy v časti „Snímanie s požadovaným vzhľadom“.

Záznam režimov snímania
(režim Flexible ISO/režim Cine EI/režim Cine EI Quick)
V zázname režimov snímania vyberiete základný farebný rozsah pre zaznamenané signály a výstupné signály. Tu
vybraný farebný rozsah je farebný rozsah video výstupu, keď sú nastavenia [LUT On/Off] nastavené na [MLUT Off].
Farebný rozsah môžete prepnúť pomocou [Project] > [Cine EI/Flex.ISO Set] > [Color Gamut] v ponuke kamery.

[S-Gamut3.Cine/SLog3]: Ľahko nastaviteľný farebný rozsah pre digitálne kino (DCI-P3).
[S-Gamut3/SLog3]: Široký farebný rozsah Sony, ktorý pokrýva farebný priestor ITU-R BT.2020.

Podrobnosti nájdete v časti „Snímanie s úpravou vzhľadu v postprodukcii“.
 
Podporované funkcie v jednotlivých režimoch snímania sú uvedené v nasledujúcej tabuľke.
●: Podporované, –: Nie je podporované

Custom Flexible ISO Cine EI Cine EI Quick

ISO/Gain ● ● – –

AGC ● ● – –

Base Sensitivity ● – – –

Base ISO – ● ● ● (prepojené s EI)
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Rada

V režime Cine EI Quick a Cine EI sa sníma pri základnej citlivosti ISO bez použitia zosilnenia, aby sa maximalizoval výkon
obrazového snímača. Jas sa upravuje pomocou osvetlenia a ND filtra na úpravu množstva svetla, ktoré dopadá na obrazový
snímač.

Nastavenie systémovej frekvencie

Prepínajte pomocou [Project] > [Rec Format] > [Frequency] vo webovej ponuke alebo ponuke kamery. Jednotka sa môže
po prepnutí automaticky reštartovať v závislosti od zvolenej hodnoty.

Poznámka

Počas nahrávania alebo prehrávania nemôžete zmeniť systémovú frekvenciu.

Nastavenie režimu snímania kamery

Môžete nastaviť efektívnu veľkosť obrazu a rozlíšenie obrazového snímača.
Prepínajte pomocou [Project] > [Rec Format] > [Imager Scan Mode] vo webovej ponuke alebo ponuke kamery.
[FF]: Veľkosť celého rámčeka.
[S35]: Veľkosť Super 35mm.

Poznámka

Počas nahrávania alebo prehrávania nemôžete prepnúť režim snímania kamery.

Pri nastavení na S35 je formát videa obmedzený na 1920×1080.

Nastavenie kodeku

Môžete nastaviť kodek pre záznam.
Prepínajte pomocou [Project] > [Rec Format] > [Codec] vo webovej ponuke alebo ponuke kamery.

Poznámka

Počas nahrávania alebo prehrávania nemôžete kodek prepnúť.

Nastavenie formátu videa

Môžete nastaviť formát videa pre záznam a výstupný formát videa pre výstup z kamery.

Nastavte formát záznamu pre nahrávanie pomocou [Project] > [Rec Format] > [Video Format] vo webovej ponuke
alebo ponuke kamery.

Custom Flexible ISO Cine EI Cine EI Quick

Exposure Index – – ● ●

Auto Shutter ● ● – –

ATW ● ● – –

LUT On/Off – ● ● ●

Scene File ● – – –

Paint/Look
(okrem Base Look)

● – – –

112



Prepnite výstupný formát z konektorov SDI OUT a HDMI OUT pomocou [Monitoring] > [Output Format] vo webovej
ponuke alebo ponuke kamery.

Poznámka

Počas nahrávania alebo prehrávania nemôžete formát videa prepnúť.

Na signál z konektorov SDI OUT a HDMI OUT sa môžu vzťahovať obmedzenia, v závislosti od nastavenia formátu videa.

Súvisiaca téma
Prehľad vzhľadu

Snímanie s úpravou vzhľadu v postprodukcii

5-041-959-13(1) Copyright 2022 Sony Corporation
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Podporované pamäťové karty

Jednotka zaznamenáva zvuk a video na pamäťové karty CFexpress Type A (predávajú sa osobitne) alebo na pamäťové
karty SDXC (predávajú sa osobitne), ktoré sú vložené do zásuviek na karty. Pamäťové karty sa používajú aj na zástupné
nahrávanie.

Pamäťové karty CFexpress Type A

V jednotke používajte pamäťové karty Sony CFexpress Type A* uvedené v časti „Odporúčané nahrávacie médiá“.
Podrobnosti o práci s médiami od iných výrobcov nájdete v návode na obsluhu médií alebo si prečítajte informácie od
výrobcu.

Pamäťové karty SDXC

V jednotke používajte pamäťové karty SDXC* uvedené v časti „Odporúčané nahrávacie médiá“.

Odporúčané nahrávacie médiá

Zaručené prevádzkové podmienky sa budú líšiť v závislosti od nastavení Rec Format a Recording.

CFexpress Type A
VPG400-compliant
Podporované pre všetky formáty záznamu jednotky.

SDXC
Podporované za podmienok v nasledujúcej tabuľke. „●“ znamená, že funkčnosť bola overená a „–“ znamená, že
funkčnosť nie je zaručená.

RAW Out & XAVC-I, 4096×2160 Class 300, Normálny režim

RAW Out & XAVC-I, 3840×2160 Class 300, Normálny režim

V tomto sprievodcovi s nápovedou označované ako „CFexpress karty“.*

V tomto sprievodcovi s nápovedou označované ako „SD karty“.*

Systémová frekvencia Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – ● ●

25P – – – – – ● ●

24P – – – – – ● ●

23.98P – – – – – ● ●
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RAW Out & XAVC-I, 3840×2160 Class 300, S&Q (60 fps alebo menej)

RAW Out & XAVC-I, 3840×2160 Class 300, S&Q (100 fps, 120 fps)
Overené médium nie je k dispozícii.

XAVC-I, 4096×2160 Class 300, Normálny režim

XAVC-I, 4096×2160 Class 300, S&Q (60 fps alebo menej)

Systémová frekvencia Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – ● ●

Systémová frekvencia Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

Systémová frekvencia Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – ● ●

25P – – – – – ● ●

24P – – – – – ● ●

23.98P – – – – – ● ●

Systémová frekvencia Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – – ●

25P – – – – – – ●
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XAVC-I, 3840×2160 Class 300, Normálny režim

XAVC-I, 3840×2160 Class 300, S&Q (60 fps alebo menej)

XAVC-I, 3840×2160 Class 300, S&Q (100 fps, 120 fps)
Overené médium nie je k dispozícii.

XAVC-I, 1920×1080 Class 100, Normálny režim

XAVC-I, 1920×1080 Class 100, S&Q (60 fps alebo menej)

Systémová frekvencia Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

24P – – – – – – ●

23.98P – – – – – – ●

Systémová frekvencia Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – ● ●

Systémová frekvencia Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

Systémová frekvencia Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●

50P – – – – – ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – ● – ● ● ●

Systémová frekvencia Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●
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XAVC-I, 1920×1080 Class 100, S&Q (100 fps, 120 fps)

XAVC-I, 1920×1080 Class 100, S&Q (150 fps, 180 fps)
Overené médium nie je k dispozícii.

XAVC-I, 1920×1080 Class 100, S&Q (200 fps, 240 fps)
Overené médium nie je k dispozícii.

XAVC-L, 3840×2160 420, Normálny režim

XAVC-L, 3840×2160 420, S&Q (60 fps alebo menej)

Systémová frekvencia Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

50P – – – – – ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – ● ●

Systémová frekvencia Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

Systémová frekvencia Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – ● – ● ● ●

Systémová frekvencia Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●
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XAVC-L, 3840×2160 420, S&Q (100 fps, 120 fps)

XAVC-L, 1920×1080 HD50, Normálny režim

XAVC-L, 1920×1080 HD50, S&Q (60 fps alebo menej)

XAVC-L, 1920×1080 HD50, S&Q (100 fps, 120 fps)

Systémová frekvencia Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

23.98P – – – – – – ●

Systémová frekvencia Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●

50P – – – – – ● ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – –

Systémová frekvencia Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – ● – ● ● ●

Systémová frekvencia Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P ● ● ● ● ● ● ●

50P ● ● ● ● ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – ● – ● ● ●

Systémová frekvencia Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●
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XAVC-L, 1920×1080 HD50, S&Q (150 fps, 180 fps)

XAVC-L, 1920×1080 HD50, S&Q (200 fps, 240 fps)

XAVC-L, 1920×1080 HD35, Normálny režim

XAVC-L, 1920×1080 HD35, S&Q (60 fps alebo menej)

Systémová frekvencia Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

23.98P – – – – – ● ●

Systémová frekvencia Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●

50P – – – – – ● ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

Systémová frekvencia Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●

50P – – – – – ● ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

Systémová frekvencia Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P ● ● ● ● ● ● ●

50P ● ● ● ● ● ● ●

29.97P ● ● ● ● ● ● ●

25P ● ● ● ● ● ● ●

23.98P ● ● ● ● ● ● ●

Systémová frekvencia Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P ● ● ● ● ● ● ●

50P ● ● ● ● ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●
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XAVC-L, 1920×1080 HD35, S&Q (100 fps, 120 fps)

XAVC-L, 1920×1080 HD35, S&Q (150 fps, 180 fps)

XAVC-L, 1920×1080 HD35, S&Q (200 fps, 240 fps)

5-041-959-13(1) Copyright 2022 Sony Corporation

Systémová frekvencia Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

23.98P – – ● – ● ● ●

Systémová frekvencia Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – – – – ● ●

Systémová frekvencia Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – ● ●

Systémová frekvencia Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – – ●
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Vloženie pamäťových kariet

Táto téma popisuje preventívne opatrenia pri vkladaní pamäťových kariet.

Otvorte kryt médií v časti pre zásuvku karty.1

Vložte pamäťovú kartu.

V prípade kariet CFexpress je štítok otočený nahor.

Poznámka

Na jednotke namontovanej na strope štítok smeruje nadol.

V prípade kariet SD je štítok otočený nadol.

Poznámka

Na jednotke namontovanej na strope štítok smeruje nahor.

Kontrolka prístupu svieti na červeno, potom sa zmení na zelenú, ak je karta použiteľná.

2
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Poznámka

Pamäťová karta, zásuvka pre pamäťovú kartu a obrazové údaje na pamäťovej karte sa môžu poškodiť, ak kartu zasuniete do
zásuvky v nesprávnej orientácii.

Pri nahrávaní na médiá vložené do oboch zásuviek A a B pre karty CFexpress Type A/SD vložte médiá do oboch zásuviek, ktoré
sa odporúčajú pre prácu s formátom záznamu.

5-041-959-13(1) Copyright 2022 Sony Corporation

Poznámka

Ak kontrolka prístupu nepretržite bliká na červeno a nezmení sa na zelenú, jednotku dočasne vypnite a pamäťovú kartu
vyberte a znovu vložte.

Zatvorte kryt médií.3
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Vysunutie pamäťovej karty

Otvorte kryt médií v časti pre zásuvku karty a ľahko zatlačte na pamäťovú kartu, aby sa karta vysunula.

Poznámka

Ak je jednotka vypnutá alebo keď je počas prístupu na pamäťovú kartu vybratá pamäťová karta, nemožno zaručiť integritu údajov
na karte. Všetky údaje zaznamenané na karte môžu byť znehodnotené. Pred vypnutím jednotky alebo vybratím pamäťovej karty
vždy skontrolujte, či je kontrolka prístupu zelená alebo nesvieti.

Pri vyberaní pamäťovej karty ihneď po dokončení záznamu môže byť pamäťová karta horúca, čo však neznamená problém.

5-041-959-13(1) Copyright 2022 Sony Corporation
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Formátovanie (inicializácia) pamäťových kariet

Ak vložíte neformátovanú pamäťovú kartu alebo pamäťovú kartu, ktorá bola naformátovaná podľa inej špecifikácie, na
obrazovom paneli kamery sa zobrazí správa „Media Needs to be Formatted“.
Naformátujte kartu pomocou nasledujúceho postupu.

Poznámka

Formátovaním pamäťovej karty sa vymažú všetky údaje vrátane zaznamenaných video údajov a súborov nastavení.

Počas vykonávania sa môžu zobrazovať správy v závislosti od dĺžky procesu formátovania.

Ak formátovanie zlyhá
Pamäťové karty, ktoré jednotka nepodporuje, nemožno naformátovať.
Zobrazí sa varovná správa. Pri výmene karty za podporovanú pamäťovú kartu postupujte podľa pokynov.

Používanie karty naformátovanej na jednotke v zásuvke iného zariadenia
Najskôr urobte zálohu karty a potom kartu naformátujte v zariadení, ktoré sa má použiť.

5-041-959-13(1) Copyright 2022 Sony Corporation

Vyberte [TC/Media] > [Format Media] v ponuke kamery.1

Vyberte Media(A) (zásuvka A) alebo Media(B) (zásuvka B) a potom vyberte metódu formátovania (Full
Format alebo Quick Format).

Zobrazí sa potvrdzujúca správa.
[Full Format]: Úplne inicializuje médiá vrátane oblasti údajov a informácií o správe údajov.
[Quick Format]: Inicializuje iba informácie o správe údajov média.

2

Vyberte [Execute].

Počas formátovania sa zobrazí správa a kontrolka prístupu svieti načerveno.
Po dokončení formátovania sa zobrazí správa o dokončení.

3
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Kontrola zostávajúceho času záznamu

Pri snímaní (nahrávanie/pohotovostný režim) môžete sledovať na obrazovom paneli kamery zostávajúcu kapacitu
pamäťovej karty v každej zásuvke pomocou indikátorov zostávajúcej kapacity média v zásuvke A/B.
Zostávajúci čas záznamu sa počíta zo zostávajúcej kapacity média v každej zásuvke a aktuálneho formátu záznamu
(bitová rýchlosť záznamu) a zobrazuje sa v minútach.

Načasovanie výmeny pamäťovej karty
Keď celkový zostávajúci čas nahrávania na dve pamäťové karty klesne na menej ako 5 minút, zobrazí sa správa „Media
Near Full“, začne blikať kontrolka nahrávania/záznamu a upozorní vás.
Nahraďte za médium, ktoré má voľné miesto.
Ak budete pokračovať v nahrávaní, kým celkový zostávajúci čas nahrávania nedosiahne nulu, správa sa zmení na
„Media Full“ a záznam sa zastaví.

Poznámka

Na jednu pamäťovú kartu je možné zaznamenať až približne 600 klipov.

5-041-959-13(1) Copyright 2022 Sony Corporation
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Obnova pamäťových kariet

Ak sa z nejakého dôvodu vyskytne chyba na pamäťovej karte, musí byť karta pred použitím obnovená.
Keď vložíte pamäťovú kartu, ktorú je potrebné obnoviť, obrazový panel kamery zobrazí správu s otázkou, či ju chcete
obnoviť.

Obnovenie karty
Vyberte [Execute] pomocou tlačidiel so šípkami v ovládacom paneli GUI a stlačte tlačidlo [Set].
Počas formátovania sa zobrazuje správa a stav priebehu (%) a kontrolka prístupu svieti načerveno.
Po dokončení obnovenia sa zobrazí správa o dokončení.

Ak obnovenie zlyhá
Pamäťové karty, na ktorých sa vyskytli chyby pamäte, nie je možné obnoviť. Zobrazí sa varovná správa. Pri výmene
pamäťovej karty postupujte podľa pokynov.
Pamäťové karty, na ktorých sa vyskytli chyby pamäte, sa môžu stať opätovne použiteľné, ak budú preformátované.
V niektorých prípadoch je možné niektoré klipy obnoviť, zatiaľ čo iné nie. Obnovené klipy je možné normálne prehrať.

Poznámka

Na obnovenie médií zaznamenaných touto jednotkou použite túto jednotku.

Médiá nahrané na inom zariadení ako tejto jednotke alebo na jednotke inej verzie (dokonca rovnakého modelu) sa nemusia dať
pomocou tejto jednotky obnoviť.

Klipy kratšie ako 2 sekundy nie je možné obnoviť.

5-041-959-13(1) Copyright 2022 Sony Corporation
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Spustenie/zastavenie nahrávania

Táto téma popisuje, ako spustiť/zastaviť nahrávanie.

Pripojte potrebné zariadenia a skontrolujte, či sú jednotka a periférne zariadenia napájané.1

Vložte jednu alebo obidve pamäťové karty.2

Skontrolujte stav napájania jednotky v ľavej hornej časti obrazovky webovej aplikácie.

Keď je zapnuté napájanie
Keď je jednotka zapnutá, na hlavnom vypínači v hornej časti obrazovky webovej aplikácie sa zobrazí [Power ON].

Kontrolka POWER sa rozsvieti na prednej strane jednotky a obraz z kamery sa zobrazí na živej prevádzkovej
obrazovke webovej aplikácie.

Poznámka

Ak heslo správcu nebolo nakonfigurované, zobrazí sa obrazovka s výzvou na konfiguráciu hesla. Pozrite si časť
„Inicializácia jednotky“.

Keď je napájanie v pohotovostnom stave
Keď je zdroj napájania jednotky v pohotovostnom režime, na hlavnom vypínači vo webovej aplikácii sa zobrazí
[Power Standby].

V tomto stave stlačte hlavný vypínač a vyberte [Power ON]. Jednotka sa zapne, kontrolka POWER sa rozsvieti
nazeleno na prednej strane jednotky a obraz z kamery sa zobrazí na živej prevádzkovej obrazovke webovej
aplikácie.

Rada

3
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Prepnutie napájania jednotky do pohotovostného stavu
Stlačte hlavný vypínač vo webovej aplikácii a výberom položky [Power Standby] nastavte jednotku do pohotovostného
stavu.

Rada

Napájací zdroj môžete tiež nastaviť do pohotovostného stavu pomocou hlavného vypínača na dodanom infračervenom diaľkovom
ovládači.

Jednotku môžete zapnúť aj pomocou hlavného vypínača na dodávanom infračervenom diaľkovom ovládači.

Stlačte tlačidlo nahrávania START/STOP .

Nahrávanie sa spustí a kontrolka nahrávania/záznamu (2 miesta) na jednotke sa rozsvieti.
Počas nahrávania tlačidlo START/STOP nahrávania svieti. Tiež sa zobrazí ikona cieľového záznamového média
a [●Rec].

4

Nahrávanie zastavíte opätovným stlačením tlačidla nahrávania START/STOP.

Nahrávanie sa zastaví a kontrolka nahrávania/záznamu (2 miesta) na jednotke zhasne.
Počas pohotovostného režimu nahrávania tlačidlo START/STOP nahrávania nesvieti. Tiež sa zobrazí ikona
cieľového záznamového média a [Stby].

Rada

Nahrávanie môžete spustiť/zastaviť aj pomocou tlačidla START/STOP nahrávania na dodávanom infračervenom diaľkovom
ovládači.

5
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Súvisiaca téma
Inicializácia jednotky

5-041-959-13(1) Copyright 2022 Sony Corporation
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Prepínanie medzi pamäťovými kartami

Keď sú vložené dve pamäťové karty, môžete stlačením tlačidla [Slot Select] na ovládacom paneli prehrávania webovej
aplikácie prepínať pamäťové karty.

Rada

Pamäťové karty môžete prepínať aj stlačením tlačidla SLOT SEL (výber zásuvky pre pamäťovú kartu (A)/(B)) na dodanom
infračervenom diaľkovom ovládači.

O prenesenom zázname

Pri nahrávaní jednotka automaticky prepne na druhú pamäťovú kartu tesne pred znížením zostávajúcej kapacity prvej
karty na nulu (prenesený záznam). Pri výmene pamäťových kariet môžete pokračovať v nahrávaní nepretržite tak, že
nahradíte plnú pamäťovú kartu novou pamäťovou kartou.

Poznámka

Počas režimu prehrávania nemôžete prepínať medzi pamäťovými kartami. Nepodporuje sa ani nepretržité prehrávanie klipu
nahraného na médiu v zásuvke A a zásuvke B.

O zaznamenaných údajoch

Keď zastavíte nahrávanie, obrazové, zvukové a sprievodné údaje od začiatku do konca nahrávania sa uložia ako jeden
„klip“ na pamäťovú kartu.

Názov klipu zaznamenaných údajov

Názov každého klipu zaznamenaného jednotkou sa automaticky priradí pomocou [TC/Media] > [Clip Name Format]
v ponuke kamery.

Maximálna doba trvania klipu

Až 6 hodín na klip.
Maximálna doba nepretržitého nahrávania je rovnaká ako maximálna doba trvania klipu. Ak čas záznamu prekročí
maximálnu dobu trvania klipu, automaticky sa vytvorí nový klip a záznam bude pokračovať. Nový klip sa na obrazovke
s miniatúrami zobrazí ako samostatný klip.
Počas preneseného záznamu sa zaznamenáva viac klipov za sebou, ale nahrávanie sa automaticky zastaví po približne
24 hodinách.

Poznámka

Počas nahrávania nevyberajte pamäťovú kartu. Počas nahrávania vymieňajte pamäťové karty iba v zásuvkách, pre ktoré nesvieti
kontrolka prístupu do zásuvky.

Keď zostávajúca kapacita zaznamenávanej pamäťovej karty klesne na menej ako jednu minútu a do druhej zásuvky je vložená
zapisovateľná pamäťová karta, zobrazí sa správa „Will Switch Slots Soon“. Správa zmizne po výmene zásuviek pre pamäťové
karty.

Prenesený záznam nemusí fungovať, ak sa nahrávanie spustí, keď je zostávajúca kapacita pamäťovej karty menej ako jedna
minúta. Pred začatím nahrávania skontrolujte, či je zostávajúca kapacita pamäťovej karty viac ako jedna minúta pre zaručenie
správneho preneseného záznamu.

Video vytvorené pomocou funkcie preneseného záznamu jednotky nie je možné na jednotke plynulo prehrať.
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Ak chcete skombinovať video vytvorené pomocou funkcie preneseného záznamu jednotky, použite softvér „Catalyst Browse“.

5-041-959-13(1) Copyright 2022 Sony Corporation
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Kontrola zvuku

Zvuk vychádza z konektorov SDI a HDMI jednotky. Vyberte kombináciu zvukových kanálov, ktoré sú na výstupe
z konektora HDMI pomocou [Audio] > [Audio Output] > [HDMI/Stream Output CH] v ponuke kamery.
CH1/CH2: CH1 a CH2 kombinácia
CH3/CH4: CH3 a CH4 kombinácia
Pri sledovaní zvuku vo webovej aplikácii použite merač úrovne zvuku v pravom dolnom rohu obrazu kamery.

5-041-959-13(1) Copyright 2022 Sony Corporation
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Zadanie časových údajov

Táto téma popisuje, ako nastaviť časové údaje.

Nastavenie časového kódu

Nastavte časový kód na nahrávanie pomocou [TC/Media] > [Timecode] v ponuke kamery.

Nastavenie používateľských bitov

K nahranému obrazu môžete pridať 8-miestne hexadecimálne číslo ako používateľské bity. Môžete tiež nastaviť
používateľské bity pre aktuálny čas. Nastavte pomocou [TC/Media] > [Users Bit] v ponuke kamery.

Zobrazenie časových údajov

Nastavte časový kód na zobrazenie pomocou [TC/Media] > [TC Display] > [Display Select] v ponuke kamery.
Stlačením priraditeľného tlačidla s priradenou funkciou [DURATION/TC/U-BIT] sa postupne prepína zobrazenie medzi
časovým kódom, používateľskými bitmi a dobou trvania.

5-041-959-13(1) Copyright 2022 Sony Corporation
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Kontrola záznamu (Rec Review)

Na obrazovke môžete skontrolovať posledný zaznamenaný klip (kontrola záznamu).

Poznámka

Funkcia Rec Review nie je podporovaná, ak sa po nahraní klipu zmení formát videa.

Nastavenie počiatočnej pozície Rec Review

Počiatočnú pozíciu prehrávania môžete nastaviť na jednu z nasledujúcich možností [Technical] > [Rec Review] v ponuke
kamery.

Posledné 3 sekundy klipu
Posledných 10 sekúnd klipu
Začiatok klipu

Rada

Ak chcete po nahraní viacerých klipov skontrolovať konkrétny klip, stlačením tlačidla [Thumbnail] zobrazíte obrazovku
s miniatúrami a výberom klipu spustíte prehrávanie.

Môžete tiež stlačiť tlačidlo THUMBNAIL na dodanom infračervenom diaľkovom ovládači, aby ste zobrazili obrazovku
s miniatúrami.

Rec Review metóda

Predtým priraďte funkciu Rec Review jednému z priraditeľných tlačidiel na paneli úprav základnej konfigurácie.

Podrobnosti o priradení nájdete v časti „Priraditeľné tlačidlá“ v časti „Užitočné funkcie“.

Zastavte nahrávanie a potom stlačením priraditeľného tlačidla priradeného k funkcii Rec Review spustite prehrávanie
predtým nahraného klipu.
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Klip sa prehrá do konca, Rec Review sa ukončí a jednotka sa vráti do Stby režimu (pohotovostný režim).

Zastavenie Rec Review
Stlačte priraditeľné tlačidlo s priradenou funkciou Rec Review alebo stlačte tlačidlo [Cancel/Back].
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Rada

Funkciu Rec Review môžete zastaviť aj stlačením tlačidla [Cancel/Back] na dodanom infračervenom diaľkovom ovládači.

Súvisiaca téma

Priraditeľné tlačidlá

5-041-959-13(1) Copyright 2022 Sony Corporation
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Obrazovka úpravy orámovania

Orámovanie sa nastavuje pomocou nasledujúcich častí živej prevádzkovej obrazovky.

Poznámka

V závislosti od nasmerovania kamery, ohniskovej vzdialenosti objektívu a polohy transfokácie môže byť viditeľná časť zariadenia
alebo káblov pripojených k pripojovaciemu bloku. Pred snímaním skontrolujte zorné pole objektívu a ohniskovú vzdialenosť, ktorú
používate. Rozsah otáčania/nakláňania môžete ovládať aj pomocou [Pan-Tilt] > [P/T Range Limit] vo webovej ponuke. Pri zapnutí
jednotky alebo keď sa vykoná reset otáčania/nakláňania, toto nastavenie limitu rozsahu sa ignoruje. Podrobnosti nájdete v časti
[Pan-Tilt] > [P/T Range Limit] vo webovej ponuke.

Rada

Orámovanie môžete ovládať aj pomocou dodávaného infračerveného diaľkového ovládača.

5-041-959-13(1) Copyright 2022 Sony Corporation

Ovládací panel prednastavenej polohy1.

Karta  (Main) / karta  (Others)2.

Ovládací panel orámovania3.
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Interchangeable Lens Digital Camera
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Úprava smeru snímania pomocou webovej aplikácie

Horizontálny pohyb kamery sa nazýva otáčanie (panoráma) a pohyb kamery vertikálne sa nazýva nakláňanie.
Smer snímania môžete upraviť pomocou funkkcií otáčania a nakláňania.

Rada

Ak sa pod joystickom zobrazí [Execute Pan-Tilt Reset], došlo k nesúladu v pôvodných informáciách pre ovládanie otáčania
a nakláňania jednotky. Ak chcete aktualizovať pôvodné informácie, vykonajte funkciu resetovania otáčania/nakláňania.
Podrobnosti nájdete v časti „Resetovanie otáčania/nakláňania“.

Aby kamera smerovala zozadu dopredu
Stlačte  (otáčanie/nakláňanie domov) na karte  (Others) na ovládacom paneli kamery.

Poznámka

V závislosti od nasmerovania kamery, ohniskovej vzdialenosti objektívu a polohy transfokácie môže byť viditeľná časť zariadenia
alebo káblov pripojených k pripojovaciemu bloku. Pred snímaním skontrolujte zorné pole objektívu a ohniskovú vzdialenosť, ktorú
používate. Rozsah otáčania/nakláňania môžete ovládať aj pomocou [Pan-Tilt] > [P/T Range Limit] vo webovej ponuke. Pri zapnutí
jednotky alebo keď sa vykoná reset otáčania/nakláňania, toto nastavenie limitu rozsahu sa ignoruje. Podrobnosti nájdete v časti
[Pan-Tilt] > [P/T Range Limit] vo webovej ponuke.

Súvisiaca téma
Resetovanie otáčania/nakláňania
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Stlačením  (otáčanie/nakláňanie/transfokácia) na ovládacom paneli zarámovania zobrazíte joystick.1

Potiahnite stred joysticku v smere, ktorý chcete sledovať, zatiaľ čo sledujete obrazový panel kamery.

Smer a rýchlosť kamery sa mení v závislosti od smeru a úrovne ťahu.
Otáčanie/nakláňanie môžete presnejšie nastaviť stlačením okrajových oblastí joysticku.

2
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Nastavenie prevádzkovej rýchlosti otáčania/nakláňania

Prevádzkovú rýchlosť otáčania/nakláňania môžete zmeniť pomocou posuvníka [Pan-Tilt Speed] v ovládacom paneli
kamery ovládaním joysticku.

Poznámka

Ak sa v dosahu pohybu kamery nachádza stena alebo iná prekážka, dávajte pozor, aby ste počas otáčania/nakláňania nenarazili
do kamery alebo objektívu.

Zrýchlenie otáčania/nakláňania závisí od fyzikálnych vlastností, ako je vyváženie hmotnosti objektívu. Nastavenie zrýchlenia
môžete zmeniť pomocou [Pan-Tilt] > [P/T Acceleration] > [Ramp Curve] vo webovej ponuke alebo ponuke kamery.

5-041-959-13(1) Copyright 2022 Sony Corporation

Stlačte kartu  (Main) na ovládacom paneli kamery.1

Zo zoznamu vyberte posuvník [Pan-Tilt Speed].

Ak sa posuvník [Pan-Tilt Speed] nezobrazuje, zobrazte ho výberom jedného z dvoch tlačidiel na výber funkcie
posuvníka.

2

Nastavte gombík posuvníka doľava alebo doprava.

Posunutím gombíka doľava znížite prevádzkovú rýchlosť, zatiaľ čo posunutím gombíka doprava zvýšite
prevádzkovú rýchlosť.

3
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Nastavenie prevádzkového zrýchlenia otáčania/nakláňania

Zrýchlenie môžete nastaviť v deviatich stupňoch pomocou [Pan-Tilt] > [P/T Acceleration] > [Ramp Curve] vo webovej
ponuke alebo ponuke kamery. Zvýšte hodnotu pre rýchlejšie zmeny rýchlosti alebo znížte hodnotu pre postupnejšie
zmeny rýchlosti.
Pre lepšiu odozvu pri ovládaní otáčania/nakláňania zvoľte hodnotu v rozsahu 7 až 9.
Pre väčšiu presnosť polohy na začiatku/konci pohybu do prednastavenej polohy sa odporúča hodnota v rozsahu 1 až 6.

Podrobnosti o prednastavenej polohe nájdete v časti „Uloženie/obnovenie polohy otáčania/nakláňania a polohy
transfokácie“.

Poznámka

Keď je hodnota nastavená na vysokú hodnotu, funkcia nemusí fungovať správne, ak je nasadený ťažký objektív. Pred skutočným
použitím skontrolujte fungovanie.

Vzťah medzi nastavením [Ramp Curve] a funkciou otáčania/nakláňania

Pri ovládaní otáčania/nakláňania

Keď sa vyvolá prednastavená poloha
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Nastavenie smeru snímania pomocou dodávaného infračerveného diaľkového
ovládača

Smer snímania môžete upraviť pomocou ovládacích tlačidiel otáčania a nakláňania na dodávanom infračervenom
diaľkovom ovládači.

Aby kamera smerovala zozadu dopredu
Stlačte tlačidlo HOME.

Poznámka

V závislosti od nasmerovania kamery, ohniskovej vzdialenosti objektívu a polohy transfokácie môže byť viditeľná časť zariadenia
alebo káblov pripojených k pripojovaciemu bloku. Pred snímaním skontrolujte zorné pole objektívu a ohniskovú vzdialenosť, ktorú
používate. Rozsah otáčania/nakláňania môžete ovládať aj pomocou [Pan-Tilt] > [P/T Range Limit] vo webovej ponuke. Pri zapnutí
jednotky alebo keď sa vykoná reset otáčania/nakláňania, toto nastavenie limitu rozsahu sa ignoruje. Podrobnosti nájdete v časti
[Pan-Tilt] > [P/T Range Limit] vo webovej ponuke.

5-041-959-13(1) Copyright 2022 Sony Corporation

Pomocou tlačidiel so šípkami ovládate otáčanie/nakláňanie.

Počas sledovania obrazu kamery stlačte tlačidlo šípky v smere, ktorý chcete zobraziť.
Ak sa chcete presunúť na krátku vzdialenosť, krátko stlačte tlačidlo so šípkou.
Ak sa chcete presunúť na veľkú vzdialenosť, stlačte a podržte tlačidlo so šípkou.
Ak sa chcete pohybovať diagonálne, stlačte a podržte tlačidlo  (šípka nahor) alebo  (šípka nadol) a stlačte
tlačidlo  (šípka doľava) alebo  (šípka doprava).

1
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Nastavenie typu transfokácie

Nastavte typ transfokácie pomocou [Technical] > [Zoom] > [Zoom Type] v ponuke kamery.
Typ transfokácie sa bude líšiť v závislosti od typu pripojeného objektívu.

Poznámka

Clear Image Zoom nie je k dispozícii v nasledujúcich prípadoch.

Ak je [Shooting] > [S&Q Motion] > [Setting] nastavené na On a nastavenie [Frame Rate] v ponuke kamery je vyššie ako 60
snímok za sekundu
Ak je [Project] > [Rec Format] > [Codec] v ponuke kamery nastavené na [RAW] alebo na možnosť, ktorá zahŕňa RAW

Stlačením prepínača SERVO/MANUAL na objektíve sa obnoví zväčšenie funkcie Clear Image Zoom na 1×.

Funkcia AF-S nie je podporovaná počas Clear Image Zoom.

Clear Image Zoom

Jednotka je vybavená funkciou transfokácie, ktorá využíva spracovanie obrazového signálu s názvom Clear Image
Zoom. Keď je zapnutá funkcia Clear Image Zoom, je transfokácia podporovaná aj pre objektívy s pevnou ohniskovou
vzdialenosťou. Môže sa tiež použiť na predĺženie rozsahu nad optický rozsah na objektíve s transfokáciou.
Maximálny pomer transfokácie pomocou funkcie Clear Image Zoom sa líši v závislosti od rozlíšenia záznamu.

Pre rozlíšenie záznamu QFHD/4K: 1,5×
Pre rozlíšenie záznamu HD: 2×

5-041-959-13(1) Copyright 2022 Sony Corporation

Typ pripojeného objektívu
[Zoom Type] nastavenia

[Optical Zoom Only] [On(Clear Image Zoom)]

Objektív s pevným ohniskom/Objektív
s manuálnou transfokáciou

Transfokácia nie je
podporovaná.

Clear Image Zoom je podporované.

Motorový objektív s transfokáciou
Podporovaná je len optická
transfokácia.

Podporované sú optická transfokácia
a Clear Image Zoom.

143



Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Úprava transfokácie pomocou webovej aplikácie

Transfokáciu jednotky môžete upraviť pomocou optickej transfokácie alebo funkciou Clear Image Zoom. Táto téma
popisuje, ako vykonať úpravy pomocou webovej aplikácie. Podrobnosti o funkcii Clear Image Zoom nájdete v časti
„Nastavenie typu transfokácie“.

Poznámka

V závislosti od nasmerovania kamery, ohniskovej vzdialenosti objektívu a polohy transfokácie môže byť viditeľná časť zariadenia
alebo káblov pripojených k pripojovaciemu bloku. Pred snímaním skontrolujte zorné pole objektívu a ohniskovú vzdialenosť, ktorú
používate. Rozsah otáčania/nakláňania môžete ovládať aj pomocou [Pan-Tilt] > [P/T Range Limit] vo webovej ponuke. Pri zapnutí
jednotky alebo keď sa vykoná reset otáčania/nakláňania, toto nastavenie limitu rozsahu sa ignoruje. Podrobnosti nájdete v časti
[Pan-Tilt] > [P/T Range Limit] vo webovej ponuke.

Skutočná rýchlosť a presnosť transfokácie sa budú líšiť v závislosti od objektívu. Pred použitím skontrolujte fungovanie.

Rada

Objektív s manuálnou transfokáciou môžete ovládať pomocou ovládača objektívu (voliteľné príslušenstvo), ktorý je kompatibilný
s touto jednotkou. Podrobnosti nájdete v častiach „Pripojenie ovládača objektívu“ a „Úprava transfokácie pomocou ovládača
objektívu“.

Súvisiaca téma

Nastavenie typu transfokácie

Pripojenie ovládača objektívu

Úprava transfokácie pomocou ovládača objektívu

Stlačením karty  (otáčanie/nakláňanie/transfokácia) na ovládacom paneli zarámovania zobrazíte
ovládací panel otočenia/naklonenia.

1

Posuňte gombík posuvníka [Zoom] v smere [T] (teleobjektív) alebo [W] (širokouhlý) pre úpravu
transfokácie.

Rýchlosť transfokácie sa mení podľa pohybu posúvača.

2
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Nastavenie prevádzkovej rýchlosti transfokácie

Prevádzkovú rýchlosť posuvníka [Zoom] na ovládacom paneli orámovania môžete zmeniť pomocou posuvníka [Zoom
Speed] na ovládacom paneli kamery.

Poznámka

Skutočná rýchlosť a presnosť transfokácie sa budú líšiť v závislosti od objektívu. Pred použitím skontrolujte fungovanie.
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Stlačte kartu  (Main) na ovládacom paneli kamery.1

Zo zoznamu vyberte posuvník [Zoom Speed].

Ak sa posuvník [Zoom Speed] nezobrazuje, zobrazte ho výberom jedného z dvoch tlačidiel na výber funkcie
posuvníka.

 

2

Nastavte gombík posuvníka [Zoom Speed] doľava alebo doprava.

Posunutím gombíka doľava znížite prevádzkovú rýchlosť, zatiaľ čo posunutím gombíka doprava zvýšite
prevádzkovú rýchlosť.

3
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Nastavenie transfokácie pomocou dodávaného infračerveného diaľkového ovládača

Transfokáciu jednotky môžete upraviť pomocou optickej transfokácie alebo funkciou Clear Image Zoom. Táto téma
popisuje, ako vykonať úpravy pomocou dodávaného infračerveného diaľkového ovládača. Podrobnosti o funkcii Clear
Image Zoom nájdete v časti „Nastavenie typu transfokácie“.

Poznámka

V závislosti od nasmerovania kamery, ohniskovej vzdialenosti objektívu a polohy transfokácie môže byť viditeľná časť zariadenia
alebo káblov pripojených k pripojovaciemu bloku. Pred snímaním skontrolujte zorné pole objektívu a ohniskovú vzdialenosť, ktorú
používate. Rozsah otáčania/nakláňania môžete ovládať aj pomocou [Pan-Tilt] > [P/T Range Limit] vo webovej ponuke. Pri zapnutí
jednotky alebo keď sa vykoná reset otáčania/nakláňania, toto nastavenie limitu rozsahu sa ignoruje. Podrobnosti nájdete v časti
[Pan-Tilt] > [P/T Range Limit] vo webovej ponuke.

Rada

Objektív s manuálnou transfokáciou môžete ovládať pomocou ovládača objektívu (voliteľné príslušenstvo), ktorý je kompatibilný
s touto jednotkou. Podrobnosti nájdete v častiach „Pripojenie ovládača objektívu“ a „Úprava transfokácie pomocou ovládača
objektívu“.

Súvisiaca téma

Nastavenie typu transfokácie

Pripojenie ovládača objektívu

Úprava transfokácie pomocou ovládača objektívu

5-041-959-13(1) Copyright 2022 Sony Corporation

Stlačením tlačidla transfokácie upravte transfokáciu.

Stlačte tlačidlo T (teleobjektív) alebo W (širokouhlý) pri sledovaní obrazovky a upravte transfokáciu.
Ak chcete priblížiť, stlačte tlačidlo T.
Ak chcete oddialiť, stlačte tlačidlo W.

1
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
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Kalibrácia objektívu s bajonetom E

Kalibrácia koriguje rozdiely v polohe transfokácie spôsobené rozdielmi jednotlivých objektívov pri použití objektívu
s motorovou transfokáciou s bajonetom E.
Ak chcete presne vypočítať polohu transfokácie, nakalibrujte váš objektív, aby ste opravili individuálne rozdiely
v objektíve pomocou nasledujúceho postupu.

Kalibračné údaje
V jednotke je možné uložiť kalibračné údaje až pre päť objektívov. Najstaršie údaje sa prepíšu pri 6. alebo
nasledujúcej kalibrácii objektívu.
Stlačením tlačidla  (stav kamery) v spoločnej oblasti obrazovky webovej aplikácie a výberom [Lens] > [Calibration
Data] môžete skontrolovať, či sú pre pripojený objektív k dispozícii kalibračné údaje.

5-041-959-13(1) Copyright 2022 Sony Corporation

Ak má objektív prepínač SERVO/MANUAL, nastavte ho do polohy SERVO.

Poznámka

Ak je prepínač v polohe MANUAL, objektív nebude môcť prijímať pokyny transfokácie z jednotky.

1

Spustite kalibráciu pomocou [Technical] > [Lens] > [Lens Calibration] v ponuke kamery.

Počas kalibrácie sa objektív s transfokáciou automaticky pohybuje a zameriava.

2
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Uloženie/obnovenie otáčania/nakláňania, polohy transfokácie a nastavenia zaostrenia
pomocou webovej aplikácie

Nastavenie otočenia/naklonenia, polohy transfokácie a zaostrovania môžete uložiť a v prípade potreby ich vyvolať
pomocou webovej aplikácie (funkcia predvoľby polohy).

Podrobnosti o položkách, ktoré je možné uložiť/obnoviť, nájdete v časti „Prednastavená poloha uložených položiek“.

Poznámka

Predvoľbu polohy nie je možné uložiť, ak pomer Clear Image Zoom prekročí 1×.

Ak sa nastavenie [Pan-Tilt] > [P/T Direction] [Ceiling] vo webovej ponuke sa zmení, všetky uložené predvoľby polohy sa vymažú.

Pomocný režim PTZ nastavte na [Pos.] v rozbaľovacom zozname v hornej časti ovládacieho panela
predvoľby polohy.

1

Určite polohu, ktorú chcete uložiť, pomocou operácií otáčania/nakláňania a transfokácie.2

Stlačte tlačidlo [+] na ovládacom paneli pre predvoľbu polohy.

Obraz s uloženou polohou sa zobrazí na ovládacom paneli pre prednastavenú polohu.

Rada

Ak sa ovládací panel pre prednastavenú polohu nezobrazuje, zobrazte ho stlačením tlačidla  (Otvoriť).

Polohy sa ukladajú v poradí od [Preset1].

Ak sú v sekvencii predvolieb nepoužité predvoľby, polohy sa uložia do predvolieb počnúc nepoužitými predvoľbami.
Napríklad, ak sú uložené predvoľby polohy v [Preset1] a [Preset3], ale nie v [Preset2], budú ďalšie predvoľby polohy
uložené do [Preset2] a potom do [Preset4].

3

149



Zrušenie obnovenia predvoľby polohy
Stlačením tlačidla  (Zrušiť obnovenie) zobrazeného na ovládacom paneli predvoľby polohy počas obnovenia
predvoľby polohy zrušíte obnovenie. Pomocou joysticku a posuvníka [Zoom] upravte zarámovanie.

Je možné uložiť až 100 predvolieb polohy.

Každú predvoľbu polohy môžete premenovať. Podrobnosti nájdete v časti „Premenovanie predvolieb polôh pomocou
webovej aplikácie“.

Obnovenie uloženej polohy.

Dvakrát stlačte miniatúru polohy, ktorú chcete obnoviť, na ovládacom paneli pre prednastavenú polohu, aby ste
obnovili zodpovedajúcu polohu.

Rada

Polohu môžete obnoviť aj stlačením obrázka, stlačením tlačidla  (Ponuka predvoľby polohy), ktoré sa zobrazí, a výberom
[Recall].

Rýchlosť prechodu na uloženú polohu je určená nastavením [Pan-Tilt] > [P/T Preset] > [Pan-Tilt] > [Pan-Tilt Speed for
Common] vo webovej ponuke, keď bola poloha uložená. Po uložení môžete zmeniť aj rýchlosť prechodu. Podrobnosti
nájdete v časti „Zmena rýchlosti prechodu (otáčanie/nakláňanie/transfokácia/zaostrovanie) pri obnovení predvoľby polohy“.

Stupeň zmeny polohy otáčania/naklonenia pri pohybe do prednastavenej polohy je možné upraviť pomocou nastavení
rýchlosti prechodu a [Ramp Curve]. Podrobnosti nájdete v časti „Zmena rýchlosti prechodu
(otáčanie/nakláňanie/transfokácia/zaostrovanie) pri obnovení predvoľby polohy“ a „Nastavenie prevádzkového zrýchlenia
otáčania/nakláňania“.

Ak sa počas prehrávania predvolieb vyvolá iná predvoľba, spustenie prvej vyvolanej predvoľby sa zastaví a spustí sa
následne vyvolaná predvoľba.

Poznámka

Ak sa teplota prostredia medzi uložením predvoľby polohy a jej prehrávaním výrazne zmenila, môže dôjsť k odchýlke
v snímaní.

Počas obnovovania predvoľby polohy nemôžete vykonávať iné úkony ako obnovenie alebo zrušenie predvoľby polohy.

4
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Súvisiaca téma
Prednastavená poloha uložených položiek

Premenovanie predvolieb polôh pomocou webovej aplikácie

Zmena rýchlosti prechodu (otáčanie/nakláňanie/transfokácia/zaostrovanie) pri obnovení predvoľby polohy

Nastavenie prevádzkového zrýchlenia otáčania/nakláňania

5-041-959-13(1) Copyright 2022 Sony Corporation
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Premenovanie predvolieb polôh pomocou webovej aplikácie

Uložené predvoľby polohy môžete premenovať.

5-041-959-13(1) Copyright 2022 Sony Corporation

Pomocný režim PTZ nastavte na [Pos.] v rozbaľovacom zozname v hornej časti ovládacieho panela
predvoľby polohy.

1

Stlačte predvoľbu polohy, ktorú chcete premenovať.

V pravom hornom rohu obrázka sa zobrazí tlačidlo  (Ponuka predvoľby polohy).

2

Stlačte tlačidlo  (Ponuka predvoľby polohy) a zo zobrazenej ponuky vyberte možnosť [Rename].3

Zadajte nový názov predvoľby.4
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Nahradenie uloženej predvoľby polohy novou polohou pomocou webovej aplikácie

Uloženú predvoľbu polohy môžete nahradiť novou polohou.

5-041-959-13(1) Copyright 2022 Sony Corporation

Pomocný režim PTZ nastavte na [Pos.] v rozbaľovacom zozname v hornej časti ovládacieho panela
predvoľby polohy.

1

Určite polohu, ktorú chcete uložiť, pomocou operácií otáčania/nakláňania a transfokácie.2

Stlačte obrázok polohy, ktorú chcete nahradiť, na ovládacom paneli predvoľby polohy.

V pravom hornom rohu obrázka sa zobrazí tlačidlo  (Ponuka predvoľby polohy).

3

Stlačte tlačidlo  (Ponuka predvoľby polohy) a zo zobrazenej ponuky vyberte možnosť [Replace].

Nová poloha nahradí aktuálne nastavenie.

4
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
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Odstránenie uloženej predvoľby polohy pomocou webovej aplikácie

Uložené predvoľby polohy môžete vymazať.
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Pomocný režim PTZ nastavte na [Pos.] v rozbaľovacom zozname v hornej časti ovládacieho panela
predvoľby polohy.

1

Stlačte obrázok polohy, ktorú chcete odstrániť, na ovládacom paneli predvoľby polohy.

V pravom hornom rohu obrázka sa zobrazí tlačidlo  (Ponuka predvoľby polohy).

2

Stlačte tlačidlo  (Ponuka predvoľby polohy) a zo zobrazenej ponuky vyberte možnosť [Delete].

Uložená poloha sa vymaže.

3
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Synchronizácia otočenia/naklonenia a transfokácie/zaostrenia pri obnovení predvoľby
polohy

Pri obnovovaní uloženej predvoľby polohy môžete synchronizovať otáčanie/nakláňanie a transfokáciu pre plynulejšie
snímanie.

Rada

Nastavenia používané na registráciu predvoľby polohy môžete zadať vopred. Nastavte [Pan-Tilt] > [P/T Preset] > [Default] >
[Zoom Sync] na [On] vo webovej ponuke.

Ak je [Pan-Tilt] > [P/T Preset] > [Speed Select] nastavené na [Common], všetky predvoľby polohy sa obnovia nastavenou
rýchlosťou pomocou [Pan-Tilt] > [P/T Preset] > [Common Speed].

Po dokončení pohybu transfokácie sa kamera presunie do uloženej polohy zaostrenia.

Po dokončení pohybu sa [AF Transition Speed] vráti na pôvodné nastavenie.

Pomocný režim PTZ nastavte na [Pos.] v rozbaľovacom zozname v hornej časti ovládacieho panela
predvoľby polohy.

1

Stlačte obrázok predvoľby polohy, pre ktorú chcete zmeniť rýchlosť prechodu.

V pravom hornom rohu obrázka sa zobrazí tlačidlo  (Ponuka predvoľby polohy).

2

Stlačte tlačidlo  (Ponuka predvoľby polohy) a zo zobrazenej ponuky vyberte možnosť [Edit…].

Zobrazí sa obrazovka nastavenia pre zvolenú predvoľbu polohy.

3

Posunutím prepínača [Zoom Sync] doprava zapnite funkciu a stlačte tlačidlo [OK].

Pri ďalšom obnovení uloženej polohy sa kamera bude pohybovať nakonfigurovanou rýchlosťou.

4
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Zmena rýchlosti prechodu (otáčanie/nakláňanie/transfokácia/zaostrovanie) pri
obnovení predvoľby polohy

Pri obnovení uloženej predvoľby polohy môžete zmeniť rýchlosť prechodu
(otáčanie/nakláňanie/transfokácia/zaostrovanie).

Rada

Ak je [Pan-Tilt] > [P/T Preset] > [Speed Select] nastavené na [Common], všetky polohy sa obnovia nastavenou rýchlosťou
pomocou [Pan-Tilt] > [P/T Preset] > [Common Speed].

Po dokončení pohybu transfokácie sa kamera presunie do uloženej polohy zaostrenia.

Po dokončení pohybu sa [AF Transition Speed] vráti na pôvodné nastavenie.

Nastavte [Pan-Tilt] > [P/T Preset] > [Speed Select] na [Separate] vo webovej ponuke.1

Pomocný režim PTZ nastavte na [Pos.] v rozbaľovacom zozname v hornej časti ovládacieho panela
predvoľby polohy.

2

Stlačte obrázok predvoľby polohy, pre ktorú chcete zmeniť rýchlosť prechodu.

V pravom hornom rohu obrázka sa zobrazí tlačidlo  (Ponuka predvoľby polohy).

3

Stlačte tlačidlo  (Ponuka predvoľby polohy) a zo zobrazenej ponuky vyberte možnosť [Edit…].

Zobrazí sa obrazovka nastavenia pre zvolenú predvoľbu polohy.

4

Pomocou posuvníkov nastavte prechodové rýchlosti (otáčanie/nakláňanie/transfokácia/zaostrovanie), ktoré
chcete zmeniť, alebo priamo zadajte hodnoty a stlačte tlačidlo [OK].

Pri ďalšom obnovení uloženej polohy sa kamera bude pohybovať nakonfigurovanou rýchlosťou.

5
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Interchangeable Lens Digital Camera
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Uloženie/obnovenie polohy otáčania/nakláňania a transfokácie pomocou dodávaného
infračerveného diaľkového ovládača

Polohu otáčania/nakláňania a transfokácie môžete uložiť a v prípade potreby ich vyvolať pomocou dodávaného
infračerveného diaľkového ovládača.

Súvisiaca téma

Zmena rýchlosti prechodu (otáčanie/nakláňanie/transfokácia/zaostrovanie) pri obnovení predvoľby polohy

Upravte otáčanie/nakláňanie a transfokáciu kamery.1

Pomocný režim PTZ nastavte na [Pos.] v rozbaľovacom zozname v hornej časti ovládacieho panela
predvoľby polohy vo webovej aplikácii.

2

Stlačte a podržte tlačidlo PRESET a stlačte jedno z tlačidiel 1 až 3.

Poloha sa uloží.

3

Obnovenie uloženej polohy.

Stlačením jedného z tlačidiel 1 až 3 obnovíte túto predvoľbu polohy.

Rada

Rýchlosť prechodu pri obnovení predvoľby polohy je určená uloženou hodnotou [Pan-Tilt] > [P/T Preset] > [Pan-Tilt Speed]
vo webovej ponuke. Po uložení hodnoty môžete rýchlosť prechodu zmeniť. Podrobnosti nájdete v časti „Zmena rýchlosti
prechodu (otáčanie/nakláňanie/transfokácia/zaostrovanie) pri obnovení predvoľby polohy“.

4
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Nahrávanie zarámovaní kamery pomocou webovej aplikácie

Pomocou webovej aplikácie môžete zaznamenať zarámovania kamery.

Nastavte východiskovú polohu kamery.1

Pomocný režim PTZ nastavte na [Trace] v rozbaľovacom zozname v hornej časti ovládacieho panela
predvoľby polohy.

2

Stlačte tlačidlo [+] na ovládacom paneli pre predvoľbu polohy.

Pridá sa miniatúra a kamera sa prepne do pohotovostného stavu nahrávania.

Rada

3
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Rada

Zostávajúci čas nahrávania sa počas nahrávania zobrazuje v hornej časti obrazového panela kamery.

Poznámka

Zaznamenané zarámovanie sa vymaže, ak prepnete na stropnú montáž

Prepnutie systémovej frekvencie môže vymazať zaznamenané zarámovanie.

Transfokácia nie je podporovaná, keď je pripojený ovládač objektívu.

Maximálne trvanie záznamu jedného zarámovania je 3 minúty. Nahrávanie sa automaticky zastaví, keď doba nahrávania
dosiahne 3 minúty.

Nahrávanie zarámovania nie je možné spustiť, ak je pomer Clear Image Zoom väčší ako 1×.

Ak je kamera počas nahrávania zarámovania ovládaná z iného zariadenia, zaznamenajú sa aj úkony z druhého zariadenia.
Podrobnosti o nahrávaní pomocou diaľkového ovládača tretej strany získate od príslušného výrobcu.

Nastavenia zaostrenia a kvality obrazu sa touto funkciou nezaznamenávajú.

Otáčanie/nakláňanie/transfokácia zaznamenané pri nahrávaní zarámovania sa nedajú presne reprodukovať počas prehrávania
zarámovania.

Stlačením tlačidla  (Zavrieť) na miniatúre môžete ukončiť pohotovostný stav nahrávania a vrátiť sa do normálnej
prevádzky.

Spustite zarámovanie pomocou joysticku a posuvníka [Zoom].

Nahrávanie sa spustí v okamihu, keď sa začne zarámovanie.

4

Stlačením tlačidla  (Zastaviť nahrávanie) na miniatúre zastavíte nahrávanie.5
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Ak po zaznamenaní zarámovania nastavíte limit rozsahu otáčania/nakláňania pomocou [Pan-Tilt] > [P/T Range Limit] vo webovej
ponuke, obmedzenie rozsahu otáčania/nakláňania sa počas prehrávania zarámovania neuplatní. Ak chcete použiť zarámovanie
a funkciu obmedzenia otáčania/nakláňania spoločne, pred nahrávaním zarámovania nastavte obmedzenie rozsahu
otáčania/nakláňania.

Zaznamenané zarámovanie nie je možné prehrať, keď je zvolený výstup RAW video.

Zaznamenané zarámovanie nie je možné prehrať, ak sa z výstupného konektora SDI nevysiela videosignál.

5-041-959-13(1) Copyright 2022 Sony Corporation
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Prehrávanie zarámovaní kamery pomocou webovej aplikácie

Pomocou webovej aplikácie môžete prehrať zaznamenané zarámovanie kamery.

Pomocný režim PTZ nastavte na [Trace] v rozbaľovacom zozname v hornej časti ovládacieho panela
predvoľby polohy.

1

Vyberte miniatúru so zarámovaním, ktoré chcete prehrať.

Na miniatúre sa zobrazí tlačidlo  (Pripraviť).

2

Stlačte tlačidlo  (Pripraviť).

Kamera sa presunie do východiskovej polohy zarámovania a prepne sa do pohotovostného stavu prehrávania.

3

Stlačte tlačidlo  (Prehrať) na miniatúre.4
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Rada

V pohotovostnom stave prehrávania a počas prehrávania môžete zrušiť prehrávanie a vrátiť sa do normálnej prevádzky
vykonaním niektorej z nasledujúcich operácií.

Stlačte tlačidlo  (Stop) na miniatúre alebo na ovládacom paneli predvoľby polohy.
Použite joystick.
Použite posuvník [Zoom].

Uplynulý čas prehrávania sa počas prehrávania zobrazuje v hornej časti obrazového panela kamery.

Poznámka

Ak sa nastavenie Clear Image Zoom líši medzi nahrávaním a prehrávaním zarámovania, môže dôjsť k neočakávanému
správaniu.

Prehrávanie transfokácie nie je podporované, keď je pripojený ovládač objektívu. Ovládanie transfokácie zastaví prehrávanie
zarámovania.

Počas prehrávania zarámovania zmena limitu rozsahu otáčania/nakláňania pomocou [Pan-Tilt] > [P/T Range Limit] vo webovej
ponuke nemá žiadny účinok. Pred nahrávaním zarámovania nastavte limit rozsahu otočenia/naklonenia.

5-041-959-13(1) Copyright 2022 Sony Corporation

Spustí sa prehrávanie zarámovania.
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Odstránenie zaznamenaného zarámovania kamery pomocou webovej aplikácie

Zaznamenané zarámovanie kamery môžete odstrániť pomocou webovej aplikácie.

5-041-959-13(1) Copyright 2022 Sony Corporation

Pomocný režim PTZ nastavte na [Trace] v rozbaľovacom zozname v hornej časti ovládacieho panela
predvoľby polohy.

1

Vyberte miniatúru so zarámovaním, ktoré chcete odstrániť.

Na miniatúre sa zobrazí tlačidlo  (ponuka Trace).

2

Stlačte tlačidlo  (ponuka Trace).

Zobrazí sa ponuka.

3

V zobrazenej ponuke vyberte [Delete].

Vybrané zarámovanie sa odstráni.

4
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Nahrávanie zarámovaní kamery pomocou dodaného infračerveného diaľkového
ovládania

Pomocou dodaného infračerveného diaľkového ovládača môžete zaznamenať zarámovania kamery.

Podrobnosti o prehrávaní zaznamenaného zarámovania nájdete v časti „Prehrávanie zarámovaní kamery pomocou
dodaného infračerveného diaľkového ovládania“.

Poznámka

Maximálne trvanie záznamu jedného zarámovania je 3 minúty. Nahrávanie sa automaticky zastaví, keď doba nahrávania
dosiahne 3 minúty.

Ak je kamera počas záznamu zarámovania ovládaná z iného zariadenia, ako súčasť zarámovania sa zaznamená aj zarámovanie
z iného zariadenia.

Ak sa kvalita obrazu upraví počas nahrávania zarámovania, táto zmena sa nezaznamená.

Súvisiaca téma

Prehrávanie zarámovaní kamery pomocou dodaného infračerveného diaľkového ovládania

5-041-959-13(1) Copyright 2022 Sony Corporation

Prístup k živej prevádzkovej obrazovke webovej aplikácie.1

Pomocný režim PTZ nastavte na [Trace] v rozbaľovacom zozname v hornej časti ovládacieho panela
predvoľby polohy.

2

Pomocou infračerveného diaľkového ovládača nastavte východiskovú polohu kamery.3

Stlačte a podržte tlačidlo PRESET a stlačte jedno z tlačidiel POSITION1 až 3.

Kamera sa prepne do pohotovostného stavu nahrávania.

4

Vykonajte zarámovanie, ktoré chcete zaznamenať.5

Ak chcete ukončiť nahrávanie, stlačte a podržte tlačidlo PRESET a stlačte tlačidlo POSITION zvolené
v kroku 4.

6
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Prehrávanie zarámovaní kamery pomocou dodaného infračerveného diaľkového
ovládania

Pomocou dodaného infračerveného diaľkového ovládača môžete prehrať zaznamenané zarámovanie kamery.

Poznámka

Ovládanie otočenia/naklonenia/transfokácie kamery zastaví prehrávanie.

Súvisiaca téma
Nahrávanie zarámovaní kamery pomocou dodaného infračerveného diaľkového ovládania

5-041-959-13(1) Copyright 2022 Sony Corporation

Prístup k živej prevádzkovej obrazovke webovej aplikácie.1

Pomocný režim PTZ nastavte na [Trace] v rozbaľovacom zozname v hornej časti ovládacieho panela
predvoľby polohy.

2

Vyberte a stlačte jedno z tlačidiel POSITION1 až 3, pre ktoré bolo zaznamenané zarámovanie.

Otáčanie/nakláňanie/transfokácia kamery sa presunie do východiskovej polohy prehrávania.

3

Potom, ako sa kamera presunie do východiskovej polohy prehrávania, znova stlačte to isté tlačidlo
POSITION.

Spustí sa prehrávanie.

4
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Obrazovka nastavenia zaostrenia

Zaostrenie sa nastavuje pomocou nasledujúcich častí živej prevádzkovej obrazovky.

5-041-959-13(1) Copyright 2022 Sony Corporation

Obrazový panel kamery
Zaostrenie môžete upraviť dotknutím sa obrazu kamery. Dotykové ovládanie môžete vypnúť vo webovej aplikácii
vypnutím prepínača [Touch Focus] na karte  (Focus) v ovládacom paneli kamery.

1.

Ovládací panel kamery – karta  (Focus)2.

Ovládací panel GUI3.
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Manuálne nastavenie pomocou webovej aplikácie

Zaostrenie môžete upraviť manuálne, napríklad v nasledujúcich prípadoch.

Subjekty čiastočne zakryté kvapkami vody
Objekty s nízkym kontrastom proti pozadiu
Objekty ďalej od blízkych subjektov

Poznámka

Manuálne zaostrovanie nie je možné ovládať z webovej aplikácie počas transfokácie.

Rada

Automatické zaostrenie môžete použiť aj vtedy, keď je hlavným spôsobom činnosti manuálne nastavenie. Podrobnosti nájdete
v časti „Manuálne nastavenie automatického zaostrenia (AF Assist) pomocou webovej aplikácie“.

Súvisiaca téma

Kontrola prepínačov objektívu

Manuálne nastavenie automatického zaostrenia (AF Assist) pomocou webovej aplikácie

5-041-959-13(1) Copyright 2022 Sony Corporation

Ak je objektív vybavený prepínačom zaostrenia, prepnite prepínač do polohy „AF/MF“ alebo „AF“.

Poznámka

Ak je prepínač v polohe „Full MF“ alebo „MF“, zaostrenie objektívu nie je možné ovládať z jednotky. Pozrite si časť „Pre
objektív s prepínačom režimu transfokácie“ v časti „Kontrola prepínačov objektívu“.

1

Automatické zaostrenie vypnete posunutím prepínača [Auto Focus] do ľavej polohy na ovládacom paneli
kamery.

Je aktivovaný režim manuálneho zaostrenia.

 (MF)

2

Upravte pomocou posúvača v spodnej časti karty  (Focus).3
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Manuálne nastavenie pomocou dodávaného infračerveného diaľkového ovládača

Zaostrenie môžete upraviť manuálne pomocou dodávaného infračerveného diaľkového ovládača.

Rada

Automatické zaostrenie môžete použiť aj vtedy, keď je hlavným spôsobom činnosti manuálne nastavenie. Podrobnosti nájdete v
časti „Manuálne zaostrenie počas automatického zaostrenia pomocou dodávaného infračerveného diaľkového ovládača“.

Súvisiaca téma

Manuálne zaostrenie počas automatického zaostrenia pomocou dodávaného infračerveného diaľkového ovládača

5-041-959-13(1) Copyright 2022 Sony Corporation

Stlačte tlačidlo MF na infračervenom diaľkovom ovládači.1

Upravte zaostrenie manuálne pomocou tlačidiel F (Ďaleko) a N (Blízko).

Ak chcete zaostriť na vzdialený objekt, stlačte tlačidlo F.
Ak chcete zaostriť na blízky objekt, stlačte tlačidlo N.

2
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Zaostrenie určením polohy zaostrenia (bodové zaostrenie)

V režime manuálneho zaostrenia môžete na obrazovom paneli kamery určiť polohu, v ktorej chcete upraviť zaostrenie.

Poznámka

Funkcia bodového zaostrenia nefunguje, ak je objektív nastavený na manuálne zaostrenie.

Rada

V režime bodového zaostrenia môžete stlačením priraditeľného tlačidla priradeného funkcii [Push AF/MF] dočasne zastaviť
bodové zaostrenie a povoliť automatické zaostrenie, kým je tlačidlo stlačené. Po uvoľnení tlačidla sa zaostrenie vráti na
manuálne zaostrenie.
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Nastavte [Shooting] > [Focus] > [Touch Function in MF] na [Spot Focus] vo webovej ponuke alebo v ponuke
kamery.

1

Posuňte prepínač [Touch Focus] na karte  (Focus) do polohy vpravo, aby ste ho zapli.2

Posuňte prepínač [Auto Focus] na karte  (Focus) do polohy vľavo, aby ste ho vypli.3

Zadajte polohu zaostrenia.

Zobrazí sa značka bodového zaostrenia a obraz sa upraví tak, aby bol v danej polohe zaostrený.

Príklad určenia polohy dotykovým ovládaním

4
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Dočasné použitie automatického zaostrenia (Push Auto Focus (AF))

V režime manuálneho zaostrenia môžete dočasne upraviť zaostrenie pomocou automatického zaostrenia stlačením
tlačidla [Push AF/MF], čím sa zaostrí automaticky, keď je tlačidlo stlačené.
To môže byť užitočné, ak chcete počas manuálneho zaostrovania pomaly presúvať zaostrenie z jedného objektu na
druhý.

Poznámka

Funkcia vynúteného automatického zaostrenia nefunguje, ak je objektív nastavený na manuálne zaostrenie.

Rada

Rovnaká operácia je vykonateľná pomocou priraditeľného tlačidla priradeného na [Push AF/MF].

5-041-959-13(1) Copyright 2022 Sony Corporation

Nastavte [Shooting] > [Focus] > [Push AF Mode] na [AF] v ponuke kamery.1

Posuňte prepínač [Auto Focus] na karte  (Focus) do polohy vľavo, aby ste ho vypli.2

Stlačte tlačidlo [Push AF/MF].

Automatické zaostrenie je aktívne, kým je stlačené tlačidlo.

Automatické zaostrenie sa po uvoľnení tlačidla uvoľní a zaostrenie sa vráti na manuálne zaostrenie.

3
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Použitie automatického zaostrenia na jeden záber (Push Auto Focus (AF-S))

V režime manuálneho zaostrenia môžete stlačením tlačidla [Push AF/MF] automaticky zaostriť vysokou rýchlosťou.
Táto funkcia je vhodná, keď pred snímaním zaostríte na objekt.

Poznámka

Funkcia vynúteného automatického zaostrenia nefunguje, ak je objektív nastavený na manuálne zaostrenie.

Pri použití tlačidla [Display] nie je rámček oblasti zaostrenia skrytý.

Nastavte [Shooting] > [Focus] > [Push AF Mode] na [Single-shot AF(AF-S)] vo webovej ponuke alebo
v ponuke kamery.

1

Zadajte polohu, pre ktorú chcete upraviť zaostrenie, pomocou [Shooting] > [Focus] > [Focus Area (AF-S)]
v ponuke kamery.

Rada

Polohu môžete zmeniť stlačením priraditeľného tlačidla priradeného k [Focus Setting], čím sa zobrazí oranžový rámček
okolo oblasti zaostrenia, a výberom polohy pomocou dotykového ovládania.

2

Posuňte prepínač [Auto Focus] na karte  (Focus) do polohy vľavo, aby ste ho vypli.3

Stlačte tlačidlo [Push AF/MF].

Ak tlačidlo uvoľníte pred dokončením zaostrenia, automatické zaostrenie sa zastaví.

Počas vynúteného automatického zaostrenia sa stav zaostrenia zobrazuje pomocou indikátora zaostrenia.
Svieti: Zaostrenie je fixné v polohe zaostrenia.
Bliká: Rozostrené. Keďže jednotka nezaostruje automaticky, zmeňte kompozíciu a nastavenia zaostrenia, aby ste
zaostrili.
Po uvoľnení tlačidla sa zaostrenie vráti na manuálne zaostrenie.

4
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Počas operácie Clear Image Zoom nie je možné nastaviť polohu rámčeka [Focus Area (AF-S)]. Počas operácie vynúteného
automatického zaostrovania funkcia AF tiež dáva prioritu stredovej oblasti.

Rada

Rovnaká operácia je vykonateľná pomocou priraditeľného tlačidla priradeného na [Push AF/MF].

[Push AF Mode] môžete tiež priradiť priraditeľnému tlačidlu.

[Focus Area (AF-S)] môžete tiež priradiť priraditeľnému tlačidlu.

Rámček oblasti zaostrenia môžete zobraziť/skryť pomocou [Monitoring] > [Display On/Off] > [Focus Area Ind.(AF-S)] v ponuke
kamery.

5-041-959-13(1) Copyright 2022 Sony Corporation
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Automatické nastavenie pomocou webovej aplikácie

Jednotka používa na rýchle zaostrenie fázovú detekciu AF a kontrastné AF na presné zaostrenie.
Kombinácia týchto dvoch metód AF poskytuje automatické zaostrenie s vysokou rýchlosťou aj vysokou presnosťou.

Poznámka

Vyžaduje sa objektív, ktorý podporuje automatické zaostrenie.

V závislosti od podmienok snímania nemusí byť možné dosiahnuť presnosť.

Na objektíve s bajonetom A nie je možné zaostrenie nastaviť automaticky.

Rada

Počas režimu automatického zaostrenia môžete upraviť zaostrenie pomocou posuvníka Focus na ovládacom paneli kamery.
Podrobnosti nájdete v časti „Manuálne nastavenie automatického zaostrenia (AF Assist) pomocou webovej aplikácie“.

Súvisiaca téma
Kontrola prepínačov objektívu

Manuálne nastavenie automatického zaostrenia (AF Assist) pomocou webovej aplikácie

5-041-959-13(1) Copyright 2022 Sony Corporation

Ak je objektív vybavený prepínačom zaostrenia, prepnite prepínač do polohy „AF/MF“ alebo „AF“.

Poznámka

Ak je prepínač v polohe „Full MF“ alebo „MF“, zaostrenie objektívu nie je možné ovládať z jednotky. Pozrite si časť „Pre
objektív s prepínačom režimu transfokácie“ v časti „Kontrola prepínačov objektívu“.

1

Automatické zaostrenie zapnete posunutím prepínača [Auto Focus] do polohy vpravo na ovládacom paneli
kamery.

Je aktivovaný režim automatického zaostrenia.

 (AF)

2
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Automatické nastavenie pomocou dodávaného infračerveného diaľkového ovládača

Zaostrenie môžete upraviť automaticky pomocou dodávaného infračerveného diaľkového ovládača.

Poznámka

Automatické zaostrenie môžete použiť aj vtedy, keď je hlavným spôsobom činnosti manuálne nastavenie. Podrobnosti nájdete v
časti „Manuálne zaostrenie počas automatického zaostrenia pomocou dodávaného infračerveného diaľkového ovládača“.

Súvisiaca téma
Manuálne zaostrenie počas automatického zaostrenia pomocou dodávaného infračerveného diaľkového ovládača
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Stlačte tlačidlo AF na infračervenom diaľkovom ovládači.

Zaostrenie na objekt sa upraví automaticky.

1
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Nastavenie oblasti/polohy automatického zaostrenia (Focus Area)

Cieľovú oblasť môžete nastaviť pre automatické zaostrenie a upraviť zaostrenie pre túto oblasť.

Stlačením tlačidla [Menu] ovládacieho panela GUI otvoríte ponuku kamery.1

Nastavte cieľovú oblasť pre automatické zaostrenie pomocou [Shooting] > [Focus] > [Focus Area] v ponuke
kamery.

[Wide]:
Pri zaostrovaní vyhľadá objekt v širokom uhle záberu. Rámček sa nezobrazí.

[Zone]:
Automaticky vyhľadá polohu zaostrenia v rámci zadanej zóny.
Po výbere zadajte polohu pomocou tlačidiel so šípkami na ovládacom paneli GUI.

Stlačením a podržaním tlačidla [Set] sa môžete vrátiť do strednej polohy.
[Flexible Spot]:
Zaostruje na zadanú pozíciu v obraze.

2
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Poznámka

Pri použití tlačidla [Display] na obrazovom paneli kamery nie je rámček oblasti zaostrenia skrytý.

Počas Clear Image Zoom je oblasť zaostrenia nastavená na [Wide] (napevno).

Rada

Rámček oblasti zaostrenia môžete zobraziť/skryť pomocou [Monitoring] > [Display On/Off] > [Focus Area Indicator] v ponuke
kamery.

5-041-959-13(1) Copyright 2022 Sony Corporation

Po výbere zadajte polohu pomocou tlačidiel so šípkami na ovládacom paneli GUI.

Stlačením a podržaním tlačidla [Set] sa môžete vrátiť do strednej polohy.

179



Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Rýchla zmena oblasti zaostrenia (Focus Setting)

Polohu a veľkosť oblasti automatického zaostrenia môžete počas snímania rýchlo zmeniť tak, že priradíte [Focus Setting]
priraditeľnému tlačidlu.

Podrobnosti o priraditeľných tlačidlách nájdete v časti „Priraditeľné tlačidlá“.

Operácia sa líši v závislosti od nastavenia oblasti zaostrenia.

Ak je [Shooting] > [Focus] > [Focus Area] nastavené na [Flexible Spot] alebo [Zone] v ponuke
kamery

Polohu oblasti zaostrenia môžete zmeniť stlačením priraditeľného tlačidla priradeného k [Focus Setting] a úpravou
pomocou tlačidiel so šípkami na ovládacom paneli GUI. Stlačením tlačidla [Set] môžete vrátiť polohu oblasti zostrenia
do stredu a zároveň ju upraviť.
Veľkosť oblasti zaostrenia môžete zmeniť stlačením a podržaním priraditeľného tlačidla priradeného k [Focus
Setting]. Po zmene veľkosti môžete zmeniť polohu oblasti zaostrenia stlačením tlačidla [Set]. Po dokončení sa vráťte
na pôvodnú obrazovku stlačením priraditeľného tlačidla priradeného k [Focus Setting].

Ak je [Shooting] > [Focus] > [Focus Area] nastavené na [Wide] v ponuke kamery

Veľkosť oblasti zaostrenia môžete zmeniť iba stlačením a podržaním priraditeľného tlačidla priradeného k [Focus
Setting]. Polohu je možné zmeniť aj najprv zmenou typu na [Flexible Spot] alebo [Zone].

Rada

Ak sú obe [Shooting] > [Focus] > [Push AF Mode] nastavené na [Single-shot AF(AF-S)] v ponuke kamery a prepínač [Auto Focus]
je nastavený do polohy vypnuté (režim manuálneho zaostrenia), môžete zmeniť polohu oblasti zaostrenia [Focus Area (AF-S)].

Ak je možné zmeniť polohu oblasti zaostrenia, rámček oblasti zaostrenia sa zobrazí oranžovo.

Súvisiaca téma
Priraditeľné tlačidlá

5-041-959-13(1) Copyright 2022 Sony Corporation
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Posunutie rámčeka oblasti zaostrenia pomocou dotykového ovládania (Touch Focus
Area)

Polohu oblasti zaostrenia môžete zmeniť klepnutím na priraditeľné tlačidlo priradené k [Focus Setting], čím zmeníte
zobrazenie oblasti zaostrenia na oranžovú, a potom posuňte rámček oblasti zaostrenia pomocou dotykového ovládania
na obrazovom paneli kamery.
Klepnutím na obrazovku posuňte oblasť zaostrenia tak, aby bola sústredená na klepnutú pozíciu. Ťahaním po obrazovke
presuniete oblasť zaostrenia do polohy označenej prstom.

Rada

Dotykovú oblasť zaostrenia na obrazovke snímania môžete povoliť/zakázať pomocou priraditeľného tlačidla priradeného k [Focus
Setting].

Klepnite na ľubovoľnú polohu.

Ťuknutá poloha sa stane stredom oblasti zaostrenia.

1

Ťahaním posúvajte oblasť zaostrenia, ktorá sledujte polohu prsta.2
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Poznámka

Ak klepnete na pozíciu alebo presuniete oblasť zaostrenia na pozíciu, ktorá presahuje rozsah nastavenia, oblasť zaostrenia sa
nastaví na horný/dolný/ľavý/pravý okraj rozsahu nastavenia.

Táto funkcia nie je k dispozícii za nasledujúcich okolností.

Keď je prepínač [Touch Focus] vypnutý na ovládacom paneli kamery
Keď je rámček oblasti zaostrenia zobrazený sivou farbou alebo sa nezobrazuje vôbec

5-041-959-13(1) Copyright 2022 Sony Corporation
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Úprava činnosti automatického zaostrenia (rýchlosť prechodu AF, citlivosť na
prepínanie medzi objektmi AF)

Funkciu automatického zaostrenia môžete upraviť zmenou rýchlosti prechodu a citlivosti posunu objektu.

Nastavenie rýchlosti prechodu AF

Rýchlosť zaostrenia pri zmene objektu môžete nastaviť pomocou tlačidla [AF Transition Speed] na ovládacom paneli
kamery.

Vyberte rýchlosť z rozsahu od [Speed 1] (pomalá) do [Speed 7] (rýchla) v krokoch po 1. Stlačte tlačidlo < na zníženie
hodnoty (pomalšie) alebo tlačidlo > na zvýšenie hodnoty (rýchlejšie).
Keď je nastavená nízka rýchlosť, zaostrenie sa pri zmene zaostrovaného objektu pohybuje pomaly, čo umožňuje
snímanie s pôsobivým výrazom obrazu.
Pri nastavení na vysokú rýchlosť sa zaostrenie rýchlo prepína medzi objektmi. V nižšie uvedenom príklade sa zaostrenie
rýchlo zmení z budovy na pozadí na osobu kráčajúcu v popredí. Objekt, ktorý vstúpi do rámčeka, je okamžite zaostrený,
čo je ideálne nastavenie pre dokumentárne snímanie, ktoré vyžaduje rýchle zaostrenie.

Citlivosť na prepínanie medzi objektmi AF

Citlivosť na zmenu medzi objektmi môžete nastaviť pomocou tlačidla [AF Subj. Shift Sens.] na ovládacom paneli kamery.
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Vyberte citlivosť z rozsahu od [Sens 1] (zablokovaná) do [Sens 5] (citlivá) v krokoch po 1. Stlačte tlačidlo < na zníženie
hodnoty (zmeniť pomaly) alebo tlačidlo > na zvýšenie hodnoty (zmeniť rýchlo).
Ak je nastavená nízka citlivosť, zaostrenie sa ľahko nepresunie, aj keď sa pred zaostreným objektom pohne iný objekt.

Ak je nastavená vysoká citlivosť, zaostrenie sa posunie tak, aby sa uprednostnil objekt, ktorý sa pohybuje vpredu.

Rada

Ak [AF Speed/Sens.] je priradené na priraditeľné tlačidlo, stĺpcový graf pre úpravu hodnôt sa pri každom stlačení tlačidla zobrazí
na obrazovom paneli kamery v nasledujúcom poradí, čo vám umožní zmeniť nastavenia AF transition speed a AF subject shift
sensitivity.
Rýchlosť prechodu AF → Citlivosť na prepínanie medzi objektmi AF → Žiadne zobrazenie …

5-041-959-13(1) Copyright 2022 Sony Corporation
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Manuálne nastavenie automatického zaostrenia (AF Assist) pomocou webovej
aplikácie

Po manuálnom posunutí a úprave zaostrenia môžete posunúť ovládanie zaostrenia na automatické zaostrenie na jemné
nastavenie zaostrenia.

Poznámka

V stave AF assist je posun zaostrenia obtiažny, bez ohľadu na nastavenie [Shooting] > [Focus] > [AF Subj. Shift Sens.] v ponuke
kamery.

Stav AF assist sa zruší nasledujúcim spôsobom.

Keď objekt zaostrený pomocou posuvníka [Focus] už nie je viditeľný
Pri prepnutí na manuálne zaostrovanie
Keď sa spustí AF so sledovaním v reálnom čase

Rada

Stav AF assist je možné rýchlo zrušiť pomocou priraditeľného tlačidla nastaveného na [Push AF/MF].

Nastavte [Shooting] > [Focus] > [AF Assist] na [On] v ponuke kamery.1

Nastavte [Shooting] > [Focus] > [AF Assist Control] na [On] vo webovej ponuke.2

Automatické zaostrenie zapnete posunutím prepínača [Auto Focus] do polohy vpravo na ovládacom paneli
kamery.

Je aktivovaný režim automatického zaostrenia.

3

Nastavte cieľové zaostrenie pomocou posuvníka [Focus] na ovládacom paneli kamery.

[Near]: Zaostriť na blízky objekt.
[Far]: Zaostriť na vzdialený objekt.

V stave AF assist sa objekt vo vzdialenosti nastavenej pomocou posuvníka [Focus] automaticky zaostrí.

4

185



AF so sledovaním v reálnom čase sa zastaví pri použití posuvníka [Focus].

V režime Face/Eye Only AF sa automatické zaostrenie zameriava na tvár najbližšie k polohe zaostrenia posuvníka [Focus].

5-041-959-13(1) Copyright 2022 Sony Corporation
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Manuálne zaostrenie počas automatického zaostrenia pomocou dodávaného
infračerveného diaľkového ovládača

Ak je [Shooting] > [Focus] > [AF Assist] nastavené na [On] v ponuke kamery, môžete použiť tlačidlo F (Ďaleko) a N
(Blízko) na dodanom infračervenom diaľkovom ovládači aj počas automatického zaostrenia na úpravu zaostrenia na
objekt.

5-041-959-13(1) Copyright 2022 Sony Corporation
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Dočasné použitie manuálneho zaostrenia počas automatického zaostrenia (Push
Manual Focus)

Stlačením tlačidla [Push AF/MF] v režime automatického zaostrenia zaostrujete manuálne, kým je tlačidlo stlačené. Po
uvoľnení tlačidla sa zaostrenie vráti na automatické zaostrenie.
Takto môžete dočasne zastaviť automatické zaostrovanie a zaostriť manuálne, keď sa pred objekt dostane niečo, čo nie
je predmetom snímania.

Rada

Rovnaká operácia je vykonateľná pomocou priraditeľného tlačidla priradeného na [Push AF/MF].

5-041-959-13(1) Copyright 2022 Sony Corporation
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Sledovanie pomocou detekcie tváre a očí (Face/Eye Detection AF)

Jednotka dokáže detegovať tváre a oči ľudí ako sledovaný cieľ a potom upraviť zaostrenie na tváre a oči v oblasti
zaostrenia.
Pri rozpoznaní tvárí sa zobrazia sivé rámčeky na detekciu tváre/očí. Ak je možné automatické zaostrenie, rámčeky sa
zmenia na biele a spustí sa sledovanie. Keď sú rozpoznané oči a zaostrenie je upravené, na očiach sa zobrazí rámček
detekcie tváre/očí. Keď sa zistí viac osôb, automaticky sa určí hlavný subjekt.
Táto funkcia je k dispozícii, iba ak je režim zaostrenia AF alebo počas vynúteného automatického zaostrovania.

Rada

Keď je oblasť zaostrenia nastavená na [Zone] alebo [Flexible Spot] a tváre alebo oči sa prekrývajú v rámci určenej oblasti
zaostrenia, rámčeky detekcie tváre/očí sa zmenia na biele a jednotka zaostrí na tieto tváre/oči.

Ak sa použije vynútené automatické zaostrovanie (AF-S), rámčeky detekcie tváre/očí pre zaostrené tváre/oči sa zmenia na
zelené.

Nastavenie pomocou tlačidla [Face/Eye Detection AF] na ovládacom paneli kamery

Stlačte tlačidlo [Face/Eye Detection AF] a nastavte funkciu AF s detekciou tváre/očí.

[Face/Eye Only AF]: Kamera deteguje tváre/oči subjektov (osôb), zameriava sa a sleduje iba ich tváre/oči. Pokiaľ tvár
alebo oko nie sú rozpoznané, AF sa dočasne zastaví a zobrazí sa ikona  (Face/Eye Only AF režim automatického
zaostrenia pozastavený). Tento režim je účinný, ak chcete automaticky zaostrovať a sledovať iba tvár/oči.
[Face/Eye Priority AF]: Kamera rozpoznáva tváre oči subjektov (osôb) a uprednostňuje zaostrenie/sledovanie tvárí/očí.
Ak tvár alebo oko nie sú rozpoznané, zaostrenie je v režime AF (predvolené nastavenie).
[AF]: Funkcia AF detekcie tváre/očí je deaktivovaná.

Poznámka

Počas vynúteného automatického zaostrenia sa aktivuje [Face/Eye Priority AF] aj keď je momentálne vybraté [Face/Eye Only
AF].

Keď je prepínač [Auto Focus] nastavený na vypnutú polohu, je detekcia tváre/očí AF deaktivovaná (s výnimkou režimu
vynúteného automatického zaostrenia).

Ak kamkordér vypnete, keď je vybraté [Face/Eye Only AF], pri nasledujúcom zapnutí kamkordéra sa režim automaticky prepne na
[Face/Eye Priority AF].
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Rada

Automatického zaostrovanie s detekciou tváre/očí môžete nastaviť pomocou [Shooting] > [Focus] > [Face/Eye Detection AF]
v ponuke kamery.

Skrytie rámčekov detekcie tváre/očí
Rámčeky detekcie tváre/očí môžete zobraziť/skryť pomocou [Monitoring] > [Display On/Off] > [Face/Eye Detection
Frame] v ponuke kamery.

Poznámka

Zelené rámčeky detekcie tváre/očí sa zobrazia pre tváre a oči, ktoré sú zaostrené pomocou vynúteného automatického
zaostrenia (AF-S), a nie sú skryté tlačidlom [Display] alebo keď je [Face/Eye Detection Frame] nastavené na [Off].

Prepínanie činnosti automatického zaostrenia s detekciou tváre/očí pomocou priraditeľného tlačidla
Priraďte [Face/Eye Detection AF] na priraditeľné tlačidlo. Potom môžete prepínať činnosť automatického zaostrenia
s detekciou tváre/očí v poradí [Face/Eye Priority AF], [Face/Eye Only AF] a [AF] pri každom stlačení tlačidla.

Nastavenie pomocou priamej ponuky

Pomocou priamej ponuky môžete tiež nastaviť činnosť automatického zaostrenia s detekciou tváre/očí.

Podrobnosti o priamej ponuke nájdete v časti „Funkcie priamej ponuky“.

Súvisiaca téma
Funkcie priamej ponuky

5-041-959-13(1) Copyright 2022 Sony Corporation
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Sledovanie konkrétneho subjektu (Realtime Tracking AF)

Môžete zachovať zaostrenie na objekt špecifikovaním objektu dotykovým ovládaním alebo výberom rámčeka detekcie
tváre na ovládacom paneli kamery.
Po výbere subjektu sa zobrazí biely rámik sledovania a spustí sa sledovanie.

Rada

Sledovanie prebieha po celej ploche snímky bez ohľadu na nastavenie oblasti zaostrenia.

Keď je [Shooting] > [Focus] > [Touch Function in MF] nastavené na [Tracking AF] vo webovej ponuke alebo ponuke kamery, je
podporované automatické zaostrenie AF so sledovaním v reálnom čase, aj keď je režim zaostrenia nastavený na režim MF.

Nasledujúce akcie sa vykonajú pre sledovaný cieľ v závislosti od nastavenia prevádzkového režimu automatického
zaostrenia s detekciou tváre/oka.

[Face/Eye Only AF] alebo [Face/Eye Priority AF]: Zaostrenie a sledovanie určeného subjektu.
Ak je cieľom sledovania osoba a rozpozná sa tvár/oko, fotoaparát zaostrí na túto tvár/oko.
Keď sa zistí sledovaná cieľová tvár/oko, sledovaná cieľová tvár sa uloží. Po uložení sa zobrazí  (ikona uloženej
sledovanej tváre) .

Poznámka

Ak sa sledovanie AF spustí počas manuálneho zaostrovania, cieľová sledovaná tvár sa neuloží.

[AF]: Používa sa na zaostrovanie a sledovanie určeného objektu. Detekcia tváre/očí sa neaktivuje, aj keď sledovaným
cieľom je osoba.

Poznámka

Funkcia AF so sledovaním v reálnom čase nefunguje, ak je objektív nastavený na manuálne zaostrenie.

Spustenie sledovania AF v reálnom čase

Keď je konkrétny subjekt určený ako cieľ sledovania, spustí sa sledovanie tohto cieľa.

Určenie dotykovým ovládaním
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Posuňte prepínač [Touch Focus] na karte  (Focus) na ovládacom paneli kamery do pravej polohy, aby ste funkciu
zapli, potom klepnite na cieľový objekt, ktorý chcete sledovať, v niektorom z nasledujúcich stavov.

Počas manuálneho zaostrovania alebo pri stlačení manuálneho zaostrovania a keď je [Shooting] > [Focus] > [Touch
Function in MF] nastavené na [Tracking AF] vo webovej ponuke alebo ponuke kamery
Počas automatického zaostrovania alebo počas vynúteného automatického zaostrovania (AF)

Určenie výberom rámčeka detekcie tváre
Presuňte kurzor výberu tváre (oranžové podčiarknutie) na cieľový objekt, ktorý chcete sledovať, pomocou tlačidiel so
šípkami na ovládacom paneli GUI a stlačte tlačidlo [Set].

A: Rámčeky detekcie tváre (sivé)
B: Sledovací rámček
C: Kurzor na výber tváre (oranžový)

Poznámka

Počas manuálneho zaostrovania nemožno spustiť sledovanie výberom rámčeka detekcie tváre.

Rada

Môžete tiež zmeniť sledovaný cieľ počas sledovania AF v reálnom čase.

Zastavenie sledovania AF v reálnom čase

Stlačte tlačidlo  (zastavenie AF so sledovaním v reálnom čase).

Rada

Sledovanie AF v reálnom čase sa zastaví v nasledujúcich prípadoch:

Keď sa prepne prepínač [Auto Focus] alebo ovládač AUTO/MANUAL na objektíve
Keď sa zmení režim zaostrovania
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Keď sa aktivuje AF assist
Keď sa zmení nastavenie oblasti zaostrenia alebo činnosť automatického zaostrenia s detekciou tváre/očí
Keď sa stlačí priraditeľné tlačidlo priradené k [Push AF/MF]
Keď sa cieľ sledovania nenachádza na obrazovke snímania alebo keď je objekt na niekoľko sekúnd rozostrený

Keď je sledovaná tvár uložená (keď je zobrazená ikona  (ikona uloženej sledovanej tváre)), sledovanie AF v reálnom čase sa
obnoví, keď uložená sledovaná tvár vstúpi do snímanej oblasti. Ak chcete odstrániť sledovanú tvár, zastavte sledovanie AF
v reálnom čase, ako je popísané vyššie.

5-041-959-13(1) Copyright 2022 Sony Corporation
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Obrazovka nastavenia jasu

Jas môžete upraviť nastavením clony, zosilnenia, rýchlosti uzávierky a úpravou úrovne svetla pomocou ND filtrov
na nasledujúcich ovládacích paneloch živej prevádzkovej obrazovky webovej aplikácie. Jas môžete nastaviť aj
automaticky.

Poznámka

Zosilnenie sa nedá upraviť, keď je [Shooting Mode] nastavené na [Cine EI Quick] alebo [Cine EI]. Taktiež nie je možné
automaticky nastaviť jas pomocou rýchlosti uzávierky, keď je nastavená na [Cine EI Quick] alebo [Cine EI]. Je podporované
automatické nastavenie jasu pomocou clony a ND filtra.

Rada

Režim Cine EI je režim na snímanie so základnou citlivosťou bez použitia zosilnenia, aby sa maximalizoval výkon obrazového
snímača. Jas sa upravuje pomocou osvetlenia a ND filtra na úpravu množstva svetla, ktoré dopadá na obrazový snímač.

Ovládací panel kamery – karta  (Main)1.

Panel základnej konfigurácie kamery
Na tlačidlách zobrazuje stav nastavenia základných funkcií potrebných na snímanie. Stlačením tlačidla zobrazíte
príslušnú obrazovku nastavenia pre každú funkciu na paneli nastavenia základnej konfigurácie kamery nižšie.

2.

Panel nastavenia základnej konfigurácie kamery
Zobrazí panel nastavenia pre položku nastavenia vybratú na paneli základnej konfigurácie kamery.

3.
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Podrobnosti o Exposure Index (EI) nájdete v časti „Zmena rozloženia tmavých a svetlých oblastí v zaznamenanom videu“.

Súvisiaca téma
Zmena rozloženia tmavých a svetlých oblastí v zaznamenanom videu

5-041-959-13(1) Copyright 2022 Sony Corporation
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Nastavenie základnej citlivosti

Pred začatím úpravy jasu môžete nastaviť základnú citlivosť.

Ak je [Shooting Mode] nastavené na [Custom]

Stlačte tlačidlo [ISO/Gain] na paneli základnej konfigurácie kamery a nastavte [Base Sensitivity] na paneli nastavenia
ISO/Gain na [High] alebo [Low].
Vyberte [Low] za normálnych svetelných podmienok a vyberte [High] pri znížených svetelných podmienkach.
Obrazovka, ak je [AGC] vypnuté

Obrazovka, ak je [AGC] zapnuté

Ak je [Shooting Mode] nastavené na [Flexible ISO] alebo [Cine EI]

Stlačte tlačidlo [Base ISO/Exposure Index] na paneli základnej konfigurácie kamery a nastavte [Base ISO] na paneli
nastavenia Base ISO/Exposure Index na [ISO 12800] alebo [ISO 800].
Vyberte [ISO 800] za normálnych svetelných podmienok a vyberte [ISO 12800] pri znížených svetelných podmienkach.

Rada

196



Môžete to nastaviť aj na karte  (Main) na ovládacom paneli kamery.

Dá sa nastaviť aj pomocou [Shooting] > [ISO/Gain/EI] > [Base Sensitivity] alebo [Base ISO] v ponuke kamery.

[Base ISO/Sensitivity] môžete tiež priradiť priraditeľnému tlačidlu.

V režime snímania [Cine EI Quick] sa základná citlivosť automaticky nastaví podľa nastavenia indexu expozície.

5-041-959-13(1) Copyright 2022 Sony Corporation
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Nastavenie cieľovej úrovne pre automatické nastavenie jasu

Cieľová úroveň pre automatické nastavenie jasu sa nastavuje pomocou posuvníka [AE Level] na ovládacom paneli
kamery.

5-041-959-13(1) Copyright 2022 Sony Corporation

Stlačte kartu  (Main) na ovládacom paneli kamery.

Ak sa posuvník [AE Level] nezobrazuje, zobrazte ho výberom jedného z dvoch tlačidiel na výber funkcie posuvníka
a zo zoznamu vyberte posuvník [AE Level].

Zobrazí sa posuvník [AE Level].

1

Pomocou posuvníka nastavte cieľovú úroveň.

Nastavte gombík posuvníka doľava, aby bol obraz tmavší. Nastavte gombík posuvníka doprava, aby bol obraz
svetlejší.

Rada

Dá sa nastaviť aj pomocou [Shooting] > [Auto Exposure] > [Level] v ponuke kamery.

2
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Automatická úprava clony

Jas môžete nastaviť automaticky podľa objektu. Vyžaduje sa kompatibilný objektív.

Poznámka

Na objektíve s bajonetom A nie je možné clonu nastaviť automaticky.

Rada

[Auto Iris] môžete tiež priradiť priraditeľnému tlačidlu.

5-041-959-13(1) Copyright 2022 Sony Corporation

Ak je nasadený objektív s prepínačom Auto Iris, prepnite prepínač do polohy AUTO.1

Stlačte tlačidlo [Iris] na paneli základnej konfigurácie kamery.

Rámček tlačidla [Iris] sa zmení na oranžový.

Zobrazí sa panel nastavenia Iris.

2

Posuňte prepínač [Auto] do polohy vpravo, aby ste ho zapli.

Clona sa prepne do režimu automatického nastavenia. Automaticky upravená hodnota clony sa zobrazuje na pravej
strane prepínača.

3
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Manuálna úprava clony

Jas môžete nastaviť manuálne.

Dočasné automatické nastavenie clony
Môžete tiež stlačiť tlačidlo [Push Auto] na paneli nastavenia Iris a nastaviť clonu automaticky, keď je tlačidlo stlačené.

Ak je nasadený objektív s prepínačom Auto Iris, prepnite prepínač do polohy AUTO.

Poznámka

Keď je prepínač Auto Iris na objektíve nastavený do polohy MANUAL, funkcie [Auto Iris] a [Push Auto Iris] na jednotke
nebudú mať žiadny účinok. Ručné nastavenie clony na jednotke tiež nemá žiadny účinok.

1

Stlačte tlačidlo [Iris] na paneli základnej konfigurácie kamery.

Rámček tlačidla [Iris] sa zmení na oranžový.

Zobrazí sa panel nastavenia Iris.

2

Posuňte prepínač [Auto] do polohy vľavo, aby ste ho vypli.

Clona sa prepne do režimu manuálneho nastavenia.

3

Upravte clonu pomocou posuvníka [Iris] alebo nastavovacích tlačidiel [Iris].

Rada

Nastavenia posuvníka a nastavovacích tlačidiel sú prepojené.

Clonu môžete tiež priradiť na posuvník na karte  (Main) na ovládacom paneli kamery.

4
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Rada

Stlačením priraditeľného tlačidla priradeného k funkcii [Push Auto Iris] automaticky upravíte clonu pri stlačení tlačidla.
Po uvoľnení tlačidla sa clona vráti do manuálneho režimu.

5-041-959-13(1) Copyright 2022 Sony Corporation
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Automatická úprava zosilnenia

Jas môžete upraviť automaticky pomocou nastavenia zosilnenia, keď je [Shooting Mode] nastavené na [Custom] alebo
[Flexible ISO].

5-041-959-13(1) Copyright 2022 Sony Corporation

Nastavte [Project] > [Shooting Mode] na [Custom] vo webovej ponuke alebo v ponuke kamery.1

Stlačte tlačidlo [ISO/Gain] na paneli základnej konfigurácie kamery.

Rámček tlačidla [ISO/Gain] sa zmení na oranžový.

Zobrazí sa panel nastavenia ISO/Gain.

2

Posuňte prepínač [AGC] do polohy vpravo, aby ste ho zapli.

Zosilnenie sa prepne do režimu automatického nastavenia. Automaticky upravená hodnota zosilnenia sa zobrazuje
na pravej strane prepínača.

Rada

Rovnakú akciu môžete vykonať aj nastavením [Shooting] > [Auto Exposure] > [AGC] na [On] v ponuke kamery.

[AGC] môžete tiež priradiť priraditeľnému tlačidlu.

3
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Manuálna úprava zosilnenia

Jas môžete upraviť manuálne. pomocou nastavenia zosilnenia, keď je [Shooting Mode] nastavené na [Custom] alebo
[Flexible ISO].
Zosilnenie môžete ovládať, keď chcete upraviť expozíciu pomocou nastavenia pevnej clony alebo ak chcete zabrániť
zvýšeniu zosilnenia v dôsledku AGC.

Dočasné manuálne nastavenie zosilnenia
Zosilnenie môžete tiež dočasne upraviť priradením [ISO/Gain] tlačidlu na výber funkcie posuvníka na karte  (Main) na
ovládacom paneli kamery a pomocou posuvníka.
To je užitočné, ak chcete upraviť expozíciu o jeden krok bez zmeny hĺbky ostrosti.
Výsledok úpravy sa vráti na prednastavenú hodnotu nakonfigurovanú pomocou [ISO/Gain<L>] po vykonaní ktorejkoľvek
z nasledujúcich činností.

Nastavte [Project] > [Shooting Mode] na [Custom] vo webovej ponuke alebo v ponuke kamery.1

Stlačte tlačidlo [ISO/Gain] na paneli základnej konfigurácie kamery.

Rámček tlačidla [ISO/Gain] sa zmení na oranžový.

Zobrazí sa panel nastavenia ISO/Gain.

2

Posuňte prepínač [AGC] do polohy vľavo, aby ste ho vypli.

Zosilnenie sa prepne do režimu manuálneho nastavenia.

3

Upravte zosilnenie pomocou posuvníka [ISO/Gain] alebo nastavovacích tlačidiel [ISO/Gain].

Rada

Nastavenia posuvníka a nastavovacích tlačidiel sú prepojené.

4
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Zmena položiek nastavenia ISO/Gain
Prepínanie základnej citlivosti
Nastavenie prepínača AGC do polohy zapnuté
Prepnutie napájania jednotky do pohotovostného režimu

Dočasné automatické nastavenie zosilnenia pomocou priraditeľného tlačidla
Stlačením priraditeľného tlačidla priradeného k funkcii [Push AGC] automaticky upravíte zosilnenie pri stlačení tlačidla.
Po uvoľnení tlačidla sa zosilnenie vráti do manuálneho režimu.
Výsledok úpravy sa vráti na prednastavenú hodnotu nakonfigurovanú pomocou [ISO/Gain<L>] po vykonaní ktorejkoľvek
z nasledujúcich činností.

Zmena položiek nastavenia ISO/Gain
Prepínanie základnej citlivosti
Nastavenie prepínača AGC do polohy zapnuté
Prepnutie napájania jednotky do pohotovostného režimu

Poznámka

Túto funkciu nemožno vykonať, keď je [Shooting] > [Iris] > [Bokeh Control] nastavené na [On] v ponuke kamery.

5-041-959-13(1) Copyright 2022 Sony Corporation
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Automatická úprava uzávierky

Uzávierku môžete nastaviť automaticky podľa jasu obrazu.
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Stlačte tlačidlo [Shutter] na paneli základnej konfigurácie kamery.

Rámček tlačidla [Shutter] sa zmení na oranžový.

Zobrazí sa panel nastavenia Shutter.

1

Stlačte tlačidlo [Shutter Type] a vyberte [Auto] zo zoznamu.

Rada

Rovnakú akciu môžete vykonať aj nastavením [Shooting] > [Auto Exposure] > [Auto Shutter] na [On] v ponuke kamery.

[Auto Shutter] môžete tiež priradiť priraditeľnému tlačidlu.

2
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Manuálna úprava uzávierky

Uzávierku môžete nastaviť manuálne.

Stlačte tlačidlo [Shutter] na paneli základnej konfigurácie kamery.

Rámček tlačidla [Shutter] sa zmení na oranžový.

Zobrazí sa panel nastavenia Shutter.

1

Stlačte tlačidlo [Shutter Type] a vyberte [Speed] zo zoznamu.2

Upravte uzávierku pomocou posuvníka [Speed] alebo nastavovacích tlačidiel [Speed].

Ak chcete upraviť čas expozície tak, aby zodpovedal intervalu snímok, vyberte [Off] v kroku 2. Môžete tiež nastaviť
pevnú hodnotu pomocou [ECS] (frekvencia) alebo ju automaticky upraviť pomocou [Auto].
Príklad: Nastavenie pomocou [ECS] (frekvencia)

Rada

Nastavenia posuvníka a nastavovacích tlačidiel sú prepojené.

Ak chcete použiť [Angle] namiesto [Speed] alebo [Off], nastavte [Shooting] > [Shutter] > [Mode] na [Angle] v ponuke
kamery.

3
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O ND filtri

V podmienkach, kde je osvetlenie príliš jasné, môžete nastaviť vhodný jas zmenou ND filtra.
Pri snímaní jasne osvetleného objektu môže prílišné zatvorenie clony spôsobiť difrakčnú neostrosť a obraz sa začne
rozostrovať (typický jav pre kamery). Tento efekt môžete potlačiť, aby ste dosiahli lepšie výsledky snímania pomocou
filtra ND.
Jednotka obsahuje nasledujúce režimy ND filtra.
Prednastavený režim

Pozrite si časť „Úprava v prednastavenom režime“.

Variabilný režim (automatické nastavenie)

Pozrite si časť „Automatická úprava vo variabilnom režime“.

Variabilný režim (manuálne nastavenie)

Pozrite si časť „Manuálna úprava vo variabilnom režime“.

Súvisiaca téma

Úprava v prednastavenom režime

Automatická úprava vo variabilnom režime

Manuálna úprava vo variabilnom režime

5-041-959-13(1) Copyright 2022 Sony Corporation
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Úprava v prednastavenom režime

Vopred si môžete vybrať tri hodnoty priepustnosti ND filtra a pri snímaní medzi nimi rýchlo prepínať.

Rada

Keď stlačíte priraditeľné tlačidlo priradené k [ND Filter Position], ND filter sa zmení v poradí [Clear] → [Preset1] → [Preset2] →
[Preset3] → [Clear].
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Nastavte [Shooting] > [ND Filter] > [Mode] na [Preset] v ponuke kamery.1

Stlačte tlačidlo [ND Filter] na paneli základnej konfigurácie kamery.

Rámček tlačidla [ND Filter] sa zmení na oranžový.

Zobrazí sa panel nastavenia ND Filter.

2

Stlačte tlačidlo [ND Filter] a vyberte jednu z nasledujúcich možností zo zoznamu.

[Clear]: Žiadny ND filter.
[Preset1]: Priepustnosť nastavená v [Shooting] > [ND Filter] > [Preset1] v ponuke kamery.
[Preset2]: Priepustnosť nastavená v [Shooting] > [ND Filter] > [Preset2] v ponuke kamery.
[Preset3]: Priepustnosť nastavená v [Shooting] > [ND Filter] > [Preset3] v ponuke kamery.

Keď je pre filter ND vybratá jedna z možností [Preset1] až [Preset3], hodnota priepustnosti sa zobrazí vedľa názvu
filtra ND.

3
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Interchangeable Lens Digital Camera
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Automatická úprava vo variabilnom režime

Pomocou filtra ND môžete povoliť automatické nastavenie expozície.

Poznámka

Keď počas snímania prepnete ND filter na alebo z [Clear], na obraze sa zobrazí rámček ND filtra a zaznie prevádzkový zvuk.

Rada

Môžete tiež priradiť [Auto ND Filter] priraditeľnému tlačidlu a stlačením tlačidla prepínať medzi [Auto] a [Manual].
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Nastavte [Shooting] > [ND Filter] > [Mode] na [Variable] v ponuke kamery.1

Stlačte tlačidlo [ND Filter] na paneli základnej konfigurácie kamery.

Rámček tlačidla [ND Filter] sa zmení na oranžový.

Zobrazí sa panel nastavenia ND Filter.

2

Stlačte tlačidlo [ND Filter] a vyberte [Auto] zo zoznamu.

Automaticky upravená hodnota priepustnosti ND filtra sa zobrazí vedľa tlačidla [ND Filter].

3
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
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Manuálna úprava vo variabilnom režime

Pomocou ND filtra môžete vykonať manuálne nastavenie expozície.

Automatické dočasné nastavenie
Môžete priradiť [Push Auto ND] priraditeľnému tlačidlu a dočasne zapnúť automatický ND filter, kým je tlačidlo stlačené.
Uvoľnením tlačidla sa funkcia automatického ND filtra vráti späť na hodnotu vypnuté.
Nastavte ND filter na [Manual].

Poznámka

Keď počas snímania prepnete ND filter na alebo z [Clear], na obraze sa zobrazí rámček ND filtra a zaznie prevádzkový zvuk.

Rada

Nastavte [Shooting] > [ND Filter] > [Mode] na [Variable] v ponuke kamery.1

Stlačte tlačidlo [ND Filter] na paneli základnej konfigurácie kamery.

Rámček tlačidla [ND Filter] sa zmení na oranžový.

Zobrazí sa panel nastavenia ND Filter.

2

Stlačte tlačidlo [ND Filter] a vyberte [Manual] zo zoznamu.3

Nastavte priepustnosť ND filtra pomocou posuvníka [ND Filter] alebo nastavovacích tlačidiel [ND Filter].

Rada

Nastavenia posuvníka a nastavovacích tlačidiel sú prepojené.

Filter ND môžete upraviť aj na karte  (Main) v ovládacom paneli kamery.

4
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Môžete tiež priradiť [ND Filter Position] priraditeľnému tlačidlu a stlačením tlačidla prepínať medzi [Manual] a [Clear].

Môžete tiež stlačiť tlačidlo [Push Auto] na paneli nastavenia ND Filter a zapnúť automatický ND Filter, keď je tlačidlo stlačené.

5-041-959-13(1) Copyright 2022 Sony Corporation
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Obrazovka nastavenia vyváženia bielej

Vyváženie bielej môžete upraviť pomocou živej prevádzkovej obrazovky webovej aplikácie, aby ste dosiahli vyváženie
bielej, vďaka ktorému bude obraz vyzerať prirodzenejšie.

5-041-959-13(1) Copyright 2022 Sony Corporation

Panel základnej konfigurácie kamery1.

Panel nastavenia základnej konfigurácie kamery
Zobrazí panel nastavenia pre položku nastavenia vybratú na paneli základnej konfigurácie kamery.

2.
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Interchangeable Lens Digital Camera
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Automatické nastavenie vyváženia bielej

Vždy môžete dosiahnuť správne nastavené vyváženie bielej pomocou ATW (automatické sledovanie vyváženia bielej).
Keď je zapnuté ATW, vyváženie bielej sa automaticky nastaví podľa zmeny teploty farby svetelného zdroja.

Poznámka

ATW sa nedá použiť, keď je [Shooting Mode] nastavené na [Cine EI] alebo [Cine EI Quick].

Nemusí byť vždy možné nastaviť vhodnú farbu pomocou ATW v závislosti od svetelných podmienok a podmienok objektu.
Príklady:

Keď objektu dominuje jedna farba, napríklad obloha, more, zem alebo kvety.
Keď je teplota farieb extrémne vysoká alebo extrémne nízka.

Ak je rýchlosť automatického sledovania ATW nízka alebo nie je možné dosiahnuť príslušný efekt, stlačením tlačidla [WB SET]
spustíte automatické vyváženie bielej.

Rada

Rýchlosť odozvy v režime ATW si môžete vybrať z piatich krokov (1, 2, 3, 4, 5) pomocou [Shooting] > [White Setting] > [ATW
Speed] v ponuke kamery. Čím nižšie číslo, tým vyššia je rýchlosť odozvy.

Aktuálne nastavenie vyváženia bielej môžete zmraziť tak, že priradíte funkciu [ATW Hold] priraditeľnému tlačidlu a stlačením
priraditeľného tlačidla dočasne pozastavíte režim ATW v priebehu režimu ATW.
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Stlačte tlačidlo [White Balance] na paneli základnej konfigurácie kamery.

Rámček tlačidla [White Balance] sa zmení na oranžový.

Zobrazí sa panel nastavenia White Balance.

1

Stlačte tlačidlo [White Mode] a vyberte [ATW] zo zoznamu.2
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Ručné nastavenie vyváženia bielej

Vyváženie bielej môžete nastaviť manuálne.

Stlačte tlačidlo [White Balance] na paneli základnej konfigurácie kamery.

Rámček tlačidla [White Balance] sa zmení na oranžový.

Zobrazí sa panel nastavenia White Balance.

1

Stlačte tlačidlo [White Mode] a vyberte jednu z nasledujúcich možností zo zoznamu.

[Memory A(T/T)]

[Memory A(R/B)]

[Preset]

2

Upravte vyváženie bielej pomocou posuvníkov alebo nastavovacích tlačidiel.

Rada

Nastavenia posuvníka a nastavovacích tlačidiel sú prepojené.

Rozdiel medzi [Memory A(T/T)] a [Memory A(R/B)] je, že os úpravy je iná, ale výsledky úpravy sú prepojené.

Pre [Memory A(T/T)]
Tento režim upravuje vyváženie bielej uložené v pamäti A úpravou teploty farby (Temp) a hodnoty Tint.
Teplotu farby môžete nastaviť v krokoch po 20 K v rozsahu 2000 K až 5600 K. Hodnoty nad 5600 K je možné
nastaviť v intervaloch, ktoré sa rovnajú množstvu zmeny farby (zmiešanej) od 5580 K do 5600 K.

3
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Stlačením tlačidla [Reset] na pravej strane [Temp] alebo [Tint] obnovíte príslušné nastavenie na predvolenú
hodnotu.
Pre [Memory A(R/B)]
Tento režim upravuje vyváženie bielej uložené v pamäti A úpravou R Gain a B Gain.
Stlačením tlačidla [Reset] obnovíte príslušné nastavenie zosilnenia na predvolenú hodnotu.
Pre [Preset]
Tento režim upravuje teplotu farieb na prednastavenú hodnotu.
Hodnotu môžete nastaviť v krokoch po 100 K.
V režime predvolieb môžete tiež priradiť [Preset White Select] priraditeľnému tlačidlu a stlačením tlačidla zmeniť na
vopred nakonfigurovanú prednastavenú hodnotu.
[Custom]: 3200 K → 4300 K → 5600 K → 6300 K → 3200 K…
[Flexible ISO], [Cine EI], [Cine EI Quick]: 3200 K → 4300 K → 5500 K → 3200 K…
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Spustenie automatického vyváženia bielej

V režime pamäte A sa vyváženie bielej, ktoré sa má uložiť, nastaví automaticky.

Stlačte tlačidlo [White Balance] na paneli základnej konfigurácie kamery.

Rámček tlačidla [White Balance] sa zmení na oranžový.

Zobrazí sa panel nastavenia White Balance.

1

Stlačte tlačidlo [White Mode] a vyberte [Memory A(T/T)] alebo [Memory A(R/B)] zo zoznamu.

[Memory A(T/T)]

[Memory A(R/B)]

2

Umiestnite biely papier (alebo iný objekt) na miesto s rovnakým zdrojom osvetlenia a s rovnakými
podmienkami ako objekt, potom ho priblížte, čím sa na obrazovke zobrazí biela farba.

3

Upravte jas.

Upravte clonu podľa postupu v časti „Manuálna úprava clony“.

4

Stlačte tlačidlo [WB SET] na paneli nastavenia vyváženia bielej.

[Memory A(T/T)]

[Memory A(R/B)]

5
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Poznámka

Ak nastavenie nie je úspešné, na obrazovke sa na asi tri sekundy zobrazí chybové hlásenie. Ak chybové hlásenie pretrváva aj po
opakovaných pokusoch o nastavenie vyváženia bielej, obráťte sa na servisného zástupcu spoločnosti Sony.

Rada

Môžete ho spustiť aj v režime ATW. Môžete to použiť, keď chcete rýchlo upraviť vyváženie bielej počas prevádzky ATW. Po
nastavení sa režim vráti do normálnej prevádzky ATW.

Súvisiaca téma

Manuálna úprava clony
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Ak je automatické vyváženie bielej spustené v režime pamäte, výsledok automatického nastavenia sa uloží do
pamäte A.
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Obrazovka konfigurácie zvuku

Hlasitosť zvuku, ktorú má jednotka zaznamenať, môžete upraviť na obrazovke živej prevádzky webovej aplikácie.
Nakonfigurujte prepínače na pripojovacom bloku jednotky a nakonfigurujte zvuk pomocou ponuky kamery alebo webovej
ponuky.
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Ovládací panel kamery – karta  (Audio)1.
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Výber zvukového vstupného zariadenia

Nastavte nasledujúce prepínače podľa zariadenia pripojeného ku konektoru AUDIO IN.

Poznámka

Zvuk sa nezaznamenáva v režime Interval Rec alebo Slow & Quick Motion.
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Keď je pripojený mikrofón, nastavte prepínač SETUP 2 na pripojovacom bloku na zadnej strane jednotky.

CH-1 a CH-2 majú spoločné nastavenia.

1

Nastavenie Popis

OFF
(predvolené)

Vyberte, ak používate dynamický mikrofón alebo mikrofón napájaný z batérie. Toto vypne
fantómové napájanie +48 V a nastaví vstup LINE alebo MIC ako zdroj zvuku CH-1 a CH-2.

ON
Vyberte, ak používate mikrofón kompatibilný s fantómovým napájaním +48V. Tým sa zapne
+48V fantómové napájanie a nastaví mikrofón kompatibilný s fantómovým napájaním ako zdroj
zvuku CH-1 a CH-2.

Nastavte typ pripojeného zariadenie pomocou [Audio] > [Audio Input] > [AUDIO IN Select] v ponuke kamery.2

Nastavte zvukový vstup pomocou [Audio] > [Audio Input] > [CH1 Input Select] na [CH4 Input Select] vo
webovej ponuke alebo ponuke kamery.

3
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Automatická úprava úrovne záznamu zvuku

Nastavte kanál, pre ktorý chcete automaticky nastaviť úroveň nahrávania zvuku [Auto] na stránke [Audio] webovej
ponuky alebo pomocou [Audio] > [Audio Input] > [CH1 Level Control] až [CH4 Level Control] v ponuke kamery.
Kanály určené pre automatické nastavenie sú označené ikonou  (Auto) vedľa príslušných kanálov na karte  (Audio)
na obrazovke živej prevádzky.

5-041-959-13(1) Copyright 2022 Sony Corporation
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Manuálna úprava úrovne záznamu zvuku

Úroveň nahrávania zvuku môžete upraviť manuálne.

5-041-959-13(1) Copyright 2022 Sony Corporation

Nastavte kanál, pre ktorý chcete manuálne nastaviť úroveň nahrávania zvuku [Manual] na stránke [Audio]
webovej ponuky alebo pomocou [Audio] > [Audio Input] > [CH1 Level Control] až [CH4 Level Control]
v ponuke kamery.

1

Stlačte kartu  (Audio) na ovládacom paneli kamery.2

Na obrazovke [Audio] v ovládacom paneli kamery nastavte úroveň nahrávania zvuku pomocou posuvníka
alebo nastavovacích tlačidiel pre kanál, ktorého úroveň nahrávania zvuku chcete nastaviť manuálne.

Poznámka

Kanály, pre ktoré je zobrazená ikona  (Auto), sa nastavia automaticky. Zmeny hodnôt pomocou posuvníka alebo tlačidiel
sa nepoužijú na zaznamenaný zvuk.

Rada

Nastavenia posuvníka a nastavovacieho tlačidla v každom riadku sú prepojené.

Vstupnú úroveň zvuku môžete skontrolovať v reálnom čase pomocou zobrazenia merača úrovne zvuku na obrazovke
snímania.

3
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Funkcie priamej ponuky

Môžete skontrolovať stav a nastavenia jednotky zobrazenej ponad obraz kamery a vybrať a zmeniť nastavenia pomocou
ovládacích tlačidiel GUI na infračervenom diaľkovom ovládači.
Je možné nakonfigurovať nasledujúce položky.
[Face/Eye Detection AF]
[SteadyShot]
[White Mode]
[Color Temp]
[Scene File]
[ND Filter Position]
[Auto ND Filter]
Hodnota [ND Filter]
[Auto Iris]
Hodnota [Iris]
[AGC]
Hodnota [Gain]
Hodnota [ISO]
[Exposure Index]
[Shutter Type]
[Auto Shutter]
Hodnota [Shutter]
[Auto Exposure Mode]
[Auto Exposure Level]
[S&Q Motion] a [Frame Rate]

Rada

Rovnakú funkciu môžete vykonať aj pomocou priraditeľného tlačidla a ovládacieho panelu GUI webovej aplikácie.

Stlačte priraditeľné tlačidlo priradené funkcii [Direct Menu] na infračervenom diaľkovom ovládači.

Tlačidlo [Direct Menu] je priradené priraditeľnému tlačidlu 1 predvolene z výroby.
Oranžovým kurzorom je možné zvoliť iba položky na obrazovke, ktoré je možné konfigurovať pomocou priamej
ponuky.

1

Presuňte kurzor na položku, ktorú chcete nastaviť, pomocou tlačidiel so šípkami na ovládacom paneli GUI
a stlačte tlačidlo [Set].

Zobrazí sa ponuka alebo položka na bielom pozadí.

2

Pomocou tlačidiel so šípkami vyberte nastavenie a stlačte tlačidlo [Set].

Ponuka alebo biele pozadie zmizne a zobrazí sa nové nastavenie s oranžovým kurzorom.
Znovu stlačte priraditeľné tlačidlo priradené k [Direct Menu] alebo počkajte 3 sekundy bez vykonania akejkoľvek
akcie, aby ste opustili priamu ponuku.

3
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Priraditeľné tlačidlá

Vo webovej aplikácii jednotky je desať priraditeľných tlačidiel, ktorým môžete priradiť funkcie.
Priraditeľné tlačidlá sa zobrazia na živej prevádzkovej obrazovke a na prevádzkovej obrazovke prehrávania.

Poznámka

Zoznam priraditeľných tlačidiel sa nezobrazuje pri konfigurácii nastavení na paneli základných operácií kamery na živej
prevádzkovej obrazovke. Ak chcete operáciu ukončiť, stlačte tlačidlo [X] v pravej hornej časti panela nastavení.

V predvolenom nastavení sú tlačidlám priradené nasledujúce funkcie.
Tlačidlo 1: [Direct Menu]
Tlačidlo 2: [Focus Setting]
Tlačidlo 3: [Rec Review]

Tlačidlá 1 až 3 sú ekvivalentom rovnakých číselných tlačidiel na dodávanom infračervenom diaľkovom ovládači.

Tlačidlo 4: [Push Auto ND]
Tlačidlo 5: [Crop Select]
Tlačidlo 6: [Marker]
Tlačidlo 7: [Video Signal Monitor]
Tlačidlo 8: [Clip Flag OK]
Tlačidlo 9: [Color Bars]
Tlačidlo Focus Hold: [Focus Hold]

Tlačidlo Focus Hold je ekvivalentné tlačidlu Focus Hold na objektíve s bajonetom E.

Zmena funkcie tlačidla
Použite [Project] > [Assignable Button] v ponuke kamery.
Keď zmeníte priradenie, zmení sa zobrazenie zoznamu priraditeľných tlačidiel.
Podrobnosti o priraditeľných funkciách nájdete v časti „Assignable Button“ v časti „Ponuka kamery a podrobné
nastavenia“.

Súvisiaca téma

Assignable Button

5-041-959-13(1) Copyright 2022 Sony Corporation
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Slow & Quick Motion

Keď je formát záznamu nastavený na nasledujúce hodnoty, môžete určiť rôzne hodnoty snímkovacej frekvencie
snímania a snímkovacej frekvencie prehrávania.
Nasledujúca tabuľka zobrazuje konfigurovateľné obnovovacie frekvencie.

Systémová frekvencia: 59.94/50/29.97/25/23.98, Režim snímania kamery: FF

Systémová frekvencia: 59.94/50/29.97/25/23.98, Režim snímania kamery: S35

Systémová frekvencia: 24, Režim snímania kamery: FF

Poznámka

Slow & Quick Motion nie je možné nastaviť počas nahrávania, prehrávania alebo počas zobrazenia obrazovky s miniatúrami.

Záznam zvuku nie je podporovaný v režime Slow & Quick Motion.

Funkcie automatická clona a automatická uzávierka sú v režime Slow & Quick Motion deaktivované.

Automatické zaostrovanie má v režime Slow & Quick Motion nasledujúce obmedzenia.

Obmedzenia spôsobené modelom objektívu, frekvenciou systému a frekvenciou snímania

Kodek Formát videa Konfigurovateľné snímkové frekvencie

RAW 3840×2160P 1–60, 100, 120

RAW & XAVC-I 3840×2160P 1–60, 100, 120

XAVC-I

4096×2160P 1–60

3840×2160P 1–60, 100, 120

1920×1080P 1–60, 100, 120, 150, 180, 200, 240

XAVC-L
3840×2160P 1–60, 100, 120

1920×1080P 1–60, 100, 120, 150, 180, 200, 240

Kodek Formát videa Konfigurovateľné snímkové frekvencie

XAVC-I 1920×1080P 1–60, 100, 120

XAVC-L 1920×1080P 1–60, 100, 120

Kodek Formát videa Konfigurovateľné snímkové frekvencie

XAVC-I 4096×2160P 1–60
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Funkcia automatického zaostrovania je dočasne deaktivovaná, ak je clona nastavená na hodnotu F18 alebo vyššiu.

Podrobnosti o používaní výstupu RAW nájdete v časti „Záznam RAW videa“.

Súvisiaca téma

Záznam RAW videa
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Objektív Sony Systémová frekvencia Dostupnosť AF

Iné ako SEL16F28 – Podporované 7 fps alebo viac

SEL16F28

59.94/29.97/23.98 Podporované 30, 60, 120, 240 fps

50,00/25,00 Podporované 25, 50, 100, 200 fps

24,00 Nepodporované
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Prerušované nahrávanie videa (Interval Rec)

Funkcia Interval Rec umožňuje nahrať prerušované video do vnútornej pamäte jednotky. Táto funkcia predstavuje
efektívny spôsob snímania pomaly sa pohybujúcich objektov.
Keď začnete nahrávať, jednotka automaticky zaznamená určitý počet snímok (Number of Frames) v stanovenom
časovom intervale(Interval Time).

A: Interval snímania (Interval Time)
B: Počet snímok v jednom zábere(Number of Frames)

Poznámka

Naraz je možné použiť iba jednu špeciálnu funkciu nahrávania, napríklad nahrávanie Interval Rec.

Ak je počas používania Interval Rec povolený iný špeciálny režim nahrávania, Interval Rec sa automaticky uvoľní.

Režim Interval Rec sa automaticky uvoľní po zmene systémových nastavení, napríklad formátu videa.

Nastavenia Interval Rec nie je možné meniť počas nahrávania alebo prehrávania alebo keď je zobrazená obrazovka s náhľadmi.

Obmedzenia počas nahrávania
Zvuk sa nezaznamenáva.
Kontrola záznamu (Rec Review) nie je možná.

Ak je jednotka počas nahrávania vypnutá
Keď je napájanie jednotky nastavené do pohotovostného stavu, k médiu sa pristupuje na niekoľko sekúnd, aby sa do
tohto okamihu zaznamenali obrázky uložené v pamäti, a potom sa jednotka automaticky prepne do pohotovostného
stavu.
Ak je odpojený jednosmerný napájací kábel, napájanie je odpojené zo sieťového adaptéra alebo je odpojené
napájanie PoE++, môže dôjsť k strate nahraných záberov zaznamenaných do tohto momentu (maximálne 10
sekúnd). Treba postupovať opatrne.

Nastavenie počtu snímok a intervalu medzi snímaním
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Nastavte [Project] > [Interval Rec] > [Setting] na [On] vo webovej ponuke, a nastavte [Number of Frames] a [Interval
Time].
Jednotka opustí režim Interval Rec, keď je vypnutá, ale nastavenia [Number of Frames] a [Interval Time] sa zachovajú.
Pri ďalšom snímaní v režime Interval Rec ich nemusíte znova nastavovať.

Rada

Dá sa nastaviť aj pomocou [Project] > [Interval Rec] v ponuke kamery.

Spustenie snímania

Stlačením tlačidla nahrávania START/STOP spustíte nahrávanie. Striedavo sa zobrazujú „Int●Rec“ a „Int●Stby“.

Zastavenie snímania

Zastavte nahrávanie.
Po ukončení snímania sa video údaje uložené v pamäti až do tohto bodu zapíšu na médium.
Ak chcete ukončiť režim Interval Rec, vykonajte jeden z nasledujúcich krokov.

Prepnite napájanie jednotky do pohotovostného režimu.
V pohotovostnom režime nahrávania nastavte [Project] > [Interval Rec] > [Setting] na [Off].

Po reštartovaní jednotky sa automaticky uvoľní aj režim Interval Rec.

5-041-959-13(1) Copyright 2022 Sony Corporation
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Nahrávanie obrázkov vo vyrovnávacej pamäti (Picture Cache Rec)

Funkcia Picture Cache Rec vám umožňuje zachytiť video spätne, keď začnete nahrávať, a to tak, že pri snímaní budete
uchovávať internú vyrovnávaciu pamäť po určitú dobu.

Nastavenie veľkosti vyrovnávacej pamäte

Nastavte [Project] > [Picture Cache Rec] > [Setting] na [On] vo webovej ponuke, a nastavte veľkosť vyrovnávacej pamäte
pomocou [Cache Size].

Poznámka

Picture Cache Rec nie je možné použiť v kombinácii s Interval Rec, 2-zásuvkovým simultánnym nahrávaním alebo zástupným
nahrávaním. Keď je Picture Cache Rec nastavené na On, tieto ďalšie špeciálne režimy nahrávania sú nútene nastavené na Off.

Režim Picture Cache Rec nie je možné vybrať počas nahrávania alebo prebiehajúceho Rec Review.

Keď je Picture Cache Rec nastavené na On, časový kód sa zaznamenáva v režime [Free Run], aj keď je nastavený na [Regen]
alebo [Rec Run].

Nastavenie [Output Format] nemusí byť konfigurovateľné v režime Picture Cache Rec. Ak k tomu dôjde, dočasne nastavte Picture
Cache Rec na Off a potom zmeňte nastavenie.

Rada

Čas vyrovnávacej pamäte môže byť kratší v závislosti od formátu záznamu. Skontrolujte čas zobrazený v [Project] > [Picture
Cache Rec] > [Cache Rec Time] vo webovej ponuke.

Dá sa nastaviť aj pomocou [Project] > [Picture Cache Rec] v ponuke kamery.

Pomocou priraditeľného tlačidla môžete tiež prepínať [Picture Cache Rec] medzi On a Off.

Spustenie Picture Cache Rec

Keď je [Picture Cache Rec] nastavené na On, zobrazí sa „●Cache“ (● je zelená).
Keď stlačíte tlačidlo nahrávania START/STOP, spustí sa nahrávanie a video sa zapíše na pamäťové karty počnúc
videom uloženým vo vyrovnávacej pamäti.

Poznámka

Zmenou formátu záznamu alebo základného vzhľadu sa vymaže video vo vyrovnávacej pamäti, ktoré bolo dovtedy uložené,
a spustí sa ukladanie nového videa. V dôsledku toho nie je možné ukladať obrázky do vyrovnávacej pamäte obrázkov pred
zmenou formátu, a to ani v prípade, že začnete nahrávať ihneď po zmene formátu.

[Cache Size] nastavenia Čas vyrovnávacej pamäte (približný)

[Short] 5 sekúnd

[Medium] 10 sekúnd

[Long] 20 sekúnd

[Max] Maximálna hodnota pre každý formát záznamu
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Ak je Picture Cache Rec nastavené na On alebo Off ihneď po vložení pamäťovej karty, dáta vyrovnávacej pamäte sa nemusia na
kartu zaznamenať.

Video sa ukladá do vyrovnávacej pamäte, keď je funkcia Picture Cache Rec nastavená na On. Video pred nastavením funkcie na
On sa neukladá do vyrovnávacej pamäte.

Video sa neukladá do vyrovnávacej pamäte počas prístupu na pamäťovú kartu, napríklad počas prehrávania, nahrávania alebo
zobrazenia na obrazovke miniatúr. Nahrávanie videa do vyrovnávacej pamäte obrázkov počas tohto intervalu nie je možné.

Zrušenie Picture Cache Rec

Nastavte [Project] > [Picture Cache Rec] > [Setting] na [Off] vo webovej ponuke alebo stlačte priraditeľné tlačidlo
priradené k funkcii [Picture Cache Rec].

5-041-959-13(1) Copyright 2022 Sony Corporation
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Súčasné nahrávanie na pamäťové karty A a B. (2-slot Simul Rec)

Môžete súčasne nahrávať na pamäťovú kartu A aj na pamäťovú kartu B nastavením [Project] > [Simul Rec] > [Setting] na
[On] vo webovej ponuke alebo ponuke kamery.

Nahrávanie oddelene na pamäťovú kartu A a pamäťovú kartu B

Nahrávanie na každú pamäťovú kartu môžete spustiť/zastaviť nezávisle pomocou tlačidla nahrávania START/STOP
alebo tlačidla [2nd Rec START/STOP] na karte  (Others).
V predvolenom nastavení z výroby sú obe tlačidlá nastavené na spustenie/zastavenie simultánneho nahrávania na
pamäťové karty A aj B.
Keď sú tlačidlá nastavené na ovládanie nahrávania pre rôzne pamäťové karty, ovládanie spustenia/zastavenia
[SDI/HDMI Rec Control] sleduje stav nahrávania v zásuvke A.

Zmena nastavenia

Nastavte nasledovné pomocou [Project] > [Simul Rec] > [Rec Button Set] v ponuke kamery.

5-041-959-13(1) Copyright 2022 Sony Corporation

[Rec Button Set]
nastavenia Tlačidlá a pamäťové karty

Rec Button:<Slot A>
<Slot B>
2nd Rec Button:<Slot
A> <Slot B>

Spustí/zastaví súčasne nahrávanie na pamäťové karty A a B pomocou ktoréhokoľvek tlačidla.

Rec Button:<Slot A>
2nd Rec Button:<Slot
B>

Tlačidlo nahrávania START/STOP spustí/zastaví nahrávanie na pamäťovú kartu A a tlačidlo
[2nd Rec START/STOP] na karte  (Others) spustí/zastaví nahrávanie na pamäťovú kartu B.

Rec Button:<Slot B>
2nd Rec Button:<Slot
A>

Tlačidlo nahrávania START/STOP spustí/zastaví nahrávanie na pamäťovú kartu B a tlačidlo
[2nd Rec START/STOP] na karte  (Others) spustí/zastaví nahrávanie na pamäťovú kartu A.
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Monitor videosignálu

Typ videosignálu, ktorý sa má zobraziť na obrazovom paneli kamery, môžete nastaviť na tvar vlny, vektoroskop alebo
histogram [Monitoring] > [Video Signal Monitor] > [Setting] v ponuke kamery.
Oranžová čiara označuje nastavenú hodnotu úrovne [Level Marker 1] a [Level Marker 2].
Funkciu [Video Signal Monitor] môžete tiež priradiť priraditeľnému tlačidlu.

Zobrazenie monitorovaného cieľa
V zázname režimov snímania sa v pravom hornom rohu monitora videosignálu zobrazí informácia o nastavení farebného
rozsahu alebo nastavení LUT monitora, čím sa označí sledovaný cieľ.

5-041-959-13(1) Copyright 2022 Sony Corporation

233



Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Označenie klipu

Do klipu môžete pridať označenie klipu [OK] stlačením priraditeľného tlačidla priradeného k funkcii [Clip Flag OK]
a výberom [Add OK].
Označenie klipu [OK] môžete odstrániť dvojitým stlačením tlačidla a výberom [Delete Clip Flag].

Rada

Môžete tiež pridať označenie klipu pomocou [Thumbnail] > [Set Clip Flag] v ponuke kamery.

Obrazovku miniatúr možno zobraziť zoradenú podľa typu príznaku klipu (filtrovaná obrazovka s miniatúrami klipu). Podrobnosti
nájdete v časti „Operácie s nahratými klipmi“ v časti „Obrazovka s miniatúrami“.

Súvisiaca téma

Operácie s nahratými klipmi

5-041-959-13(1) Copyright 2022 Sony Corporation
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Kompenzácia dýchania

Môžete nastaviť, či sa má vykonať kompenzácia dýchania pre objektív pomocou [Technical] > [Lens] > [Breathing
Compensation] v ponuke kamery.
Táto funkcia koriguje jav, pri ktorom dochádza k zmenám uhla pohľadu pri zmene polohy zaostrenia.
Keď sa vykoná kompenzácia dýchania, časť obrazu sa elektronicky oreže, aby sa zachoval konštantný uhol pohľadu,
takže sa neobjaví jav dýchania.

Poznámka

Keď je aktivovaná kompenzácia dýchania, uhol pohľadu a kvalita obrazu sa môžu mierne zmeniť.

V závislosti od objektívu nemusí byť možné opraviť zmenu zorného uhla, keď je aktivovaná kompenzácia dýchania.

Kompenzácia nie je možná, keď je nasadený objektív, ktorý nepodporuje kompenzáciu dýchania.

Táto funkcia je nastavená na Off (napevno) v nasledujúcich prípadoch.

Ak je [Technical] > [Lens] > [Distortion Comp.] nastavené na [Off] v ponuke kamery
Keď [Shooting] > [S&Q Motion] > [Setting] je nastavené na [On] vo webovej ponuke alebo v ponuke kamery
Keď je [Project] > [Rec Format] > [Codec] nastavené na [RAW] alebo [RAW & XAVC-I] vo webovej ponuke alebo v ponuke
kamery

5-041-959-13(1) Copyright 2022 Sony Corporation
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Prehľad zástupného nahrávania

Táto funkcia umožňuje súčasne zaznamenávať zástupné údaje s nízkym rozlíšením súčasne s nahrávaním pôvodných
dátových videí s vysokým rozlíšením.

Podrobnosti o podporovaných pamäťových kartách, formátovaní pamäťových kariet a kontrole zostávajúcej kapacity
nájdete v časti „Podporované pamäťové karty“ v „Príprava pamäťových kariet“.

O zaznamenanom súbore
Prípona názvu súboru je „.mp4“.
Časový kód sa tiež zaznamenáva súčasne.

Cieľ úložiska zaznamenaného súboru
Zaznamenaný súbor je uložený v nasledujúcom priečinku.

O názve súboru
Názov súboru pozostáva z názvu klipu zaznamenaného na pamäťovej karte a prípony „S03“.
Názvy klipov nájdete v časti [TC/Media] > [Clip Name Format] v ponuke kamery.

Súvisiaca téma

Podporované pamäťové karty
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Záznamové médiá Cesta k priečinku

SDXC /PRIVATE/XDROOT/Sub

CFexpress Type A /XDROOT/Sub
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Nahrávanie zástupného súboru

Nahrávanie môžete spustiť, keď je povolené zástupné nahrávanie.

Zastavenie snímania
Zastavte nahrávanie.

Nastavenie zvukového kanálu pre zástupné nahrávanie
Nastavte zvukový kanál pre zástupné nahrávanie údajov pomocou [Project] > [Proxy Rec] > [Audio Channel] v ponuke
kamery.
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Nastavte [Project] > [Proxy Rec] > [Setting] na [On] vo webovej ponuke alebo v ponuke kamery.1

Vložte pamäťovú kartu do zásuvky pre kartu CFexpress Type A/SD .

V prípade kariet CFexpress vkladajte štítkom nahor.
V prípade kariet SD vkladajte štítkom nadol.

Poznámka

Proxy Rec nie je možné nastaviť na On súčasne s S&Q Motion alebo Interval Rec. Keď je Proxy Rec nastavené na On,
tieto ostatné režimy nahrávania sú vynútene nastavené na Off.

2

Stlačte tlačidlo nahrávania START/STOP .

Spustí sa zástupné nahrávanie.

Poznámka

Ak je jednotka vypnutá alebo keď je počas prístupu na pamäťovú kartu vybratá pamäťová karta, nemožno zaručiť integritu
údajov na karte.
Všetky údaje zaznamenané na pamäťovej karte môžu byť znehodnotené. Pred vypnutím jednotky alebo vybratím
pamäťovej karty sa vždy uistite, že kontrolka prístupu na pamäťovú kartu nesvieti.

Uistite sa, že pamäťová karta pri vkladaní alebo vyberaní nevyskočí.

3
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Prehľad vzhľadu

Keď je jednotka v režime Custom, môžete pridať úpravy čiernej, matice a ďalších parametrov, aby ste vytvorili „vzhľad“,
ktorý vychádza zo základného vzhľadu.

Môžete tiež rýchlo zvoliť iný vzhľad uložením rôznych kombinácií nastavení do súborov scén.
Jednotka je vybavená celkovo siedmymi prednastavenými vzhľadmi.

5-041-959-13(1) Copyright 2022 Sony Corporation
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Výber vzhľadu

Táto téma popisuje, ako vybrať vzhľad.

Skontrolujte, že [Project] > [Base Setting] > [Shooting Mode] je nastavené na [Custom] vo webovej ponuke
alebo v ponuke kamery.

Rada

V režime [Custom] sa tlačidlá [ISO/Gain] a [Scene File] zobrazia na paneli základnej konfigurácie kamery.

1

Stlačte tlačidlo [Scene File] na paneli základnej konfigurácie kamery.

Rámček tlačidla [Scene File] sa zmení na oranžový.

Zobrazí sa panel nastavenia Scene File.

2

Stlačte tlačidlo [Scene File] na paneli nastavenia a vyberte zo zoznamu súbor scény s požadovaným
vzhľadom.

Nasledujúce predvoľby sú vopred nakonfigurované.

Rada

3

[Target Display] [SDR(BT.709)] [HDR(HLG)]

Súbor scény 1 [S-Cinetone] [HLG Live]

Súbor scény 2 [Standard] [HLG Natural]

Súbor scény 3 [Still] (Nezaregistrovaný)

Súbor scény 4 [ITU709] (Nezaregistrovaný)

Súbor scény 5 [709tone] (Nezaregistrovaný)

Súbory scény 6 až 16 (Nezaregistrovaný) (Nezaregistrovaný)
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Vzhľad si môžete vybrať aj pomocou [Paint/Look] > [Scene File] > [Recall] v ponuke kamery. Predvolený vzhľad môžete tiež
vyvolať pomocou [Scene File] > [Preset Recall].

Poznámka

Predvoľba súboru scény 5 je nastavená na [709tone] s verziou softvéru 2.0 alebo novšou. Zobrazí sa, keď sa vo webovej
ponuke vykoná [Maintenance] > [Reset] > [Factory Default].
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Import požadovaného základného vzhľadu

Ako základný vzhľad môžete importovať súbor 3D LUT vytvorený v počítači alebo na inom zariadení. Je možné
naimportovať až 16 súborov.
Formát súboru: Súbor CUBE (*.cube) pre 3D LUT so 17 alebo 33 mriežkami vytvorený pomocou Catalyst Browse, RAW
Viewer alebo DaVinci Resolve* (Blackmagic Design Pty. Ltd.).

Vstupný farebný rozsah / gama: [S-Gamut3.Cine/S-Log3] alebo [S-Gamut3/S-Log3]

Úprava pre podexpozíciu

Overené pomocou Resolve V9.0, V10.0 a V11.0.*

Uložte súbor 3D LUT do zariadenia s webovou aplikáciou.1

Otvorte [Paint/Look] > [Base Look] vo webovej ponuke.

Zobrazí sa zoznam zaregistrovaných základných vzhľadov.

2

Stlačte tlačidlo [Import] na riadku, do ktorého chcete súbor importovať.

Zobrazí sa dialógové okno výberu súboru.

3

Vyberte pripravený súbor 3D LUT.

Importovaný súbor 3D LUT sa stane základným vzhľadom jednotky.

4

Vyberte importovaný súbor 3D LUT pomocou [Paint/Look] > [Base Look] > [Select] v ponuke kamery.5

Nakonfigurujte [Paint/Look] > [Base Look] > [Input] a [Output] v ponuke kamery, aby sa zhodovali
s atribútmi importovaného súboru 3D LUT.

6
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Ak existuje tendencia k podexponovaniu, keď je zvolená automatická expozícia pri použití importovaného základného
vzhľadu, upravte vzhľad pomocou [Paint/Look] > [Base Look] > [AE Level Offset] vo webovej ponuke.

Poznámka

Samotný import súboru 3D LUT nemá vplyv na obrázok. Načítajte importovaný súbor 3D LUT pomocou [Paint/Look] > [Base
Look] > [Select] v ponuke kamery.

Ak [Input] nie je nastavený správne, nebude dosiahnutý správny vzhľad.

Nastavenia položiek ponuky [Input], [Output], a [AE Level Offset] sa použijú na základný vzhľad vybraný pomocou [Select]. Ak sa
importuje viac súborov 3D LUT, vyberte každý súbor 3D LUT pomocou [Select] a nakonfigurujte [Input], [Output], a [AE Level
Offset] jednotlivo pre každý súbor.

Nakonfigurované nastavenia [Input], [Output] a [AE Level Offset] sa uložia pre každý súbor 3D LUT.

Možnosti výberu základného vzhľadu/LUT pre importované súbory 3D LUT sú spoločné pre režimy [SDR(BT.709)], [HDR(HLG)]
a záznam režimov snímania, ale farebný priestor a gama konverzia sa podľa týchto režimov nevykonávajú.

Súbory 3D LUT sa neodstránia, keď je [Maintenance] > [Reset] > [All Reset (except for Network Settings)] vykonané vo webovej
ponuke.

 (chyba pripojenia súboru 3D LUT) zobrazená pred obrazovkou [Base Look Name] znamená, že súbory 3D LUT nemožno
pripojiť ku klipom nahratých v zázname režimov snímania. Znovu importujte súbor 3D LUT.

5-041-959-13(1) Copyright 2022 Sony Corporation
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Prispôsobenie vzhľadu

Vzhľad si môžete prispôsobiť na základe základného vzhľadu pomocou posuvníkov [Master Black], [R Black] a [B Black]
na paneli úprav Scene File na paneli základnej konfigurácie kamery a [Paint/Look] > [Matrix], prípadne ďalších položiek
nastavenia v ponuke kamery.
Pripojte jednotku k televízoru alebo monitoru a pri sledovaní obrazu na obrazovke televízora alebo monitora upravte
kvalitu obrazu.

1: [R Black] posuvník/nastavovacie tlačidlá
2: [B Black] posuvník/nastavovacie tlačidlá
3: [Master Black] posuvník/nastavovacie tlačidlá

Poznámka

Keď importujete súbor 3D LUT a použijete ho na obrázok, požadovaný vzhľad definovaný v súbore 3D LUT sa nedosiahne, ak sa
zmení ponuka [Paint/Look] > [Matrix] a iné nastavenia vzhľadu ako základné v ponuke kamery.

Všetky prispôsobené nastavenia môžete resetovať pomocou [Paint/Look] > [Reset Paint Settings] > [Reset without Base Look]
v ponuke kamery.
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Uloženie vzhľadu

Aktuálny vzhľad môžete uložiť ako súbor scény do vnútornej pamäte pomocou [Paint/Look] > [Scene File] > [Store]
v ponuke kamery.
Uložený vzhľad môžete rýchlo vyvolať pomocou panela úprav Scene File alebo pomocou funkcií priamej ponuky.

Poznámka

Ak vyberiete iný vzhľad bez uloženia aktuálneho vzhľadu, aktuálny vzhľad sa zahodí.

Rada

Prednastavené súbory scén môžete prepísať. Ak chcete obnoviť predvolený súbor scény, načítajte vzhľad, ktorý sa má obnoviť,
pomocou [Paint/Look] > [Scene File] > [Preset Recall] v ponuke kamery a potom uložte pomocou [Scene File] > [Store].

Odstránenie uloženého vzhľadu
Súbor scény uložený vo vnútornej pamäti môžete odstrániť pomocou [Paint/Look] > [Scene File] > [Delete] v ponuke
kamery.

Rada

Po odstránení sa Scene File už nezobrazuje na paneli úprav ani v priamej ponuke.

5-041-959-13(1) Copyright 2022 Sony Corporation
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Odstránenie základného vzhľadu

Importované súbory 3D LUT môžete odstrániť jednotlivo pomocou [Paint/Look] > [Base Look] > [Delete] v ponuke
kamery.
Všetky importované súbory 3D LUT môžete odstrániť pomocou [Paint/Look] > [Base Look] > [Delete All] v ponuke
kamery.

Poznámka

Pred odstránením skontrolujte, či sa základný vzhľad nepoužíva v žiadnych súboroch scén. Ak sa odstráni základný vzhľad, ktorý
sa používa, vzhľad zodpovedajúcich súborov scén bude nesprávny.

Importované súbory 3D LUT sa neodstránia, ak [Maintenance] > [Reset] > [All Reset (except for Network Settings)] je vykonané
vo webovej ponuke.

Odstránený základný vzhľad už nemožno použiť ako LUT v zázname režimov snímania.

5-041-959-13(1) Copyright 2022 Sony Corporation
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Snímanie s úpravou vzhľadu v postprodukcii

Použitím jednotky v zázname režimov snímania*1 a rovnomerným zaznamenávaním stupňovania od tmavých po svetlé
oblasti môžete v postprodukcii vykonať jemné úpravy, napríklad lokálne obnoviť stupňovanie tmavých a svetlých oblastí.
Pri prezeraní zaznamenaných snímok na bežnom monitore sa však bude celkový kontrast javiť nízky, čo sťažuje úpravy
zaostrenia a expozície.
Môžete použiť LUT na sledovaný cieľ v jednotke, aby ste pomohli pri rôznych úpravách počas snímania. LUT použitý pri
snímaní môžete použiť aj automaticky pri prehrávaní, aby ste rýchlo skontrolovali konečný výsledok.
LUT sa používajú v nasledujúcich systémoch. Môže sa však použiť iba jeden LUT.

SDI výstup
HDMI výstup a streamovanie
Zástupný klip nahratý na záznamové médium
Klip s vysokým rozlíšením (hlavný) zaznamenaný na záznamovom médiu
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Všeobecný termín pre režim Flexible ISO /Cine EI /Cine EI Quick*1
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Použitie LUT na HDMI výstup a streamovanie

Na HDMI výstup a streamovanie môžete použiť LUT.

Poznámka

Obraz na obrazovom paneli kamery webovej aplikácie je tiež zahrnutý v streamovanom obraze.

Rada

Toto sa dá nastaviť aj pomocou [Shooting] > [LUT On/Off] > [HDMI/Stream] v ponuke kamery.

Rovnakým spôsobom je možné nastaviť SDI výstup.

Pre video na záznamovom médiu to môžete nastaviť pomocou [Shooting] > [LUT On/Off] > [Internal Rec] a [Proxy] v ponuke
kamery.

 (chyba pripojenia súboru 3D LUT) zobrazená pred obrazovkou [Base Look/LUT] znamená, že súbory 3D LUT nemožno
pripojiť ku klipom nahratých v zázname režimov snímania. Znovu importujte súbor 3D LUT.
Táto ikona sa zobrazí aj vtedy, keď sa pripojenie nepodarí z dôvodu dočasného preťaženia spracovania.

Skontrolujte, či [Project] > [Base Setting] > [Shooting Mode] je nastavené na [Flexible ISO], [Cine EI] alebo
[Cine EI Quick] vo webovej ponuke alebo v ponuke kamery.

Rada

V zázname režimov snímania sa tlačidlá [Base ISO/Exposure Index] a [Base Look/LUT] zobrazujú na paneli základnej
konfigurácie kamery.

1

Stlačte tlačidlo [Base Look/LUT] na paneli základnej konfigurácie kamery.

Rámček tlačidla [Base Look/LUT] sa zmení na oranžový.

Zobrazí sa panel nastavenia Base Look/LUT.

2

Vyberte [HDMI/Stream] > [MLUT].3
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Zmena LUT

Môžete zmeniť LUT tak, aby sa použil.

Rada

Jednotka poskytuje [s709], [709(800%)] a [S-Log3] ako prednastavené LUT.

Môžete tiež importovať a použiť súbor 3D LUT. Podrobnosti nájdete v častiach „Import požadovaného základného vzhľadu“
a „Odstránenie základného vzhľadu“.

Toto sa dá nastaviť aj pomocou [Paint/Look] > [Base Look] > [Select] v ponuke kamery.

Súvisiaca téma
Import požadovaného základného vzhľadu

Odstránenie základného vzhľadu

5-041-959-13(1) Copyright 2022 Sony Corporation

Stlačte tlačidlo [Base Look/LUT] na paneli základnej konfigurácie kamery.

Rámček tlačidla [Base Look/LUT] sa zmení na oranžový.

Zobrazí sa panel nastavenia Base Look/LUT.

1

Stlačte tlačidlo [Base Look/LUT] a vyberte základný vzhľad, ktorý chcete použiť.2
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Zmena rozloženia tmavých a svetlých oblastí v zaznamenanom videu

V režimoch snímania Cine EI a Cine EI Quick môžete zmeniť rozloženie tmavých a svetlých oblastí, napríklad ak chcete
uprednostniť tón tmavých oblastí pred svetlými oblasťami, zmenou Exposure Index zo základnej citlivosti.

Stlačte tlačidlo [Base Look/LUT] na paneli základnej konfigurácie kamery.

Rámček tlačidla [Base Look/LUT] sa zmení na oranžový.

Zobrazí sa panel nastavenia Base Look/LUT.

1

Vyberte [HDMI/Stream] > [MLUT].

Na HDMI výstup a streamovanie sa aplikuje LUT.

2

Stlačte tlačidlo [Base ISO/Exposure Index] na paneli základnej konfigurácie kamery.

Rámček tlačidla [Base ISO/Exposure Index] sa zmení na oranžový.

Zobrazí sa panel nastavenia Base ISO/Exposure Index.

3

Upravte index expozície podľa požadovaného rozloženia tmavých a svetlých oblastí pomocou posuvníka
[Exposure Index] alebo nastavovacích tlačidiel [Exposure Index].

Pre [Cine EI]

Pre [Cine EI Quick]
Základná citlivosť sa nastaví automaticky podľa zadaného indexu expozície.

4
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Rada

Toto sa dá nastaviť aj pomocou [Shooting] > [ISO/Gain/EI] > [Exposure Index] v ponuke kamery.

Rovnakým spôsobom je možné použiť SDI výstup.

Druhá číselná hodnota nastavenia označuje, koľko krokov informácie o jase je priradených svetlým oblastiam (jas vyšší ako 18%
sivá). Oblasti svetlejšie ako tieto sú preexponované.
Príklad: V prípade „400EI/5.0E“ je na svetlej strane priradených 5,0 krokov.

Môžete ho tiež použiť ako pomôcku na kontrolu tónu tmavých a svetlých oblastí počas snímania. Po kontrole expozície sa
nezabudnite vrátiť k pôvodnej hodnote EI. Aj v režime Cine EI Quick dávajte pozor, aby ste negatívne neovplyvnili základnú
citlivosť.
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Upravte osvetlenie a/alebo ND filter tak, aby obrazový výstup kamery z [HDMI/Stream] mal vhodnú
expozíciu.

5
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Záznam RAW videa

Výstupný videosignál RAW môžete nahrávať z konektora SDI OUT jednotky na podporovaný externý rekordér.
Podporované výstupné formáty RAW sú uvedené nižšie.

Systémová frekvencia [Codec] [RAW Output Format]

59.94 / 50 / 29.97 / 25 / 23.98

RAW 4096×2160

RAW 3840×2160

RAW & XAVC-I 4096×2160

RAW & XAVC-I 3840×2160

24
RAW 4096×2160

RAW & XAVC-I 4096×2160

Pripojte externý záznamník RAW ku konektoru SDI OUT jednotky.1

Nastavte [Project] > [Base Setting] > [Shooting Mode] na [Cine EI], [Cine EI Quick] alebo [Flexible ISO] vo
webovej ponuke alebo v ponuke kamery.

2

Nastavte uhol pohľadu (iba FF) pomocou [Project] > [Rec Format] > [Imager Scan Mode] vo webovej ponuke
alebo ponuke kamery.

3

Nastavte [Project] > [Rec Format] > [Codec] na [RAW] vo webovej ponuke alebo v ponuke kamery.

Výberom [RAW & XAVC-I] sa bude súčasne nahrávať video na externý rekordér RAW a video na pamäťové karty
v jednotke.

4

Nastavte rozlíšenie pomocou [Project] > [Rec Format] > [RAW Output Format] vo webovej ponuke alebo
ponuke kamery.

5

Skontrolujte, či je externý rekordér zapnutý, a potom stlačte tlačidlo START/STOP nahrávania na živej
prevádzkovej obrazovke.

Stav nahrávania videa vo formáte RAW je indikovaný ikonou na obrazovom paneli kamery.

6
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Poznámka

Klipy sa nemusia nahrať správne, keď sa nahrávanie spustí na externom rekordéri bez použitia tlačidla nahrávania START/STOP
na živej prevádzkovej obrazovke.

5-041-959-13(1) Copyright 2022 Sony Corporation

Poznámka

Signál riadenia nahrávania je vyvedený na výstup z konektora SDI OUT jednotky, nie je však možné zistiť stav externého
rekordéra. Podľa toho môže jednotka indikovať, že prebieha záznam videa RAW, aj keď externý rekordér v skutočnosti
nenahráva. Skontrolujte indikátor na externom rekordéri, aby ste dosiahli správny prevádzkový stav.
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Nahrávanie videa RAW v režime Slow & Quick Motion

Video RAW môžete nahrávať v režime Slow & Quick Motion.

Podrobnosti o podporovaných snímkových frekvenciách pri snímaní nájdete v časti „Slow & Quick Motion“.

Súvisiaca téma

Slow & Quick Motion

5-041-959-13(1) Copyright 2022 Sony Corporation
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Zapnutie/vypnutie funkcie ovládania bokehu

Stupeň bokehu môžete jednoducho upraviť prepojením ND filtra a zosilnenia s prevádzkou clony.

Zapnutie/vypnutie funkcie ovládania bokehu

Túto funkciu je možné aktivovať iba pri manuálnom nastavení expozície. Nastavte ND filter na variabilný režim, potom
nastavte clonu, zisk, uzávierku a ND filter na manuálne nastavenie.
Funkciu ovládania bokehu môžete zapnúť/vypnúť pomocou položky [Shooting] > [Iris] > [Bokeh Control] v ponuke
kamery.
Keď je funkcia ovládania bokehu nastavená naOn, ikona  (B) sa zobrazí na ND filtri a indikátoroch zosilnenia.

Poznámka

Táto funkcia je povolená len na objektívoch s bajonetom E, ktoré dokážu komunikovať s prístrojom.

Maximálny účinok tejto funkcie možno dosiahnuť použitím objektívu Sony s bajonetom E.

Funkcia ovládania bokehu sa nastaví na Off, keď dôjde k niektorej z nasledujúcich činností.

Keď je jednotka vypnutá
Keď je ktorýkoľvek z filtrov clony, zosilnenia, uzávierky alebo ND nastavený na Auto
Pri prepnutí režimu snímania
Keď je ND filter nastavený na vymazanie alebo prednastavený režim
Keď je objektív odstránený
Keď sa jednotka reštartuje, napríklad po prepnutí frekvencie

Rada

Funkciu [Bokeh Control] môžete tiež nastaviť na priraditeľné tlačidlo a prepínať funkciu úpravy bokehu medzi On a Off pomocou
tlačidla.

5-041-959-13(1) Copyright 2022 Sony Corporation
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Nastavenie stupňa bokehu

Podľa potreby upravte nastavenia v krokoch 2 až 4.

Poznámka

Vzhľad sa môže líšiť v závislosti od rýchlosti prevádzky, objektívu, nastavení snímania a subjektu, tiež sa môže meniť jas.
Dôrazne odporúčame vykonať test kamery pred snímaním.

Jas sa môže zmeniť, keď sa zmení smer činnosti clony, napríklad pri otvorení clony po jej zatvorení alebo pri zatvorení clony po
jej otvorení. V takom prípade vopred upravte trochu viac, ako je potrebné, a potom trochu ustúpte, skontrolujte jas a potom
začnite fotografovať. Napríklad, ak chcete otvoriť clonu na apertúru F8 a rozmazať pozadie, najskôr zatvorte apertúru za F8
a potom sa vráťte na F8, skontrolujte jas a začnite fotografovať.

Operácie ovládania bokehu vykonávajte pomaly. Ak potrebujete zrýchliť operáciu, pokúste sa postupne upravovať a zároveň
kontrolovať zmeny na obrázku.

Rada

Keď je funkcia ovládania bokehu nastavená na On, filter ND a zosilnenie spolupracujú, aby kompenzovali zmeny expozície
v dôsledku nastavenia clony, čo vám umožňuje zmeniť stupeň bokehu.

Ovládanie bokehu je najprv prepojené s ND filtrom v reakcii na činnosť clony. Keď už nie je možné meniť ND filter, pripojí sa
zosilnenie.

V režime MF sa odporúča najskôr otvoriť clonu a potom upraviť zaostrenie.

Ak namiesto funkcie ovládania bokehu použijete automatický ND filter, ND filter sa bude riadiť zmenou jasu objektu.

Zobrazenie počas pripojenia zosilnenia
Keď je funkcia ovládania bokehu nastavená na On, zosilnenie sa môže meniť pri nastavovaní clony.
Keď je pripojenie zosilnenia aktívne a zosilnenie sa zmení, v hornej časti obrazovky sa zobrazí správa a ikona  (B)
bliká na indikátore zosilnenia.

Nastavte funkciu ovládania bokehu na On.1

Úplne otvorte clonu.2

Nastavte ND filter na 1/128.3

Nastavte zosilnenie na 0 dB a použite osvetlenie, aby ste dosiahli správnu expozíciu.4

Upravte zaostrenie.5

Upravte clonu.

Stupeň bokehu sa mení.

6
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Prehľad ukladania a načítania konfiguračných údajov

Nastavenia jednotky môžete uložiť ako konfiguračné údaje pomocou webovej aplikácie. Takto môžete rýchlo vyvolať
príslušnú sadu nastavení ponuky pre aktuálnu situáciu.
Pomocou tejto jednotky môžete uložiť takmer všetky nastavenia týkajúce sa funkcií kamery, okrem nasledujúcej
poznámky, ako súbor ALL (súbor so všetkými nastaveniami).

Poznámka

Nastavenia sieťových funkcií a overovacie informácie sa neuložia. Podrobnosti o uložených položkách nájdete v časti „Zoznam
položiek ponuky“.

Súvisiaca téma

Zoznam položiek ponuky

5-041-959-13(1) Copyright 2022 Sony Corporation
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Ukladanie súboru ALL

Táto téma popisuje, ako uložiť súbor ALL.
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Otvorte [Project] > [All File] vo webovej ponuke.1

Stlačte tlačidlo [Save All File] > [Save].

Webový prehliadač za okamih stiahne súbor s názvom all-file.ALL.

2

Zadajte umiestnenie a názov súboru pre stiahnutý súbor all-file.ALL a súbor uložte.

Podrobnosti o operáciách so súbormi nájdete v návode na obsluhu prístroja.

3
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Načítanie súboru ALL

Táto téma popisuje, ako načítať súbor ALL.

Poznámka

Po načítaní konfiguračných údajov sa prístroj automaticky reštartuje. Po reštarte znova načítajte stránku vo webovom prehliadači.
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Otvorte [Project] > [All File] vo webovej ponuke.1

Stlačte tlačidlo [Load All File] > [Load].

Na zariadení s otvorenou webovou aplikáciou sa zobrazí dialógové okno na otvorenie súboru.

2

Otvorte súbor, ktorý chcete načítať.

Podrobnosti o operáciách so súbormi nájdete v návode na obsluhu prístroja.

3

Keď sa zobrazí obrazovka s potvrdením načítania názvu súboru, stlačte tlačidlo [OK].4

Keď sa zobrazí obrazovka s výsledkami vykonania, stlačte tlačidlo [OK].5

Počkajte, kým sa jednotka reštartuje, a potom znova pripojte webovú aplikáciu.6
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O prenose súborov

Zástupný alebo pôvodný súbor, ktorý je zaznamenaný na jednotke, môžete nahrať na server na internete alebo na server
v lokálnej sieti.

Poznámka

Keď je napájací zdroj nastavený do pohotovostného režimu, prenosy súborov sú pozastavené, aj keď je jednotka stále napájaná.

5-041-959-13(1) Copyright 2022 Sony Corporation
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Registrácia cieľovej adresy pre prenos súborov

Pred spustením prenosu súborov môžete zaregistrovať cieľový server prenosu.

Nastavte [Network] > [File Transfer] > [Default Upload Server] > [Server Settings1] (alebo [Server Settings2],
[Server Settings3]) vo webovej ponuke.

Rada

Názov možnosti výberu sa zmení podľa [Display Name] nakonfigurovaného v ďalšom kroku.

1

Nakonfigurujte nasledujúce položky pre [Network] > [FTP Server 1] na [FTP Server 3] vo webovej ponuke.

[Display Name]
Zadajte názov servera, ktorý sa zobrazí v zozname úloh prenosu pri výbere cieľového servera prenosu.
[Service]
Zobrazí typ servera.
[FTP]: FTP server
[Host Name]
Zadajte adresu alebo názov hostiteľa servera.
[Port]
Zadajte číslo portu servera, ktorý chcete pripojiť.
[User Name]
Zadajte meno používateľa.
[Password]
Zadajte heslo.
[Passive Mode]
Zapnutie/vypnutie pasívneho režimu.
[Destination Directory]
Zadajte názov adresára na cieľovom serveri.

Poznámka

Ak sú do [Destination Directory] zadané neplatné znaky na cieľovom serveri, súbory sa prenesú do domovského adresára
používateľa. Neplatné znaky sa budú líšiť v závislosti od servera.

[Using Secure Protocol]
Nastavte, či sa má vykonať bezpečný prenos na FTP.
[Root Certificate]
Načítať/vymazať certifikát.
[Load]: Načítať certifikát CA. Načíta certifikáty vo formáte PEM.
[Clear]: Zmazať certifikát CA.
[None]: Nenačítať ani nezmazať certifikát.

Poznámka

Pred načítaním certifikátu CA nastavte hodiny jednotky na správny čas.

[Load] nie je možné zvoliť pri nahrávaní do formátu XAVC-I 4096×2160P/3840×2160P 59.94/50P.

[Root Certificate Status]: Zobrazuje stav načítania certifikátu.

2
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[Reset]: Resetuje Server Settings na predvolené hodnoty.

263



Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Nahranie zástupného súboru na pamäťovú kartu z obrazovky miniatúr

Zástupné súbory môžete nahrať na pamäťovú kartu jednotlivo z obrazovky miniatúr.

Poznámka

Zaregistrovať možno až 200 úloh prenosu.
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Stlačte tlačidlo [Thumbnail] na živej prevádzkovej obrazovke webovej aplikácie.

Displej sa zmení z obrazu kamery na obrazovku miniatúr.

1

Vyberte [Thumbnail] > [Transfer Clip (Proxy)] > [Select Clip] v ponuke kamery.

Ak chcete preniesť všetky zástupné súbory súčasne, vyberte [Transfer Clip (Proxy)] > [All Clips].
Klipy je možné prenášať z obrazovky miniatúr alebo z obrazovky miniatúr s nastaveným filtrom na klipy.

2

Vyberte klip, ktorý chcete preniesť pomocou tlačidla [Set] a stlačte tlačidlo [Menu].

Zobrazí sa obrazovka s potvrdením prenosu.

3

Vyberte [Execute].

Zástupný súbor zodpovedajúci vybranému klipu sa zaregistruje ako úloha prenosu a začne sa nahrávanie.
Keď je úloha prenosu úspešne zaregistrovaná, zobrazí sa obrazovka s výsledkami prenosu.

4

Stlačte tlačidlo [OK].5
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Nahranie pôvodného súboru na pamäťovú kartu z obrazovky miniatúr

Pôvodný súbor môžete nahrať na pamäťovú kartu z obrazovky miniatúr.

Poznámka

Zaregistrovať možno až 200 úloh prenosu.
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Stlačte tlačidlo [Thumbnail] na živej prevádzkovej obrazovke webovej aplikácie.

Displej sa zmení z obrazu kamery na obrazovku miniatúr.

1

Vyberte [Thumbnail] > [Transfer Clip] > [Select Clip] v ponuke kamery.

Ak chcete preniesť všetky originálne súbory súčasne, vyberte [Transfer Clip] > [All Clips].
Klipy je možné prenášať z obrazovky miniatúr alebo z obrazovky miniatúr s nastaveným filtrom na klipy.

2

Vyberte klip, ktorý chcete preniesť pomocou tlačidla [Set] a stlačte tlačidlo [Menu].

Zobrazí sa obrazovka s potvrdením prenosu.

3

Vyberte [Execute].

Pôvodný súbor vybraného klipu sa zaregistruje ako úloha prenosu a začne sa nahrávanie.
Keď je úloha prenosu úspešne zaregistrovaná, zobrazí sa obrazovka s výsledkami prenosu.

4

Stlačte tlačidlo [OK].5

265



Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Kontrola stavu prenosu súborov

Stav prenosu súboru môžete skontrolovať výberom [Network] > [File Transfer] > [View Job List] v ponuke kamery.

Poznámka

Zaregistrovať možno až 200 úloh prenosu.

Úlohy prenosu sa zachovajú, keď sa jednotka prepne do pohotovostného režimu, ale ak sa odpojí napájanie iným spôsobom,
môže sa stratiť až 10 minút najnovších informácií o priebehu.

Ak sa počas prenosu súboru vyskytne chyba, prenos klipu s rovnakým názvom ako prenesený klip sa nemusí obnoviť v závislosti
od nastavení a stavu cieľového servera prenosu. V takom prípade skontrolujte nastavenia a stav cieľového servera prenosu.

Rada

Ak je [Network] > [File Transfer] > [Auto Upload (Proxy)] nastavené na [On] v ponuke kamery a existuje sieťové pripojenie,
zástupné súbory sa automaticky nahrajú na server určený pomocou [Default Upload Server], keď sa nahrávanie skončí.

5-041-959-13(1) Copyright 2022 Sony Corporation
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Nahrávanie pomocou zabezpečeného FTP

Súbory so šifrovaním môžete nahrávať pomocou protokolu FTPS v explicitnom režime (FTPES) pre pripojenie
k cieľovému súborovému serveru.
Pre bezpečný FTP prenos nastavte [Using Secure Protocol] na [On] v nastaveniach cieľového súborového servera
a načítajte certifikát.

Podrobnosti o konfigurácii nájdete v časti „Registrácia cieľovej adresy pre prenos súborov“.

Súvisiaca téma

Registrácia cieľovej adresy pre prenos súborov

5-041-959-13(1) Copyright 2022 Sony Corporation
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O streamovaní

Jednotka môže súčasne streamovať obraz a zvuk, ktorý vychádza z konektora HDMI.

Poznámka

Ak chcete použiť streamovanie ako hlavné video, nastavte [Monitoring] > [Output Display] > [SDI] na [On] a [HDMI/Stream] na
[Off] vo webovej ponuke a sledujte stav kamery na monitore SDI.

Ak je pripojený monitor HDMI, ktorý nepodporuje výstupný formát HDMI nakonfigurovaný pomocou ponuky [Monitoring] vo
webovej ponuke alebo v ponuke kamery, obraz z kamery sa vo webovej aplikácii nezobrazí. Výstup streamovaného videa nebude
takisto prítomný na výstupe.

Rozlíšenie streamovania nemožno nastaviť vyššie ako rozlíšenie výstupného signálu HDMI.

Pri sledovaní viacerými používateľmi môže byť obraz zdeformovaný v závislosti od nastavení kodeku.

Jednotka podporuje nasledujúce metódy streamovania. Video kodeky dostupné na výber sú uvedené v zátvorkách.

RTSP (H.264, H.265)
RTMP (H.264)*1

SRT-Caller (H.264)
SRT-Listener (H.264)
NDI|HX (H.264, H.265)

Nakonfigurujte nastavenie formátu streamovania, nastavenie video kodeku a nastavenie zvukového kodeku v tomto
poradí.

●: Povolené, –: Nepovolené

Rada

Obraz na obrazovom paneli kamery webovej aplikácie je tiež streamovaný systém.

Formát streamovania
Nastavenie kodeku

Video Stream 1 Video Stream 2 Video Stream 3 Audio Stream

RTSP
●
video 1

●*2

video 2
– ●

RTMP ● – – ●*1

SRT ● – – ●

NDI|HX
●
Main

●
Sub

– ●

Webová aplikácia – – ● –

RTMP možno vybrať, keď [Stream] > [Audio Stream] je nastavené na [On] vo webovej ponuke.*1

Keď je systémová frekvencia 59.94 alebo 50 a výstupný formát HDMI je 3840×2160 alebo vyšší, výstup video 2 nie je dostupný.*2
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Nastavenie formátu streamovania

Nastavte formát streamovania pomocou [Stream] > [Stream] > [Stream Setting] > [Setting] vo webovej ponuke.

Ak je [Setting] nastavené na [RTSP]

Pri streamovaní RTSP môže obraz z jednej kamery súčasne sledovať až päť používateľov.
Môžete nastaviť až dva režimy video kodeku.
[Port Number]
Nastavuje číslo portu, ktoré sa má použiť na streamovanie RTSP. Predvolená hodnota je 554.
Zmenou nastavenia sa reštartuje server RTSP.
[Time Out]
Určuje časový limit príkazu Keep-Alive pre streamovanie RTSP. Časový limit je možné nastaviť v rozsahu 0 sekúnd až
600 sekúnd. Predvolená hodnota je 60 sekúnd.
Keď je nastavená na 0 sekúnd, časový limit kvôli príkazu Keep-Alive nenastane.
[Authentication]
Nastavuje, či sa vyžaduje overenie.
[Video Port Number 1], [Video Port Number 2]
Určuje číslo komunikačného portu obrazových údajov, ktorý sa má použiť na streamovanie jednosmerného vysielania
RTSP. Predvolená hodnota z výroby pre Video Port Number 1 je 51000. Predvolená hodnota z výroby pre Video Port
Number 2 je 53000. Zadajte párne číslo v rozsahu 1024 až 65534. Tu nastavené číslo a následné nepárne číslo získané
pripočítaním 1 sa stanú dvomi číslami portov, ktoré sa používajú na komunikáciu a kontrolu obrazových údajov.
[Video Port Number 1] a [Video Port Number 2] zodpovedajú [Stream] > [Video Stream] > [Video Stream 1] a [Video
Stream 2].
[Audio Port Number]
Určuje číslo komunikačného portu pre audio dáta používané pre RTSP jednosmerné streamovanie. Predvolená hodnota
je 57000. Zadajte párne číslo v rozsahu 1024 až 65534. Tu nastavené číslo a následné nepárne číslo získané
pripočítaním 1 sa stanú dvomi číslami portov, ktoré sa používajú na komunikáciu a kontrolu zvukových údajov.

Ak je [Setting] nastavené na [RTMP]

Režim video kodeku, ktorý možno použiť pre RTMP, je len H.264. Ak chcete používať RTMP, [Stream] > [Audio Stream]
musí byť [On] vo webovej ponuke.
[Server URL]
Nastaví cieľovú adresu URL odosielania. Zadajte reťazec znakov začínajúci na "rtmp://" alebo "rtmps://".
[Stream Key]
Zadajte streamovací kľúč získaný z používanej lokality. Stlačením tlačidla [Clear] sa záznam vymaže.

Poznámka

Pri manipulácii so streamovacím kľúčom buďte opatrní. Ak je streamovací kľúč známy tretej strane, hrozí riziko falšovania
streamu.

[Root Certificate]
Importuje koreňový certifikát potrebný na streamovanie pomocou protokolu RTMPS. Ak chcete importovať koreňový
certifikát, stlačte tlačidlo [Load] a vyberte koreňový certifikát. Stlačením tlačidla [OK] v dialógovom okne výberu súboru
importujte vybraný súbor do jednotky. Ak je v jednotke importovaný koreňový certifikát, aktualizuje sa koreňový certifikát.
Ak chcete odstrániť importovaný koreňový certifikát, stlačte tlačidlo [Delete] na obrazovke nastavenia. Stav koreňového
certifikátu sa zobrazí v [Root Certificate Status].

Poznámka
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Importujte koreňový certifikát požadovaný streamovacou službou.

Ak je [Setting] nastavené na [SRT-Caller] alebo [SRT-Listener]

Režim video kodeku je len H.264.
[Destination]
Zobrazuje sa, keď je režim streamovania nastavený na [SRT-Caller]. Nastaví cieľovú adresu URL pripojenia.
[Port Number]
Zobrazuje sa, keď je režim streamovania nastavený na [SRT-Listener]. Nastavuje číslo portu, na ktorom sa má prijímať.
Predvolená hodnota je 4201.
[Latency]
Nastavuje oneskorenie v rozsahu 20 ms až 8000 ms. Predvolená hodnota je 120.
[TTL]
Nastavuje hodnotu TTL v rozsahu 1 až 255. Predvolená hodnota je 64.
[Encryption]
Vyberá metódu šifrovania. Vyberte Off, AES128 alebo AES256. Predvolená hodnota je Off.
[Passphrase]
Nastavuje prístupovú frázu použitú na šifrovanie. Stlačením tlačidla [Clear] sa resetuje nakonfigurovaná prístupová fráza.
[ARC]
Ak chcete aktivovať funkciu Adaptive Rate Control, nastavte na On.
Keď je aktivovaná funkcia Adaptive Rate Control, možno obmedziť prerušenia obrazu spôsobené preťažením
komunikačnej linky.

Ak je [Setting] nastavené na [NDI|HX]

Jednotka je v súlade s NDI|HX verzia 2 od NewTek.
Ak chcete používať NDI|HX, musíte si zakúpiť licenčný kľúč.
Zakúpenie licenčného kľúča
Nakupujte na nasledujúcej URL adrese NewTek.
https://www.newtek.com/ndihx/products/upgrade/

Poznámka

Stiahnite si najnovší ovládač NDI|HX a nainštalujte ho do výrobku NewTek.

Podrobnosti o registrácii a prevádzke NDI|HX nájdete v návode na obsluhu výrobku NewTek.

[License]
Zobrazuje licenčné informácie pre povolenú licenciu.
[Source Name]
Zobrazuje názov zdroja.
[Group]
Ak chcete povoliť funkciu zoskupovania NDI, nastavte na On.
[Group Name]: Nastaví názov skupiny NDI. Je možné nakonfigurovať viacero nastavení oddelených čiarkou.
[Discovery Server 1], [Discovery Server 2]
Nastaví NDI server zisťovania 1 a NDI server zisťovania 2.
[Reliable UDP Mode]
Ak chcete povoliť režim Reliable UDP, nastavte na On.
[Multicast Mode]
Ak chcete povoliť viacsmerné streamovanie, nastavte na On.
[Multicast Prefix]: Nastavuje prefix, ktorý sa má použiť pre viacsmerné streamovanie.
[Multicast Netmask]: Nastavuje masku siete, ktorá určuje viacsmerný rozsah adries.
[Multicast TTL]: Nastavuje hodnotu TTL pre viacsmerné streamovanie v rozsahu 1 až 256. Predvolená hodnota je 3.
[Multi-TCP Mode]
Ak chcete povoliť režim Multi-TCP, nastavte na On.
[Unicast UDP Mode]
Ak chcete povoliť režim Unicast UDP, nastavte na On.
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Informácie o službách a softvéri tretích strán
Môžu platiť iné podmienky používania.

Poskytovanie služieb a aktualizácií softvéru môže byť prerušené alebo ukončené bez upozornenia.
Popis služieb a softvéru sa môže zmeniť bez upozornenia.
Môže sa vyžadovať samostatná registrácia a predplatné.

Spoločnosť Sony nezodpovedá za žiadne nároky používateľov alebo tretích strán v dôsledku používania služieb
a softvéru iných spoločností.

5-041-959-13(1) Copyright 2022 Sony Corporation
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Nastavenie video kodeku pre streamovanie

Nastavte videokodek pomocou [Stream] > [Video Stream] vo webovej ponuke.

[Video Stream 1], [Video Stream 2], [Video Stream 3]
Môžete nastaviť až tri režimy snímky kodeku. Nakonfigurujte nasledujúce nastavenia samostatne pre každý režim
snímky.
[Video Stream 3] sa používa na zobrazenie obrazového panela kamery webovej aplikácie.

Poznámka

Keď je [Stream] > [Stream Setting] > [Setting] nastavené na [RTMP], [SRT-Caller] alebo [SRT-Listener], niektoré z nastavení
[Video Stream 1], [Video Stream 2] a [Video Stream 3] ([Codec], [Size], [Frame Rate], [Bit Rate Compression Mode]) majú
predvolené hodnoty.

[Codec 1], [Codec 2], [Codec 3]
Vyberte [H.264], [H.265] alebo [Off]. Upozorňujeme, že [Codec 1] nie je možné nastaviť na [Off]. Taktiež [Codec 3] je
nastavené na [JPEG] (napevno).

Poznámka

Nasledujúce príznaky sa môžu vyskytnúť v závislosti od kombinácie rôznych nastavení, ako je veľkosť obrázka, snímková
frekvencia a prenosová rýchlosť [Codec 1], [Codec 2] a [Codec 3].

Zvýšené oneskorenie videa.
Preskakovanie snímok počas prehrávania videa.
Prerušovaný zvuk.
Pomalá odozva kamery na rôzne príkazy.
Pomalá odozva kamery na operácie z diaľkového ovládača.
Pomalé zobrazovanie displeja obrazovky a operácie konfigurácie.

Ak sa vyskytnú tieto príznaky, znížte hodnoty parametrov veľkosti obrázku, snímkovej frekvencie a prenosovej rýchlosti alebo
zmeňte hodnoty iných parametrov nastavenia, aby ste problém vyriešili.

Keď je [Stream] > [Stream Setting] > [Setting] nastavené na [RTMP], [SRT-Caller] alebo [SRT-Listener], [Codec 1] je nastavené
na [H.264] (napevno). [Codec 2] je nastavené na [Off] (napevno).

Keď sa zmení veľkosť obrázku alebo systémová frekvencia výstupu HDMI, [Codec 2] sa nastaví na [Off].

[Size 1], [Size 2], [Size 3]
Vyberie veľkosť obrázku na streamovanie z kamery.
Dostupné možnosti veľkosti obrázku sa budú líšiť v závislosti od veľkosti obrázku výstupu HDMI.

Poznámka

Keď sa zmení veľkosť obrázku alebo systémová frekvencia výstupu HDMI, vyberie sa maximálna veľkosť obrázku.

[Frame Rate 1], [Frame Rate 2], [Frame Rate 3]
Nastaví snímkovú frekvenciu snímky.
Jednotky „fps“ označujú počet streamovaných snímok za sekundu.
Dostupné možnosti snímkovej frekvencie sa budú líšiť v závislosti od veľkosti obrázku výstupu HDMI.

Poznámka
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Keď sa zmení veľkosť obrázku alebo systémová frekvencia výstupu HDMI, vyberie sa maximálna snímková frekvencia.

[I-Picture Mode 1], [I-Picture Mode 2]
Vyberie metódu určenia intervalu vkladania I-picture pre H.264 a H.265 z [Time] alebo [Frame].
Nie je možné nastaviť pre [Codec 3].
[Time]: Nastaví interval vkladania I-picture ako čas.
[Frame]: Nastaví interval vkladania I-picture ako počet snímok.
[I-Picture Interval 1], [I-Picture Interval 2]
Nastaví interval vkladania I-picture v jednotkách sekúnd. Nastavuje hodnotu v rozsahu 1 sekunda až 5 sekúnd.
Predvolená hodnota je 1 sekunda.
Nie je možné nastaviť pre [Codec 3].
[I-Picture Ratio 1], [I-Picture Ratio 2]
Nastaví interval vkladania I-picture pre H.264 a H.265 ako počet snímok v rozsahu 15 až 300. Predvolená hodnota je
300 snímkov.
Nie je možné nastaviť pre [Codec 3].
[Profile 1], [Profile 2]
Nastaví profil obrazu kodeku H.264 alebo H.265.
[H.264]: Vyberte profil [high], [main] alebo [baseline].
[H.265]: Vyberte profil [main] alebo [main10]. Keď sú povolené dva videokodeky, je k dispozícii iba možnosť výberu
profilu [main].
Účinnosť kompresie snímky sa zvyšuje v poradí [high], [main] a [baseline]. Vyberte profil podporovaný vaším systémom.
Keď je [H.265] nastavené na [main10], prevádzka je v [main10], keď HDMI výstup je YCrCb alebo v [main], keď HDMI
výstup je RGB.
Nie je možné nastaviť pre [Codec 3].
[Bit Rate Compression Mode 1], [Bit Rate Compression Mode 2]
Vyberte [CBR] alebo [VBR].
Ak chcete zachovať konštantnú prenosovú rýchlosť, vyberte [CBR]. Ak chcete zachovať kvalitu snímky, vyberte [VBR].
Nie je možné nastaviť pre [Codec 3].

Poznámka

Skutočná rýchlosť snímania a prenosová rýchlosť sa môžu líšiť od nastavených hodnôt v závislosti od veľkosti obrázku, scény
snímania, sieťového prostredia a ďalších faktorov.

Keď je [Stream] > [Stream Setting] > [Setting] nastavené na [RTMP], [SRT-Caller] alebo [SRT-Listener], [Bit Rate Compression
Mode 1] je nastavené na [CBR] (napevno).

[Bit Rate 1], [Bit Rate 2]
Môžete nastaviť prenosovú rýchlosť na video stream, keď je [Bit Rate Compression Mode] nastavené na [CBR].
Nastavenie vysokej prenosovej rýchlosti vám umožní streamovať video vo vysokej obrazovej kvalite.
Nie je možné nastaviť pre [Codec 3].
[Quality 1], [Quality 2], [Quality 3]
Nastaví kvalitu snímky v rozsahu 1 až 10. Hodnota 10 nastavuje najvyššiu kvalitu snímky. Predvolená hodnota je 6.
Pre [Quality 1] a [Quality 2] môžete nastaviť kvalitu obrazu H.264 nastavením [Bit Rate Compression Mode] na [VBR]
a [Codec] na [H.264]. Kvalitu obrazu H.265 môžete nastaviť nastavením [Bit Rate Compression Mode] na [VBR]
a [Codec] na [H.265].
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Nastavenie zvukového kodeku pre streamovanie

Nastavte zvukový kodek pomocou [Stream] > [Audio Stream] vo webovej ponuke.
[Setting]
Ak chcete povoliť zvukové streamovanie, nastavte na On.

Poznámka

Ak chcete vybrať RTMP, vždy vopred nastavte možnosť On.

[Codec]
Vyberie typ kodeku, ktorý sa použije na streamovanie zvuku.
[AAC (256kbps)]: Vyberte, ak chcete uprednostniť kvalitu zvuku.
[AAC (128kbps)]: Vyberte, ak chcete uprednostniť dátovú kapacitu.
Toto nastavenie nemá vplyv na klip zaznamenaný zariadením ani na zvukový signál vložený do signálu HDMI/SDI.

5-041-959-13(1) Copyright 2022 Sony Corporation
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Spustenie/zastavenie streamovania

Pre [RTSP], [SRT-Listener] a [NDI|HX]

Jednotka čaká na požiadavku na doručenie streamingu.
Spustite klientsku aplikáciu na sledovanie streamovania a prejdite na adresu URL zobrazenú v nasledujúcej tabuľke.
Zadajte hodnoty pre meno používateľa a heslo, ktoré sú nakonfigurované na jednotke.

<camera_address>: IP adresa jednotky
<Port>: Konfigurácia portu prijímača pomocou [Port Number]

Poznámka

Prehrávanie vo všetkých aplikáciách alebo zariadeniach nie je zaručené.

Pre [RTMP] a [SRT-Caller]

Pre spustenie streamovania stlačte tlačidlo [Stream now] na karte  (Stream) na živej prevádzkovej obrazovke.
Označenie tlačidla sa zmení na [Stop stream] a v hornej časti obrazového panela kamery sa zobrazí ikona [Stream].
Stlačením tlačidla [Stop stream] počas streamovania zastavíte streamovanie. Označenie tlačidla sa zmení späť na
[Stream now] a v hornej časti obrazového panela kamery zmizne ikona [Stream].

Poznámka

Prehrávanie vo všetkých aplikáciách alebo zariadeniach nie je zaručené.

5-041-959-13(1) Copyright 2022 Sony Corporation

Formát streamovania Adresa URL

RTSP
Video Stream 1 rtsp://<camera_address>:<Port>/video1

Video Stream 2 rtsp://<camera_address>:<Port>/video2

SRT-Listener srt://<camera_address>:<Port>

NDI|HX Pozrite si návod na obsluhu pre klientske zariadenie kompatibilné s NDI|HX.
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Obrazovka s miniatúrami

Keď stlačíte tlačidlo [Thumbnail] na obrazovke prehrávania alebo tlačidlo THUMBNAIL na infračervenom diaľkovom
ovládači, klipy zaznamenané na pamäťovej karte sa zobrazia na obrazovom paneli kamery. Táto obrazovka na
obrazovom paneli kamery sa označuje ako obrazovka s miniatúrami.
Môžete zvoliť klip na obrazovke s miniatúrami a spustiť jeho prehrávanie.
Stlačením tlačidla [Thumbnail] počas zobrazenia obrazovky miniatúr zatvoríte obrazovku miniatúr a vrátite sa
k zobrazeniu snímaného obrazu.

Poznámka

Na obrazovke s miniatúrami sa zobrazia iba klipy zaznamenané v aktuálne zvolenom formáte záznamu. Ak sa očakávaný
zaznamenaný klip nezobrazí, skontrolujte formát záznamu. Pred formátovaním (inicializáciou) média si túto skutočnosť všimnite.

Rozloženie obrazovky

Miniatúra vybraného klipu sa zobrazí s oranžovým pozadím.
Informácie o vybranom klipe sa zobrazia v spodnej časti obrazovky.
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Vybraná pamäťová karta
Ak je pamäťová karta chránená proti zápisu, na pravej strane sa zobrazí ikona zámku.

1.

Číslo klipu/celkový počet klipov2.

Miniatúra (indexový obrázok)
Zobrazí indexový obrázok klipu. Pri zaznamenávaní klipu sa jeho prvý rámček automaticky nastaví ako indexový
obrázok.
Informácie o klipe/rámčeku sa zobrazia pod miniatúrou. Zobrazené informácie môžete zmeniť pomocou [Thumbnail]
> [Customize View] > [Thumbnail Caption] v ponuke kamery.

3.

Názov klipu
Zobrazí názov vybraného klipu.

4.

Formát záznamu
Zobrazí formát súboru vybraného klipu.

5.

Špeciálne informácie o zázname
Zobrazí režim nahrávania, iba ak bol klip zaznamenaný v špeciálnom režime nahrávania.
V prípade klipov Slow & Quick Motion sa snímková frekvencia zobrazuje vpravo.

6.

Trvanie klipu7.

Dátum vytvorenia8.
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Prehrávanie nahraných klipov

Zaznamenané klipy môžete prehrávať, keď je jednotka v pohotovostnom režime (Stby) záznamu.
Táto téma popisuje, ako prehrať nahrané klipy pomocou ovládacieho panela GUI.

Vložte pamäťovú kartu, ktorú chcete prehrať.1

Stlačte tlačidlo [Thumbnail].

Zobrazia sa miniatúry klipov.

2

Pomocou tlačidiel so šípkami na ovládacom paneli GUI presuňte kurzor na miniatúru klipu, ktorý chcete
prehrať.

3
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Poznámka

Na hranici medzi klipmi môže dôjsť k chvíľkovému rozpadu obrazu alebo k zobrazeniu statického obrazu. Počas tohto obdobia
nemôžete jednotku ovládať.

Poznámka

Klipy nie je možné vyberať dotykovým ovládaním.

Stlačte tlačidlo [Set] na ovládacom paneli GUI.

Prehrávanie sa začne od začiatku zvoleného klipu.

4

Podľa potreby ovládajte ovládací panel prehrávania.

Rada

Prevádzku môžete ovládať aj pomocou ovládacieho panelu GUI.

Prehrať: Stlačte tlačidlo [Set].
Pozastavenie prehrávania: Počas prehrávania stlačte tlačidlo [Set]. Opätovným stlačením sa vrátite k normálnemu
prehrávaniu.
Preskočenie na začiatok klipu/začiatok ďalšieho klipu: Stlačte ľavé/pravé tlačidlo.
Rýchly posun dozadu/dopredu: Stlačte a podržte ľavé/pravé tlačidlo. Po uvoľnení tlačidla sa prehrávanie vráti na
normálnu rýchlosť.
Zastavenie prehrávania: Stlačte tlačidlo [Cancel/Back].

5

Tlačidlo Funkcia

Tlačidlo  (Prehrávanie/Pauza) Prehrá klip. Počas prehrávania pozastaví klip.

Tlačidlo  (Rýchly posun dopredu), tlačidlo
 (Rýchly posun dozadu)

Prehráva klip vysokou rýchlosťou. Po stlačení tlačidla sa
rýchlosť prehrávania zmení v troch krokoch.

Tlačidlo  (Predchádzajúci), tlačidlo 
(Nasledujúci)

Preskočí na začiatok klipu alebo predchádzajúci/nasledujúci
klip.

Tlačidlo  (Stop) Zastaví prehrávanie a prepne na obrazovku snímania.
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Keď vyberiete klip na obrazovke s miniatúrami a začnete prehrávať, môže sa na začiatku klipu vyskytnúť chvíľkové skreslenie
obrazu. Ak chcete zobraziť začiatok klipu bez skreslenia, pozastavte prehrávanie, stlačením tlačidla  (Predchádzajúci) sa
vráťte na začiatok klipu a znova spustite prehrávanie.
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Operácie s nahratými klipmi

Na obrazovke s miniatúrami môžete klipy ovládať alebo skontrolovať ich vlastnosti pomocou ponuky [Thumbnail]
v ponuke kamery.
Stlačením tlačidla [Menu] na prevádzkovej obrazovke prehrávania zobrazíte ponuku kamery na obrazovom paneli
kamery.
Pomocou ponuky [Thumbnail] v ponuke kamery môžete vykonávať nasledujúce operácie.
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Rada

Ponuku kamery môžete zobraziť aj stlačením tlačidla [Menu] na živej prevádzkovej obrazovke.

Operácie pomocou ponuky [Thumbnail] v ponuke kamery
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Vyberte funkciu, ktorú chcete spustiť, pomocou tlačidiel so šípkami na ovládacom paneli GUI a stlačte tlačidlo [Set].
Stlačením tlačidla [Cancel/Back] sa vrátite na predchádzajúcu obrazovku.

Poznámka

Niektoré položky nie je možné zvoliť v závislosti od stavu, kedy bola zobrazená ponuka.

Položky ponuky pre operácie s klipmi

Ponuka [Thumbnail] v ponuke kamery obsahuje nasledujúce položky ponuky týkajúce sa operácií s klipmi.
[Display Clip Properties]
[Set Clip Flag]
[Lock/Unlock Clip]
[Delete Clip]
[Transfer Clip]
[Transfer Clip (Proxy)]
[Filter Clips]
[Customize View]

Podrobnosti o každej položke ponuky nájdete v „ponuke [Thumbnail]“.

Zobraziť obrazovku vlastností klipu
Výberom [Thumbnail] > [Display Clip Properties] v ponuke kamery zobrazíte obrazovku s vlastnosťami klipu.
Stlačením tlačidla  (Predchádzajúci) alebo  (Nasledujúci) preskočíte na predchádzajúci/nasledujúci klip.

Pridať označenia klipu
Do klipov môžete pridať označenia klipu (značky OK, NG alebo KP) pre filtrovanie zobrazovania klipov na základe
označenia klipu.
Vyberte miniatúru klipu, ku ktorému chcete pridať označenie klipu, a potom vyberte označenie klipu pomocou
[Thumbnail] > [Set Clip Flag] v ponuke kamery.

Rada

Môžete tiež použiť priraditeľné tlačidlo priradené k funkcii označenia klipu na pridanie označení klipu.

Zobraziť filtrovanú obrazovku s miniatúrami klipov
V ponuke kamery vyberte položku [Thumbnail] > [Filter Clips] a vyberte typ označenia klipu, aby sa zobrazili iba klipy,
ktoré majú zadané označenie.
Ak chcete zobraziť všetky klipy, vyberte [All].
Môžete tiež stlačiť tlačidlo [Display] a zoradiť zobrazenie miniatúr podľa označenia.

Odstrániť klipy
Klipy môžete odstrániť z pamäťových kariet.
Vyberte [Thumbnail] > [Delete Clip] > [Select Clip] alebo [All Clips] v ponuke kamery.
[Select Clip]: Odstráni vybratý klip. Je podporovaný výber viacerých klipov.
[All Clips]: Vymaže všetky zobrazené klipy.

Zmeniť informácie zobrazené na obrazovke miniatúr

Nastavenie Pridané označenie klipu

[Add OK] OK

[Add NG] NG

[Add KEEP] KP
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Môžete zmeniť informácie o klipe/rámčeku zobrazené pod miniatúrou.
Výberom [Thumbnail] > [Customize View] > [Thumbnail Caption] v ponuke kamery a vyberte informácie, ktoré chcete
zobraziť.
[Date Time]: Zobrazuje dátum a čas vytvorenia klipu a jeho poslednej úpravy.
[Time Code]: Zobrazuje časový kód.
[Duration]: Zobrazuje trvanie klipu.
[Sequential Number]: Na každej miniatúre zobrazí poradové číslo.
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Konfigurácia ponuky kamery

Po stlačení tlačidla [Menu] na ovládacom paneli GUI alebo tlačidla MENU na infračervenom diaľkovom ovládači sa na
obrazovom paneli kamery zobrazí ponuka kamery na konfiguráciu rôznych požadovaných nastavení pre snímanie
a prehrávanie.

Ponuka obsahuje nasledujúce ponuky.

Konfigurácia ponuky

Ponuka [User]
Obsahuje položky ponuky nakonfigurované používateľom.
Dá sa upraviť pomocou [Edit User Menu].
Ponuka [Edit User]
Obsahuje položky ponuky na úpravu ponuky [User].
Ponuka [Shooting]
Obsahuje nastavenia týkajúce sa snímania.
Ponuka [Project]
Obsahuje základné nastavenia projektu.
Ponuka [Paint/Look]
Obsahuje nastavenia týkajúce sa kvality obrazu.
Ponuka [Pan-Tilt]
Obsahuje nastavenia týkajúce sa otáčania/nakláňania.
Ponuka [TC/Media]
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Obsahuje nastavenia týkajúce sa časových kódov a záznamových médií.
Ponuka [Monitoring]
Obsahuje nastavenia týkajúce sa výstupu videa a zobrazenia na obrazovke.
Ponuka [Audio]
Obsahuje nastavenia týkajúce sa zvuku.
Ponuka [Thumbnail]
Obsahuje nastavenia týkajúce sa zobrazenia miniatúr.
Ponuka [Technical]
Obsahuje nastavenia pre technické položky.
Ponuka [Network]
Obsahuje nastavenia týkajúce sa sietí.
Ponuka [Maintenance]
Obsahuje nastavenia zariadení, ako sú hodiny a jazyk.

Konfigurácia a hierarchia ponuky kamery

Úroveň 1 Úroveň 2

User
(Továrenské nastavenia)

Base Setting

Focus

S&Q Motion

LUT On/Off

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

Assignable Button

Scene File

Base Look

P/T Acceleration

Clip Name Format

Format Media

Video Signal Monitor

Marker

Zoom

Lens

Edit User Menu
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Úroveň 1 Úroveň 2

Shooting

ISO/Gain/EI

ND Filter

Shutter

Iris

Auto Exposure

White

White Setting

Offset White

Focus

S&Q Motion

LUT On/Off

Noise Suppression

Flicker Reduce

SteadyShot

Project

Base Setting

Rec Format

Cine EI/Flex.ISO Set

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

SDI/HDMI Rec Control

Assignable Button

Paint/Look

Scene File

Base Look

Reset Paint Settings

Black

Knee

Detail

Matrix

Multi Matrix
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Úroveň 1 Úroveň 2

Pan-Tilt P/T Acceleration

TC/Media

Timecode

TC Display

Users Bit

HDMI TC Out

Clip Name Format

Update Media

Format Media

Media Life

Monitoring

Output Format

Display On/Off

Video Signal Monitor

Marker

Audio
Audio Input

Audio Output

Thumbnail

Display Clip Properties

Set Clip Flag

Lock/Unlock Clip

Delete Clip

Transfer Clip

Transfer Clip (Proxy)

Filter Clips

Customize View

Technical

Color Bars

Genlock

Tally

Rec Review

Zoom

Lens

APR
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Úroveň 1 Úroveň 2

Network
Wired LAN

File Transfer

Maintenance

Language

Clock Set

Hours Meter
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Ovládanie ponuky kamery

Po stlačení tlačidla [Menu] na ovládacom paneli GUI alebo tlačidla MENU na infračervenom diaľkovom ovládači sa na
obrazovom paneli kamery zobrazí ponuka kamery na konfiguráciu rôznych požadovaných nastavení pre snímanie
a prehrávanie.
Ponuka sa ovláda pomocou tlačidiel na ovládacom paneli GUI.

Tlačidlo [Menu]: Stlačením tlačidla zobrazíte ponuku kamery. Opätovným stlačením počas zobrazenia ponuky kamery
ponuku skryjete.
Tlačidlá so šípkami: Pomocou tlačidiel so šípkami posúvajte kurzor nahor/nadol/doľava/doprava v ponuke kamery
a vyberáte položky ponuky alebo nastavenia.
Tlačidlo [Set]: Stlačením aktivujete vybranú položku.
Tlačidlo [Cancel/Back]: Stlačte pre návrat do predchádzajúcej ponuky. Nedokončená zmena je zrušená.

Poznámka

Niektoré položky nie je možné zvoliť v závislosti od stavu, kedy bola zobrazená ponuka.

Nastavenie položiek ponuky

Presuňte kurzor na položku, ktorú chcete nastaviť, pomocou tlačidiel so šípkami na ovládacom paneli GUI a stlačením
tlačidla [Set] použite nastavenie.

Oblasť výberu položky ponuky zobrazuje až osem riadkov. Ak nie je možné zobraziť dostupné možnosti pre položku
súčasne, posúvajte displej pohybom kurzora nahor/nadol.
Pre podpoložky s veľkým rozsahom nastavení (napríklad −99 až +99) sa oblasť nastavení nezobrazí. Aktuálne
nastavenie je zvýraznené, čo naznačuje, že hodnotu je možné zmeniť.
Výberom [Execute] pre funkciu sa vykoná príslušná funkcia.
Výber položky, ktorá si pred vykonaním vyžaduje potvrdenie, dočasne skryje ponuku a zobrazí potvrdzujúcu správu.
Skontrolujte správu a potom vyberte, či sa má funkcia vykonať alebo zrušiť.

5-041-959-13(1) Copyright 2022 Sony Corporation
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Zadanie znakového reťazca

Keď vyberiete položku, napríklad názov súboru, ktorý vyžaduje zadávanie znakov, zobrazí sa obrazovka pre zadávanie
znakov.
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Pomocou tlačidiel so šípkami na ovládacom paneli GUI vyberte typ znaku a použite nastavenie.

[ABC]: Veľké abecedné znaky
[abc]: Malé abecedné znaky
[123]: Číselné znaky
[!#$]: Špeciálne znaky

1

Vyberte znak a stlačte tlačidlo [Set], aby ste použili nastavenie.

Kurzor sa presunie na ďalšie pole.
[Space]: Vloží znak medzery na pozíciu kurzora.
[←] [→]: Presunie polohu kurzora.
[BS]: Vymaže znak naľavo od kurzora (backspace).

2

Po dokončení stlačte tlačidlo [Done] a použite nastavenie.

Reťazec znakov sa potvrdí a obrazovka na zadávanie znakov zmizne.

3
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

User

Táto téma popisuje funkcie a nastavenia každej položky ponuky.

Poznámka

Položky ponuky v ponuke [User] môžete pridávať a odstraňovať pomocou ponuky [Edit User]. Konfigurovať možno až 20
položiek.
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Položka Popis

Base Setting Project > Base Setting položka

Focus Shooting > Focus položka

S&Q Motion Shooting > S&Q Motion položka

LUT On/Off Shooting > LUT On/Off položka

Simul Rec Project > Simul Rec položka

Proxy Rec Project > Proxy Rec položka

Interval Rec Project > Interval Rec položka

Picture Cache Rec Project > Picture Cache Rec položka

Assignable Button Project > Assignable Button položka

Scene File Project > Scene File položka

Base Look Paint/Look > Base Look položka

P/T Acceleration Pan-Tilt > P/T Acceleration položka

Clip Name Format TC/Media > Clip Name Format položka

Format Media TC/Media > Format Media položka

Video Signal Monitor Monitoring > Video Signal Monitor položka

Marker Monitoring > Marker položka

Zoom Technical > Zoom položka

Lens Technical > Lens položka

Edit User Menu Zobrazí ponuku Edit User.
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Edit User

Ponuka [Edit User] sa zobrazí na najvyššej úrovni, keď je v ponuke [Edit User Menu] vybratá položka [User].
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Položka Nastavenie
podpoložky

Predvolené
nastavenie
z výroby

Popis

Add Item
Pridať položku do
ponuky [User]

– – Pridá položku 2. úrovne ponuky do ponuky [User].

Customize Reset
Obnovenie položky
v ponuke [User]

– –
Obnoví výrobné nastavenia položiek ponuky
zaregistrovaných v ponuke [User].

Položka 2. úrovne
ponuky vybratá počas
úprav

Delete –
Vymaže zaregistrovanú položku 2. úrovne ponuky
z ponuky [User].

Move –
Zmení usporiadanie zaregistrovaných položiek
ponuky v ponuke [User].

Edit Sub Item –
Upravuje (registrácia/odstránenie) zaregistrovanej
podpoložky 3. úrovne ponuky v ponuke [User].
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Interchangeable Lens Digital Camera
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ISO/Gain/EI

Nastavenie zosilnenia.

Položka Nastavenie podpoložky Predvolené nastavenie
z výroby Popis

Mode ISO/dB dB
Vyberie režim nastavenia
zosilnenia.

ISO/Gain<L>

Podrobnosti o nastaveniach nájdete
v časti „ISO/Gain Nastavenia
a predvolené hodnoty“.

–
Nastaví prednastavenú
hodnotu zosilnenia <L>.

Exposure
Index<L>

Ak je Base ISO nastavené na ISO 800:
200EI / 4.0E
250EI / 4.3E
320EI / 4.7E
400EI / 5.0E
500EI / 5.3E
640EI / 5.7E
800EI / 6.0E
1000EI / 6.3E
1250EI / 6.7E
1600EI / 7.0E
2000EI / 7.3E
2500EI / 7.7E
3200EI / 8.0E
Ak je Base ISO nastavené na ISO
12800:
3200EI / 4.0E
4000EI / 4.3E
5000EI / 4.7E
6400EI / 5.0E
8000EI / 5.3E
10000EI / 5.7E
12800EI / 6.0E
16000EI / 6.3E
20000EI / 6.7E
25600EI / 7.0E
32000EI / 7.3E
40000EI / 7.7E
51200EI / 8.0E

Ak je Base ISO
nastavené na ISO 800:
800EI / 6.0E
Ak je Base ISO
nastavené na ISO
12800: 12800EI / 6.0E

Nastavuje hodnotu Exposure
Index<L>.

Shockless
Gain

On / Off Off
Zapína/vypína funkciu
bezskokového zosilnenia.

Base
Sensitivity

High / Low Low
Nastavuje základnú citlivosť
pre režim Custom.
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Súvisiaca téma

Nastavenia ISO/Gain a predvolené hodnoty
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Položka Nastavenie podpoložky Predvolené nastavenie
z výroby Popis

Base ISO ISO 12800 / ISO 800 ISO 800
Nastavuje základnú citlivosť
ISO pre režim Cine
EI/Flexible ISO.
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ND Filter

Nastavuje prednastavené hodnoty pre ND filter.
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Položka Nastavenie podpoložky Predvolené nastavenie
z výroby Popis

Mode Preset / Variable Variable Vyberie režim ND filtra.

Preset1
1/4 / 1/8 / 1/16 / 1/32 / 1/64 /
1/128

1/4
Nastavuje prednastavenú hodnotu 1 pre
ND filter.

Preset2
1/4 / 1/8 / 1/16 / 1/32 / 1/64 /
1/128

1/16
Nastavuje prednastavenú hodnotu 2 pre
ND filter.

Preset3 1/4 / 1/8 / 1/16 / 1/32 / 1/64 /
1/128

1/64 Nastavuje prednastavenú hodnotu 3 pre
ND filter.
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Interchangeable Lens Digital Camera
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Shutter

Nastavuje prevádzku elektronickej uzávierky.
Použité na jasné snímanie rýchlo sa pohybujúcich objektov.

Položka Nastavenie podpoložky
Predvolené
nastavenie
z výroby

Popis

Mode Speed / Angle Speed

Vyberie režim pre nastavenie
rýchlosti uzávierky v sekundách
(Speed) alebo ako uhol uzávierky
(Angle).

Shutter
Speed
On/Off

On / Off Off

Nastavuje, či čas expozície, keď je
vybratý režim Speed, sleduje
hodnotu [Shutter Speed] alebo je
nastavený na úplnú expozíciu.

Shutter
Speed

64F až 1/8000
Dostupné nastavenia sa líšia v závislosti od
frekvencie snímok zvoleného formátu videa.
59.94P: 64F / 32F / 16F / 8F / 7F / 6F / 5F /
4F / 3F / 2F / 1/50 / 1/60 / 1/100 / 1/120 /
1/125 / 1/250 / 1/500 / 1/1000 / 1/2000 /
1/4000 / 1/8000
50P: 64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F /
3F / 2F / 1/50 / 1/60 / 1/100 / 1/120 / 1/125 /
1/250 / 1/500 / 1/1000 / 1/2000 / 1/4000 /
1/8000
29.97P: 64F / 32F / 16F / 8F / 7F / 6F / 5F /
4F / 3F / 2F / 1/30 / 1/40 / 1/50 / 1/60 / 1/100 /
1/120 / 1/125 / 1/250 / 1/500 / 1/1000 / 1/2000
/ 1/4000 / 1/8000
25P: 64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F /
3F / 2F / 1/25 / 1/33 / 1/50 / 1/60 / 1/100 /
1/120 / 1/125 / 1/250 / 1/500 / 1/1000 / 1/2000
/ 1/4000 / 1/8000
24P/23.98P: 64F / 32F / 16F / 8F / 7F / 6F /
5F / 4F / 3F / 2F / 1/24 / 1/32 / 1/48 / 1/50 /
1/60 / 1/96 / 1/100 / 1/120 / 1/125 / 1/250 /
1/500 / 1/1000 / 1/2000 / 1/4000 / 1/8000

59.94P:
1/60
50P: 1/50
29.97P: 1/30
25P: 1/25
24P/23.98P:
1/24

Nastaví rýchlosť uzávierky, keď je
zvolený režim Speed.

Shutter
Angle

64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 3F /
2F / 360.0° / 300.0° / 270.0° / 240.0° / 216.0° /
210.0° / 180.0° / 172.8° / 150.0° / 144.0° /
120.0° / 90.0° / 86.4° / 72.0° / 45.0° / 30.0° /
22.5° / 11.25° / 5.6°

180.0°
Nastaví uhol uzávierky, keď je
zvolený režim Angle.

ECS On/Off On / Off Off
Zapína/vypína funkciu Extended
Clear Scan.
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Položka Nastavenie podpoložky
Predvolené
nastavenie
z výroby

Popis

ECS
Frequency

23.99 až 8000
Dostupné nastavenia sa líšia v závislosti od
frekvencie snímok zvoleného formátu
záznamu.

59.94P: 60.00
50P: 50.00
29.97P: 30.00
23.98P: 23.99
25P: 25.02
24P: 24.02

Nastaví frekvenciu ECS, keď je
Mode nastavený na ECS.
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Iris

Vykoná nastavenia clony.
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Položka Nastavenie
podpoložky

Predvolené nastavenie
z výroby Popis

Bokeh
Control

On / Off Off
Zapnutie/vypnutie funkcie ovládania
bokehu.
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Auto Exposure

Slúži na nastavenie automatického nastavenia expozície.

Položka Nastavenie podpoložky
Predvolené
nastavenie
z výroby

Popis

Level

+3.0 / +2.75 / +2.5 / +2.25 / +2.0 / +1.75 /
+1.5 / +1.25 / +1.0 / +0.75 / +0.5 / +0.25 / ±0
/ −0.25 / −0.5 / −0.75 / −1.0 / −1.25 / −1.5 /
−1.75 / −2.0 / −2.25 / −2.5 / −2.75 / −3.0

±0
Nastavuje úroveň jasu pre
automaticky detegovanú expozíciu.

Mode Backlight / Standard / Spotlight Standard

Nastavuje prevádzkový režim
automatického nastavenia expozície.
Backlight: Režim podsvietenia
(režim zníženia stmavnutia objektu,
keď je objekt v protisvetle)
Standard: Štandardný režim
Spotlight: Režim bodového svetla
(režim pre zníženie orezania bielej,
keď je objekt osvetlený bodovým
svetlom)

Speed −99 až +99 ±0
Nastavuje rýchlosť úpravy
automatického nastavenia expozície.

AGC On / Off Off
Zapína/vypína funkciu AGC
(automatické riadenie zosilnenia).

AGC Limit

Podrobnosti o nastaveniach nájdete
v časti „AGC Limit Nastavenia
a predvolené hodnoty“.

–
Nastavuje maximálne zosilnenie
funkcie AGC.

AGC Point F2.8 / F4 / F5.6 F2.8
Nastavuje hodnotu F-stop clony, pri
ktorej sa spustí prevádzka AGC, keď
je funkcia AGC nastavená na On.

Auto
Shutter

On / Off Off
Zapína/vypína funkciu automatického
ovládania uzávierky.

A.SHT Limit 1/100 / 1/150 / 1/200 / 1/250 / 1/2000 1/2000
Nastavuje najvyššiu rýchlosť
uzávierky funkcie automatickej
uzávierky.

A.SHT Point F5.6 / F8 / F11 / F16 F11
Nastavuje hodnotu clony F-stop
clony, kde sa spustí automatická
uzávierka.
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Súvisiaca téma

Nastavenia AGC Limit a predvolené hodnoty
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Položka Nastavenie podpoložky
Predvolené
nastavenie
z výroby

Popis

Clip High
light

On / Off Off

Zapína/vypína funkciu, ktorá ignoruje
najjasnejšie oblasti, a poskytuje tak
plochejšiu odozvu pri vysokej
svietivosti.

Detect
Window

1 / 2 / 3 / 4 / 5 / 6 / Custom 1

Nastavuje rozsah merania svetla na
automatické nastavenie expozície
podľa jasu objektu. (Nie je k
dispozícii pri manuálnom nastavení
expozície)

Detect
Window
Indication

On / Off Off
Zapína/vypína indikáciu rozsahu
merania svetla.

Custom
Width

40 až 999 500
Nastavuje šírku rozsahu merania
svetla.

Custom
Height

70 až 999 500
Nastavuje výšku rozsahu merania
svetla.

Custom H
Position

−479 až +479 ±0
Nastavuje vodorovnú polohu rozsahu
merania svetla.

Custom V
Position

−464 až +464 ±0
Nastavuje vertikálnu polohu rozsahu
merania svetla.
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White

Nastavuje vyváženie bielej.
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Položka Nastavenie
podpoložky

Predvolené
nastavenie

z výroby
Popis

Preset
White

2000K až
15000K

3200K Nastavuje prednastavenú hodnotu vyváženia bielej.

Color
Temp <A>

2000K až
15000K

3200K

Nastavuje farebnú teplotu vyváženia bielej uloženú v pamäti A.

Poznámka

Pretože Color Temp je orezané na 2000K a 15000K počas
činnosti R Gain/B Gain nemusí byť možné zobraziť správnu
hodnotu Color Temp pre hodnotu R Gain/B Gain.

Tint<A> −99 až +99 ±0

Nastavuje hodnotu odtieňa vyváženia bielej uloženú v bielej
pamäti A.

Poznámka

Pretože Tint je orezaný na ±99 počas operácie R Gain/B Gain,
nemusí byť možné zobraziť správnu hodnotu odtieňa farby pre
danú hodnotu R Gain/B Gain.

R Gain
<A>

−99.0 až +99.0 ±0.0
Nastavuje hodnotu zosilnenia vyváženia bielej R uloženú
v pamäti A.

B Gain
<A>

−99.0 až +99.0 ±0.0
Nastavuje hodnotu zosilnenia vyváženia bielej B uloženú
v pamäti A.
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White Setting

Upravuje nastavenie vyváženia bielej.
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Položka Nastavenie
podpoložky

Predvolené nastavenie
z výroby Popis

Shockless
White

Off / 1 / 2 / 3 2

Nastavuje rýchlosť odozvy vyváženia bielej pri
prepínaní režimu vyváženia bielej.
Off: Prepína sa okamžite.
1 až 3: Čím vyššie číslo, tým pomalšie sa prepína.

ATW Speed 1 / 2 / 3 / 4 / 5 3
Nastavuje rýchlosť odozvy v režime ATW.
Najvyššia rýchlosť odozvy je 1 a najnižšia rýchlosť
odozvy je 5.
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Offset White

Nastavuje posun vyváženia bielej.
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Položka Nastavenie
podpoložky

Predvolené
nastavenie

z výroby
Popis

Offset White <A> On / Off Off
Vyberie, či sa má k vyváženiu bielej v pamäti A pridať
(On) alebo nepridať (Off) hodnota posunu.

Offset Color
Temp<A>

−99 až +99 ±0
Nastavuje posunutie farebnej teploty, ktoré sa pripočíta
k vyváženiu bielej v pamäti A, keď je položka [Offset
White <A>] nastavená na On.

Offset Tint<A> −99 až +99 ±0
Nastaví posun hodnoty odtieňa, ktorý sa pripočíta
k vyváženiu bielej v pamäti A, keď je položka [Offset
White <A>] nastavená na On.

Offset
White<ATW>

On / Off On
Vyberie, či sa má k vyváženiu bielej ATW pridať (On)
alebo nepridať (Off) hodnota posunu.

Offset Color
Temp<ATW>

−99 až +99 ±0
Nastaví posun farebnej teploty, ktorý sa má pridať
k vyváženiu bielej ATW, keď je [Offset White<ATW>]
nastavené na On.

Offset
Tint<ATW>

−99 až +99 ±0
Nastaví posun hodnoty odtieňa, ktorý sa má pridať k
vyváženiu bielej ATW, keď je [Offset White<ATW>]
nastavené na On.
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Focus

Nastavuje zaostrovanie.

Položka Nastavenie
podpoložky

Predvolené
nastavenie
z výroby

Popis

AF
Transition
Speed

1(Slow) / 2 / 3 / 4 /
5 / 6 / 7(Fast)

5
Nastavuje rýchlosť zaostrenia, keď sa objekt zmení počas
automatického zaostrovania.

AF Subj.
Shift Sens.

1(Locked On) / 2 /
3 / 4 /
5(Responsive)

5(Responsive)
Nastavuje citlivosť na zmenu zaostrenia objektu počas
automatického zaostrovania.

Focus Area
Wide / Zone /
Flexible Spot

Wide

Nastavuje cieľovú oblasť pre automatické zaostrenie
a vynútené automatické zaostrenie (AF) .

Pozrite si časti „Automatické nastavenie zaostrenia
(Auto Focus)“ a „Nastavenie oblasti/polohy
automatického zaostrenia (Focus Area)“.

Wide: Pri zaostrovaní vyhľadá objekt v širokom uhle
záberu.
Zone: Automaticky vyhľadá polohu zaostrenia v rámci
zadanej zóny.
Flexible Spot: Zaostruje na zadanú pozíciu v obraze.

Focus Area
(AF-S)

Flexible Spot Flexible Spot
Nastavuje cieľovú oblasť pre vynútené automatické
zaostrovanie (AF-S).

Face/Eye
Detection
AF

Face/Eye Only AF /
Face/Eye Priority
AF / Off

Face/Eye Priority
AF

Zapína/vypína automatické zaostrovanie s detekciou tváre.

Pozrite si „Sledovanie pomocou detekcie tváre a očí
(Face/Eye Detection AF)“.

Push AF
Mode

AF / Single-shot
AF(AF-S)

AF Nastavuje režim vynúteného automatického zaostrovania.

Touch
Function in
MF

Tracking AF / Spot
Focus

Tracking AF
Nastaví operáciu pri dotyku obrazu kamery na živej
prevádzkovej obrazovke webovej aplikácie v režime MF.

AF Assist On / Off On

Pri nastavení na On vám umožní dočasne prepísať
automatické zaostrovanie a nastaviť zaostrovanie
manuálne.

Pozrite si „Manuálne nastavenie automatického
zaostrenia (AF Assist) pomocou webovej aplikácie“
a „Manuálne zaostrenie počas automatického zaostrenia
pomocou dodávaného infračerveného diaľkového
ovládača“.
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Súvisiaca téma
Nastavenie oblasti/polohy automatického zaostrenia (Focus Area)

Sledovanie pomocou detekcie tváre a očí (Face/Eye Detection AF)

Manuálne nastavenie automatického zaostrenia (AF Assist) pomocou webovej aplikácie

Manuálne zaostrenie počas automatického zaostrenia pomocou dodávaného infračerveného diaľkového ovládača
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S&Q Motion

Nastavuje režim pre pomalý a rýchly pohyb (pozrite si časť „Slow & Quick Motion“).

Súvisiaca téma

Slow & Quick Motion
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Položka Nastavenie podpoložky
Predvolené
nastavenie

z výroby
Popis

Setting On / Off Off
Zapína/vypína režim pre pomalý a rýchly
pohyb.

Frame
Rate

1fps až 60fps / 100fps / 120fps /
150fps / 180fps / 200fps / 240fps

–

Nastavuje rýchlosť snímania pre snímanie
spomaleného a rýchleho pohybu.

Poznámka

Dostupné nastavenia sa líšia v závislosti od
zvolenej systémovej frekvencie, kodeku
a formátu videa.

308



Sprievodca s nápovedou
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LUT On/Off

Nastavuje LUT.
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Položka Nastavenie podpoložky Predvolené
nastavenie z výroby Popis

SDI MLUT On / MLUT Off MLUT Off
Vyberie, či sa má použiť Monitor LUT na
výstupné video SDI.

HDMI/Stream MLUT On / MLUT Off MLUT Off
Vyberie, či sa má použiť Monitor LUT na
HDMI a streamovanie výstupného videa.

Proxy MLUT On / MLUT Off MLUT Off
Vyberie, či sa má použiť Monitor LUT pre
nahrávanie zástupného videa.

Internal Rec MLUT On / MLUT Off MLUT Off
Vyberie, či sa má použiť Monitor LUT pre
nahrávanie hlavného videa.

LUT On/Off
Button Target

SDI / HDMI/Stream / SDI
a HDMI/Stream

HDMI/Stream
Nastavuje cieľový výstup ovládaný
priraditeľným tlačidlom priradeným k LUT
On/Off.
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Noise Suppression

Nastavuje potlačenie hluku.

Rada

Nastavenia [Setting(Custom)] a [Level(Custom)] nastavenia sa prejavia v nastavení [Target Display].
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Položka Nastavenie
podpoložky

Predvolené
nastavenie z výroby Popis

Setting(Custom) On / Off On
Zapína/vypína funkciu potlačenia hluku
v režime Custom.

Level(Custom) Low / Mid / High Mid
Nastavuje úroveň potlačenia hluku v režime
Custom.

Setting (Cine EI/Flex.
ISO)

On / Off Off
Zapína/vypína funkciu potlačenia šumu
v režime Zaznamenávanie snímania.

Level (Cine EI/Flex.
ISO)

Low / Mid / High Mid
Nastavuje úroveň potlačenia šumu v režime
Zaznamenávanie snímania.
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Flicker Reduce

Nastavuje korekciu blikania.
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Položka Nastavenie
podpoložky

Predvolené nastavenie
z výroby Popis

Mode Auto / On / Off Off Nastavuje režim korekcie blikania.

Frequency 50Hz / 60Hz 60Hz
Nastavuje frekvenciu zdroja energie napájajúceho
svetlo, ktoré spôsobuje blikanie.
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Sprievodca s nápovedou
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SteadyShot

Nastavuje stabilizáciu obrazu.
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Položka Nastavenie
podpoložky

Predvolené
nastavenie z výroby Popis

Setting
Active / Standard
/ Off

Off

Nastavuje funkciu stabilizácie obrazu.

Poznámka

Povolené, keď je pripojený kompatibilný objektív.

Pri nastavení na Active alebo Standard sa môže počas funkcie
otáčania/nakláňania vyskytnúť neočakávané správanie.
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
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Base Setting

Nastavuje základné nastavenie.

Súvisiaca téma

Konfigurácia základnej činnosti
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Položka Nastavenie podpoložky Predvolené
nastavenie z výroby Popis

Shooting
Mode

Custom / Flexible ISO /
Cine EI Quick / Cine EI

Custom

Nastaví režim snímania.

Pozrite si časť „Nastavenie režimu snímania“
v časti „Konfigurácia základnej činnosti“.

Target
Display

SDR(BT.709) / HDR(HLG) SDR(BT.709)
Nastavuje farebný rozsah záznamu/výstupu
v režime Custom.
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Interchangeable Lens Digital Camera
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Rec Format

Nastavuje formát záznamu.

Nastavenia [RAW Output Format]

Predvolené hodnoty sú zobrazené tučným písmom.
Podmienky, za ktorých nemožno nastaviť [RAW Output Format], boli vynechané.

Položka Nastavenie podpoložky
Predvolené
nastavenie

z výroby
Popis

Frequency 59.94 / 50 / 29.97 / 25 / 24 / 23.98 59.94 Vyberie systémovú frekvenciu.

Imager Scan
Mode

FF / S35 FF Vyberie veľkosť snímača.

Codec
RAW / RAW & XAVC-I / XAVC-I /
XAVC-L

XAVC-I

Nastaví kodek nahrávania/prehrávania klipu.

Poznámka

Keď je [Imager Scan Mode] nastavené na
[S35], [RAW] a [RAW & XAVC-I] nemožno
vybrať.

RAW Output
Format

Dostupné nastavenia sa líšia
v závislosti od nastavenia
[Frequency].

Pozrite si časť „Nastavenia
[RAW Output Format]“ nižšie.

–

Nastaví veľkosť snímky RAW na výstup do
externého RAW rekordéra.

Poznámka

Keď je [Codec] nastavené na [RAW &
XAVC-I], nastavenie [Video Format] sa
prepne v spojení s nastavením [RAW
Output Format].

Video
Format

Dostupné nastavenia sa líšia
v závislosti od nastavení
[Frequency], [Imager Scan Mode]
a [Codec].

Pozrite si časť „Nastavenia
[Video Format]“ nižšie.

– Nastaví veľkosť obrazu a bitovú rýchlosť.

Frequency Imager Scan Mode Codec Nastavenie

59.94 / 50 / 29.97 / 25 / 23.98 FF RAW / RAW & XAVC-I
4096×2160
3840×2160

24 FF RAW / RAW & XAVC-I 4096×2160
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Nastavenia [Video Format]

Predvolené hodnoty sú zobrazené tučným písmom.
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Frequency Imager Scan Mode Codec Nastavenie

59.94 / 50 / 29.97 / 25 / 23.98

FF

RAW –

RAW & XAVC-I
4096×2160P
3840×2160P

XAVC-I
4096×2160P
3840×2160P
1920×1080P

XAVC-L
3840×2160P
1920×1080P 50
1920×1080P 35

S35

XAVC-I 1920×1080P

XAVC-L
1920×1080P 50
1920×1080P 35

24 FF
RAW –

RAW & XAVC-I / XAVC-I 4096×2160P

315



Sprievodca s nápovedou

Interchangeable Lens Digital Camera
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Cine EI/Flex.ISO Set

Vykoná nastavenia Zaznamenávanie režimu snímania (pozri „Nastavenie režimu snímania“ v časti „Konfigurácia
základnej činnosti“).

Súvisiaca téma

Konfigurácia základnej činnosti
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Položka Nastavenie podpoložky Predvolené nastavenie
z výroby Popis

Color
Gamut

S-Gamut3/SLog3 / S-
Gamut3.Cine/SLog3

S-Gamut3.Cine/SLog3
Nastavenie farebného rozsahu pre záznam
režimov snímania ([Flexible ISO], [Cine EI
Quick], [Cine EI]).

Embed
LUT File

On / Off On
Zapína/vypína nahrávanie metadát súboru 3D
LUT (súbor CUBE).
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
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Simul Rec

Vykoná nastavenia režimu simultánneho nahrávania s 2 zásuvkami (pozrite si „Súčasné nahrávanie na pamäťové karty A
a B. (2-slot Simul Rec)“).
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Položka Nastavenie podpoložky Predvolené
nastavenie z výroby Popis

Setting On / Off Off
Zapína/vypína režim 2-
zásuvkového simultánneho
nahrávania.

Rec
Button
Set

Rec Button:<Slot A> <Slot B> 2nd Rec Button:
<Slot A> <Slot B> / Rec Button:<Slot A> 2nd
Rec Button:<Slot B> / Rec Button:<Slot B>
2nd Rec Button:<Slot A>

Rec Button:<Slot A>
<Slot B> 2nd Rec
Button:<Slot A> <Slot
B>

Priraďuje tlačidlá nahrávania
používané na ovládanie
každého nahrávacieho média.
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
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Proxy Rec

Vykoná nastavenia režimu pre zástupné nahrávanie (pozrite si „Zástupné nahrávanie“).
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Položka Nastavenie
podpoložky

Predvolené nastavenie
z výroby Popis

Setting On / Off Off Zapína/vypína režim zástupného nahrávania.

Audio
Channel

CH1/CH2 /
CH3/CH4

CH1/CH2
Vyberie zvukový kanál, ktorý sa má zaznamenať
do zástupných údajov.
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Interchangeable Lens Digital Camera
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Interval Rec

Vykoná nastavenia režimu pre prerušované nahrávanie (pozrite si „Prerušované nahrávanie videa (Interval Rec)“).
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Položka Nastavenie podpoložky Predvolené nastavenie
z výroby Popis

Setting On / Off Off

Zapína/vypína režim intervalového
nahrávania. (Nastavením tohto
režimu na On nastavíte všetky
ostatné špeciálne režimy na Off.)

Interval
Time

1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15
/ 20 / 30 / 40 / 50 (sek)
1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15
/ 20 / 30 / 40 / 50 (min)
1 / 2 / 3 / 4 / 6 / 12 / 24 (hod)

1

Nastavuje interval medzi nahrávkami
v režime nahrávania Interval Rec
(keď je Interval Rec nastavené na
On).

Number
of Frames

1frame / 2frames / 3frames /
6frames / 9frames / 12frames
Dostupné nastavenia sa líšia
v závislosti od frekvencie snímok
vybraného formátu videa.
59.94P/50P: 2frames / 6frames /
12frames
29.97P/25P/24P/23.98P: 1frame /
3frames / 6frames / 9frames

59.94P/50P: 2frames
29.97P/25P/24P/23.98P:
1frame

Nastavuje počet snímok, ktoré sa
majú zaznamenať pri jednom
snímaní v režime nahrávania Interval
Rec (keď je Interval Rec nastavené
na On).

319



Sprievodca s nápovedou

Interchangeable Lens Digital Camera
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Picture Cache Rec

Vykoná nastavenia režimu nahrávania do vyrovnávacej pamäte obrázkov (pozri „Nahrávanie obrázkov vo vyrovnávacej
pamäti (Picture Cache Rec)“).

Súvisiaca téma
Nahrávanie obrázkov vo vyrovnávacej pamäti (Picture Cache Rec)
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Položka Nastavenie
podpoložky

Predvolené
nastavenie

z výroby
Popis

Setting On / Off Off Zapína/vypína funkciu vyrovnávacej pamäte obrázkov.

Cache Size
Short / Medium /
Long / Max

Max
Nastavuje čas akumulácie obrázkov vo vyrovnávacej
pamäti obrázkov (čas nahrávania vyrovnávacej pamäte
obrázkov).

Cache Rec
Time

– –
Zobrazuje čas akumulácie obrázkov vo vyrovnávacej
pamäti obrázkov (čas nahrávania vyrovnávacej pamäte
obrázkov).
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SDI/HDMI Rec Control

Nastavuje ovládanie nahrávania SDI/HDMI.
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Položka Nastavenie
podpoložky

Predvolené
nastavenie
z výroby

Popis

Setting
Off / SDI/HDMI
Remote I/F /
Parallel Rec

Off

Nastavuje riadenie spustenia a zastavenia záznamu externého
pripojeného zariadenia prostredníctvom výstupného signálu
SDI/HDMI.
Off: Nepoužívať diaľkové ovládanie.
SDI/HDMI Remote I/F: Ovládanie zastavenia a spustenia
záznamu externého pripojeného zariadenia, ak v jednotke nie je
vložené žiadne médium. Nie je synchronizované s presnosťou
snímky na médium v jednotke.
Parallel Rec: Ovládanie zastavenia a spustenia záznamu
externého pripojeného zariadenia, ak v jednotke je vložené
médium. Synchronizované s presnosťou snímky na médiá
v jednotke.

Poznámka

Na ovládanie pomocou výstupného signálu HDMI nastavte
[TC/Media] > [HDMI TC Out] > [Setting] na [On] v ponuke kamery.
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Assignable Button

Nastaví priradenia funkcií priraditeľným tlačidlám (<1> až <9>) a [Focus Hold Button].
Je možné priradiť nasledujúce funkcie.
[Off]: Žiadne priradenie funkcie.
[Base ISO/Sensitivity]: Prepína základnú citlivosť obrazového snímača.
[AGC]: Zapína/vypína funkciu AGC.
[Push AGC]: Aktivuje funkciu AGC, keď je stlačené tlačidlo.
[ND Filter]

V premenlivom režime: Nastavuje priepustnosť ND filtra. Stlačením a podržaním prepínate medzi Clear/Manual/Auto.
V režime predvolieb: Stlačením a podržaním prepnete predvoľby.

[ND Filter Position]: Prepína ND filtre.
[Auto ND Filter]: Zapína/vypína funkciu ND filtra.
[Push Auto ND]: Aktivuje funkciu automatického filtra ND, keď je stlačené tlačidlo.
[Auto Iris]: Zapína/vypína funkciu clony.
[Push Auto Iris]: Aktivuje funkciu automatická clona, keď je stlačené tlačidlo.
[Bokeh Control]: Zapnutie/vypnutie funkcie ovládania režimu bokeh.
[Auto Shutter]: Zapína/vypína funkciu automatickej uzávierky.
[AE Level/Mode]: Upravuje úroveň AE. Stlačením a podržaním prepnete režim AE.
[Backlight]: Prepína medzi Backlight a Standard.
[Spotlight]: Prepína medzi Spotlight a Standard.
[Preset White Select]: Prepína hodnotu prednastaveného režimu vyváženia bielej.
[ATW]: Zapína/vypína funkciu ATW.
[ATW Hold]: Pozastaví činnosť funkcie ATW.
[AF Speed/Sens.]: Prepína nastavenie rýchlosti prechodu AF a nastavenie citlivosti posunu objektu AF.
[Focus Setting]: Nastavuje oblasť zaostrenia.
[Face/Eye Detection AF]: Prepína nastavenia automatického zaostrovania s detekciou tváre.
[Push AF Mode]: Prepína nastavenie režimu vynúteného automatického zaostrovania.
[Push AF/MF]: V režime zaostrenia MF aktivuje automatické zaostrovanie pri stlačení tlačidla. V režime zaostrovania AF
aktivuje MF pri stlačenom tlačidle.
[Focus Hold]: V režime automatického zaostrovania je zaostrenie fixné, kým je stlačené tlačidlo.
[S&Q Motion]: Zapína/vypína funkciu Slow & Quick Motion. Nastavuje snímkovú frekvenciu pri stlačení a podržaní.
[LUT On/Off]: Zapína/vypína funkciu LUT. Cieľ prepínania sa nastavuje pomocou [Shooting] > [LUT On/Off] > [LUT
On/Off Button Target].
[SteadyShot]: Prepína medzi Active, Standard a Off.
[Crop Select]: Prepína Imager Scan Mode. Prepínanie povolené v rámci rozsahu bez zmeny formátu záznamu.
[Rec]: Spustenie/zastavenie nahrávania.
[Picture Cache Rec]: Zapína/vypína režim nahrávania do vyrovnávacej pamäte.
[Rec Review]: Zapína/vypína funkciu kontroly záznamu.
[Clip Flag OK]: Vykoná Add OK. Pre vykonanie stlačte dvakrát Delete Clip Flag.
[Clip Flag NG]: Vykoná Add NG. Pre vykonanie stlačte dvakrát Delete Clip Flag.
[Clip Flag Keep]: Vykoná Add KEEP. Pre vykonanie stlačte dvakrát Delete Clip Flag.
[Slot Select]: Prepína medzi pamäťovou zásuvkou (A) a (B).
[Color Bars]: Zapína/vypína farebné pruhy.
[DURATION/TC/U-BIT]: Prepína medzi Time Code, Users Bit a Duration.
[Display]: Zapína/vypína indikátory na obrazovke.
[Lens Info]: Prepína indikátor hĺbky ostrosti.
[Video Signal Monitor]: Prepína monitor videosignálu (napríklad monitor priebehu).
[Marker]: Zapína/vypína funkciu značkovača.
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[Thumbnail]: Zobrazí/ukončí obrazovku miniatúr.
[Auto Upload (Proxy)]: Zapína/vypína automatický prenos zástupných súborov.
[Direct Menu]: Zobrazí/ukončí priamu ponuku.
[User Menu]: Zobrazí/ukončí ponuku User.
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Interchangeable Lens Digital Camera
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Scene File

Vykoná nastavenia súvisiace so súbormi scén (pozrite si časť „Snímanie s požadovaným vzhľadom“).
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Položka Nastavenie podpoložky
Predvolené
nastavenie

z výroby
Popis

Recall – –
Načíta súbor scény uložený v internej
pamäti a použije nastavenia ako
aktuálne nastavenie kvality obrazu.

Store – –
Uloží aktuálny stav kvality obrazu ako
súbor scény do vnútornej pamäte.

Delete – –
Vymaže súbor scény uložený vo
vnútornej pamäti.

Preset
Recall

Ak je Shooting Mode nastavené na
Custom a Target Display nastavené na
SDR(BT.709): S-Cinetone / Standard / Still /
ITU709/ 709tone
Ak je Shooting Mode nastavené na
Custom a Target Display nastavené na
HDR(HLG): HLG Live / HLG Natural

–
Použije prednastavené nastavenia
kvality obrazu (neprepisovateľné) ako
aktuálne nastavenie kvality obrazu.
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Interchangeable Lens Digital Camera
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Base Look

Nastavenia týkajúce sa základného vzhľadu.
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Položka Nastavenie podpoložky Predvolené nastavenie z výroby Popis

Select

Ak je Shooting Mode nastavené na
Custom a Target Display nastavené na
SDR(BT.709): S-Cinetone / Standard / Still
/ ITU709 / 709tone / User1 až User16
Ak je Shooting Mode nastavené na
Custom a Target Display nastavené na
HDR(HLG): HLG Live / HLG Natural /
User1 až User16
Ak je Shooting Mode nastavené na
záznam režimov snímania: s709 /
709(800) / S-Log3 / User1 až User16

Ak je Shooting Mode nastavené
na Custom a Target Display
nastavené na SDR(BT.709): S-
Cinetone
Ak je Shooting Mode nastavené
na Custom a Target Display
nastavené na HDR(HLG): HLG
Live
Ak je Shooting Mode nastavené
na záznam režimov snímania:
s709

Vyberie základný
vzhľad.

Delete – –
Vymaže vybratý
základný vzhľad.

Delete All – –
Vymaže všetky
základné vzhľady.

Input S-Gamut3/SLog3 / S-Gamut3.Cine/SLog3 S-Gamut3.Cine/SLog3

Nastaví vstupný
rozsah pre základný
vzhľad vybratý
pomocou [Select].

Output BT.709 / HLG BT.709

Nastaví výstupný
farebný rozsah pre
základný vzhľad
vybratý pomocou
[Select].

AE Level
Offset

0EV / 1/3EV / 2/3EV / 1EV / 4/3EV / 5/3EV
/ 2EV

0EV

Nastaví referenčnú
hodnotu expozície pre
základný vzhľad
vybratý pomocou
[Select].
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Reset Paint Settings

Obnoví nastavenia ponuky [Paint/Look], okrem základného vzhľadu.
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Položka Nastavenie
podpoložky

Predvolené nastavenie
z výroby Popis

Reset without
Base Look

Execute / Cancel –
Obnoví nastavenia ponuky [Paint/Look],
okrem základného vzhľadu.
Execute: Vykonať funkciu.
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Black

Nastavuje čierne nastavenia.
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Položka Nastavenie podpoložky Predvolené nastavenie z výroby Popis

Master Black −99.0 až +99.0 ±0.0 Nastaví hlavnú úroveň čiernej.

R Black −99.0 až +99.0 ±0.0 Nastavuje úroveň čiernej R.

B Black −99.0 až +99.0 ±0.0 Nastavuje úroveň čiernej B.
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Knee

Nastavuje funkciu korekcie lomu.
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Položka Nastavenie podpoložky Predvolené nastavenie
z výroby Popis

Setting

Ak je Target Display
nastavené na
SDR(BT.709): On / Off / ---
Ak je Target Display
nastavené na HDR(HLG):
On / Off / ---

Ak je Target Display
nastavené na
SDR(BT.709): Off
Ak je Target Display
nastavené na HDR(HLG):
Off

Zapína/vypína funkcie korekcie lomu.

Poznámka

Povolené, iba ak je [Base Look] > [Select]
nastavené na [Standard], [ITU709],
[709tone], [HLG Live], alebo [ HLG
Natural].

Auto
Knee

Ak je Target Display
nastavené na
SDR(BT.709): On / Off / ---
Ak je Target Display
nastavené na HDR(HLG):
On / Off / ---

Ak je Target Display
nastavené na
SDR(BT.709): On
Ak je Target Display
nastavené na HDR(HLG):
Off

Zapína/vypína funkciu automatického lomu.

Poznámka

Povolené, iba ak je [Base Look] > [Select]
nastavené na [Standard], [ITU709] alebo
[709tone].

Point 75% až 109% 90% Nastavuje bod lomu.

Slope −99 až +99 ±0 Nastavuje sklon lomu.
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Detail

Nastavenie podrobností úprav.
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Položka Nastavenie
podpoložky

Predvolené
nastavenie
z výroby

Popis

Setting On / Off On Zapína/vypína funkciu podrobností.

Level −7 až +7 ±0 Nastavuje úroveň podrobností.

Manual
Setting

On / Off / --- Off Zapína/vypína funkciu manuálneho nastavenia detailov.

H/V Ratio −2 až +2 ±0

Nastavuje vyváženie medzi horizontálnymi (H)
a vertikálnymi (V) detailmi pre manuálne nastavenie
detailov.

Poznámka

Táto položka sa líši v závislosti od verzie softvéru.*1

B/W
Balance

Type1 / Type2 /
Type3 / Type4 /
Type5

Type3
Nastavuje vyváženie medzi čiernymi (B) detailmi pre oblasti
s nízkou svietivosťou a bielymi (W) detailmi pre oblasti
s vysokou svietivosťou pre manuálne nastavenie detailov.

Limit 0 až 7 7
Nastavuje limitnú úroveň detailov pre manuálne nastavenie
detailov.

Crispening 0 až 7 0
Nastavuje úroveň ostrenia pre manuálne nastavenie
detailov.

High Light
Detail

0 až 4 0
Nastavuje úroveň detailov oblastí s vysokou svietivosťou pre
manuálne nastavenie detailov.

Vo verzii softvéru 1.00 je položka ponuky [V/H Balance]. Vo verzii softvéru 1.10 alebo novšej je položka ponuky [H/V Ratio]. Rozsah nastavenia
je nezmenený od −2 do 0 až +2, vplyv na kvalitu obrazu je však odlišný.
Verzia softvéru 1.00: Čím vyššia je nastavená hodnota, tým vyšší je horizontálny (H) detail.
Verzia softvéru 1.10 alebo novšia: Čím vyššia je nastavená hodnota, tým vyšší je vertikálny (V) detail.
Po aktualizácii z verzie softvéru 1.00 na verziu 1.10 alebo novšiu sa nastavenia [All File], [Scene File] a ďalšie nastavenia zdedia, ale
s obrátenou polaritou (kvalita obrazu sa zachová).
Ak ste zaregistrovali položku ponuky [V/H Balance] v ponuke [User] po aktualizácii softvéru sa automaticky nahradí položkou ponuky [H/V Ratio]
v ponuke [User].

*1
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Interchangeable Lens Digital Camera
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Matrix

Nastavenie maticovej korekcie.
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Položka Nastavenie
podpoložky

Predvolené nastavenie
z výroby Popis

User Matrix On / Off Off Zapína/vypína funkciu maticovej korekcie.

User Matrix
Level

−99 až +99 ±0 Nastavuje sýtosť farieb celého obrazu.

User Matrix
Phase

−99 až +99 ±0 Nastavuje farebný tón (fázu) celého obrazu.

User Matrix R-
G

−99 až +99 ±0 Nastavuje používateľom definovanú
používateľskú maticu R-G.

User Matrix R-
B

−99 až +99 ±0
Nastavuje používateľom definovanú
používateľskú maticu R-B.

User Matrix G-
R

−99 až +99 ±0
Nastaví používateľom definovanú
používateľskú maticu G-R.

User Matrix G-
B

−99 až +99 ±0
Nastaví používateľom definovanú
používateľskú maticu G-B.

User Matrix B-
R

−99 až +99 ±0 Nastaví používateľom definovanú
používateľskú maticu B-R.

User Matrix B-
G

−99 až +99 ±0
Nastaví používateľom definovanú
používateľskú maticu B-G.
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Interchangeable Lens Digital Camera
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Multi Matrix

Nastavenie multimaticovej korekcie.
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Položka Nastavenie podpoložky Predvolené
nastavenie z výroby Popis

Setting On / Off Off
Zapína/vypína funkciu
multimaticovej korekcie.

Reset Execute / Cancel –
Obnoví predvolené hodnoty odtieňa
a sýtosti farieb každej osi.

Axis
B / B+ / MG− / MG / MG+ / R / R+ / YL− /
YL / YL+ / G− / G / G+ / CY / CY+ / B−

B Vyberie os.

Hue −99 až +99 ±0
Nastavuje odtieň farby použitej pre
korekciu s viacerými maticami.

Saturation −99 až +99 ±0
Nastavuje sýtosť farby použitej na
korekciu viacerých matíc.
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Interchangeable Lens Digital Camera
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P/T Acceleration

Vykonáva nastavenia súvisiace so zrýchlením pre otáčanie/nakláňanie.
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Položka Nastavenie
podpoložky

Predvolené
nastavenie z výroby Popis

Ramp
Curve

1 až 9 8
Vyberá zrýchlenie/spomalenie pre otáčanie/nakláňanie.
Čím je číslo väčšie, tým je vyššie zrýchlenie.
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Timecode

Nastavenie časového kódu.
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Položka Nastavenie
podpoložky

Predvolené nastavenie
z výroby Popis

Mode
Preset / Regen /
Clock

Preset

Nastavuje prevádzkový režim časového kódu.
Preset: Spustí sa od prednastavenej hodnoty.
Regen: Spustí sa od časového kódu konca
predchádzajúceho klipu.
Clock: Ako časový kód sa použijú interné hodiny.

Run Rec Run / Free Run Rec Run Rec Run: Spustí sa iba pri nahrávaní.
Free Run: Vždy beží, bez ohľadu na nahrávanie.

Setting – –
Nastaví časový kód na ľubovoľnú hodnotu.
Set: Nastaviť hodnotu.

Reset Execute / Cancel –
Resetuje časový kód na 00:00:00:00.
Execute: Vykonať funkciu.

TC
Format

DF / NDF DF
Nastavuje formát časového kódu.
DF: Drop Frame
NDF: Non-Drop Frame
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Interchangeable Lens Digital Camera
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TC Display

Nastavenie zobrazenia časových údajov.
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Položka Nastavenie podpoložky Predvolené nastavenie
z výroby Popis

Display
Select

Timecode / Users Bit /
Duration

Timecode
Prepína zobrazenie časových
údajov.
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Interchangeable Lens Digital Camera
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Users Bit

Nastavenia súvisiace s používateľskými bitmi.
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Položka Nastavenie
podpoložky

Predvolené nastavenie
z výroby Popis

Mode Fix / Time Fix

Nastavuje používateľský bitový režim.
Fix: Používa ľubovoľnú pevnú hodnotu
v používateľských bitoch.
Time: Používa aktuálnu hodinu, minútu a sekundu
v používateľských bitoch.

Setting – – Nastaví používateľské bity na ľubovoľnú hodnotu.
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HDMI TC Out

Nastavenia týkajúce sa výstupu časového kódu pri použití HDMI.
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Položka Nastavenie
podpoložky

Predvolené
nastavenie z výroby Popis

Setting On / Off Off
Nastavuje, či sa má výstupný časový kód odosielať do
zariadení na iné účely pomocou rozhrania HDMI.
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Clip Name Format

Nastavenia súvisiace s pomenovaním a odstránením klipu.
Keď je [Auto Naming] nastavené [Cam ID + Reel#], prvé štyri znaky názvov klipov sa určia pre každé záznamové
médium. Keď sa vloží nové záznamové médium alebo keď posledný klip na záznamovom médiu nezodpovedá
nastaveniam [Camera ID] alebo [Reel Number], názov klipu bliká, aby vás upozornil.
Keď je [Auto Naming] nastavené na [Title], ako prvú časť názvov klipov môžete použiť ľubovoľný reťazec znakov.

Položka Nastavenie
podpoložky

Predvolené
nastavenie

z výroby
Popis

Auto
Naming

Cam ID + Reel# / Title

Vyberie formát pomenovania klipu.
Cam ID + Reel#: ID kamery + číslo cievky + číslo záberu
+ dátum + náhodný reťazec
Title: Ľubovoľný reťazec zadaný pomocou [Title Prefix] +
číslo klipu

Camera ID A až Z A

Nastaví ID kamery používané pri generovaní názvov
klipov.

Poznámka

Konfigurovateľné len vtedy, ak je [Auto Naming]
nastavené na [Cam ID + Reel#].

Reel
Number

001 až 999 001

Nastavuje časť s číslom cievky, ktorá sa používa pri
generovaní názvov klipov.

Poznámka

Konfigurovateľné len vtedy, ak je [Auto Naming]
nastavené na [Cam ID + Reel#].

Camera
Position

C / L / R C

Nastavuje prvú časť znaku čísla záberu, ktorá sa používa
pri generovaní názvov klipov.

Poznámka

Konfigurovateľné len vtedy, ak je [Auto Naming]
nastavené na [Cam ID + Reel#].
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Nastavenie [Title Prefix]

Súvisiaca téma

Zadanie znakového reťazca
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Položka Nastavenie
podpoložky

Predvolené
nastavenie

z výroby
Popis

Title Prefix

nnn_(nnn sú posledné
3 číslice sériového
čísla)
(max. 7-miestny
displej)

nnn

Nastavuje titulnú časť (4 až 46 znakov) názvu klipu.
Otvára obrazovku zadávania reťazca znakov.

Podrobnosti o nastavení titulkov a obrazovke
zadávania znakov nájdete nižšie v častiach
„Nastavenie názvu“ a „Zadanie znakového reťazca“.

Poznámka

Konfigurovateľné len vtedy, ak je [Auto Naming]
nastavené na [Title].

Number
Set

0001 až 9999 0001

Nastavuje štvormiestnu číselnú príponu názvu klipu.

Poznámka

Konfigurovateľné len vtedy, ak je [Auto Naming]
nastavené na [Title].

Pomocou tlačidiel so šípkami na ovládacom paneli GUI vyberte znak (znak je zvýraznený), ktorý chcete
vložiť na pozíciu kurzora v oblasti [Title Prefix] z oblasti výberu znakov, a stlačte tlačidlo [Set] na
ovládacom paneli GUI.

Vloží sa vybraný znak a kurzor sa posunie doprava.

1

Opakovaním kroku 1 vytvorte názov.

Použite [BS] podľa potreby.

2

Po nastavení názvu zatvorte obrazovku zadávania znakov výberom možnosti [Done].

Podrobnosti o činnosti na obrazovke zadávania znakov nájdete v časti „Zadanie znakového reťazca“.

Je možné vybrať nasledujúce znaky.
!#$%()+,-.;=@[ ]^_~ medzera
0123456789
abcdefghijklmnopqrstuvwxyz
ABCDEFGHIJKLMNOPQRSTUVWXYZ

3
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Update Media

Aktualizuje súbor správy na pamäťových kartách (pozrite si „Obnova pamäťových kariet“).

Súvisiaca téma

Obnova pamäťových kariet
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Položka Nastavenie
podpoložky

Predvolené nastavenie
z výroby Popis

Media(A) Execute / Cancel –
Aktualizuje súbor správy na pamäťovej karte
v zásuvke A.
Execute: Vykonať funkciu.

Media(B) Execute / Cancel –
Aktualizuje súbor správy na pamäťovej karte
v zásuvke B.
Execute: Vykonať funkciu.
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Interchangeable Lens Digital Camera
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Format Media

Formátuje (inicializuje) pamäťové karty (pozrite si „Formátovanie (inicializácia) pamäťových kariet“).

Súvisiaca téma

Formátovanie (inicializácia) pamäťových kariet
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Položka Nastavenie podpoložky Predvolené nastavenie
z výroby Popis

Media(A)
Full Format / Quick Format /
Cancel

–
Naformátuje pamäťovú kartu
v zásuvke A.

Media(B)
Full Format / Quick Format /
Cancel

–
Naformátuje pamäťovú kartu
v zásuvke B.
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Interchangeable Lens Digital Camera
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Media Life

Zobrazuje zostávajúcu životnosť pamäťových kariet.

Poznámka

Vyžaduje pamäťové karty, ktoré podporujú zobrazenie zostávajúcej životnosti médií.
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Položka Nastavenie
podpoložky

Predvolené nastavenie
z výroby Popis

Media(A) – –
Zobrazuje zostávajúcu životnosť pamäťovej karty
v zásuvke A.

Media(B) – –
Zobrazuje zostávajúcu životnosť pamäťovej karty
v zásuvke B.
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Interchangeable Lens Digital Camera
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Output Format

Nastavenie výstupného formátu.

Súvisiaca téma

Výstupné formáty a obmedzenia
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Položka Nastavenie podpoložky Predvolené
nastavenie z výroby Popis

SDI Podrobnosti o nastaveniach nájdete v časti
„Výstupné formáty a obmedzenia“.

– Nastavuje výstupné
rozlíšenie SDI a HDMI.HDMI –
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Display On/Off

Nastavenia pre zobrazenú položku.
Ak chcete zobraziť položku na displeji, vyberte On. Ak chcete skryť položku na displeji, vyberte Off.

Položka Nastavenie podpoložky Predvolené nastavenie z výroby

File Transfer Status On / Off On

Rec/Play Status On / Off On

RAW Output Control Status On / Off On

Tally On / Off On

Focus Mode On / Off On

Focus Position On / Off On

Focus Area Indicator On / Off On

Focus Area Ind.(AF-S) On / Off On

Face/Eye Detection Frame On / Off On

Lens Info On / Off Off

Imager Scan Mode On / Off On

Rec Format On / Off On

Frame Rate On / Off On

Zoom Position On / Off On

SteadyShot On / Off On

Base Look/Rec Look On / Off On

SDI/HDMI Rec Control On / Off On

Monitoring Look On / Off On

Proxy Status On / Off On

Base ISO/Sensitivity On / Off On

Media Status On / Off On

Clip Name On / Off On

White Balance On / Off On

Scene File On / Off On

Focus Indicator On / Off On
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Položka Nastavenie podpoložky Predvolené nastavenie z výroby

Auto Exposure Mode On / Off On

Auto Exposure Level On / Off On

Timecode On / Off On

ND Filter On / Off On

Iris On / Off On

ISO/Gain/EI On / Off On

Shutter On / Off On

Level Gauge On / Off On

Audio Level Meter On / Off On

Video Level Warning On / Off On

Clip Number On / Off On

Notice Message On / Off On
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Video Signal Monitor

Vykoná nastavenia monitora videosignálu.
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Položka Nastavenie podpoložky Predvolené nastavenie
z výroby Popis

Setting
Off / Waveform / Vector /
Histogram

Off
Nastavuje typ monitora
videosignálu.

Level Marker
1

0% až 109% 70%
Nastavuje úroveň značky úrovne
jasu 1.

Level Marker
2

0% až 109% 100%
Nastavuje úroveň značky úrovne
jasu 2.
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Marker

Nastavenia zobrazenia značky.

Položka Nastavenie podpoložky
Predvolené
nastavenie

z výroby
Popis

Setting On / Off On Zapína/vypína zobrazenie všetkých značiek.

Color
White / Yellow / Cyan / Green /
Magenta / Red / Blue

White Výber signálnej farby značky.

Center
Marker

1 / 2 / 3 / 4 / Off Off Výber stredovej značky.

Safety Zone On / Off Off Zapína/vypína značku bezpečnostnej zóny.

Safety Area 80% / 90% / 92.5% / 95% 90%
Vyberie veľkosť značky bezpečnostnej zóny
(ako percento z celkovej veľkosti
obrazovky).

Aspect
Marker

Line / Mask / Off Off Vyberie typ značky pomeru strán.

Aspect
Mask

0 až 15 12
Nastavuje úroveň videosignálu mimo
značku.

Aspect
Safety Zone

On / Off Off
Zapína/vypína značku bezpečnostnej zóny
pomeru strán.

Aspect
Safety Area

80% / 90% / 92.5% / 95% 90%
Vyberie veľkosť značky bezpečnostnej zóny
pomeru strán (ako percento z celkovej
veľkosti obrazovky).

Aspect
Select

1:1 / 4:3 / 13:9 / 14:9 / 15:9 / 16:9 /
17:9 / 1.66:1 / 1.85:1 / 2.35:1 /
2.39:1 / Custom

2.39:1
Nastavuje režim pri zobrazovaní značky
pomeru strán.

Custom
Aspect
Ratio

Zadajte ľubovoľnú hodnotu. 01.00:01.00

Nastaví pomer strán na ľubovoľnú hodnotu.

Poznámka

Povolené, keď je [Aspect Select]
nastavené na [Custom].

Guide
Frame

On / Off Off
Zapína/vypína zobrazenie vodiaceho
rámčeka.

100%
Marker

On / Off Off Zapína/vypína značku 100%.
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Položka Nastavenie podpoložky
Predvolené
nastavenie

z výroby
Popis

User Box On / Off Off
Zapína/vypína zobrazenie značky
používateľského rámčeka.

User Box
Width

3 až 479 240
Nastaví šírku značky používateľského
rámčeka (vzdialenosť od stredu k ľavému
a pravému okraju).

User Box
Height

3 až 269 135
Nastaví výšku značky používateľského
rámčeka (vzdialenosť od stredu k hornému
a dolnému okraju).

User Box H
Position

−476 až +476 0
Nastavuje vodorovnú polohu stredu značky
používateľského rámčeka.

User Box V
Position

−266 až +266 0
Nastavuje zvislú polohu stredu značky
používateľského rámčeka.

347



Sprievodca s nápovedou

Interchangeable Lens Digital Camera
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Audio Input

Nastavenie zvukového vstupu.

Položka Nastavenie
podpoložky

Predvolené
nastavenie
z výroby

Popis

AUDIO IN
Select

MIC / LINE MIC
Vyberie typ zariadenia pripojeného ku konektoru
AUDIO IN.

Phantom
Power +48V

On / Off Off Zobrazuje stav fantómového napájania +48 V.

CH1 Input
Select

AUDIO IN CH1 AUDIO IN CH1 Zobrazuje vstupný zdroj na nahrávanie na kanáli 1.

CH2 Input
Select

AUDIO IN CH1 /
AUDIO IN CH2

AUDIO IN CH2 Prepína vstupný zdroj na nahrávanie na kanáli 2.

CH3 Input
Select

Off / AUDIO IN CH1 AUDIO IN CH1 Prepína vstupný zdroj na nahrávanie na kanáli 3.

CH4 Input
Select

Off / AUDIO IN CH1 /
AUDIO IN CH2

AUDIO IN CH2 Prepína vstupný zdroj na nahrávanie na kanáli 4.

AUDIO IN
CH1 MIC Ref.

−80dB / −70dB /
−60dB / −50dB /
−40dB / −30dB

−50dB
Nastavuje referenčnú úroveň nahrávania pre vstup
mikrofónu XLR z AUDIO IN CH1.

AUDIO IN
CH2 MIC Ref.

−80dB / −70dB /
−60dB / −50dB /
−40dB / −30dB

−50dB
Nastavuje referenčnú úroveň nahrávania pre vstup
mikrofónu XLR z AUDIO IN CH2.

Line Input
Reference

+4dB / 0dB / −3dB /
EBUL

+4dB
Vyberie referenčnú vstupnú úroveň, keď je [AUDIO IN
Select] nastavené na LINE.

Reference
Level

−20dB / −18dB /
−16dB / −12dB /
EBUL

−20dB
Vyberie úroveň nahrávania signálu referenčného tónu 1
kHz.

CH1 Wind
Filter

On / Off Off
Zapína/vypína filter redukcie vetra pre záznam kanála
1.

CH2 Wind
Filter

On / Off Off
Zapína/vypína filter redukcie vetra pre záznam kanála
2.

CH3 Wind
Filter

On / Off Off
Zapína/vypína filter redukcie vetra pre záznam kanála
3.

CH4 Wind
Filter

On / Off Off
Zapína/vypína filter redukcie vetra pre záznam kanála
4.
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Položka Nastavenie
podpoložky

Predvolené
nastavenie
z výroby

Popis

CH1 Level
Control

Auto / Manual Auto
Vyberie automatické nastavenie úrovne audio vstupu
alebo manuálne nastavenie pre nahrávací kanál 1.

CH2 Level
Control

Auto / Manual Auto
Vyberie automatické nastavenie úrovne audio vstupu
alebo manuálne nastavenie pre nahrávací kanál 2.

CH3 Level
Control

Auto / Manual Auto
Vyberie automatické nastavenie úrovne audio vstupu
alebo manuálne nastavenie pre nahrávací kanál 3.

CH4 Level
Control

Auto / Manual Auto
Vyberie automatické nastavenie úrovne audio vstupu
alebo manuálne nastavenie pre nahrávací kanál 4.

CH1 Input
Level

0 až 99 49 Nastavuje vstupnú úroveň pre nahrávanie kanálu 1.

CH2 Input
Level

0 až 99 49 Nastavuje vstupnú úroveň pre nahrávanie kanálu 2.

CH3 Input
Level

0 až 99 49 Nastavuje vstupnú úroveň pre nahrávanie kanálu 3.

CH4 Input
Level

0 až 99 49 Nastavuje vstupnú úroveň pre nahrávanie kanálu 4.

Master Input
Level

0 až 99 99 Nastavuje hlavnú vstupnú úroveň zvuku.

Limiter Mode
Off / −6dB / −9dB /
−12dB / −15dB /
−17dB

Off
Pri manuálnom nastavení vstupnej úrovne zvuku zvolí
charakteristiku obmedzovača pre veľké vstupné
signály.

CH1&2 AGC
Mode

Mono / Stereo Stereo
Nastavuje režim automatického nastavenia úrovne pre
nahrávanie kanálov 1 a 2. Keď je nastavené na Stereo,
AGC je prepojené medzi kanálmi.

CH3&4 AGC
Mode

Mono / Stereo Stereo
Nastavuje režim automatického nastavenia úrovne pre
nahrávanie kanálov 3 a 4. Keď je nastavené na Stereo,
AGC je prepojené medzi kanálmi.

AGC Spec
−6dB / −9dB / −12dB /
−15dB / −17dB

−6dB Vyberie charakteristiku AGC.

1kHz Tone on
Color Bars

On / Off Off

Zapína/vypína signál referenčného tónu 1 kHz pri
zobrazení farebných pruhov.

Poznámka

Ak je nastavené [On], referenčný tónový signál 1 kHz
sa nastaví na nahrávanie na kanáloch 3 a 4, aj keď sú
[CH3 Input Select] a [CH4 Input Select] nastavené na
[Off].
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Sprievodca s nápovedou
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Audio Output

Nastavenie zvukového výstupu.
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Položka Nastavenie
podpoložky

Predvolené
nastavenie z výroby Popis

HDMI/Stream
Output CH

CH1/CH2 /
CH3/CH4

CH1/CH2
Nastavuje kombináciu zvukových kanálov pre
HDMI/streamovaný výstup.
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Sprievodca s nápovedou
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Display Clip Properties

Zobrazí obrazovku vlastností klipu.
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Položka Nastavenie
podpoložky

Predvolené nastavenie
z výroby Popis

Display Clip
Properties

– –
Zobrazí obrazovku vlastností
klipu.
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
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Set Clip Flag

Nastavenie označenia klipu.
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Položka Nastavenie podpoložky Predvolené nastavenie z výroby Popis

Add OK – – Pridá označenie OK.

Add NG – – Pridá označenie NG.

Add KEEP – – Pridá označenie KEEP.

Delete Clip Flag – – Vymaže všetky označenia.
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Lock/Unlock Clip

Nastavenia ochrany klipu.
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Položka Nastavenie podpoložky Predvolené nastavenie z výroby Popis

Select Clip – – Vyberie a uzamkne/odomkne klip.

Lock All Clips – – Uzamkne všetky klipy.

Unlock All Clips – – Odomkne všetky klipy.
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Delete Clip

Vymaže klipy.
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Položka Nastavenie podpoložky Predvolené nastavenie z výroby Popis

Select Clip – – Odstráni vybratý klip.

All Clips – – Vymaže všetky klipy.
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Transfer Clip

Prenáša klipy.
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Položka Nastavenie
podpoložky

Predvolené nastavenie
z výroby Popis

Select
Clip

– – Prenesie vybrané klipy.

All Clips – –

Prenesie všetky klipy.

Poznámka

Zaregistrovať možno až 200 úloh
prenosu.
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Transfer Clip (Proxy)

Prenáša zástupné klipy.
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Položka Nastavenie
podpoložky

Predvolené nastavenie
z výroby Popis

Select
Clip

– –
Prenáša zástupné klipy zodpovedajúce
vybraným klipom.

All Clips – –

Prenáša zástupné klipy zodpovedajúce všetkým
klipom.

Poznámka

Zaregistrovať možno až 200 úloh prenosu.
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Interchangeable Lens Digital Camera
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Filter Clips

Nastavenie klipov pre zobrazenie.
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Položka Nastavenie
podpoložky

Predvolené nastavenie
z výroby Popis

OK – – Zobraziť iba klipy, ktoré majú označenie OK.

NG – – Zobraziť iba klipy, ktoré majú označenie NG.

KEEP – – Zobraziť iba klipy, ktoré majú označenie KEEP.

None – – Zobraziť iba klipy, ktoré nemajú žiadne označenie.

All – –
Zobraziť všetky klipy bez ohľadu na to, či existuje
nejaké označenie.
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Customize View

Prepína zobrazenie miniatúr.
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Položka Nastavenie podpoložky Predvolené nastavenie
z výroby Popis

Thumbnail
Caption

Date Time / Time Code / Duration /
Sequential Number

Time Code
Prepína informácie zobrazené
pod miniatúrami.
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Color Bars

Nastavenia farebných pruhov.
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Položka Nastavenie podpoložky Predvolené nastavenie z výroby Popis

Setting On / Off Off Zapína/vypína farebné pruhy.

Type ARIB / 100% / 75% / SMPTE ARIB Vyberie typ farebných pruhov.
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Genlock

Konfiguruje zobrazenie stavu genlocku (pozrite si „Synchronizácia fázy video signálu (Genlock)“).

Súvisiaca téma

Synchronizácia fázy video signálu (Genlock)
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Položka Nastavenie podpoložky Predvolené nastavenie
z výroby Popis

Reference
Internal / External(HD) /
External(SD)

–
Zobrazuje typ referenčného signálu
genlock.
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Interchangeable Lens Digital Camera
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Tally

Nastaví nastavenia kontrolky nahrávania/záznamu (pozrite si „Pripojenie záznamového signálu“).

Súvisiaca téma
Pripojenie záznamového signálu
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Položka Nastavenie
podpoložky

Predvolené
nastavenie z výroby Popis

Tally Lamp
Brightness

High / Low / Off High Nastavuje jas kontrolky nahrávania/záznamu.

G Tally Lamp Enable / Disable Enable Zapína/vypína kontrolku záznamu G.

Tally Control External / Internal Internal

Vyberie cieľ pre príjem riadiacich informácií
kontrolky nahrávania/záznamu jednotky.
External: Ovládanie záznamu mimo kamery.
Internal: Ovládanie pomocou funkcií nahrávania
kamery.
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Rec Review

Vykoná nastavenia kontroly nahrávania (pozrite si „Kontrola záznamu (Rec Review)“).

Súvisiaca téma

Kontrola záznamu (Rec Review)
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Položka Nastavenie
podpoložky

Predvolené nastavenie
z výroby Popis

Setting 3s / 10s / Clip 3s
Nastaví čas prehrávania klipov práve zaznamenaných
na kontrolu záznamu.
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Zoom

Vykoná nastavenia transfokácie („Úprava transfokácie“).
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Položka Nastavenie podpoložky Predvolené nastavenie
z výroby Popis

Zoom
Type

Optical Zoom Only / On(Clear Image
Zoom)

Optical Zoom Only
Nastavuje typ
transfokácie.
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
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Lens

Nastavenia týkajúce sa objektívov.

Súvisiaca téma

Kompenzácia dýchania
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Položka Nastavenie
podpoložky

Predvolené
nastavenie
z výroby

Popis

Lens Calibration Execute / Cancel –

Vykonáva funkciu, ktorá koriguje rozdiely v polohe
transfokácie v dôsledku rozdielov jednotlivých
objektívov pri použití objektívu s motorickou
transfokáciou.

Zoom Ring
Direction

Left(W)/Right(T) /
Right(W)/Left(T)

Left(W)/Right(T)

Nastavuje smer činnosti krúžku transfokácie.

Poznámka

Povolené iba pri použití objektívu s bajonetom E,
ktorý podporuje prepínanie smeru krúžku
transfokácie.

Shading
Compensation

Auto / Off Auto Nastavuje automatickú kompenzáciu tieňovania.

Chroma
Aberration
Comp.

Auto / Off Auto
Nastavuje automatickú kompenzáciu chromatickej
aberácie.

Distortion Comp. Auto / Off Auto Nastavuje automatickú kompenzáciu skreslenia.

Breathing
Compensation

Auto / Off Off
Nastavuje kompenzáciu dýchania objektívu.

Pozrite si časť „Kompenzácia dýchania“.

Distance Display Meter / Feet Meter
Nastavuje zobrazovacie jednotky pre informácie
o objektíve a polohe zaostrenia.

Zoom Position
Display

Focal Length /
Number / Bar Focal Length

Nastavuje formát zobrazenia pre polohu
transfokácie.
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APR

Vykoná APR.
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Položka Nastavenie
podpoložky

Predvolené
nastavenie z výroby Popis

APR Execute / Cancel –

Spustí APR (automatické obnovenie pixelov) pre
automatické nastavenie obrazového snímača.
Execute: Vykonať funkciu.

Poznámka

Pred spustením APR vždy nasaďte krytku objektívu.
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Wired LAN

Nastavenia súvisiace s káblovým pripojením LAN.
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Položka Nastavenie
podpoložky

Predvolené nastavenie
z výroby Popis

HTTP Port – 80 Zobrazuje prístupový port HTTP.

Detail
Settings

– – Zobrazuje vlastnosti káblového pripojenia LAN.

DHCP
On / Off

On
Zobrazuje, či je DHCP povolené (On) alebo
nepovolené (Off).

IP Address –
Zobrazuje IP adresu jednotky, keď je [DHCP]
nastavené na [Off].

Subnet Mask –
Zobrazuje masku podsiete jednotky, keď je [DHCP]
nastavené na [Off].

Gateway –
Nastaví predvolenú bránu, keď je [DHCP]
nastavené na [Off].

DNS Auto
On / Off

On
Zobrazuje nastavenie automatického získavania
DNS.
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

File Transfer

Vykoná nastavenia súvisiace s prenosom súborov (pozrite si „O prenose súborov“).

Súvisiaca téma

O prenose súborov
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Položka Nastavenie
podpoložky

Predvolené
nastavenie

z výroby
Popis

Auto Upload
(Proxy)

On / Off Off Zapne/vypne automatické nahrávanie zástupného súboru.

Default
Upload
Server

Server Settings1
až 3 > Display
Name

–

Vyberie server pre nahrávanie súborov. Tu vybraný server
sa stane miestom automatického nahrávania pre zástupné
súbory a miestom pre nahrávanie súborov z obrazovky
miniatúr.
Zobrazuje nastavenia [Display Name] nakonfigurované
v [Server Settings1 až 3].

Clear
Completed
Jobs

Execute / Cancel –
Vymaže dokončené úlohy prenosu zo zoznamu.
Execute: Vykonať funkciu.

Clear All Jobs Execute / Cancel –
Vymaže všetky úlohy prenosu zo zoznamu.
Execute: Vykonať funkciu.

View Job List – – Zobrazí zoznam úloh prenosu.
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Language

Nastavuje jazyk displeja.
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Položka Nastavenie podpoložky Predvolené nastavenie z výroby Popis

Select – –
Nastavuje jazyk displeja.
Set: Nastaviť hodnotu.
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
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Clock Set

Nastavuje interné nastavenia hodín.

Poznámka

Keď sa toto nastavenie zmení z ponuky kamery, vypnite napájanie jednotky a reštartujte jednotku. Ak sa pomocou infračerveného
diaľkového ovládača alebo webovej aplikácie spustí pohotovostný režim, môže dôjsť k neočakávanému správaniu.
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Položka Nastavenie podpoložky Predvolené nastavenie
z výroby Popis

Time
Zone

UTC − 12:00 až UTC +
14:00

–
Nastavuje časový rozdiel od UTC v 30-
minútových intervaloch.

Date
Mode

YYMMDD / MMDDYY /
DDMMYY

YYMMDD

Vyberie formát zobrazenia pre dátumy.
YYMMDD: Rok, mesiac, deň
MMDDYY: Mesiac, deň, rok
DDMMYY: Deň, mesiac, rok

12H/24H 12H / 24H 24H
Vyberie formát zobrazenia hodín.
12H: 12-hodinový režim
24H: 24-hodinový režim

Date – –
Nastavuje aktuálny dátum.
Set: Nastaviť hodnotu.

Time – –
Nastavuje aktuálny čas.
Set: Nastaviť hodnotu.
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Hours Meter

Zobrazuje akumulovaný čas chodu.
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Položka Nastavenie
podpoložky

Predvolené nastavenie
z výroby Popis

Hours(System) – –
Zobrazuje akumulované hodiny používania
(nemožno resetovať).

Hours(Reset) – –
Zobrazuje akumulované hodiny používania (je
možné resetovať).

Reset Execute / Cancel –
Resetuje akumulovaný čas chodu na 0.
Execute: Vykonať funkciu.
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Interchangeable Lens Digital Camera
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Nastavenia ISO/Gain a predvolené hodnoty

Rozsah nastavení [ISO/Gain<L>] a predvolené hodnoty sa líšia v závislosti od nastavení [Mode], [Base Look] > [Select]
a [Base Sensitivity].
Predvolené hodnoty v tabuľkách sú zobrazené tučným písmom.

Ak je [Mode] nastavené na [ISO]

Ak je [Base Look] > [Select] nastavené na [S-Cinetone], [Standard], [ITU709], [709tone] alebo [Still]

Ak je [Base Look] > [Select] nastavené na [HLG Live] alebo [HLG Natural]

Ak je [ISO/Gain/EI] > [Base Sensitivity] nastavené na
[Low]

Ak je [ISO/Gain/EI] > [Base Sensitivity] nastavené na
[High]

ISO 320
ISO 400
ISO 500
ISO 640
ISO 800
ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600
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Ak je [Base Look] > [Select] nastavené na [User1] až [User16]

Ak je [Mode] nastavené na [dB]

Je možné nakonfigurovať hodnotu v rozsahu −3dB až +30dB v krokoch po 1dB.
Predvolená hodnota je 0dB.
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Ak je [ISO/Gain/EI] > [Base Sensitivity] nastavené na
[Low]

Ak je [ISO/Gain/EI] > [Base Sensitivity] nastavené na
[High]

ISO 800
ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 128000
ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600

Ak je [ISO/Gain/EI] > [Base Sensitivity] nastavené na
[Low]

Ak je [ISO/Gain/EI] > [Base Sensitivity] nastavené na
[High]

ISO 800
ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 12800
ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600
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Interchangeable Lens Digital Camera
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Nastavenia AGC Limit a predvolené hodnoty

Rozsah nastavení [AGC Limit] a predvolené hodnoty sa líšia v závislosti od nastavení [Mode], [Base Look] > [Select]
a [Base Sensitivity].
Predvolené hodnoty v tabuľkách sú zobrazené tučným písmom.

Ak je [Mode] nastavené na [ISO]

Ak je [Base Look] > [Select] nastavené na [S-Cinetone], [Standard], [ITU709], [709tone] alebo [Still]

Ak je [Base Look] > [Select] nastavené na [HLG Live] alebo [HLG Natural]

Ak je [ISO/Gain/EI] > [Base Sensitivity] nastavené na
[Low]

Ak je [ISO/Gain/EI] > [Base Sensitivity] nastavené na
[High]

ISO 400
ISO 500
ISO 640
ISO 800
ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600
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Ak je [Base Look] > [Select] nastavené na [User1] až [User16]

Ak je [Mode] nastavené na [dB]

Vyberte si z 3dB / 6dB / 9dB / 12dB / 15dB / 18dB / 21dB / 24dB / 27dB / 30dB.
Predvolená hodnota je 15dB.
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Ak je [ISO/Gain/EI] > [Base Sensitivity] nastavené na
[Low]

Ak je [ISO/Gain/EI] > [Base Sensitivity] nastavené na
[High]

ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600

Ak je [ISO/Gain/EI] > [Base Sensitivity] nastavené na
[Low]

Ak je [ISO/Gain/EI] > [Base Sensitivity] nastavené na
[High]

ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Nastavenia kvality obrazu uložené pre každý režim snímania

Aktuálny stav konfiguračných položiek súvisiacich s kvalitou obrazu sa ukladá pre každý z nasledujúcich režimov
snímania. Keď zmeníte režim snímania, použijú sa príslušné nastavenia, ktoré sú uložené pre režim cieľového snímania.

Režim Custom SDR(BT.709) cieľové zobrazenie
Režim Custom HDR(HLG) cieľové zobrazenie
Zaznamenávanie snímania (Cine EI, Cine EI Quick, Flexible ISO)

Položky konfigurácie súvisiace s kvalitou obrazu, ktoré sa ukladajú pre každý režim snímania, sú uvedené
v nasledujúcich tabuľkách.
„Áno“ označuje nastavenie, ktoré je uložené, a „Nie“ označuje nastavenie, ktoré nie je uložené. „Áno“ zahŕňajúce viacero
stĺpcov označuje bežné nastavenia.

Položka

Režim snímania

Custom Flexible
ISO

Cine EI
Quick

Cine
EISDR(BT.709) HDR(HLG)

Ponuka
Snímanie

ISO/Gain/EI

ISO/Gain Áno1) Áno Nie

Exposure Index Nie Nie Áno Áno

Base Sensitivity Áno Nie

Base ISO Nie Áno4) Nie3) Áno4)

White
Preset White Áno Áno

Iné ako vyššie Áno

White Setting Áno

Offset White Áno Nie

LUT On/Off Nie Áno

Noise
Suppression

Setting(Custom) Áno Áno Nie

Level(Custom) Áno Áno Nie

Setting (Cine
EI/Flex. ISO) Nie Áno

Level (Cine EI/Flex.
ISO)

Nie Áno
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Položka

Režim snímania

Custom Flexible
ISO

Cine EI
Quick

Cine
EISDR(BT.709) HDR(HLG)

Ponuka
Paint/Look

Base Look

Select Áno Áno Áno

Input2) Áno

Output2) Áno

AE Level Offset2) Áno

Black Áno Áno Nie

Knee
Auto Knee Áno Nie Nie

Iné ako vyššie Áno Áno Nie

Detail Áno Áno Nie

Matrix Áno Áno Nie

Multi Matrix Áno Áno Nie

Samostatné nastavenia citlivosti ISO sa ukladajú pre režim Custom SDR(BT.709) aj HDR(HLG).1)

Nastavenia sa ukladajú pre každý Základný vzhľad, a nezávisia od režimu snímania.2)

Základná citlivosť ISO sa mení spolu s expozičným indexom.3)

Spoločná hodnota nastavenia v režimoch snímania Flexible ISO a Cine EI.4)
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Konfigurácia webovej ponuky

Stlačením prepínacej karty prevádzkovej obrazovky [Settings] zobrazíte obrazovku nastavení.
Obrazovku nastavení použite na konfiguráciu rôznych položiek nastavenia jednotky vrátane úvodných nastavení,
sieťových nastavení, nastavení snímania/prehrávania pomocou webovej ponuky.

Ponuka obsahuje nasledujúce ponuky.

Konfigurácia a hierarchia ponuky

Úroveň 1 Popis 1. úrovne Úroveň 2

Shooting Obsahuje nastavenia týkajúce sa snímania. Focus
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Úroveň 1 Popis 1. úrovne Úroveň 2

Project Obsahuje základné nastavenia projektu.

Base Setting

Rec Format

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

All File

Paint/Look Obsahuje nastavenia týkajúce sa kvality obrazu. Base Look

Pan-Tilt Obsahuje nastavenia týkajúce sa otáčania/nakláňania.

P/T Speed

P/T Acceleration

P/T Range Limit

P/T Direction

P/T Preset

Monitoring
Obsahuje nastavenia týkajúce sa výstupu videa a zobrazenia na
obrazovke.

Output Format

Output Display

Audio Obsahuje nastavenia týkajúce sa zvuku. Audio

Technical Obsahuje nastavenia pre technické položky.

Tracking Data Output

Tally

IR Remote

RCP/MSU

Lens Controller

Network Obsahuje nastavenia týkajúce sa sietí.

Camera Name

User

Wired LAN

File Transfer

FTP Server 1

FTP Server 2

FTP Server 3

SSL

Referer Check

Brute Force Attack
Protection
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Poznámka

[Accessibility] je k dispozícii len na modeloch pre Severnú Ameriku.
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Úroveň 1 Popis 1. úrovne Úroveň 2

Stream Obsahuje nastavenia súvisiace so streamovaním.

Stream

Video Stream

Audio Stream

Maintenance Obsahuje nastavenia zariadení, ako sú hodiny a jazyk.

Language

Accessibility

Clock Set

Reset

Information

System Log

HTTP Access Log

Service

EULA

Software
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Funkcie webovej ponuky

Stlačením prepínacej karty prevádzkovej obrazovky [Settings] zobrazíte obrazovku nastavení na konfiguráciu rôznych
položiek nastavenia jednotky vrátane úvodných nastavení, nastavení siete, nastavení snímania/prehrávania pomocou
webovej ponuky.
Nakonfigurujte nastavenia vo webovej ponuke na tablete pomocou dotykového ovládania alebo na počítači pomocou
myši.
Stlačte ponuku pre položky, ktoré chcete nakonfigurovať, aby sa v tejto ponuke zobrazili položky nastavení a ich
nastavenia.

Spôsob konfigurácie

Výber hodnoty

Ponuka (úroveň 1)1.

Ponuka (úroveň 2)2.

Nastavenia3.
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Stlačte prepínač pre položku. Prepínač pre vybratú položku sa zobrazí oranžovou farbou.

Zapnutie/vypnutie položky

Stlačením prepínača položku zapnete/vypnete. Prepínač je oranžový, keď je položka zapnutá, a biely, keď je vypnutá.

Výber hodnoty zo zoznamu

Stlačte tlačidlo rozbaľovacieho zoznamu a vyberte položku zo zobrazeného zoznamu.

Výber číselnej hodnoty

Stlačením < alebo > zmeňte číselnú hodnotu. Ak je číselná hodnota podčiarknutá, môžete číselnú hodnotu zadať priamo.

Zadávanie znakov/čísla

Konfigurácia na samostatnej obrazovke
Stlačením tlačidla vykonáte operácie nastavenia na samostatnej obrazovke.

Usmerňovacia správa

Zobrazia sa informácie, ktoré vám pomôžu nakonfigurovať niektoré nastavenia a správy, ktoré upozorňujú používateľa.

Uloženie nastavenia

Po dokončení konfigurácie nastavenia uložte nastavenie stlačením tlačidla [OK].
Stlačením tlačidla [Cancel] zrušíte zmeny nastavenia a vrátite sa k predchádzajúcemu nastaveniu.
Stlačením tlačidla [Reload] aktualizujte zobrazenie na obrazovke.

Poznámka

Ak pred uložením nastavenia stlačíte tlačidlo [Reload], zmeny nastavenia sa zrušia.
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Ak sa pred uložením nastavenia presuniete na inú stránku, zmeny nastavenia sa nepoužijú.
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Focus

Nastavuje zaostrovanie.

Súvisiaca téma

Manuálne nastavenie automatického zaostrenia (AF Assist) pomocou webovej aplikácie

5-041-959-13(1) Copyright 2022 Sony Corporation

Položka Nastavenie
podpoložky

Predvolené
nastavenie

z výroby
Popis

Push AF
Mode

AF / Single-shot
AF(AF-S)

AF Nastavuje režim vynúteného automatického zaostrovania.

Touch
Function in
MF

Tracking AF /
Spot Focus

Tracking AF
Nastaví operáciu, keď sa dotknete obrazovky kamery
v režime MF.

AF Assist
Control

On / Off On

Pri nastavení na [On] môžete počas automatického
zaostrenia použiť posuvník zaostrenia vo webovej aplikácii
na úpravu polohy zaostrenia.

Podrobnosti nájdete v časti „Manuálne nastavenie
automatického zaostrenia (AF Assist) pomocou webovej
aplikácie“.

Poznámka

Táto položka je aktívna len vtedy, keď je [AF Assist]
v ponuke kamery nastavené na [On].
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Base Setting

Nastavuje základné nastavenie.

Súvisiaca téma

Konfigurácia základnej činnosti

5-041-959-13(1) Copyright 2022 Sony Corporation

Položka Nastavenie podpoložky Predvolené
nastavenie z výroby Popis

Shooting
Mode

Custom / Flexible ISO / Cine
EI Quick / Cine EI

Custom

Nastaví režim snímania.

Pozrite si časť „Režim snímania“ v časti
„Konfigurácia základnej činnosti“.

Target
Display

SDR(BT.709) / HDR(HLG) SDR(BT.709)
Nastavuje farebný rozsah záznamu/výstupu
v režime Custom.
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Rec Format

Nastavuje formát záznamu.

Nastavenia [RAW Output Format]

Položka Nastavenie podpoložky
Predvolené
nastavenie

z výroby
Popis

Frequency 59.94 / 50 / 29.97 / 25 / 24 / 23.98 59.94

Vyberie systémovú frekvenciu.

Poznámka

Ak sa frekvencia zmení, kamera sa
reštartuje. Po reštarte znova načítajte
stránku vo webovom prehliadači.

Imager Scan
Mode

FF / S35 FF Vyberie veľkosť snímača.

Codec
RAW / RAW & XAVC-I / XAVC-I /
XAVC-L

XAVC-I

Nastaví kodek nahrávania/prehrávania klipu.

Poznámka

Keď je [Imager Scan Mode] nastavené na
[S35], [RAW] a [RAW & XAVC-I] nemožno
vybrať.

RAW Output
Format

Dostupné nastavenia sa líšia
v závislosti od nastavenia
[Frequency].

Pozrite si časť „Nastavenia
[RAW Output Format]“ nižšie.

–

Nastaví veľkosť snímky RAW na výstup do
externého RAW rekordéra.

Poznámka

Keď je [Codec] nastavené na [RAW &
XAVC-I], nastavenie [Video Format] sa
prepne v spojení s nastavením [RAW
Output Format].

Video
Format

Dostupné nastavenia sa líšia
v závislosti od nastavení
[Frequency], [Imager Scan Mode]
a [Codec].

Pozrite si časť „Nastavenia
[Video Format]“ nižšie.

– Nastaví veľkosť obrázka.

Frequency Imager Scan Mode Codec Nastavenie

59.94 / 50 / 29.97 / 25 / 23.98 FF RAW / RAW & XAVC-I
4096×2160
3840×2160
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Predvolené hodnoty sú zobrazené tučným písmom.
Podmienky, za ktorých nemožno nastaviť [RAW Output Format], boli vynechané.

Nastavenia [Video Format]

Predvolené hodnoty sú zobrazené tučným písmom.
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Frequency Imager Scan Mode Codec Nastavenie

24 FF RAW / RAW & XAVC-I 4096×2160

Frequency Imager Scan Mode Codec Nastavenie

59.94 / 50 / 29.97 / 25 / 23.98

FF

RAW –

RAW & XAVC-I
4096×2160P
3840×2160P

XAVC-I
4096×2160P
3840×2160P
1920×1080P

XAVC-L
3840×2160P
1920×1080P 50
1920×1080P 35

S35

XAVC-I 1920×1080P

XAVC-L
1920×1080P 50
1920×1080P 35

24 FF
RAW –

RAW & XAVC-I / XAVC-I 4096×2160P
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Simul Rec

Vykoná nastavenia režimu simultánneho nahrávania s 2 zásuvkami (pozrite si „Súčasné nahrávanie na pamäťové karty A
a B. (2-slot Simul Rec)“).

Súvisiaca téma

Súčasné nahrávanie na pamäťové karty A a B. (2-slot Simul Rec)
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Položka Nastavenie
podpoložky

Predvolené
nastavenie z výroby Popis

Setting On / Off Off
Zapína/vypína funkciu súčasného nahrávania
a nastavuje cieľové médium nahrávania.

Rec Button
Slot A / Slot B / Slot
A/Slot B

Slot A/Slot B Zobrazuje priradenie tlačidla nahrávania pre každé
nahrávacie médium.
Nastavte [Project] > [Simul Rec] > [Rec Button Set]
v ponuke kamery.

2nd Rec
Button

Slot A / Slot B / Slot
A/Slot B

Slot A/Slot B
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Proxy Rec

Vykoná nastavenia režimu pre zástupné nahrávanie (pozrite si „Zástupné nahrávanie“).
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Položka Nastavenie
podpoložky

Predvolené nastavenie
z výroby Popis

Setting On / Off Off
Zapína/vypína režim zástupného
nahrávania.
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Interval Rec

Vykoná nastavenia režimu pre prerušované nahrávanie (pozrite si „Prerušované nahrávanie videa (Interval Rec)“).

Súvisiaca téma

Prerušované nahrávanie videa (Interval Rec)
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Položka Nastavenie podpoložky Predvolené nastavenie
z výroby Popis

Setting On / Off Off

Zapína/vypína režim intervalového
nahrávania. (Nastavením tohto
režimu na On nastavíte všetky
ostatné špeciálne režimy na Off.)

Interval
Time

1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15
/ 20 / 30 / 40 / 50 (sek)
1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15
/ 20 / 30 / 40 / 50 (min)
1 / 2 / 3 / 4 / 6 / 12 / 24 (hod)

1

Nastavuje interval medzi nahrávkami
v režime nahrávania Interval Rec
(keď je Interval Rec nastavené na
On).

Number
of Frames

1frame / 2frames / 3frames /
6frames / 9frames / 12frames
Dostupné nastavenia sa líšia
v závislosti od frekvencie snímok
vybraného formátu videa.
59.94P/50P: 2frames / 6frames /
12frames
29.97P/25P/24P/23.98P: 1frame /
3frames / 6frames / 9frames

59.94P/50P: 2frames
29.97P/25P/24P/23.98P:
1frame

Nastavuje počet snímok, ktoré sa
majú zaznamenať pri jednom
snímaní v režime nahrávania Interval
Rec (keď je Interval Rec nastavené
na On).
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Picture Cache Rec

Vykoná nastavenia režimu nahrávania do vyrovnávacej pamäte obrázkov (pozri „Nahrávanie obrázkov vo vyrovnávacej
pamäti (Picture Cache Rec)“).

Súvisiaca téma
Nahrávanie obrázkov vo vyrovnávacej pamäti (Picture Cache Rec)
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Položka Nastavenie
podpoložky

Predvolené
nastavenie

z výroby
Popis

Setting On / Off Off Zapína/vypína funkciu vyrovnávacej pamäte obrázkov.

Cache Size
Short / Medium /
Long / Max

Max
Nastavuje čas akumulácie obrázkov vo vyrovnávacej
pamäti obrázkov (čas nahrávania vyrovnávacej pamäte
obrázkov).

Cache Rec
Time

– –
Zobrazuje čas akumulácie obrázkov vo vyrovnávacej
pamäti obrázkov (čas nahrávania vyrovnávacej pamäte
obrázkov).
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

All File

Vykonáva operácie súboru ALL (pozrite si „Uloženie a načítanie konfiguračných údajov“).
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Položka Nastavenie
podpoložky

Predvolené
nastavenie z výroby Popis

Load All
File

– –

Nahrajte súbor ALL do jednotky zo zariadenia s webovou
aplikáciou.

Poznámka

Po načítaní súboru ALL do jednotky sa jednotka reštartuje.
Po reštarte znova načítajte stránku vo webovom
prehliadači.

Save All
File

– –
Uložte nastavenia jednotky do zariadenia s webovou
aplikáciou ako súbor ALL.
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Interchangeable Lens Digital Camera
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Base Look

Do jednotky môžete načítať základný pohľad.
Na obrazovke sa zobrazí zoznam dostupných základných vzhľadov. Aktuálne použitý základný vzhľad je označený
značkou ● naľavo od čísla základného vzhľadu.

[No.]: Číslo základného vzhľadu
[Base Look Name]: Názov základného vzhľadu
[Input]: Vstupný signál základného vzhľadu
[Output]: Výstupný signál základného vzhľadu
[AE Level Offset]: Referenčná hodnota posunu expozície základného pohľadu

Pridanie základného vzhľadu
Stlačením tlačidla [Import] importujete nový základný vzhľad. Postupujte podľa pokynov na obrazovke.
Po naimportovaní nastavte príslušné hodnoty pre [Input], [Output], a [AE Level Offset]. Podrobnosti nájdete v časti
„Import požadovaného základného vzhľadu“.

Súvisiaca téma
Import požadovaného základného vzhľadu
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Sprievodca s nápovedou
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P/T Speed

Vykoná nastavenia súvisiace s rýchlosťou otáčania/nakláňania.
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Položka Nastavenie
podpoložky

Predvolené
nastavenie

z výroby
Popis

Speed
Step

Normal /
Extended

Extended

Nastavuje počet rýchlostných krokov posúvania/nakláňania.
Normal: Rýchlosť je možné určiť pomocou 24 krokového
rozsahu. Toto nastavenie použite na zabezpečenie kompatibility
s existujúcimi diaľkovými kamerami Sony.
Extended: Rýchlosť je možné určiť pomocou 50 krokového
rozsahu.

Speed
Mode

Normal / Slow Normal

Nastavuje režim rýchlosti otáčania/nakláňania.
Povolené, len ak je [Speed Step] nastavené na [Normal].
Normal: Pracuje v rozsahu normálnych rýchlostí (od minima po
maximum (60 stupňov/sekundu)).
Slow: Pracuje v rozsahu nízkych rýchlostí (od minima po
maximum (40 stupňov/sekundu)).
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

P/T Acceleration

Vykoná nastavenia súvisiace s rýchlosťou otáčania/nakláňania.

5-041-959-13(1) Copyright 2022 Sony Corporation

Položka Nastavenie
podpoložky

Predvolené
nastavenie z výroby Popis

Acceleration 1 až 9 8
Vyberá zrýchlenie/spomalenie pre otáčanie/nakláňanie.
Čím je číslo väčšie, tým je vyššie zrýchlenie.

394



Sprievodca s nápovedou

Interchangeable Lens Digital Camera
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P/T Range Limit

Vykoná nastavenia súvisiace s obmedzením prevádzkového rozsahu otáčania/nakláňania.
Pomocou nasledujúcej obrazovky nastavte limity prevádzkového rozsahu otáčania/nakláňania.

Poznámka

Pri zapnutí jednotky alebo keď sa vykoná reset otáčania/nakláňania, toto nastavenie limitu rozsahu sa ignoruje. Túto funkciu nie
je možné použiť na vyhýbanie sa prekážkam v blízkosti jednotky.

Nastavte prepínač [Setting] do polohy zapnuté.

Aktivuje sa funkcia obmedzenia prevádzkového rozsahu otáčania a nakláňania.

1

Skontrolujte obraz pomocou ovládacích prvkov otáčania a nakláňania kamery.2

Ak chcete nastaviť polohy, v ktorých sa má obmedziť prevádzka, stlačte v týchto polohách tlačidlo [Left],
[Right], [Up], [Down] > [Set Current Value].

[Left]: Ľavá strana kamery
[Right]: Pravá strana kamery
[Up]: Horná strana kamery

3
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Poznámka

Polohy kamery mimo krajných polôh nie je možné uložiť ako predvoľbu.

Ak sa zmení nastavenie [Pan-Tilt] > [P/T Direction] > [Ceiling], nakonfigurované nastavenia krajnej polohy sa vrátia na predvolené
výrobné nastavenia.

Nastavenie nie je možné zmeniť počas prehrávania, počas zobrazenia miniatúr, keď dôjde k chybe otáčania/nakláňania, keď nie
je inicializované otáčanie/nakláňanie a keď je otáčanie/nakláňanie uzamknuté.
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[Down]: Spodná strana kamery

Krajné polohy sú nastavené a sú zobrazené ako číselné hodnoty (uhol).
Ak chcete zrušiť obmedzenie, stlačte tlačidlo [Reset] pre jednotlivé polohy.

Stlačte tlačidlo [OK].

Otáčanie/nakláňanie je obmedzené tak, aby zostalo v rámci nakonfigurovaných krajných polôh.

4
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

P/T Direction

Vykoná nastavenia súvisiace so smerom otáčania/nakláňania.

Poznámka

Keď sa použije zmenené nastavenie [Ceiling], všetky predvolené polohy sa vymažú, pretože súradnice otáčania/nakláňania by sa
zmenili.

Rozsah pohonu otáčania/nakláňania sa mení, ako je znázornené na nasledujúcom diagrame, v závislosti od nastavenia
[Ceiling].

A: Ak je [Ceiling] nastavené na [Off]
B: Ak je [Ceiling] nastavené na [On]

Položka Nastavenie
podpoložky

Predvolené
nastavenie

z výroby
Popis

Ceiling On / Off Off

Keď je jednotka namontovaná na pracovnej ploche, nastavte ju na
[Off]. Keď je jednotka namontovaná na strope, nastavte ju na [On].
Keď je [Ceiling] nastavené na [On], [Pan Direction] sa automaticky
nastaví na [Opposite].

Pan
Direction

Normal /
Opposite

Normal Nastavuje smer pohonu otáčania. Keď sa nastavenie zmení, smer
pohonu sa obráti.

Tilt
Direction

Normal /
Opposite

Normal
Nastavuje smer pohonu nakláňania. Keď sa nastavenie zmení,
smer pohonu sa obráti.
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

P/T Preset

Nastavuje nastavenia súvisiace s predvoľbami kamery.

Pan-Tilt
Nastavuje rýchlosť pre predvoľby.

Default
Nastaví predvolené hodnoty, ktoré sú nakonfigurované pri uložení prednastavenej polohy.
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Položka Nastavenie
podpoložky

Predvolené
nastavenie

z výroby
Popis

Pan-Tilt Speed
Setting Way

Separate /
Common

Separate
Nastavuje, či sa predvolené rýchlosti konfigurujú
samostatne alebo či sa použije spoločné nastavenie.

Pan-Tilt Speed
for Common

1 až 50 50

Nastavuje spoločnú rýchlosť pre predvoľby.

Poznámka

Maximálna rýchlosť 24 sa použije, ak je nastavená
hodnota 25 alebo vyššia, keď je [Pan-Tilt] > [P/T Speed] >
[Speed Step] nastavené na [Normal].

Položka Nastavenie
podpoložky

Predvolené
nastavenie

z výroby
Popis

Pan-Tilt Speed
for Separate

1 až 50 50
Nastaví rýchlosť pre predvoľby, keď je spôsob výberu
rýchlosti predvoľby nastavený na [Separate].

Zoom Sync On / Off On
Nastavuje, či sa pri obnovení prednastavenej polohy
synchronizuje otáčanie/nakláňanie a transfokácia.

Zoom Speed 0 až 32767 32767 Nastaví rýchlosť transfokácie.

Focus Recall On / Off On Nastaví, či sa obnovia nastavenia zaostrenia.

MF Speed 0 až 32767 32767
Nastavuje rýchlosť zaostrovania pre manuálne
zaostrovanie.
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Output Format

Nastavenie výstupného formátu.

Súvisiaca téma

Výstupné formáty a obmedzenia
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Položka Nastavenie podpoložky Predvolené
nastavenie z výroby Popis

SDI Podrobnosti o nastaveniach nájdete v časti
„Výstupné formáty a obmedzenia“.

– Nastavuje výstupné
rozlíšenie SDI a HDMI.HDMI –
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Output Display

Nastavuje nastavenia súvisiace s výstupnými signálmi.
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Položka Nastavenie
podpoložky

Predvolené
nastavenie
z výroby

Popis

SDI On / Off Off
Nastavuje, či sú ponuka a stav súčasťou výstupného
signálu SDI.

HDMI/Stream On / Off On

Nastavuje, či je ponuka a stav súčasťou výstupného signálu
HDMI.

Poznámka

Toto nastavenie sa použije aj na obraz výstupného signálu
HDMI, výstupný obraz streamovania a obraz na obrazovom
paneli webovej aplikácie.
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Audio Input

Nastavuje nastavenia týkajúce sa audio vstupu CH1 až CH4.

Nastavuje hlavnú vstupnú úroveň zvuku. Hlavná vstupová úroveň zvuku sa použije pre všetky kanály 1 až 4.
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Položka Nastavenie podpoložky Predvolené nastavenie
z výroby Popis

Level
Control

Auto / Manual Auto
Vyberá automatické alebo manuálne
nastavenie úrovne audio vstupu.

Level 0 až 99 49 Nastavuje vstupnú úroveň.

Input
Select

AUDIO IN CH1 / AUDIO
IN CH2 / Off

CH1 a CH3: AUDIO IN
CH1
CH2 a CH4: AUDIO IN
CH2

Nastavuje zdroj vstupu zvuku.

Poznámka

CH1 je nastavený na [AUDIO IN CH1]
(napevno).

Wind Filter On / Off Off Zapne/vypne filter redukcie hluku vetra.

Položka Nastavenie podpoložky Predvolené nastavenie z výroby Popis

Master 0 až 99 99 Nastavuje úroveň hlavného vstupu.
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Audio Output

Vykoná nastavenia súvisiace so zvukovým výstupom.

Poznámka

Toto nastavenie sa použije aj na streamovaný výstup zvuku.
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Položka Nastavenie
podpoložky

Predvolené
nastavenie z výroby Popis

HDMI/Stream
Output CH

CH1/CH2 /
CH3/CH4

CH1/CH2
Nastavuje kombináciu zvukových kanálov pre
HDMI/streamovaný výstup.
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Tracking Data Output

Umožňuje nastavenia týkajúce sa výstupu monitorovacích informácií (v súlade s protokolom free-d).
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Položka Nastavenie
podpoložky

Predvolené
nastavenie

z výroby
Popis

Transfer Mode
Off / Always / On
Demand

Off Vyberie spôsob výstupu monitorovacích informácií.

Camera ID 0 až 255 255 Nastaví ID jednotky.

Destination
Address

IPv4 adresa –
Keď je [Transfer Mode] nastavené na [Always], nastaví
cieľovú IP adresu monitorovacích informácií.

Destination
Port

1024 až 65534 40000
Keď je [Transfer Mode] nastavené na [Always], nastaví
číslo cieľového portu monitorovacích informácií.

Listen Port 1024 až 65534 40000
Keď je [Transfer Mode] nastavené na [On Demand],
nastaví číslo portu v jednotke na príjem požiadaviek od
klientov.
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Tally

Nastaví nastavenia kontrolky nahrávania/záznamu (pozrite si „Pripojenie záznamového signálu“).

Súvisiaca téma

Pripojenie záznamového signálu
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Položka Nastavenie
podpoložky

Predvolené
nastavenie z výroby Popis

Tally Lamp
Brightness

High / Low / Off High Nastavuje jas kontrolky nahrávania/záznamu.

G Tally Lamp Enable / Disable Enable Zapína/vypína kontrolku záznamu G.

Tally Control External / Internal Internal
Vyberie cieľ pre príjem riadiacich informácií
kontrolky nahrávania/záznamu jednotky.
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

IR Remote

Vykoná nastavenia súvisiace s infračerveným diaľkovým ovládačom.
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Položka Nastavenie
podpoložky

Predvolené nastavenie
z výroby Popis

Setting On / Off On
Aktivuje/deaktivuje prevádzku jednotky
z infračerveného diaľkového ovládača.
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

RCP/MSU

Konfiguruje nastavenie, keď je pripojené RCP/MSU (voliteľné).
Podrobnosti nájdete v časti „Pripojenie RCP/MSU (voliteľné)“.

Poznámka

Podľa potreby nakonfigurujte nastavenia na RCP/MSU.

Pre viackamerový systém sa vyžaduje MSU.

Pri použití viacerých jednotiek MSU nastavte jednu jednotku MSU ako hlavnú a všetky ostatné jednotky MSU nastavte ako
klientov.
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Položka Nastavenie
podpoložky

Predvolené
nastavenie

z výroby
Popis

CNS Mode
Off / Bridge / MCS /
PC Control

Off Nastavuje režim pripojenia pre RCP/MSU.

Master IP
Address

IPv4 adresa 0.0.0.0
Nastavuje IP adresu hlavného zariadenia pri budovaní
systému viacerých kamier na báze LAN.

Camera No.
Camera No. (1 až
96)

1
Nastaví jedinečné číslo kamery v rámci systému pri
budovaní viackamerového systému založeného na sieti
LAN.
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Lens Controller

Určí nastavenia pre pripojený ovládač objektívu (voliteľné príslušenstvo).
Podrobnosti nájdete v časti „Pripojenie ovládača objektívu“.

Poznámka

Po zmene [Setting] sa jednotka reštartuje. Znovu načítajte stránku vo webovom prehliadači.
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Položka Nastavenie
podpoložky

Predvolené
nastavenie
z výroby

Popis

Setting On / Off Off
Nastavuje, či sa má použiť ovládač objektívu (voliteľné
príslušenstvo).

Mode 0 až 15 0

Nastavuje prevádzkový režim ovládača objektívu (voliteľné
príslušenstvo).
K dispozícii sú hodnoty v rozsahu 0 až 15, ale skutočné hodnoty,
ktoré možno vybrať, sa líšia v závislosti od ovládača objektívu
(voliteľné príslušenstvo). Podrobnosti nájdete v návode na obsluhu
ovládača objektívu.

Reverse On / Off Off Obráti smer otáčania ovládača objektívu (voliteľné príslušenstvo).

Initialize – – Inicializuje ovládač objektívu (voliteľné príslušenstvo).
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Camera Name

Vykoná nastavenia súvisiace s názvom kamery (názov jednotky).

Je možné zadať až osem (0 až 8) z nasledujúcich znakov pre Camera Name.
Alfanumerické znaky
Symboly (medzera !#$`!*+-./;<=>?@[\]^_`{|})
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Položka Nastavenie podpoložky Predvolené nastavenie z výroby Popis

Camera Name – FR7 Nastaví názov kamery.
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

User

Vykoná nastavenia súvisiace s prístupom používateľa k jednotke.

Nastavenia súvisiace so správcami (Administrator) (povinné)

Nastavenia týkajúce sa všeobecných používateľov (User 1 až User 9) (voliteľné)
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Položka Nastavenie
podpoložky

Predvolené nastavenie
z výroby Popis

User Name – admin Nastaví meno používateľa.

Current
Password

– –
Pri zmene hesla zadajte aktuálne
heslo.

New Password – – Zadajte nové heslo.

Re-Type
Password

– –
Pre potvrdenie zadajte nové heslo
znova.

Položka Nastavenie
podpoložky

Predvolené nastavenie
z výroby Popis

User Name – – Nastaví meno používateľa.

Current
Password

– –
Pri zmene hesla zadajte aktuálne
heslo.

New Password – – Zadajte nové heslo.

Re-Type
Password – –

Pre potvrdenie zadajte nové heslo
znova.
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Wired LAN

Status
Zobrazuje stav siete.

IPv4
Nastavuje nastavenia súvisiace so sieťou IPv4.

Položka Nastavenie
podpoložky

Predvolené nastavenie
z výroby Popis

Host Name – – Zobrazuje názov hostiteľa.

MAC Address – – Zobrazuje MAC adresu jednotky.

Ethernet Status – –
Zobrazuje aktuálnu rýchlosť
komunikácie.

IP Address – – Zobrazuje IP adresu jednotky.

Subnet Mask – – Zobrazuje masku podsiete jednotky.

Gateway – –
Zobrazuje predvolenú bránu IPv4
jednotky.

Primary DNS Server – –
Zobrazuje primárny server DNS
jednotky.

Secondary DNS
Server

– –
Zobrazuje sekundárny server DNS
jednotky.

IPv6 Address 1 – – Zobrazuje IPv6 adresu 1 jednotky.

IPv6 Address 2 – – Zobrazuje IPv6 adresu 2 jednotky.

IPv6 Gateway – –
Zobrazuje predvolenú bránu IPv6
jednotky.

Link-local IPv6
Address

– –
Zobrazuje lokálnu adresu IPv6 link
jednotky.

Položka Nastavenie
podpoložky

Predvolené nastavenie
z výroby Popis

DHCP On / Off On Zapína/vypína funkciu [DHCP].

IP Address – –
Nastaví adresu IPv4, keď je [DHCP] nastavené
na Off.

Subnet
Mask

– –
Nastaví masku podsiete, keď je [DHCP]
nastavené na Off.
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IPv6
Nastavuje nastavenia súvisiace so sieťou IPv6.

Common
Vykoná nastavenia spoločné pre siete IPv4/IPv6.
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Položka Nastavenie
podpoložky

Predvolené nastavenie
z výroby Popis

Gateway – –
Nastaví predvolenú bránu IPv4, keď je [DHCP]
nastavené na Off.

Položka Nastavenie
podpoložky

Predvolené
nastavenie z výroby Popis

Obtain an IP Address
Automatically

On / Off On
Zapína/vypína automatické získavanie adresy
IPv6.

IP Address – –
Nastaví adresu IPv6, keď je [Obtain an IP
Address Automatically] nastavené na Off.

Prefix Length – – Nastaví prefix, keď je [Obtain an IP Address
Automatically] nastavené na Off.

Gateway – –
Nastaví predvolenú bránu IPv6, keď je [Obtain
an IP Address Automatically] nastavené na Off.

Položka Nastavenie
podpoložky

Predvolené nastavenie
z výroby Popis

HTTP Port 80, 1024 až 65534 80 Nastavuje číslo portu HTTP.

DNS Auto On / Off On
Nastavuje, či sa majú získať adresy DNS zo
servera DHCP.

Primary DNS
Server

IPv4/IPv6 adresa –
Nastaví primárny server DNS, keď je [DNS
Auto] nastavené na Off.

Secondary DNS
Server

IPv4/IPv6 adresa –
Nastaví sekundárny server DNS, keď je [DNS
Auto] nastavené na Off.
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

File Transfer

Nastavenia týkajúce sa prenosov súborov.
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Položka Nastavenie
podpoložky

Predvolené
nastavenie

z výroby
Popis

Auto
Upload
(Proxy)

On / Off Off Zapne/vypne automatické nahrávanie zástupného súboru.

Default
Upload
Server

Server Settings1
až 3 > Display
Name

Server Settings1

Vyberie server pre nahrávanie súborov. Tu vybraný server sa
stane miestom automatického nahrávania pre zástupné
súbory a miestom pre nahrávanie súborov z obrazovky
miniatúr.
Zobrazuje nastavenia [Display Name] nakonfigurované
v [Server Settings1 až 3].
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

FTP Server 1 až 3

Vykoná nastavenia súvisiace s FTP prenosmi súborov.
Nastavenia sú spoločné pre FTP Server 1 až 3.
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Položka Nastavenie
podpoložky

Predvolené
nastavenie z výroby Popis

Display Name – –
Nastavuje názov zobrazený v ponuke nastavenia
cieľa prenosu.

Service – – Zobrazí typ servera.

Host Name – –
Nastavuje názov hostiteľa cieľového servera
prenosu.

Port
21, 990, 1024 až
65534

21 Nastavuje číslo portu cieľového servera prenosu.

User Name – –
Nastavuje meno používateľa na autentifikáciu
spojenia s cieľovým serverom prenosu.

Password – –
Nastavuje heslo na autentifikáciu spojenia
s cieľovým serverom prenosu.

Passive Mode On / Off Off Zapína/vypína pasívny režim.

Destination
Directory

– – Nastaví názov cieľového adresára prenosu.

Using Secure
Protocol

On / Off Off
Nastaví, či sa má použiť (On) alebo nepoužiť (Off)
zabezpečený prenos FTP.

Root Certificate – –

Načíta koreňový certifikát pre bezpečný FTP
prenos.
Stlačte tlačidlo [Load] a na zobrazenej obrazovke
vyberte koreňový certifikát.
Stlačením tlačidla [Delete] odstránite načítaný
koreňový certifikát.

Root Certificate
Status

– – Zobrazuje stav načítania koreňového certifikátu.

Reset – – Resetuje [Server Settings] na predvolené hodnoty.
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

SSL

Vykoná nastavenia súvisiace s SSL.

SSL
Povolí/zakáže funkciu SSL.

SSL Server Authentication
Vykoná nastavenia súvisiace s overením servera SSL.

Položka Nastavenie podpoložky Predvolené nastavenie
z výroby Popis

Function
Disable / Enable / Enable (Allow HTTP connection
for some clients)

Disable
Povolí/zakáže funkciu
SSL.

Položka Nastavenie podpoložky
Predvolené
nastavenie
z výroby

Popis

Certificate
Options

Use a self-signed
certificate (For test use) /
Use an external certificate

–
Nastavuje spôsob inštalácie certifikátu servera
SSL.

Status – –
Zobrazuje platnosť certifikátu servera SSL, keď je
[Certificate Options] nastavené na [Use a self-
signed certificate (For test use)].

Issuer DN – –

Zobrazuje rozlišujúci názov vydavateľa certifikátu
servera SSL, keď je [Certificate Options]
nastavené na [Use a self-signed certificate (For
test use)].

Subject DN – –

Zobrazuje rozlišujúci názov predmetu certifikátu
servera SSL, keď je [Certificate Options]
nastavené na [Use a self-signed certificate (For
test use)].

Available Period – –
Zobrazuje platné obdobie certifikátu servera SSL,
keď je [Certificate Options] nastavené na [Use a
self-signed certificate (For test use)].

Extended Key
Usage

– –
Zobrazuje metódu rozšíreného použitia kľúča, keď
je [Certificate Options] nastavené na [Use a self-
signed certificate (For test use)].

Delete – –

Toto tlačidlo sa zobrazí, keď je [Certificate
Options] nastavené na [Use a self-signed
certificate (For test use)].
Odstráni nainštalovaný certifikát servera SSL.
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Položka Nastavenie podpoložky
Predvolené
nastavenie
z výroby

Popis

Import – –
Nainštaluje externý certifikát servera SSL zo
zoznamu, keď je [Certificate Options] nastavené
na [Use an external certificate].

Private Key
Password

– –

Nastaví heslo pre informácie o súkromnom kľúči
certifikátu servera SSL, keď je [Certificate
Options] nastavené na [Use an external
certificate].

Reset – –
Toto tlačidlo vymaže zobrazenie hesla
súkromného kľúča na zadanie nového hesla.

Self-Signed
Certificate
Generation

– –

Stlačte tlačidlo [Generate] na vygenerovanie
certifikátu s vlastným podpisom, keď je [Certificate
Options] nastavené na [Use a self-signed
certificate (For test use)].
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Referer Check

Nastavuje nastavenia súvisiace s kontrolami odkazujúcej stránky.

Exception List
Nastavuje nastavenia súvisiace so zoznamom výnimiek Referer check.

Položka Nastavenie podpoložky Predvolené nastavenie z výroby Popis

Setting On / Off On Aktivuje/deaktivuje funkciu Referer check.

Položka Nastavenie
podpoložky

Predvolené
nastavenie z výroby Popis

No. 1 až 10 – Nastaví číslo výnimky zo zoznamu.

Host
Name

– – Nastavuje názov hostiteľa výnimky.

Port
Number

– – Nastavuje číslo portu výnimky.

Set – –
Stlačením zaregistrujete nakonfigurovanú výnimku
v zozname výnimiek.

Delete – –
Vyberte výnimku, ktorú chcete vymazať, a stlačením tlačidla
vymažte zaregistrovanú výnimku zo zoznamu výnimiek.
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Brute Force Attack Protection

Vykoná nastavenia súvisiace s prevenciou proti útokom hrubou silou.

Keď sa zistí útočník, zobrazia sa informácie o zozname útočníkov.

5-041-959-13(1) Copyright 2022 Sony Corporation

Položka Nastavenie
podpoložky

Predvolené
nastavenie z výroby Popis

Setting On / Off On Zapína/vypína funkciu [Brute Force Attack Protection].

Count 3 až 100 8
Nastavuje počet pokusov, ktoré sa budú považovať za útok.
Povolené, ak je [Setting] nastavené na On.

Release
Mode Always / Timer Timer

Nastavuje podmienku uvoľnenia.
Povolené, ak je [Setting] nastavené na On.
Always: Neodstraňujte zo zoznamu útočníkov.
Timer: Odstráňte zo zoznamu útočníkov po uplynutí času
uvoľnenia nastaveného pomocou [Release Time].

Release
Time

30 až 86400 s 60

Nastavuje čas uvoľnenia.
Povolené, ak je [Setting] nastavené na On.
Keď je Release Mode nastavené na [Timer], záznamy sa
po uplynutí času uvoľnenia vymažú zo zoznamu útočníkov.
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Stream

Vykoná nastavenia streamovania (pozrite si „O streamovaní“).

Stream Setting
Nastavuje nastavenia súvisiace so streamovacím protokolom.

Poznámka

Ak chcete používať RTMP, nastavte najprv [Stream] > [Audio Stream] > [Setting] na [On].

RTSP
Nasledujúce položky sa zobrazia, keď je [Stream Setting] nastavené na [RTSP].
Nastavuje nastavenia týkajúce sa streamovania RTSP.

RTMP
Nasledujúce položky sa zobrazia, keď je [Stream Setting] nastavené na [RTMP].
Určí nastavenia týkajúce sa streamovania RTMP.

Položka Nastavenie podpoložky Predvolené nastavenie
z výroby Popis

Setting
RTSP / RTMP / SRT-Caller / SRT-Listener /
NDI|HX / Off

RTSP
Vyberie streamovací
protokol.

Položka Nastavenie
podpoložky

Predvolené
nastavenie z výroby Popis

Port Number
554, 1024 až
65534

554 Nastaví číslo portu RTSP.

Time Out 0 až 600 60 Nastavuje časový limit príkazu Keep Alive pre
streamovanie RTSP.

Authentication On / Off On Zapína/vypína funkciu autentifikácie RTSP.

Video Port
Number 1

1024 až 65534 51000
Nastavuje číslo portu pre odosielanie videa 1 pre
jednosmerné streamovanie RTSP.

Video Port
Number 2

1024 až 65534 53000
Nastavuje číslo portu pre odosielanie videa 2 pre
jednosmerné streamovanie RTSP.

Audio Port
Number

1024 až 65534 57000
Nastavuje číslo portu na odosielanie zvuku pre
jednosmerné streamovanie RTSP.
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SRT
Nasledujúce položky sa zobrazia, keď je [Stream Setting] nastavené na [SRT-Caller] alebo [SRT-Listener].
Nastavuje nastavenia súvisiace so streamovaním SRT.

NDI|HX
Nasledujúce položky sa zobrazia, keď je [Stream Setting] nastavené na [NDI|HX].
Nastavuje nastavenia súvisiace s NDI|HX.

Položka Nastavenie
podpoložky

Predvolené nastavenie
z výroby Popis

Server URL – –
Nastaví cieľovú adresu URL pripojenia RTMP alebo
RTMPS.

Stream Key – –
Nastaví streamovací kľúč získaný zo strany servera
RTMP.

Root
Certificate

– –

Načíta koreňový certifikát potrebný na pripojenie
k serveru RTMP.
Stlačte tlačidlo [Load] a na zobrazenej obrazovke
vyberte koreňový certifikát.
Stlačením tlačidla [Delete] odstránite načítaný
koreňový certifikát.
Stav sa zobrazí v položke [Root Certificate Status].

Položka Nastavenie
podpoložky

Predvolené nastavenie
z výroby Popis

Destination – –
Nastaví cieľovú adresu URL pripojenia, keď
jednotka funguje ako volajúci.

Port
Number

1024 až 65534 4201 Nastavuje číslo portu pre príjem, keď jednotka
pracuje ako prijímač.

Latency 20 až 8000 ms 120 Nastavuje latenciu.

TTL 1 až 255 64 Nastavuje hodnotu TTL.

Encryption Off / AES128 / AES256 Off
Povolí/zakáže šifrovanie a nastaví metódu
šifrovania.

Passphrase
0 alebo reťazec 10 až
79 znakov

0
Nastavuje prístupovú frázu použitú na šifrovanie.
Stlačením Reset vymažete zadanú prístupovú
frázu.

ARC On / Off On Zapína/vypína funkciu Adaptive Rate Control.

Položka Nastavenie
podpoložky

Predvolené nastavenie
z výroby Popis

License – – Zobrazuje stav inštalácie licenčného kľúča NDI.

Source Name – – Zobrazuje názov zdroja NDI.

Group On / Off Off Zapína/vypína funkciu zoskupovania NDI.
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Súvisiaca téma

O streamovaní
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Položka Nastavenie
podpoložky

Predvolené nastavenie
z výroby Popis

Group Name – –
Zobrazuje sa, keď je funkcia zoskupovania NDI
nastavená na On.
Nastaví názov skupiny.

Discovery
Server 1

– – Nastaví server zisťovania NDI 1.

Discovery
Server 2

– – Nastaví server zisťovania NDI 2.

Multicast Mode On / Off Off Zapne/vypne viacsmerné streamovanie.

Multicast Prefix 239.255.0.0 239.255.0.0

Zobrazuje sa, keď je [Multicast Mode]
nastavené na On.
Nastavuje prefix, ktorý sa má použiť pre
viacsmerné streamovanie.

Multicast
Netmask

255.255.0.0 255.255.0.0

Zobrazuje sa, keď je [Multicast Mode]
nastavené na On.
Nastavuje masku siete, ktorá určuje viacsmerný
rozsah adries.

Multicast TTL 1 až 256 3

Zobrazuje sa, keď je [Multicast Mode]
nastavené na On.
Nastavuje hodnotu TTL pre viacsmerné
streamovanie.

Multi-TCP
Mode

On / Off Off Zapína/vypína režim Multi-TCP.

Unicast UDP
Mode

On / Off On Zapína/vypína režim Unicast UDP.
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Video Stream

Nastavuje nastavenia týkajúce sa kodekov streamovaného videa.

Video Stream 1
Nastavuje nastavenia súvisiace s video kodekom 1.

Položka Nastavenie podpoložky
Predvolené
nastavenie

z výroby
Popis

Codec 1 H.264 / H.265 H.264 Nastaví kodek pre obraz 1.

Size 1
4096×2160 / 3840×2160 / 2048×1080 /
1920×1080 / 1280×720 / 640×360

1920×1080 Nastaví veľkosť obrazu 1.

Frame Rate 1

Podrobnosti o podporovaných
snímkových frekvenciách nájdete
v časti „Nastavenie video kodeku pre
streamovanie“.

–
Nastaví snímkovú frekvenciu
obrazu 1.

I-Picture Mode 1 Time / Frame Time
Nastaví interval vkladania IDR-
Frame pre obraz 1 ako čas alebo
počet snímok.

I-Picture Interval
1

1 / 2 / 3 / 4 / 5 s 1

Zobrazuje sa, keď je [I-Picture
Mode 1] nastavené na Time.
Nastaví interval vloženia rámčeka
IDR pre H.264 a H.265 ako čas.

I-Picture Ratio 1 15 až 300 rámčekov 30

Zobrazuje sa, keď je [I-Picture
Mode 1] nastavené na Frame.
Nastaví interval vkladania snímok
IDR pre H.264 a H.265 ako počet
snímok.

Profile 1
H.264: high / main / baseline
H.265: main / main10

H.264: high Nastaví profil H.264 alebo H.265.

Bit Rate
Compression
Mode 1

CBR / VBR VBR
Nastavuje kompresný režim
prenosovej rýchlosti obrazu 1.

Bit Rate 1
512 / 768 / 1000 / 2000 / 3000 / 4000 /
5000 / 6000 / 7000 / 8000 / 16000 / 24000
/ 32000 / 50000 / 64000 / 80000 kbps

16000

Zobrazuje sa, keď je [Bit Rate
Compression Mode 1] nastavené
na On.
Nastaví cieľovú hodnotu
prenosovej rýchlosti, keď je
kompresný režim prenosovej
rýchlosti nastavený na CBR.
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Video Stream 2
Nastavuje nastavenia súvisiace s video kodekom 2.

Položka Nastavenie podpoložky
Predvolené
nastavenie

z výroby
Popis

Quality 1 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 6
Nastaví kvalitu H.264 alebo
H.265.

Položka Nastavenie podpoložky
Predvolené
nastavenie

z výroby
Popis

Codec 2 H.264 / H.265 / Off Off Nastaví kodek pre obraz 2.

Size 2
4096×2160 / 3840×2160 / 2048×1080 /
1920×1080 / 1280×720 / 640×360 /
512×270

1920×1080 Nastaví veľkosť obrazu 2.

Frame Rate 2

Podrobnosti o podporovaných
snímkových frekvenciách nájdete
v časti „Nastavenie video kodeku pre
streamovanie“.

–

Zobrazuje sa, keď [Codec 2] nie je
nastavené na Off.
Nastaví snímkovú frekvenciu
obrazu 2.

I-Picture Mode 2 Time / Frame Time

Zobrazuje sa, keď [Codec 2] nie je
nastavené na Off.
Nastaví interval vkladania IDR-
Frame pre obraz 2 ako čas alebo
počet snímok.

I-Picture Interval
2

1 / 2 / 3 / 4 / 5 s 1

Zobrazuje sa, keď [Codec 2] nie je
nastavené na Off a keď [I-Picture
Mode 2] je nastavené na [Time].
Nastaví interval vloženia rámčeka
IDR pre H.264 a H.265 ako čas.

I-Picture Ratio 2 15 až 300 rámčekov 30

Zobrazuje sa, keď [Codec 2] nie je
nastavené na Off a keď [I-Picture
Mode 2] je nastavené na [Frame].
Nastaví interval vkladania snímok
IDR pre H.264 a H.265 ako počet
snímok.

Profile 2
H.264: high / main / baseline
H.265: main

– Nastaví profil H.264 alebo H.265.

Bit Rate
Compression
Mode 2

CBR / VBR VBR

Zobrazuje sa, keď [Codec 2] nie je
nastavené na Off.
Nastavuje kompresný režim
prenosovej rýchlosti obrazu 2.
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Video Stream 3
Nastavuje nastavenia súvisiace s video kodekom 3.

Súvisiaca téma

Nastavenie video kodeku pre streamovanie

5-041-959-13(1) Copyright 2022 Sony Corporation

Položka Nastavenie podpoložky
Predvolené
nastavenie

z výroby
Popis

Bit Rate 2
512 / 768 / 1000 / 2000 / 3000 / 4000 /
5000 / 6000 / 7000 / 8000 / 16000 / 24000
/ 32000 / 50000 / 64000 / 80000 kbps

8000

Zobrazuje sa, keď [Codec 2] nie je
nastavené na Off a keď [Bit Rate
Compression Mode 2] je
nastavené na [On].
Nastaví cieľovú hodnotu
prenosovej rýchlosti, keď je
kompresný režim prenosovej
rýchlosti nastavený na CBR.

Quality 2 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 6

Zobrazuje sa, keď [Codec 2] je
nastavené na H.264 a keď [Bit
Rate Compression Mode 2] je
nastavené na Off.
Nastaví kvalitu H.264 alebo
H.265.

Položka Nastavenie podpoložky
Predvolené
nastavenie

z výroby
Popis

Codec 3 JPEG JPEG
Nastaví kodek pre
obraz 3.

Size 3 1280×720 / 1024×540 / 640×360 1280×720
Nastaví veľkosť
obrazu 3.

Frame
Rate 3

Podrobnosti o podporovaných snímkových
frekvenciách nájdete v časti „Nastavenie video kodeku
pre streamovanie“.

–
Nastaví snímkovú
frekvenciu obrazu 3.

Quality 3 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 6 Nastavuje kvalitu.
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Audio Stream

Nastavuje nastavenia týkajúce sa streamovaného zvukového kodeku.

5-041-959-13(1) Copyright 2022 Sony Corporation

Položka Nastavenie podpoložky Predvolené nastavenie
z výroby Popis

Setting On / Off Off Zapína/vypína streamovaný výstup zvuku.

Codec
AAC (128kbps) / AAC
(256kbps)

AAC (128kbps)
Zobrazuje sa, keď je [Setting] nastavené
na On.
Nastaví zvukový kodek pre streamovanie.
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Language

Nastavuje jazyk displeja.

Poznámka

Dostupné jazyky sa môžu líšiť v závislosti od krajiny alebo regiónu.
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Položka Nastavenie podpoložky Predvolené nastavenie z výroby Popis

Language – – Nastavuje jazyk displeja.
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Accessibility

Nastavuje nastavenia súvisiace s čítaním zvuku (text na reč).

Poznámka

Táto funkcia je dostupná len na modeloch predávaných v Severnej Amerike. Funkciu čítačky obrazovky je možné použiť len
vtedy, keď je jazyk nastavený na angličtinu (k dátumu vydania).

Povoľte funkciu čítačky obrazovky vo webovom prehliadači na zariadení s webovou aplikáciou.

5-041-959-13(1) Copyright 2022 Sony Corporation

Položka Nastavenie podpoložky Predvolené
nastavenie z výroby Popis

Screen
Reader

On / Off Off 
Zapne/vypne funkciu čítačky obrazovky na
obrazovom paneli kamery webovej aplikácie.

Speech
Rate

Slow2 / Slow1 / Normal /
Fast1 / Fast2 / Fast3 / Fast4

Normal
Nastavuje rýchlosť funkcie čítačky obrazovky.
Vzorová pasáž sa číta nahlas pri
nakonfigurovanej rýchlosti.

Speech
Volume

1 až 15 7

Nastavuje hlasitosť funkcie čítačky obrazovky
webovej aplikácie.
Vzorová pasáž sa prečíta nahlas pri
nakonfigurovanej hlasitosti.
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Clock Set

Nastavuje interné nastavenia hodín.
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Položka Nastavenie podpoložky
Predvolené
nastavenie
z výroby

Popis

Current Date
& Time

– –
Zobrazuje aktuálny čas nakonfigurovaný na
jednotke.

PC Clock – –
Zobrazuje aktuálny čas tabletu alebo
počítača použitého na konfiguráciu.

Date & Time
Format

yyyy-mm-dd hh:mm:ss / mm-dd-
yyyy hh:mm:ss / dd-mm-yyyy
hh:mm:ss

yyyy-mm-dd Nastavuje formát zobrazenia dátumu a času.

12 h / 24 h 12 h / 24 h 24 h
Nastaví čas na 12-hodinový/24-hodinový
formát zobrazenia.

Time Setting
Keep current setting /
Synchronize with PC / Manual
setting / Synchronize with NTP

–
Nastavuje metódu konfigurácie dátumu
a času.

yy-mm-dd
hh:mm:ss

yy: 19 až 37
mm: 01 až 12
dd: 01 až 31
hh: 00 až 23
mm: 00 až 59
ss: 00 až 59 (sekundy)

–
Zobrazuje sa, keď je [Time Setting]
nastavené na Manual setting.
Nastaví dátum a čas manuálne.

NTP Auto On / Off Off

Zobrazuje sa, keď je [Time Setting]
nastavené na Synchronize with NTP.
Nastavuje, či sa majú získať IP adresa
servera NTP zo servera DHCP.

NTP Server
IPv4/IPv6 adresa alebo názov
hostiteľa

–

Zobrazuje sa, keď [Time Setting] je
nastavené na [Synchronize with NTP] a keď
[NTP Auto] je nastavené na Off.
Určuje server NTP používaný na
synchronizáciu času.

Time Zone UTC − 12:00 až UTC + 14:00 – Vyberie časové pásmo.
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Reset

Inicializuje jednotku.

Reboot
Reštartuje jednotku.

Reset
Resetuje nastavenia jednotky.

Položka Nastavenie
podpoložky

Predvolené nastavenie
z výroby Popis

Reboot Execute –

Reštartuje jednotku.
Execute: Vykonať funkciu.

Poznámka

Po reštarte znova načítajte stránku vo webovom
prehliadači.

Položka Nastavenie
podpoložky

Predvolené
nastavenie
z výroby

Popis

All Reset (except for
Network Settings)

Execute –

Resetuje nastavenia jednotky (okrem nastavení
siete).
Execute: Vykonať funkciu.

Poznámka

Importované základné vzhľady a súbory LUT sa
odstránia.

Network Reset Execute –

Resetuje sieťové nastavenia jednotky.
Execute: Vykonať funkciu.

Poznámka

Po vykonaní Network Reset sa jednotka reštartuje.
Po reštarte znova načítajte stránku vo webovom
prehliadači.
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Položka Nastavenie
podpoložky

Predvolené
nastavenie
z výroby

Popis

Factory Default Execute –

Obnoví nastavenia jednotky na predvolené výrobné
nastavenia.
Execute: Vykonať funkciu.

Poznámka

Po vykonaní Factory Default sa jednotka reštartuje.
Po reštarte znova načítajte stránku vo webovom
prehliadači.
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Information

Zobrazuje informácie o kamere a objektíve. Používa sa aj na aktualizáciu softvéru.

Camera
Zobrazuje informácie o kamere a aktualizuje softvér.

Lens
Zobrazuje informácie o objektíve a aktualizuje softvér.

Položka Nastavenie
podpoložky

Predvolené
nastavenie z výroby Popis

Model
Name

– – Zobrazuje názov modelu kamery.

Serial
Number

– – Zobrazuje sériové číslo kamery.

Version
Number – – Zobrazuje verziu softvéru kamery.

Version Up – –

Stlačte tlačidlo [Choose File] a podľa pokynov na
obrazovke aktualizujte softvér kamery.

Poznámka

Po aktualizácii sa jednotka reštartuje. Po reštarte znova
načítajte stránku vo webovom prehliadači.

Položka Nastavenie
podpoložky

Predvolené
nastavenie z výroby Popis

Model
Name

– – Zobrazuje názov modelu objektívu.

Serial
Number

– – Zobrazuje sériové číslo objektívu.

Version
Number

– – Zobrazuje verziu softvéru objektívu.
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Súvisiaca téma

Aktualizácia softvéru objektívu s bajonetom E

5-041-959-13(1) Copyright 2022 Sony Corporation

Položka Nastavenie
podpoložky

Predvolené
nastavenie z výroby Popis

Version Up – –

Stlačte tlačidlo [Choose File] a podľa pokynov na
obrazovke aktualizujte objektív kamery.

Podrobnosti nájdete v časti „Aktualizácia softvéru
objektívu s bajonetom E“.

Poznámka

Po aktualizácii objektívu sa jednotka reštartuje. Po
reštarte znova načítajte stránku vo webovom prehliadači.
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

System Log

Nastavuje nastavenia súvisiace so systémovým denníkom.

Získaný denník sa zobrazí, ako je uvedené nižšie.

Súvisiaca téma

Aktualizácia softvéru objektívu s bajonetom E
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Položka Nastavenie podpoložky
Predvolené
nastavenie
z výroby

Popis

Log Level
Critical, Warning & Info /
Critical & Warning / Critical

Critical, Warning &
Info

Nastavuje úroveň pridania záznamu do
systémového denníka.

Log Size 200 až 1024 1024
Nastavuje veľkosť denníka, ktorý sa má uložiť do
systémového denníka.

Download
as File

– –
Stlačte tlačidlo [Download] a zo zobrazenej
obrazovky uložte systémový denník do tabletu
alebo počítača.
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

HTTP Access Log

Nastavuje nastavenia súvisiace s prístupovým denníkom HTTP.
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Položka Nastavenie podpoložky
Predvolené
nastavenie

z výroby
Popis

Log Level
Critical, Warning & Info /
Critical & Warning / Critical

Critical, Warning &
Info

Nastavuje úroveň pridania záznamu do
prístupového denníka HTTP.

Log Size 200 až 1024 1024
Nastavuje veľkosť denníka, ktorý sa má uložiť do
prístupového denníka HTTP.

Download
as File

– –
Stlačte tlačidlo [Download] a zo zobrazenej
obrazovky uložte prístupový denník HTTP do
tabletu alebo počítača.
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Service

Získa informácie o jednotke. Použite pri kontaktovaní servisného zástupcu Sony.
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Položka Nastavenie
podpoložky

Predvolené
nastavenie

z výroby
Popis

I agree to
download device
information.

– –

Začiarknutím súhlasíte so získaním informácií
o zariadení a stlačte tlačidlo [OK].
Stlačte zobrazené tlačidlo [Download]. Webový
prehliadač za okamih stiahne súbor s názvom
deviceinformation.dat.

Poznámka

Po stiahnutí sa jednotka reštartuje. Reštartujte
manuálne, ak sa jednotka nereštartuje automaticky. Po
reštarte znova načítajte stránku vo webovom
prehliadači.
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EULA

Zobrazí licenčnú zmluvu s koncovým používateľom (EULA).
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Software

Zobrazuje softvérovú licenciu.

5-041-959-13(1) Copyright 2022 Sony Corporation
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Pripojenie externých monitorov a záznamových zariadení

Ak chcete zobraziť zaznamenané/prehrávané obrázky na externom monitore, nastavte typ výstupu videa pre externý
monitor a použite vhodný kábel pre pripojený monitor.
Môžete tiež pripojiť externý rekordér a nahrávať výstupný signál z jednotky.
Na externom monitore môžete zobraziť rovnaké informácie, ktoré sú viditeľné na obrazovom paneli kamery, ako sú
informácie o stave a ponuky. Nastavte požadovaný typ systému pre zobrazenie obrazovky On pomocou [Monitoring] >
[Output Display] vo webovej ponuke.

Poznámka

Ak je pripojený monitor HDMI, ktorý nepodporuje výstupný formát HDMI nakonfigurovaný pomocou ponuky [Monitoring] vo
webovej ponuke alebo v ponuke kamery, obraz z kamery sa vo webovej aplikácii nezobrazí. Výstup streamovaného videa nebude
takisto prítomný na výstupe.

Môžete nastaviť [Output Display] > [SDI] aj [HDMI/Stream] na [Off], ale to zabráni použitiu ponuky kamery a funkcií, ktoré závisia
od zobrazenia na obrazovke. Okrem toho budú hlásenia o chybách jednotky obmedzené na kontrolky (rozsvietené alebo
blikajúce) jednotky a zobrazenie značky upozornenia vpravo hore vo webovej aplikácii. Ak chcete zobraziť podrobný stav,
nastavte [Output Display] na [On].

Rada

[Output Display] > [SDI] je nastavené na [Off] a [HDMI/Stream] je nastavené na [On] v predvolenom nastavení z výroby. Ak
chcete použiť streaming ako hlavné video, nastavte [SDI] na [On] a [HDMI/Stream] na [Off] a sledujte stav kamery na monitore
SDI.

SDI OUT konektor (typ BNC)

Nastavte výstupný formát pomocou ponuky [Monitoring] vo webovej ponuke alebo v ponuke kamery.
Na pripojenie použite komerčne dostupný 75 Ω koaxiálny kábel.

Poznámka

Pred zapnutím zariadení skontrolujte, či je spojenie medzi jednotkou a externým zariadením uzemnené.

Po pripojení 75 Ω koaxiálneho kábla sa odporúča zapnúť jednotku a externé zariadenie.
Ak musí byť externé zariadenie pripojené k jednotke, keď je jednotka zapnutá, najskôr pripojte 75 Ω koaxiálny kábel
k externému zariadeniu a potom ho pripojte k jednotke.

Spustenie nahrávania na jednotke a externom zariadení súčasne
S aktivovaným výstupom signálu SDI nastavte [Project] > [SDI/HDMI Rec Control] > [Setting] na [SDI/HDMI Remote I/F]
alebo [Parallel Rec] v ponuke kamery, čím povolíte výstup spúšťacieho signálu REC na externé zariadenie pripojené ku
konektoru SDI OUT. Tým sa zosynchronizuje nahrávanie na externom zariadení s jednotkou.

Poznámka

Ak pripojené externé zariadenie nepodporuje spúšťací signál REC, zariadenie nemožno ovládať.

Keď je [Project] > [SDI/HDMI Rec Control] > [Setting] nastavené na [SDI/HDMI Remote I/F] v ponuke kamery, bude na výstupe
iba spúšťací signál REC, keď nie je momentálne vložené žiadne záznamové médium a stlačí sa tlačidlo START/STOP
nahrávania.
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HDMI OUT konektor (konektor typu A)

Nastavte On/Off výstupu a výstupný formát v ponuke [Monitoring] v ponuke fotoaparátu.

Spustenie nahrávania na jednotke a externom zariadení súčasne
S aktivovaným výstupom signálu HDMI nastavte [TC/Media] > [HDMI TC Out] > [Setting] na [On] alebo [Project] >
[SDI/HDMI Rec Control] > [Setting] na [SDI/HDMI Remote I/F] alebo [Parallel Rec] v ponuke kamery, čím povolíte výstup
spúšťacieho signálu REC na externé zariadenie pripojené ku konektoru HDMI OUT. Tým sa zosynchronizuje nahrávanie
na externom zariadení s jednotkou.

Poznámka

Ak pripojené externé zariadenie nepodporuje spúšťací signál REC, zariadenie nemožno ovládať.

Keď je [Project] > [SDI/HDMI Rec Control] > [Setting] nastavené na [SDI/HDMI Remote I/F] v ponuke kamery, bude na výstupe
iba spúšťací signál REC, keď nie je momentálne vložené žiadne záznamové médium a stlačí sa tlačidlo START/STOP
nahrávania.
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Pripojenie pomocou RCP/MSU

Niektoré funkcie jednotky je možné ovládať na diaľku pripojením diaľkového ovládacieho panela (RCP), ako je RCP-
3500/3501 alebo hlavnej nastavovacej jednotky (MSU), ako je MSU-3500, k jednotke pomocou kábla LAN.
Spôsob pripojenia sa bude líšiť v závislosti od konfigurácie súvisiacich zariadení a aplikácie.

Podrobnosti o individuálnom prepojení medzi jednotkou a RCP nájdete v časti „Jednostranné spojenie medzi
jednotkou a RCP“.
Podrobnosti o pripojení viacerých kamier pomocou MSU alebo softvéru na ovládanie kamery nájdete v časti
„Používanie jednotky v prostredí s viacerými kamerami so softvérom na diaľkové ovládanie MSU/Camera“.

Súvisiaca téma

Jednostranné spojenie medzi jednotkou a RCP

Používanie jednotky v prostredí s viacerými kamerami so softvérom na diaľkové ovládanie MSU/Camera

5-041-959-13(1) Copyright 2022 Sony Corporation
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Jednostranné spojenie medzi jednotkou a RCP

Poznámka

Pozrite si „Zoznam podporovaných funkcií“ a nakonfigurujte jednotku tak, aby spĺňala prevádzkové podmienky pre funkcie, ktoré
chcete používať, potom povoľte pripojenie k RCP pomocou nasledujúceho postupu.

Súvisiaca téma
Zoznam podporovaných funkcií
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Zapnite každé zariadenie.1

Nastavte [Technical] > [RCP/MSU] > [CNS Mode] na [Bridge] vo webovej ponuke kamery.2

Nakonfigurujte nasledujúce nastavenia na RCP.

Podrobnosti o konfigurácii nájdete v návode na obsluhu RCP.

3

Nastavte režim pripojenia na režim Bridge.1.
Zaregistrujte IP adresu kamery.2.
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Používanie jednotky v prostredí s viacerými kamerami so softvérom na diaľkové
ovládanie MSU/Camera

Môžete pripojiť viacero kamier pomocou MSU alebo softvéru na diaľkové ovládanie kamery.

Poznámka

Pozrite si „Zoznam podporovaných funkcií“ a nakonfigurujte jednotku tak, aby spĺňala prevádzkové podmienky pre funkcie, ktoré
chcete používať, potom povoľte pripojenie k MSU alebo softvéru na diaľkové ovládanie kamery pomocou nasledujúceho postupu.

Súvisiaca téma
Zoznam podporovaných funkcií
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Zapnite každé zariadenie.1

Nakonfigurujte nastavenia systémovej siete pomocou MSU alebo softvéru diaľkového ovládania kamery.

Podrobnosti o konfigurácii nájdete v návode na obsluhu MSU alebo softvéru na diaľkové ovládanie kamery.

2

Nakonfigurujte nasledujúce nastavenia pomocou [Technical] > [RCP/MSU] vo webovej ponuke kamery.3

Ak používate MSU, nastavte [CNS Mode] na [MCS]. Ak používate softvér na diaľkové ovládanie kamery,
nastavte [CNS Mode] na [PC Control].

1.

Nastavte IP adresu hlavného MSU alebo softvéru diaľkového ovládania kamery [Master IP Address].2.
Nastavte číslo kamery, pre ktorú bude kamera zaregistrovaná [Camera No.].3.
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Zoznam podporovaných funkcií

Nasledujúca tabuľka zobrazuje podporované funkcie a ich zodpovedajúce prevádzkové podmienky.

Ovládací
panel Funkcie jednotky Prevádzkové podmienky

IRIS Manuálna úprava clony –

AUTO IRIS Zapínanie a vypínanie Auto Iris –

ND
Prepínanie prednastavenej polohy ND filtra
(Clear/Preset1 na Preset3)

Táto funkcia je povolená, keď [Shooting] > [ND
Filter] > [Mode] je nastavené na [Preset] v ponuke
kamery.

MASTER
GAIN

Manuálna úprava zosilnenia zisku (3 dB jednotky)
Povolené, keď je režim snímania nastavený na
Custom a zároveň [Shooting] > [ISO/Gain/EI] >
[Mode] je nastavené na [dB] v ponuka kamery.

WHITE
(R/B)

Ručné nastavenie vyváženia bielej (R Gain/B
Gain)

Povolené, keď je [White Mode] nastavené na
[Memory A(R/B)] alebo [Memory A(T/T)].WHITE

(Color
Temp)

Ručné nastavenie vyváženia bielej (teplota
farieb/odtieň)

RCP – [Color Temp]: Teplota farieb vyváženia
bielej
RCP – [Balance]: Hodnota odtieňa vyváženia
bielej

ATW
Zapnutie/vypnutie funkcie ATW (Auto Tracing
White Balance)

Povolené, keď je režim snímania nastavený na
Custom.

BLACK R/B Úprava vyváženia čiernej
Povolené, keď je režim snímania nastavený na
Custom.
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Poznámka

Nakonfigurujte jednotku tak, aby spĺňala prevádzkové podmienky pre funkcie, ktoré chcete používať, a potom povoľte pripojenie
s RCP/MSU. Ak sa po povolení pripojenia upravia prevádzkové podmienky, môže dôjsť k neúmyselnému správaniu.
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Ovládací
panel Funkcie jednotky Prevádzkové podmienky

MASTER
BLACK

Nastavenie hlavnej úrovne čiernej

Povolené, keď je režim snímania nastavený
na Custom.
H/V Ratio a Crispening sú povolené, ak je
[Paint/Look] > [Detail] > [Manual Setting]
nastavené na [On] v ponuke kamery.

DETAIL

Zapnutie/vypnutie funkcie podrobností
Nastavenie úrovne podrobností
Nastavenie H/V Ratio
Nastavenie Crispening

User Matrix

Zapnutie/vypnutie funkcie korekcie
používateľskej matice
Nastavenie hodnôt korekcie matice (R-G/R-
B/G-R/G-B/B-R/B-G)

Multi Matrix

Zapnutie/vypnutie funkcie korekcie viacerých
matíc
Nastavenie odtieňa a sýtosti farby použitej na
korekciu viacerých matíc

Knee
Zapnutie/vypnutie funkcie korekcie lomu
Zapnutie/vypnutie funkcie automatického lomu
Nastavenie bodu a sklonu lomu

BARS Zapnutie/vypnutie farebných pruhov

SHUTTER

Zapnutie/vypnutie funkcie uzávierky
Nastavenie hodnoty rýchlosti uzávierky
(zapnutie/vypnutie automatickej uzávierky,
nastavenie uhlovej uzávierky, nastavenie
pomalej uzávierky, nastavenie ECS nie je
podporované).

Poznámka

Nastavenia uzávierky RCP sa nemusia
zobraziť v závislosti od nakonfigurovanej
hodnoty rýchlosti uzávierky.

Nastavenia uzávierky RCP sa nemusia
zobraziť správne, ak sa uzávierka nedá
ovládať z RCP.

Keď je zapnutá automatická uzávierka,
automatická uzávierka bude pokračovať
v činnosti, aj keď zapnete/vypnete uzávierku
alebo zmeníte hodnotu rýchlosti uzávierky z RCP.
Keď je uzávierka nastavená na [Angle],
zapnutie/vypnutie uzávierky alebo zmena
nastavenia rýchlosti uzávierky z RCP nie je
podporovaná.
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O prevádzke pomocou diaľkového ovládača RM-IP500 (voliteľné príslušenstvo)

Jednotku môžete ovládať pomocou diaľkového ovládača Sony RM-IP500 so softvérom verzie 2.2 alebo novším.
Zariadenia komunikujú pomocou VISCA over IP (LAN).
V závislosti od cieľovej položky, ktorú chcete ovládať, možno budete musieť zobraziť obrazovku jednotky. Pripravte si
monitor, ktorý možno použiť na kontrolu zobrazenia na obrazovke.
Diaľkový ovládač RM-IP500 podporuje nasledujúce funkcie.

Výber cieľovej kamery
Úprava orámovania (otáčanie, naklonenie, transfokácia)
Úprava zaostrenia (okrem dotykového ovládania)
Registrácia a vyvolanie prednastavených polôh
Obsluha ponuky jednotky (okrem webovej ponuky)
Úprava jasu
Úprava vyváženia bielej
Úprava vyváženia čiernej
Úprava vstupnej úrovne zvuku
Spustenie/zastavenie nahrávania
Vykonávanie priraditeľných funkcií tlačidiel jednotky

Podrobnosti o prevádzke RM-IP500 nájdete v návode na obsluhu RM-IP500.

Rada

Ak používate RM-IP500, použite panel pre túto jednotku, ktorý sa dodáva s RM-IP500.

RM-IP500 (s použitím panela pre túto jednotku)
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Pripojenie diaľkového ovládača RM-IP500

Podrobnosti o priraďovaní funkcií nájdete v návode na obsluhu RM-IP500.

5-041-959-13(1) Copyright 2022 Sony Corporation

Nastavte prepínač SETUP 3 na jednotke do polohy ON, aby ste umožnili komunikáciu VISCA over IP.

Poznámka

Nastavenie spínača sa použije pri ďalšom zapnutí jednotky.

1

Pripojte RM-IP500 k rovnakej sieti ako jednotku.2

Podľa postupu v návode na obsluhu RM-IP500 nakonfigurujte pripojenie VISCA over IP (LAN) na RM-IP500.

Priraďte túto jednotku pomocou ponuky RM > AUTO IP SETUP > ASSIGN CAM.

3

Priraďte funkcie tejto jednotky tlačidlám a ovládačom podľa potreby pomocou nasledujúcich položiek
ponuky RM RM-IP500.

SW ASSIGN
AE CONFIG2
WB MODE

4
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O synchronizácii s externým zariadením

Pri snímaní s použitím viacerých jednotiek je možné jednotky synchronizovať s konkrétnym referenčným signálom alebo
časovým kódom cez konektor GENLOCK jednotiek.

Podrobnosti o genlocku nájdete v časti „Synchronizácia fázy video signálu (Genlock)“.
Podrobnosti o synchronizácii časových kódov nájdete v časti „Uzamknutie časového kódu na iné zariadenia“.

Súvisiaca téma
Synchronizácia fázy video signálu (Genlock)

Uzamknutie časového kódu na iné zariadenia

5-041-959-13(1) Copyright 2022 Sony Corporation

449



Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Synchronizácia fázy video signálu (Genlock)

Do konektora GENLOCK môžete priviesť referenčný signál, aby ste povolili funkciu genlock.
Vstupné referenčné signály, ktoré je možné použiť, sa líšia v závislosti od systémovej frekvencie zvoleného formátu
záznamu.

Stav externej synchronizácie môžete skontrolovať pomocou [Technical] > [Genlock] > [Reference] v ponuke kamery.

Poznámka

Ak je referenčný signál nestabilný, genlock sa nedá dosiahnuť.

Pomocný signál nie je synchronizovaný.
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Systémová frekvencia formátu záznamu Podporované vstupné referenčné signály

59.94P
1920×1080 59.94i
720×486 59.94i

50P
1920×1080 50i
720×576 50i

29.97P 1920×1080 59.94i
720×486 59.94i

25P
1920×1080 50i
720×576 50i

24P
1920×1080 24PsF
1920×1080 24P

23.98P
1920×1080 23.98PsF
1920×1080 23.98P

59.94i 1920×1080 59.94i
720×486 59.94i

50i
1920×1080 50i
720×576 50i
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Uzamknutie časového kódu na iné zariadenia

Nastavte jednotku, ktorá dodáva časový kód, do režimu, v ktorom bude výstup časového kódu stále bežať (napríklad
Free Run alebo Clock).

Poznámka

Skontrolujte, či dodaný referenčný časový kód a referenčný video signál sú sfázované v súlade so štandardom časového kódu
SMPTE.

Pri práci s externým zámkom sa časový kód okamžite uzamkne s externým časovým kódom a hodnota externého časového kódu
sa zobrazí v oblasti zobrazenia časových údajov. Nezačínajte však ihneď nahrávať. Pred nahrávaním počkajte niekoľko sekúnd,
kým sa generátor časového kódu stabilizuje.

Ak frekvencia referenčného video signálu a snímková frekvencia na jednotke nie sú rovnaké, uzamknutie nie je možné získať
a jednotka nebude fungovať správne. Ak k tomu dôjde, časový kód nezíska úspešné uzamknutie pomocou externého časového
kódu.

Ak je externý zdroj časového kódu odpojený, časový kód sa môže posunúť o jednu snímku za hodinu vzhľadom na referenčný
časový kód.

Uvoľnenie vonkajšieho uzamknutia
Zmeňte nastavenie [TC/Media] > [Timecode] v ponuke kamery.
Externá synchronizácia sa tiež uvoľní, ak sa zmení systémová frekvencia a keď začnete nahrávať v špeciálnom režime
nahrávania (Slow & Quick Motion alebo Interval Rec).
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Nastavte nasledovné v [TC/Media] > [Timecode] v ponuke kamery.

Nastavte [Mode] na [Preset].
Nastavte [Run] na [Free Run].

1

Stlačením priraditeľného tlačidla priradeného k funkcii [DURATION/TC/U-BIT] zobrazíte časový kód na
obrazovke.

2

Priveďte referenčný HD alebo SD video signál do konektora GENLOCK a referenčný časový kód do
konektora TC IN.

Generátor časového kódu jednotky sa uzamkne s referenčným časovým kódom a na obrazovke sa zobrazí „EXT-
LK“.
Po uplynutí asi desiatich sekúnd od uzamknutia časového kódu sa stav externého uzamknutia zachová, aj keď je
externý referenčný zdroj časového kódu odpojený.

3
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Pripojenie externého mikrofónu alebo externého zvukového zariadenia

Môžete priviesť signál z externého mikrofónu alebo externého zvukového zariadenia a vložiť zvuk do zaznamenaného
videa alebo výstupného videa jednotky.

Pripojte externý mikrofón alebo externé zvukové zariadenie pomocou kábla XLR.

Keď je zvuk nastavený na [LINE] pomocou [Audio] > [Audio Input] > [AUDIO IN Select] v ponuke kamery, konektor
AUDIO IN funguje ako konektor AUDIO IN CH-1 a konektor AUDIO IN CH-2.

1

Kolík č. Funkcia

1 GND

2 AUDIO IN CH-1+ (HOT)

3 AUDIO IN CH-1− (COLD)

4 AUDIO IN CH-2+ (HOT)

5 AUDIO IN CH-2− (COLD)

Vypnite jednotku a pripojte XLR kábel ku konektoru AUDIO IN.2

Nastavte prepínač SETUP 2, aby ste aktivovali fantómové napájanie podľa potreby.

Prepnite napájanie +48 V (fantómové napájanie), ako je popísané nižšie.
Prepínač 2
Nastavuje, či sa po pripojení vstupného zvukového zariadenia zapne/vypne napájanie +48 V (fantómové
napájanie).

3

Nastavenie Popis

OFF
(predvolené)

Toto vypne fantómové napájanie +48 V a nastaví vstup LINE alebo MIC ako zdroj zvuku CH-1
a CH-2.
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Poznámka

Nastavenie tohto prepínača do polohy ON a pripojenie mikrofónu, ktorý nie je kompatibilný so zdrojom +48 V, môže
poškodiť pripojené zariadenie. Pred pripojením zariadenia skontrolujte nastavenie.

Nastavenie Popis

ON
Tým sa zapne +48V fantómové napájanie a nastaví mikrofón kompatibilný s fantómovým
napájaním ako zdroj zvuku CH-1 a CH-2.

Zapnite jednotku a nastavte typ pripojeného zariadenia pomocou [Audio] > [Audio Input] > [AUDIO IN
Select] v ponuke kamery.

4
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Správa/úprava klipov pomocou počítača

Klipy môžete spravovať/upravovať pomocou počítača.

Import klipov pomocou čítačky kariet (voliteľné príslušenstvo)

Pripojte k počítaču čítačku kariet CFexpress Type A alebo čítačku kariet SD a na import klipov použite softvér, ktorý
podporuje formát nahrávania tejto jednotky, ako je napríklad Catalyst Browse.

Použitie nelineárneho editačného systému

V nelineárnom editačnom systéme je potrebný editačný softvér (voliteľné príslušenstvo), ktorý podporuje formáty
zaznamenané jednotkou.

5-041-959-13(1) Copyright 2022 Sony Corporation
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Výstup signálu z optického vlákna

Výstup SDI signálu prevedený na optický signál môžete získať pripojením modulu SFP+ (voliteľné príslušenstvo) ku
konektoru OPTICAL jednotky. Použite modul SFP+, ktorý zodpovedá signálnemu pásmu každého formátu.
Signálne pásmo

4K (59.94p, 50p): 12G
4K (iné ako 59.94p, 50p): 6G
HD (59.94p, 50p): 3G
HD (iné ako 59.94p, 50p) 1.5G

Poznámka

Použite modul, ktorý vyhovuje nasledujúcim štandardom.

Štandardy SFF
SFF-8083/SFF-8418/SFF-8419*/SFF-8432/SFF-8433/SFF-8071/SFF-8472

Štandardy SDI
ST297/ST292/ST424/ST425/ST2081/ST2082

Rovnaký signál ako výstupný konektor SDI je vyvedený na modul SFP+.

Jednotka nepodporuje vstup signálu z optického vlákna.

Na výstup signálu z optického vlákna použite modul SFP+. Podrobnosti o overených moduloch SFP+ vám poskytne váš predajca
alebo servisný zástupca Sony.
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* Úroveň výkonu I (1,0 W)
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Pripojenie záznamového signálu

Táto téma popisuje ovládanie záznamového signálu.

Rozsvietenie kontrolky záznamu pomocou signálu z diaľkového ovládača

Kontrolku záznamu môžete rozsvietiť pomocou príkazu VISCA over IP z externého zariadenia, ako je napríklad RM-
IP500.
Nastavte [Technical] > [Tally] > [Tally Control] na [External] vo webovej ponuke alebo v ponuke kamery.

Rozsvietenie kontrolky záznamu z externého zariadenia

Kontrolku záznamu jednotky môžete rozsvietiť na červeno alebo na zeleno z externého zariadenia, ako je RM-IP500
alebo prepínač. Záznam môžete ovládať pomocou príkazov prenášaných cez sieť alebo pomocou vstupu záznamového
signálu na konektore OPTION jednotky.
Nastavte [Technical] > [Tally] > [Tally Control] na [External] vo webovej ponuke alebo v ponuke kamery.
Pri vstupe záznamového signálu na konektor OPTION skratujte kolík 7 na GND (buď kolík 4 alebo 5), aby sa kontrolka
záznamu rozsvietila na zeleno, alebo kolík 8 na GND (buď kolík 4 alebo 5), aby sa kontrolka záznamu rozsvietila na
červeno.

Poznámka

Keď je [Tally Control] nastavené na [External], stav nahrávania jednotky neindikuje kontrolka záznamu.

Keď sú súčasne privedené na vstup červené a zelené záznamy, kontrolka záznamu na jednotke sa rozsvieti na červeno.

Špecifikácie kolíkov konektora OPTION

Kolík
č.

Smer
signálu Špecifikácia signálov

1 – Signál RS-232C TX (pre ovládač objektívu)

2 – Signál RS-232C RX (pre ovládač objektívu)

3 OUT

Výstup zelenej kontrolky záznamu
Nízka úroveň výstupu, keď svieti zelená kontrolka záznamu.
Hi-Z (výstup s otvoreným kolektorom), keď zelená kontrolka záznamu nesvieti.

4 – GND (uzemnenie)

5 – GND (uzemnenie)
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Rozsvietenie kontrolky záznamu externého zariadenia pomocou signálu z jednotky

Kontrolku záznamu externého zariadenia môžete rozsvietiť pomocou signálu z jednotky prepojením kolíkov 3 a 6
konektora OPTION, ako je znázornené nižšie.
Príklad pripojenia kolíkov 3 a 6 konektora OPTION

Poznámka

Na kolíky 7 a 8 nepripájajte napätie.

Nepripájajte externé zariadenie, ktoré môže privádzať napätie ku konektoru OPTION.

Ak sa na kolík 3 alebo 6 aplikuje nárazové alebo spätné napätie, ktoré presahuje menovité hodnoty, môže to spôsobiť poruchu,
dym alebo požiar.

Nastavte výstupný signál pomocou [Technical] > [Tally] > [Tally Control] vo webovej ponuke alebo v ponuke kamery.
[Internal]: Nahrávanie prevádzkového stavu jednotky
[External]: Logický AND červených/zelených záznamových signálov prijatých jednotkou prostredníctvom signálu IN alebo
diaľkových ovládačov.
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Kolík
č.

Smer
signálu Špecifikácia signálov

6 OUT

Výstup červenej kontrolky záznamu
Nízka úroveň výstupu, keď svieti červená kontrolka záznamu.
Hi-Z (výstup s otvoreným kolektorom), keď červená kontrolka záznamu nesvieti.

7 IN
Zelený záznamový externý ovládací vstup
Skratovanie na zem (kolík 4 alebo 5) spôsobí, že kontrolka záznamu na jednotke sa
rozsvieti na zeleno.

8 IN
Červený záznamový externý ovládací vstup
Skratovanie na zem (kolík 4 alebo 5) spôsobí, že kontrolka záznamu na jednotke sa
rozsvieti na červeno.
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Výstup monitorovacích údajov (free-d)

Jednotka môže vysielať informácie o otočení/naklonení/transfokácii, zaostrovaní a monitorovaní clony synchronizované
so synchronizačným signálom.
Výstup údajov je v súlade s protokolom free-d, ktorý je priemyselným štandardom. Môžete si vybrať spôsob výstupu,
pričom si môžete vybrať medzi konštantným výstupom a výstupom na požiadavku klientov. Výstupnú metódu vyberte
podľa vášho systému VR/AR.

Výstupný formát údajov

Rada

Technické podrobnosti sú uvedené v „Integračnej príručke pre free-d“. Kontaktujte obchodného zástupcu spoločnosti Sony.

Monitorovacie údaje, ktoré vysiela jednotka, obsahujú nasledujúce údaje podľa formátu špecifikovaného v Type D0/D1
protokolu free-d.
Type D0 – poll/command

Skontrolujte, či je jednotka zapnutá.1

Nastavte metódu výstupu monitorovacích údajov.

Pre konštantný výstup

Pre výstup na požiadavku klientov

2

Nastavte [Technical] > [Tracking Data Output] > [Transfer Mode] na [Always] vo webovej ponuke.1.
Nastavte ID jednotky v [Camera ID].2.
Zadajte výstupnú cieľovú IP adresu v [Destination Address].3.
Zadajte číslo výstupného cieľového portu v [Destination Port].4.
Stlačte tlačidlo [OK].5.

Nastavte [Technical] > [Tracking Data Output] > [Transfer Mode] na [On Demand] vo webovej ponuke.1.
Nastavte ID jednotky v [Camera ID].2.
Zadajte číslo portu na príjem požiadaviek od klientov v [Listen Port].3.
Stlačte tlačidlo [OK].4.

Symbol Obsah Popis

<D0> Message type

<CA> Camera ID

<CD> command

Podporuje nasledujúce príkazy:

00 Stop stream mode
01 Start stream mode

<CK> Checksum
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Type D1 – camera position/orientation data

Poznámka

Monitorovacie údaje sa môžu oneskoriť alebo sa hodnoty nemusia aktualizovať v nasledujúcich situáciách:

Pri výstupe videa vo formáte RAW
Keď je zapnutá funkcia S&Q Motion
Pri zobrazení ponuky kamery
Pri zobrazovaní miniatúr
Pri prehrávaní nahraných klipov
Pri zobrazovaní webovej ponuky
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Symbol Obsah Popis

<D1> Message type

<CA> Camera ID

<PH><PM><PL> Camera Pan Angle Uhol natočenia (−170° až +170°)

<TH><TM><TL> Camera Tilt Angle Uhol naklonenia (−30° až +195°)

<RH><RM><TL> Camera Roll Angle Nepodporované (vždy 0)

<XH><XM><XL> Camera X-Position Nepodporované (vždy 0)

<YH><YM><YL> Camera Y-Position Nepodporované (vždy 0)

<HH><HM><HL> Camera Height Nepodporované (vždy 0)

<ZH><ZM><ZL> Camera Zoom Ohnisková vzdialenosť

<FH><FM><FL> Camera Focus Zaostrovacia vzdialenosť

<SH><SL> Spare/User Defined Poloha clony

<CK> Checksum
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Pripojenie ovládača objektívu

Transfokáciu objektívu s manuálnou transfokáciou môžete ovládať z webovej aplikácie, RM-IP500 (voliteľné
príslušenstvo), alebo infračerveným diaľkovým ovládaním pripojením komerčne dostupného ovládača objektívu (voliteľné
príslušenstvo), ktorý je kompatibilný s touto jednotkou.
Podrobnosti o pripojení ovládača objektívu nájdete v návode na obsluhu ovládača objektívu.
Podrobnosti o nastavení transfokácie pomocou ovládača objektívu nájdete v časti „Nastavenie transfokácie pomocou
ovládača objektívu“.

Poznámka

Pred použitím ovládača objektívu si pozorne prečítajte návod na obsluhu ovládača objektívu a uistite sa, že úplne rozumiete jeho
použitiu. Spoločnosť Sony nezodpovedá za žiadne nároky akéhokoľvek druhu vyplývajúce z používania ovládača objektívu.

Funkcia Clear Image Zoom nie je k dispozícii, keď je aktivovaný ovládač objektívu. Odporúčame nastaviť pomer priblíženia Clear
Image Zoom na 1,0× alebo vypnúť Clear Image Zoom.

Keď je aktivovaný ovládač objektívu, nie je možné nahrávať ani prehrávať zarámovanie kamery.

Súvisiaca téma

Úprava transfokácie pomocou ovládača objektívu

5-041-959-13(1) Copyright 2022 Sony Corporation
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Úprava transfokácie pomocou ovládača objektívu

Nasledujúcim postupom pripojte ovládač objektívu (voliteľné príslušenstvo) a nastavte transfokáciu.

Kontrola stavu ovládača objektívu
Stlačením tlačidla  (stav kamery) v spoločnej oblasti obrazovky webovej aplikácie zobrazíte stavovú obrazovku
kamery.

Pripojte ovládač objektívu ku konektoru OPTION na pripojovacom bloku jednotky.

Podrobnosti o pripojení nájdete v návode na obsluhu ovládača objektívu.

1

Nastavte ovládač objektívu pre váš objektív s transfokáciou.

Podrobnosti nájdete v návode na obsluhu ovládača objektívu.

2

Zablokujte otáčanie/nakláňanie jednotky a nasaďte objektív s transfokáciou.

Podrobnosti nájdete v časti „Nasadenie objektívu“.

3

Nastavte ovládač objektívu tak, aby mohol ovládať objektív s transfokáciou.4

Udržujte vyváženie hlavy kamery dopredu/dozadu tak, aby bola posuvná základňa vodorovná.

Podrobnosti nájdete v návode na obsluhu ovládača objektívu a v časti „Nasadenie objektívu“.

5

Nastavte [Technical] > [Lens Controller] > [Setting] na [On] vo webovej ponuke a stlačte tlačidlo [OK].

Jednotka sa reštartuje. Počkajte, kým sa neukončí resetovanie otočenia/naklonenia.

6

Stlačte tlačidlo  (Inicializovať ovládač objektívu) na karte  (Others) na ovládacom paneli
kamery na živej prevádzkovej obrazovke webovej aplikácie.

Ovládač objektívu sa pohybuje, aby zistil rozsah transfokácie. Podrobnosti nájdete v návode na obsluhu ovládača
objektívu.
Keď sa kontrolka  (Chyba ovládača objektívu) zmení na  (Ovládač objektívu pripravený) v ľavom hornom rohu
obrazového panela kamery, príprava je dokončená.

Poznámka

Pri inicializácii ovládača objektívu si všimnite pracovný rozsah objektívu.

7

Nastavte transfokáciu pomocou posuvníka [Zoom] vo webovej aplikácii alebo pomocou tlačidiel ovládania
transfokácie na infračervenom diaľkovom ovládači.

8
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Na tejto obrazovke môžete skontrolovať stav ovládača objektívu.

Poznámka

Pri výmene objektívu inicializujte ovládač objektívu.

Funkcia Clear Image Zoom nie je k dispozícii, keď je aktivovaný ovládač objektívu. Odporúčame nastaviť pomer priblíženia Clear
Image Zoom na 1,0× alebo vypnúť Clear Image Zoom.
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Stav Popis

Off Použite objektív s motorovou transfokáciou s bajonetom E.

Communication
Error

Medzi jednotkou a ovládačom objektívu sa vyskytla komunikačná chyba.
Skontrolujte pripojenie medzi jednotkou a ovládačom objektívu, potom si prečítajte návod na
obsluhu ovládača objektívu a inicializujte ovládač objektívu.

Uninitialized Vykonajte inicializáciu.

Initializing Počkajte na dokončenie inicializácie.

Initialization
Failed

Skontrolujte pripojenie medzi jednotkou a ovládačom objektívu, potom si prečítajte návod na
obsluhu ovládača objektívu a inicializujte ovládač objektívu.

Working Ovládajte transfokáciu pomocou ovládača objektívu.

Rotation Error
Uložený rozsah pohybu transfokácie a rozsah pohybu objektívu sa nemusia zhodovať.
Inicializujte ovládač objektívu.

System Error Skontrolujte pripojenie medzi jednotkou a ovládačom objektívu, pozrite si návod na obsluhu
ovládača objektívu a inicializujte ovládač objektívu alebo zapnite napájanie jednotky a ovládača
objektívu.Unknown Error
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Opatrenia pre používanie

Opatrenia pri preprave a balení
Pri preprave alebo balení jednotky dodržiavajte nasledujúce podmienky a nevystavujte ju silným vibráciám alebo
nárazom.

Odstráňte objektív a nasaďte kryt telesa.
Po posunutí hlavy kamery (A) dopredu otočte zaisťovaciu páčku hlavy kamery (B) v smere šípky, aby ste hlavu
kamery uzamkli.

Hlavu kamery nasmerujte tak, aby smerovala dopredu, a zaistite ju pomocou zaisťovacej páčky otáčania/nakláňania.

Odstráňte pripojovacie káble.

Kondenzácia
Ak sa toto zariadenie náhle prenesie z chladného do teplého prostredia, alebo ak náhle stúpne okolitá teplota, na
vonkajšom povrchu alebo vnútri zariadenia sa môže vytvárať vlhkosť. Tento jav je známy ako kondenzácia. Ak sa
vyskytne kondenzácia, pred použitím vypnite zariadenie a počkajte, kým kondenzácia nezmizne. Používaním zariadenia
s kondenzáciou sa môže zariadenie poškodiť.

Javy obrazového snímača CMOS kamery

Poznámka

Nasledujúce javy, ktoré sa môžu vyskytnúť na snímkach, sú špecifické pre obrazové snímače. Nenaznačujú poruchu.

Biele škvrny
Aj keď sú obrazové snímače vyrábané pomocou veľmi presných technológií, v zriedkavých prípadoch sa na
obrazovke môžu vytvárať jemné biele škvrny spôsobené kozmickým žiarením atď.
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Súvisí to s princípom obrazových snímačov a nejde o poruchu. Pravidelne vykonávajte APR.
Biele škvrny sú zvyčajne viditeľné v nasledujúcich prípadoch:

Prevádzka pri vysokej teplote prostredia
Zvýšenie zosilnenia (citlivosti)

Blikanie
Ak snímate pri osvetlení produkovanom žiarivkami, sodíkovými výbojkami, ortuťovými výbojkami alebo LED diódami,
obrazovka môže blikať alebo sa môžu líšiť farby.

Jednotky pohonu objektívu a otáčania/nakláňania
Ak sa objektív a mechanizmus pohonu otáčania/nakláňania dlhší čas nepoužívajú, môže sa zvýšiť viskozita maziva
naneseného vo vnútri, čo zabráni pohybu mechanizmu. Pravidelne používajte objektív a mechanizmus
otáčania/nakláňania.

Spotrebné diely
Ventilátor a vstavaná nabíjateľná batéria sú spotrebné diely, ktoré bude potrebné pravidelne vymieňať.
Pri prevádzke v izbovej teplote bude bežný cyklus výmeny 5 rokov. Cyklus výmeny však predstavuje len všeobecné
usmernenie a nepredstavuje záruku životnosti týchto dielov.
Podrobné informácie o náhradných dieloch vám poskytne predajca.

Očakávaná životnosť sieťového adaptéra a elektrolytického kondenzátora používaného pri bežných prevádzkových
teplotách a bežným spôsobom (8 hodín denne, 25 dní mesačne) je približne 5 rokov. Ak používanie presiahne
frekvenciu bežného používania, očakávaná životnosť sa primerane skráti.

Pravidelné kontroly sa odporúčajú, aby sa zaistilo správne fungovanie prístroja a predĺženie jeho použiteľnej životnosti.
Ďalšie informácie o kontrolách vám poskytne servisný zástupca spoločnosti Sony.

Zabudovaná nabíjateľná batéria
Jednotka má vstavanú nabíjateľnú batériu na ukladanie dátumu, času a ďalších nastavení, aj keď je jednotka vypnutá.
Vstavaná nabíjateľná batéria sa nabije po uplynutí 24 hodín, ak je jednotka pripojená k elektrickej zásuvke pomocou
sieťového adaptéra alebo ak je napájaná cez PoE++, bez ohľadu na to, či je jednotka zapnutá/vypnutá. Ak sieťový
adaptér nie je pripojený k zdroju napájania, nabíjateľná batéria sa úplne vybije približne za 2 mesiace. Zariadenie
používajte po nabití batérie. Aj keď nabíjateľná batéria nie je nabitá, prevádzka jednotky nebude ovplyvnená, pokiaľ
nebudete musieť zaznamenávať dátum.

Miesto použitia a skladovania
Skladujte na rovnom a vetranom mieste.
Prístroj nepoužívajte ani neskladujte na nasledujúcich miestach.

Miesta vystavené dažďu alebo vode (vrátane pod odkvapom)
Vonku a na miestach, ktoré presahujú 40 °C
Pamätajte, že v lete v teplom podnebí môže teplota vo vnútri auta so zatvorenými oknami ľahko prekročiť 50 °C.
Miesta chladnejšie ako 0 °C.
Na vlhkých alebo prašných miestach. Miesta, kde môže byť prístroj vystavený dažďu
Miesta vystavené vibráciám alebo nárazom
Miesta, kde sa generuje žiarenie, röntgenové lúče a silné magnetické polia.
V blízkosti rozhlasových alebo televíznych vysielačov produkujúcich silné elektromagnetické pole.
Na priamom slnečnom svetle alebo na dlhšiu dobu v blízkosti vykurovacích telies

Poznámka k laserovým lúčom
Laserové lúče môžu poškodiť obrazový snímač CMOS. Ak snímate scénu, ktorá obsahuje laserový lúč, dávajte pozor,
aby laserový lúč nebol nasmerovaný do obrazového snímača CMOS kamery. Konkrétne vysokovýkonné laserové lúče
zo zdravotníckych prístrojov alebo iných prístrojov môžu spôsobiť poškodenie v dôsledku odrazeného a rozptýleného
svetla.

Zabránenie elektromagnetickému rušeniu z prenosných komunikačných zariadení
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Používanie prenosných telefónov a iných komunikačných zariadení v blízkosti tejto jednotky môže mať za následok
poruchy a rušenie zvukových a obrazových signálov. Odporúčame vypnúť prenosné komunikačné zariadenia v blízkosti
tejto jednotky.

Neumiestňujte tento výrobok blízko zdravotníckych prístrojov
Tento výrobok (vrátane príslušenstva) obsahuje magnet(y), ktoré môžu rušiť kardiostimulátory, programovateľné
bočníkové tlakové ventily na liečbu hydrocefalu alebo iné zdravotnícke prístroje. Neumiestňujte tento výrobok blízko
osôb, ktoré používajú takéto zdravotnícke prístroje. Ak používate akýkoľvek takýto zdravotnícky prístroj, pred použitím
tohto výrobku sa poraďte so svojím lekárom.

Bezpečnostné opatrenia
SONY NEPREBERÁ ZODPOVEDNOSŤ ZA ŠKODY AKÉHOKOĽVEK DRUHU VYPLÝVAJÚCE Z NEVYKONANIA
RIADNYCH BEZPEČNOSTNÝCH OPATRENÍ NA PRENOSOVÝCH ZARIADENIACH, ZA NEODVRÁTITEĽNÉ
ÚNIKY ÚDAJOV, KTORÉ VYPLÝVAJÚ ZO ŠPECIFIKÁCIE PRENOSU, ALEBO ZA BEZPEČNOSTNÉ PROBLÉMY
VŠETKÉHO DRUHU.
V závislosti na operačnom prostredí môžu neoprávnené tretie osoby v sieti získať prístup k zariadeniu. Pri pripojení
zariadenia do siete sa uistite, že sieť je bezpečne chránená.
Z bezpečnostného hľadiska sa pri používaní jednotky pripojenej k sieti dôrazne odporúča pristupovať do ovládacieho
okna cez webový prehliadač a zmeniť nastavenia obmedzenia prístupu z továrensky prednastavených hodnôt.
Odporúčame tiež nastaviť heslo s dostatočne dlhým reťazcom znakov, ktorý je pre ostatných ťažké uhádnuť,
a bezpečne ho uložiť.
Ak pripájate tento výrobok na sieť, pripájajte sa prostredníctvom systému, ktorý poskytuje funkciu ochrany, napríklad
smerovač alebo firewall. Ak sa pripojíte bez takejto ochrany, môžu nastať problémy so zabezpečením.

Napájanie
Jednotka nie je vybavená hlavným vypínačom. Ak chcete jednotku vypnúť, skontrolujte, či sa skončili všetky operácie
a či je jednotka v pohotovostnom režime, potom odpojte sieťový adaptér. Ak používate napájanie PoE++, odpojte
kábel LAN.
Ak je to možné, použite napájanie z miesta, kde je ľahké zasunúť a vytiahnuť zástrčku.
Ak používate zásuvku na prašnom mieste, pravidelne čistite oblasť okolo zásuvky, aby ste predišli znečisteniu.
Ak sa zariadenie nepoužíva, odpojte ho od napájania.

Bezpečnostné opatrenia pre pohyblivé časti
Dbajte na to, aby sa cudzie predmety nedostali do pohyblivých častí.
Pri ručnom pohybe dielov nevyvíjajte nadmerné zaťaženie. Môže to spôsobiť poruchu.
Počas pohybu nezasahujte do prevádzky pohyblivých častí. Mohlo by to spôsobiť zranenie alebo poruchu.
Pohyblivé časti nemusia fungovať normálne, ak sa jednotka dlhší čas nepoužíva. Pravidelne používajte funkcie
otáčania/nakláňania jednotky.

Opatrenia pri nepretržitej prevádzke
Jednotka môže byť napájaná 24 hodín denne, 365 dní v roku (pohotovostný stav).
Vždy vykonajte test snímania a overte, či jednotka funguje normálne.

Nie je zaručené nepretržité snímanie po dobu dlhšiu ako 24 hodín.
Ak snímate dlhšie ako 24 hodín, uveďte jednotku do pohotovostného režimu a potom ju reštartujte.

Upozorňujeme, že spoločnosť Sony nezodpovedá za akúkoľvek kompenzáciu za obsah snímok, ak počas používania
tejto jednotky nemôžete snímať z dôvodu akejkoľvek poruchy.
Pred použitím vždy skontrolujte, či prístroj správne pracuje. SONY NEZODPOVEDÁ ZA ŠKODY AKÉHOKOĽVEK
DRUHU, VRÁTANE A BEZ OBMEDZENIA, ODŠKODNENIA ALEBO VRÁTENIA PEŇAZÍ NA ÚČET Z DÔVODU
STRATY SÚČASNÉHO ALEBO BUDÚCEHO ZISKU KVÔLI PORUCHE TOHTO PRÍSTROJA A TO BUĎ V OBDOBÍ
ZÁRUČNEJ LEHOTY ALEBO PO JEJ UPLYNUTÍ ALEBO Z AKÉHOKOĽVEK INÉHO DÔVODU.
SONY NEZODPOVEDNÁ ZA NÁROKY AKÉHOKOĽVEK DRUHU POSKYTOVANÝCH POUŽÍVATEĽOM TOHTO
PRÍSTROJA ALEBO TRETÍMI STRANAMI.
SONY NEZODPOVEDÁ ZA UKONČENIE ALEBO PRERUŠENIE AKÝCHKOĽVEK SLUŽIEB SPOJENÝCH
S TÝMTO ZARIADENÍM, KTORÉ MÔŽU VZNIKNÚŤ V DÔSLEDKU OKOLNOSTÍ AKÉHOKOĽVEK DRUHU.
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Opatrenia pre funkciu nahrávania
Vždy vykonajte testovací záznam a overte, že bol úspešne zaznamenaný. SONY NEZODPOVEDÁ ZA ŠKODY
AKÉHOKOĽVEK DRUHU, VRÁTANE A BEZ OBMEDZENIA, KOMPENZÁCIE ALEBO NÁHRADY Z DÔVODU
CHYBY TOHTO ZARIADENIA ALEBO JEHO ZÁZNAMOVÉHO MÉDIA ALEBO AKÉHOKOĽVEK INÉHO MÉDIA, ČI
ÚLOŽNÝCH SYSTÉMOV PRE NAHRÁVANIE OBSAHU AKÉHOKOĽVEK TYPU.
Pred použitím vždy skontrolujte, či prístroj správne pracuje. SONY NEZODPOVEDÁ ZA ŠKODY AKÉHOKOĽVEK
DRUHU, VRÁTANE A BEZ OBMEDZENIA, ODŠKODNENIA ALEBO VRÁTENIA PEŇAZÍ NA ÚČET Z DÔVODU
STRATY SÚČASNÉHO ALEBO BUDÚCEHO ZISKU KVÔLI PORUCHE TOHTO PRÍSTROJA A TO BUĎ V OBDOBÍ
ZÁRUČNEJ LEHOTY ALEBO PO JEJ UPLYNUTÍ ALEBO Z AKÉHOKOĽVEK INÉHO DÔVODU.
SONY NEZODPOVEDNÁ ZA NÁROKY AKÉHOKOĽVEK DRUHU POSKYTOVANÝCH POUŽÍVATEĽOM TOHTO
PRÍSTROJA ALEBO TRETÍMI STRANAMI.
SONY NEZODPOVEDÁ ZA STRATU, OPRAVU ALEBO REPRODUKCIU AKÝCHKOĽVEK ÚDAJOV
ZAZNAMENANÝCH NA VNÚTORNOM ÚLOŽNOM SYSTÉME, ZÁZNAMOVÝCH MÉDIÁCH ALEBO
AKÝCHKOĽVEK INÝCH MÉDIÁCH ALEBO SYSTÉMOCH PRE UKLADANIE DÁT.
SONY NEZODPOVEDÁ ZA UKONČENIE ALEBO PRERUŠENIE AKÝCHKOĽVEK SLUŽIEB SPOJENÝCH
S TÝMTO ZARIADENÍM, KTORÉ MÔŽU VZNIKNÚŤ V DÔSLEDKU OKOLNOSTÍ AKÉHOKOĽVEK DRUHU.

5-041-959-13(1) Copyright 2022 Sony Corporation

466



Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Výstupné formáty a obmedzenia

Táto téma popisuje výstupné formáty a obmedzenia.

Poznámka

Rozlíšenie výstupného formátu je obmedzené nastaveniami [Project] > [Rec Format] > [Frequency], [Codec], a [Video Format] vo
webovej ponuke alebo v ponuke kamery.

Rozlíšenie výstupného formátu je tiež obmedzené kombináciou s frekvenciou snímok S&Q. Okrem nižšie uvedenej tabuľky
výstupných formátov konektorov SDI OUT/HDMI OUT sa výstup HDMI zmení na Full HD alebo nižší, ak sú splnené všetky
nasledujúce podmienky.

[Shooting] > [S&Q Motion] > [Setting] je nastavené na [On]
[Shooting] > [S&Q Motion] > [Frame Rate] je vyššie ako 60 snímok za sekundu

Keď sú splnené vyššie uvedené podmienky, možnosti výberu HDMI výstupu 4096×2160P a 3840×2160P pre [Monitoring] >
[Output Format] > [SDI/HDMI] sú sivé a nemožno ich vybrať.

Ak je nakonfigurované vyššie rozlíšenie, ako je rozlíšenie prehrávaného obrazu, obraz sa nezobrazuje.

Výstupné formáty konektora SDI OUT/HDMI OUT

Keď je systémová frekvencia 50/59.94 Hz

Nastavenie Voliteľný výstupný formát

Režim
nahrávania/prehrávania

Rozlíšenie výstupu
RAW/

Rozlíšenie interného
záznamu

SDI HDMI

RAW
RAW & XAVC-I

4096×2160
(RAW)

(4096×2160 RAW)

4096×2160P
3840×2160P
1920×1080P
(predvolené)
1920×1080i

3840×2160
(RAW)

(3840×2160 RAW)

3840×2160P
1920×1080P
(predvolené)
1920×1080i
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Keď je systémová frekvencia 25/29.97 Hz

Nastavenie Voliteľný výstupný formát

Režim
nahrávania/prehrávania

Rozlíšenie výstupu
RAW/

Rozlíšenie interného
záznamu

SDI HDMI

XAVC-I
XAVC-L

4096×2160

4096×2160 (2SI)1)
4096×2160P
1920×1080P
1920×1080i

3840×2160 (2SI)
3840×2160P
1920×1080P
1920×1080i

1920×1080P (Level A)
(prednastavené)

1920×1080P
(predvolené)
1920×1080i

1920×1080P (Level B)
1920×1080P
1920×1080i

3840×2160

3840×2160 (2SI)
3840×2160P
1920×1080P
1920×1080i

1920×1080P (Level A)
(prednastavené)

1920×1080P
(predvolené)
1920×1080i

1920×1080P (Level B)
1920×1080P
1920×1080i

1920×1080i 1920×1080i

1920×1080

1920×1080P (Level A)
(prednastavené)

1920×1080P
(predvolené)
1920×1080i

1920×1080P (Level B)
1920×1080P
1920×1080i

1920×1080i 1920×1080i

(Výstup zastavený)
720×480P2)

720×576P3)

Zobrazenie na obrazovke nie je možné prekryť.1)

Keď je systémová frekvencia 59.942)

Keď je systémová frekvencia 503)
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Keď je systémová frekvencia 23.98 Hz

Nastavenie Output Format (výstupné rozlíšenie)

Režim
nahrávania/prehrávania

Rozlíšenie výstupu
RAW/

Rozlíšenie interného
záznamu

SDI HDMI

RAW
RAW & XAVC-I

4096×2160
(RAW)

(4096×2160 RAW)

4096×2160P
3840×2160P
1920×1080P
1920×1080i (predvolené)

3840×2160
(RAW)

(3840×2160 RAW)
3840×2160P
1920×1080P
1920×1080i (predvolené)

XAVC-I
XAVC-L

4096×2160

4096×2160 (2SI)
4096×2160P
1920×1080P

3840×2160 (2SI)
3840×2160P
1920×1080P

1920×1080P 1920×1080P

1920×1080PsF
(prednastavené)

1920×1080i
(prednastavené)

3840×2160

3840×2160 (2SI)
3840×2160P
1920×1080P

1920×1080P 1920×1080P

1920×1080PsF
(prednastavené)

1920×1080i
(prednastavené)

1920×1080 1920×1080P
1920×1080PsF

1920×1080P
1920×1080i

Nastavenie Output Format (výstupné rozlíšenie)

Režim
nahrávania/prehrávania

Rozlíšenie výstupu RAW/
Rozlíšenie interného

záznamu
SDI HDMI

RAW
RAW & XAVC-I

4096×2160
(RAW)

(4096×2160 RAW)
4096×2160P
3840×2160P
1920×1080P (predvolené)

3840×2160
(RAW)

(3840×2160 RAW) 3840×2160P
1920×1080P (predvolené)
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Keď je systémová frekvencia 24 Hz

5-041-959-13(1) Copyright 2022 Sony Corporation

Nastavenie Output Format (výstupné rozlíšenie)

Režim
nahrávania/prehrávania

Rozlíšenie výstupu RAW/
Rozlíšenie interného

záznamu
SDI HDMI

XAVC-I
XAVC-L

4096×2160

4096×2160 (2SI)
4096×2160P
1920×1080P

3840×2160 (2SI)
3840×2160P
1920×1080P

1920×1080P
(prednastavené)

1920×1080P
(prednastavené)

3840×2160

3840×2160 (2SI)
3840×2160P
1920×1080P

1920×1080P
(prednastavené)

1920×1080P
(prednastavené)

1920×1080
1920×1080P
(prednastavené)

1920×1080P
(prednastavené)

Nastavenie Output Format (výstupné rozlíšenie)

Režim
nahrávania/prehrávania

Rozlíšenie výstupu RAW/
Rozlíšenie interného

záznamu
SDI HDMI

RAW
RAW & XAVC-I

4096×2160
(RAW)

(4096×2160 RAW)
4096×2160P
1920×1080P
(predvolené)

XAVC-I 4096×2160
4096×2160 (2SI)
1920×1080P
(predvolené)

4096×2160P
1920×1080P
(predvolené)
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Riešenie problémov

Napájanie

Obrazový výstup

Príznak Príčina Riešenie

Jednotka sa
nezapne.

Sieťový adaptér nie je pevne pripojený ku konektoru
DC IN.

Zasuňte napájací kábel pevne až na doraz.

Sieťový napájací kábel nie je pevne zasunutý do
sieťového adaptéra alebo sieťovej zásuvky.

Zasuňte napájací kábel pevne až na doraz.

Kábel LAN nie je pevne pripojený medzi napájacím
zariadením PoE++ a jednotkou.

Skontrolujte, či je kábel zasunutý, kým
nezacvakne.

Kábel LAN je pripojený ku konektoru OPTION, ale
nie ku konektoru LAN.

Pripojte kábel LAN do konektora LAN správne.

Jednotka je pripojená k napájaciemu zariadeniu,
ktoré nepodporuje PoE++ (IEEE802.3bt, typ 4,
kompatibilné s triedou 8).

Pripojte sa k napájaciemu zariadeniu, ktoré
podporuje PoE++ (IEEE802.3bt, typ 4,
kompatibilné s triedou 8).

Celková spotreba energie presahuje maximálny
výkon zariadenia na dodávku energie PoE++.

Pozrite si návod na obsluhu napájacieho
zariadenia PoE++.

Je pripojený sieťový kábel kategórie, ktorý
nepodporuje napájanie PoE++.

Použite sieťový kábel kategórie 5e alebo vyššej
pripojený ku konektoru LAN.

Kamera, napájacie zariadenie PoE++ a periférne
zariadenia nie sú pripojené k zemi.

Pripojte kameru, napájacie zariadenie PoE++
a periférne zariadenia k zemi.

Príznak Príčina Riešenie

Žiaden obrazový výstup.

Pripojené zariadenia nie sú správne pripojené.
Pripojte pripojené zariadenia
správne.

Úvodné nastavenie nebolo dokončené.
Dokončite úvodné nastavenie
pomocou webovej aplikácie.

Z konektora HDMI
nevychádza žiadny obraz.

Je nakonfigurovaný signál, ktorý cieľové zariadenie
HDMI výstupu nepodporuje.

Zmeňte nastavenie
výstupného formátu HDMI
alebo použite zariadenie, ktoré
podporuje výstupný signál.

Používa sa kábel, ktorý nepodporuje výstupný štandard
HDMI.

Použite kábel, ktorý podporuje
používaný výstupný štandard
HDMI.
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Diaľkový ovládač

Infračervené diaľkové ovládanie

Príznak Príčina Riešenie

Z konektora SDI
nevychádza žiadny obraz.

Používa sa kábel, ktorý nepodporuje výstupný štandard
SDI.

Použite kábel, ktorý podporuje
používaný výstupný štandard
SDI.

Monitor pripojený ku konektoru SDI nepodporuje
výstupný signál.

Použite monitor, ktorý
podporuje výstupný štandard
SDI.

Formát záznamu je nastavený pre výstup RAW.
Zmeňte formát záznamu na iné
nastavenie ako výstup RAW.

Výstup HDMI je nastavený na rozlíšenie SD.
Nastavte výstup HDMI na iné
rozlíšenie ako SD.

Z optického vlákna
nevychádza žiadny obraz
alebo je obraz skreslený.

Použitý modul nespĺňa normy SFF alebo SMPTE alebo
nespĺňa výkonovú úroveň I (1,0 W).

Pozrite si časť „Výstup signálu
z optického vlákna.“

Pri použití externej
synchronizácie sa
nereprodukuje žiadny
obraz alebo je skreslený.

Neprijíma sa externý synchronizačný signál vhodný pre
nakonfigurovaný formát video signálu.

Vložte externý synchronizačný
signál vhodný pre
nakonfigurovaný formát video
signálu.

Vo zvuku je šum.

Kamera, napájacie zariadenie PoE++ a periférne
zariadenia nie sú pripojené k zemi.

Pripojte jednotku, napájacie
zariadenie PoE++ a periférne
zariadenia k zemi.

Jednotka sa používa v prostredí so zariadeniami, ktoré
generujú silné elektrické a magnetické polia (ako sú
antény televíznych/rádiových vysielačov, amatérske
rádiové vysielače, motory klimatizácií, napájacie
transformátory).

Uchovávajte mimo dosahu
zariadení, ktoré generujú silné
elektrické a magnetické polia.

Objektív, podpera objektívu a pohonná jednotka sú
v kontakte s jednotkou alebo predmetom v okolitom
prostredí a vznikajú nezvyčajné zvuky.

Nasaďte objektív správne.

Skontrolujte, či v blízkosti
kamery nie sú nejaké
prekážky.

Príznak Príčina Riešenie

Infračervené diaľkové
ovládanie po stlačení
nefunguje.

Infračervené diaľkové ovládanie je
vypnuté.

Nastavte [Technical] > [IR Remote] >
[Setting] na [On] vo webovej ponuke.

Batéria je vybitá alebo je polarita batérie
nesprávna.

Infračervené diaľkové ovládanie
používajte v blízkosti IR senzora jednotky.
Ak LED kontrolka napájania bliká,
vymeňte batériu.

Úvodné nastavenie nebolo dokončené.
Dokončite úvodné nastavenie pomocou
webovej aplikácie.
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RM-IP500

Webová aplikácia

Príznak Príčina Riešenie

Prevádzková rýchlosť
otáčania/nakláňania je
pomalá.

Rýchlosť otáčania/nakláňania
z infračerveného diaľkového ovládača je
nastavená na normálny režim.

Nastavte prepínač SETUP 4 do polohy ON
na pripojovacom bloku jednotky.

Operácia bola zameraná na
inú ako zamýšľanú kameru.

Infračervený signál bol prijatý inou
kamerou, než je určená kamera.

Nastavte [Technical] > [IR Remote] >
[Setting] na [Off] vo webovej ponuke
kamery, ktorú nechcete ovládať.

Príznak Príčina Riešenie

Kamera sa nedá ovládať diaľkovým
ovládačom RM-IP500.

Napájanie kamery nie je
pripojené.

Skontrolujte, či sa kontrolka POWER jednotky
rozsvieti na zeleno alebo oranžovo.

Kamera alebo diaľkový
ovládač nie sú pripojené
k sieti.

Skontrolujte pripojenie jednotky a diaľkového
ovládača.

Počiatočné nastavenie
kamery nebolo
dokončené.

Dokončite úvodné nastavenie pomocou webovej
aplikácie.

Komunikácia VISCA over
IP nie je povolená.

Nastavte prepínač SETUP 3 do polohy ON na
pripojovacom paneli jednotky a reštartujte
jednotku.

IP adresa kamery sa
zmenila.

Skontrolujte IP adresu kamery pomocou
[Network] > [Wired LAN] vo webovej ponuke
alebo v ponuke kamery.

IP adresa kamery bola zmenená
pomocou AUTO IP SETUP na
diaľkovom ovládači RM-IP500.

Od spustenia kamery
uplynulo najmenej 20
minút.

Reštartujte jednotku. IP adresu je možné zmeniť
pomocou AUTO IP SETUP počas prvých 20
minút po spustení jednotky.
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Príznak Príčina Riešenie

Nedá sa pripojiť pomocou webového
prehliadača.

Nie je pripojený kábel LAN
kategórie 5e alebo vyššej.

Pripojte kábel LAN kategórie 5e alebo
vyššej.

Nie je správne pripojenie
k sieti LAN alebo pripojená
sieť nefunguje normálne.

Skontrolujte, či svieti Link LED pre
konektor LAN. Ak Link LED nesvieti,
kontaktujte správcu siete.

Napájanie kamery nie je
pripojené.

Pozrite si časť „Napájanie“ vyššie.

Pre jednotku nie je
nakonfigurovaná platná
adresa IP.

Vykonajte reset siete.

Nakonfigurovaná adresa IP
sa používa na inom
zariadení.

Skontrolujte, či sú adresy IP periférnych
zariadení jedinečné.

Nakonfigurovaná maska
podsiete nezodpovedá
použitej podsieti siete.

Vykonajte reset siete.

K jednotke sa pristupuje
v rovnakej lokálnej sieti cez
proxy server.

Zmeňte konfiguráciu tak, aby sa
nepoužíval proxy server.

Nakonfigurovaná
predvolená brána pre
jednotku je nesprávna.

Vykonajte reset siete.

Zadaná adresa URL je
nesprávna.

Zadajte správnu webovú adresu a skúste
to znova.

Port HTTP je nesprávny.

Zobrazte ponuku kamery na externom
monitore a skontrolujte nastavenie
[Network] > [Wired LAN] > [HTTP Port]. Ak
je nakonfigurovaná iná hodnota ako 80,
pridajte číslo portu HTTP k názvu hostiteľa
alebo adrese IP zadanej vo webovom
prehliadači.
Príklad: Ak je port HTTP nastavený na
8080, zadajte http://<IP adresa>:8080

Číslo portu HTTP jednotky
je filtrované alebo
blokované.

Zmeňte číslo portu HTTP jednotky na port,
ktorý nie je filtrovaný ani blokovaný.

Stará vyrovnávacia pamäť
webového prehliadača má
nepriaznivý vplyv.

Vymažte vyrovnávaciu pamäť z webového
prehliadača.
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Príznak Príčina Riešenie

Nedá sa pripojiť k webovej aplikácii
pomocou 2D kódu (QR kód).

Používané zariadenie
nepodporuje mDNS.

Použite zariadenie, ktoré podporuje
mDNS.
Ak používate zariadenie, ktoré
nepodporuje mDNS, zadajte IP adresu
priamo do webového prehliadača.

Tablet alebo počítač je
pripojený k inej sieti ako
kamera.

Pripojte tablet alebo počítač k rovnakej
sieti ako jednotka.

Nedá sa pripojiť k webovej aplikácii
manuálnym zadaním adresy URL.

Používané zariadenie
nepodporuje mDNS.

Použite zariadenie, ktoré podporuje
mDNS.

Tablet alebo počítač je
pripojený k inej sieti ako
kamera.

Pripojte tablet alebo počítač k rovnakej
sieti ako jednotka.

Obrazovka overenia sa nepretržite
zobrazuje.

Nebolo zadané správne
meno používateľa alebo
heslo.

Zadajte zaregistrované meno používateľa
a heslo. Ak ste zabudli informácie
o registrovanom používateľovi, pozrite si
časť „RESET spínač“ v časti „Pripojovací
blok“ a inicializujte informácie
o používateľovi pre sieťové pripojenie.

Používateľské meno
a heslo mohlo byť zmenené
používateľom prihláseným
pomocou iného webového
prehliadača.

Správne používateľské meno a heslo si
overte u správcu jednotky.

Obraz z kamery sa nezobrazuje vo
webovej aplikácii.

HDMI výstup kamery je
nastavený na 720×480
alebo 720×576.

Zmeňte rozlíšenie HDMI výstupu jednotky.

Je pripojený monitor HDMI,
ktorý nepodporuje výstupný
signál HDMI kamery.

Odstráňte monitor HDMI alebo použite
monitor HDMI, ktorý podporuje výstupné
signály HDMI.

Jednotka bola reštartovaná
a relácia bola odpojená.

Počkajte asi minútu a znova načítajte
webový prehliadač.

Stará vyrovnávacia pamäť
webového prehliadača má
nepriaznivý vplyv.

Vymažte vyrovnávaciu pamäť z webového
prehliadača.

Rozlíšenie obrazu z kamery zobrazeného
vo webovej aplikácii je nízke.

Rozlíšenie videostreamu 3
používaného webovou
aplikáciou je nastavené na
nízke.

Zvýšte hodnotu pomocou [Stream] >
[Video Stream] > [Size 3] vo webovej
ponuke.

Ponuka kamery sa po stlačení tlačidla
[Menu] nezobrazí.

Ponuka kamery je
nakonfigurovaná tak, aby
nebola vložená do
výstupného signálu HDMI.

Nastavte [Monitoring] > [Output Display] >
[HDMI/Stream] na [On] vo webovej
ponuke.
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Snímanie

Kamera

Príznak Príčina Riešenie

Hodnota nastavenia na obrazovke
nastavení sa neaktualizuje/nezobrazuje
správne.

Obrazovka nastavení
webovej aplikácie
automaticky neodráža
nastavenia zmenené v inej
webovej aplikácii.

Stlačte tlačidlo [Reload] v spodnej časti
obrazovky nastavení webovej aplikácie.
Hodnoty nastavení na zobrazenej
obrazovke nastavenia sa znova načítajú
a aktualizujú.

Nastavenia dočasných
internetových súborov majú
vplyv.

Vymažte vyrovnávaciu pamäť z webového
prehliadača.

Nie je možné stiahnuť konfiguračný súbor
alebo protokol.

Funkcia sťahovania
súborov webového
prehliadača je zakázaná.

Povoľte funkciu sťahovania súborov vo
webovom prehliadači.

Obrazovka nastavení webovej aplikácie je
prístupná, ale nie je možné vykonávať
operácie na živej prevádzkovej obrazovke
a na prevádzkovej obrazovke
prehrávania.

Prevádzková obrazovka
webovej aplikácie je
uzamknutá.

Nastavte prepínač uzamknutia prevádzky
v pravej hornej časti webovej aplikácie do
polohy  (Funkcie odomknuté).

Zobrazenie obrazovky webovej aplikácie
chvíľu trvá.

Streamovaný obraz
jednotky je súčasne
sledovaný viacerými
používateľmi.

Znížte počet používateľov, ktorí môžu
súčasne pristupovať k webovej aplikácii.

Obraz je skreslený alebo trhaný.

Video informácie sa
neprenášajú správne kvôli
preťaženiu komunikačnej
cesty.

Znížte prenosovú rýchlosť streamovania
alebo nastavte kodek [Video Stream 3] >
[Size] na najmenšiu možnosť alebo znížte
rýchlosť, aby ste vytvorili rezervu v
komunikačnom pásme.

V tablete je spustených
niekoľko webových
prehliadačov, ktoré zaberajú
pamäť.

Zatvorte všetky webové prehliadače, ktoré
sú spustené na pozadí.

Je otvorených príliš veľa
kariet webového
prehliadača, čo spomaľuje
prevádzku.

Zatvorte všetky nepoužívané karty.

Nadmerné hromadenie
vyrovnávacej pamäte
webového prehliadača
a histórie prehliadania
spomaľuje prevádzku.

Vymažte vyrovnávaciu pamäť webového
prehliadača.

Príznak Príčina Riešenie

Obraz vyzerá skreslený na začiatku a na
konci otáčania/nakláňania.

Obraz môže byť skreslený, ak je zapnutá
funkcia stabilizácie obrazu objektívu.

Vypnite funkciu stabilizácie
obrazu objektívu.

Uhol pohľadu sa zmenil bez zásahu
používateľa.

Došlo k dýchaniu pri práci s objektívom.
Pozrite si časť
„Kompenzácia dýchania“.
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Otáčanie/nakláňanie

Príznak Príčina Riešenie

Nedá sa ovládať zaostrenie, transfokácia
alebo clona.

Nastavenia prepínačov na objektíve môžu
byť nesprávne.

Pozrite si časť „Kontrola
prepínačov objektívu“.

Príznak Príčina Riešenie

Nie je možné resetovať
otáčanie/nakláňanie.

Zaisťovacia páčka
otáčania/nakláňania je v polohe
LOCK.

Posuňte zaisťovaciu páčku otáčania/nakláňania do
polohy UNLOCK.

Kamera sa nezastaví
v očakávanej polohe.

Kamerový blok je nevyvážený.
Posuňte kamerový blok dopredu/dozadu do
vhodnej polohy, ako je popísané v časti „Nasadenie
objektívu“, a potom jednotku znova zapnite.

Je pripojený objektív, ktorý
nepodporuje otáčanie/nakláňanie.

Pozrite si informácie o kompatibilite objektívu
a nasaďte objektív, ktorý podporuje
otáčanie/nakláňanie, a potom zariadenie znova
zapnite.

Nedá sa vykonať resetovanie
otáčania/nakláňania.

Vykonajte reset otáčania/nakláňania, ako je
popísané v časti „Resetovanie
otáčania/nakláňania“.

Na hlavu kamery bola vyvinutá
neočakávaná sila, čo spôsobilo
chybu ovládania
otáčania/nakláňania.

Kamera sa nevráti do
prednej polohy po stlačení
tlačidla 
(otáčanie/nakláňanie
domov).

Bol aktivovaný režim stropnej
montáže.

Nastavte [Pan-Tilt] > [P/T Direction] > [Ceiling] vo
webovej ponuke podľa aktuálnej inštalácie a potom
jednotku znova zapnite. Pri montáži na strop bude
pripojovací blok v prednej časti kamery.

Operácia
otáčania/nakláňania je
obmedzená.

Obmedzenie rozsahu
otáčania/nakláňania je
nakonfigurované.

Podľa potreby vymažte nastavenia limitu rozsahu
otáčania/nakláňania, ako je popísané v časti „P/T
Range Limit“.

Na hlavu kamery bola vyvinutá
neočakávaná sila, čo spôsobilo
chybu otáčania/nakláňania.

Vykonajte reset otáčania/nakláňania, ako je
popísané v časti „Resetovanie
otáčania/nakláňania“.

Operácia
otáčania/nakláňania sa
vykonala v opačnom
smere.

Nastavenie režimu stropnej
montáže sa líši od skutočného
stavu montáže.

Nastavte [Pan-Tilt] > [P/T Direction] > [Ceiling] vo
webovej ponuke podľa aktuálnej inštalácie.

Nastavenia súvisiace
s orientáciou otáčania/nakláňania
boli zmenené.

Skontrolujte nastavenie [Pan-Tilt] > [P/T Direction]
vo webovej ponuke.
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Príznak Príčina Riešenie

Obraz sa nepohybuje
plynulo na začiatku a na
konci otáčania/nakláňania.

Nastavenie
zrýchlenia/spomalenia
otáčania/nakláňania je príliš
vysoké.

Znížte nastavenie zrýchlenia/spomalenia
otáčania/nakláňania, aby bol pohyb na začiatku
a na konci otáčania/nakláňania plynulejší pomocou
[Pan-Tilt] > [P/T Acceleration] > [Ramp Curve] vo
webovej ponuke alebo v ponuke kamery.
Upozorňujeme, že to bude znamenať, že objektívu
bude trvať dlhšie, kým dosiahne maximálnu
rýchlosť.

Otáčanie/nakláňanie sa
zastavilo.

Kamerový blok je nevyvážený.
Posuňte kamerový blok dopredu/dozadu do
vhodnej polohy, ako je popísané v časti „Nasadenie
objektívu“, a potom jednotku znova zapnite.

Nastavenie krivky nábehu
(zrýchlenie/spomalenie) je pre
nasadený objektív príliš vysoké.

Ak je nasadený veľký objektív, znížte hodnotu
[Pan-Tilt] > [P/T Acceleration] > [Ramp Curve] vo
webovej ponuke alebo v ponuke kamery.

Používa sa veľký objektív. Obráťte sa na zástupcu podpory spoločnosti Sony.

Jednotka je pri ovládaní
otáčania/nakláňania
zablokovaná.

Pripevňovacia skrutka držiaka
podstavca objektívu sa dotýka
kamery.

Otočte pripevňovaciu skrutku upínacej páčky
podstavca podpery objektívu tak, aby smerovala
nahor.

Upínacia páčka podpery objektívu
sa dotýka kamery.

Otočte upínaciu páčku podpery objektívu tak, aby
smerovala nahor.

Zaisťovacia páčka hlavy kamery
sa dotýka kamery.

Skontrolujte, či je zaisťovacia páčka hlavy kamery
úplne v polohe LOCK.

Počas otáčania/nakláňania
dochádza k nezvyčajnému
hluku.

Kamera je nevyvážená.
Posuňte hlavu kamery dopredu/dozadu do vhodnej
polohy tak, aby bola posuvná základňa vodorovná.

Nastavenie krivky nábehu
(zrýchlenie/spomalenie) je pre
nasadený objektív príliš vysoké.

Ak je nasadený veľký objektív, znížte hodnotu
[Pan-Tilt] > [P/T Acceleration] > [Ramp Curve] vo
webovej ponuke alebo v ponuke kamery.

Hlava kamery nie je upevnená
a počas prevádzky je počuť
pohyb.

Nastavte zaisťovaciu páčku hlavy kamery do
polohy LOCK.

Nie je možné uložiť
prednastavenú polohu.

Predvoľbu nemožno uložiť, ak sa
používa Clear Image Zoom.

Nastavte pomer Clear Image Zoom späť na 1×.
(stav, keď sa pomer nezobrazuje vpravo od 
(Pomer transfokácie))

Pri prehrávaní predvoľby
polohy je zarámovanie
posunuté.

Medzi uložením prednastavenej
polohy a jej prehrávaním sa
mohla výrazne zmeniť teplota
prostredia.

Prednastavenú polohu opäť uložte.

Kalibrácia objektívu sa
nevykonáva.

Spustite kalibráciu pomocou [Technical] > [Lens] >
[Lens Calibration] v ponuke kamery.

Je pripojený iný objektív ako ten,
ktorý bol pripojený pri uložení
predvoľby. Alebo je pozícia
transfokácie pre manuálne
priblíženie iná.

Prednastavenú polohu opäť uložte.
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Nahrávanie/prehrávanie

Príznak Príčina Riešenie

Ovládací panel rámovania
webovej aplikácie je sivý
a nedá sa ovládať.

Otáčanie/nakláňanie nie je
dostupné počas zobrazenia
obrazovky s miniatúrami a počas
prehrávania.

Zobrazte obrazovku ovládania prehrávania
a ukončite zobrazenie miniatúr alebo zastavte
prehrávanie.

Otáčanie/nakláňanie nie je
k dispozícii, keď nie je možné
zobraziť obraz z kamery vo
webovej aplikácii.

Pozrite si časť „Webová aplikácia“ v časti „Riešenie
problémov“.

Zaisťovacia páčka
otáčania/nakláňania je v polohe
LOCK.

Posuňte zaisťovaciu páčku otáčania/nakláňania do
polohy UNLOCK.

„Execute Pan-Tilt Reset“ sa
zobrazuje pod ovládacím
panelom orámovania vo
webovej aplikácii.

Na hlavu kamery bola vyvinutá
neočakávaná sila, čo spôsobilo
chybu otáčania/nakláňania.

Vykonajte reset otáčania/nakláňania, ako je
popísané v časti „Resetovanie
otáčania/nakláňania“.

Príznak Príčina Riešenie

Nahrávanie sa nespustí
po stlačení tlačidla
nahrávania
START/STOP.

Pamäťová karta je plná.
Vymeňte pamäťovú kartu za kartu
s dostatočne voľným miestom.

Pamäťovú kartu je potrebné obnoviť.
Obnovte pamäťovú kartu podľa popisu v časti
„Obnova pamäťových kariet“.

Kontrolka nahrávania/záznamu je
nakonfigurovaná ako kontrolka záznamu,
takže stav nahrávania nemožno určiť
pomocou kontrolky.

Nakonfigurujte kontrolku nahrávania/záznamu
tak, aby fungovala ako kontrolka nahrávania,
ako je popísané v časti „Pripojenie
záznamového signálu“.

Záznam zvuku nie je
možný.

Nie je pripojený mikrofón.
Pripojte mikrofón alebo zvukové zariadenie
ku konektoru AUDIO IN na pripojovacom
bloku.

Nastavenie [Master Input Level] je na
minimálnej hodnote.

Upravte [Master Input Level].

Zaznamenaný zvuk je
skreslený.

Nastavenie vstupnej úrovne zvuku je príliš
vysoké.

Upravte [CH1 Input Level] na [CH4 Input
Level] a [Master Input Level].

Pri používaní mikrofónu v hlučnom prostredí,
napríklad v sále so živou hudbou, najprv
nastavte [AUDIO IN CH1 MIC Ref.] a [AUDIO
IN CH2 MIC Ref.].

Zaznamenaný zvuk má
vysokú hladinu hluku.

Nastavenie vstupnej úrovne zvuku je príliš
nízke.

Upravte nastavenie [Audio Input Level]
a [Audio] > [Audio] > [Audio Input] > [AUDIO
IN CH1 MIC Ref.] alebo [AUDIO IN CH2 MIC
Ref.].
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Prenos súboru

IP streamovanie

Príznak Príčina Riešenie

Klipy nie je možné
prehrať.

Klip sa upravuje.
Klipy nie je možné prehrať, ak ste zmenili
názvy súborov alebo priečinkov alebo ak sa
klip používa v počítači. Nejde o poruchu.

Klip bol zaznamenaný pomocou inej
kamery, ako je táto jednotka.

Klipy zaznamenané inou kamerou, ako je táto
jednotka, sa nemusia dať prehrať alebo sa
môžu zobraziť v nesprávnej veľkosti. Nejde
o poruchu.

Príznak Príčina Riešenie

Nahrávanie súborov
zlyhalo.

Používateľské meno a heslo na
serveri nie sú správne.

Používateľské meno a heslo na serveri nemusia byť
správne. Zadajte správne vstupné hodnoty.

Príznak Príčina Riešenie

Streamovanie nie je k dispozícii.

Používateľské meno alebo
heslo zadané v klientskej
aplikácii na sledovanie
streamovania z jednotky je
nesprávne.

Ak je formát streamovania jednotky nastavený
na [RTSP], [SRT-Listener], alebo [NDI|HX], je
potrebné zadať používateľské meno a heslo
nastavené pre túto jednotku v klientskej
aplikácii. Zadajte správne meno používateľa
a heslo.

Streamovací protokol nie je
nastavený.

Vyberte cieľový protokol pomocou [Stream] >
[Stream Setting] vo webovej ponuke.

Bolo nastavených šesť alebo
viac relácií RTSP.

Nastavte počet relácií na päť alebo menej.

Číslo portu UDP nie je
správne nastavené.

Nastavte číslo portu a ďalšie nastavenia pre
cieľový protokol pomocou [Stream] > [Stream] >
[Stream Setting] vo webovej ponuke.

Komunikácia UDP je
zablokovaná.

Skontrolujte nastavenia bezpečnostného
softvéru.

Zvuk sa neprenáša.
Streamovanie zvukového
výstupu je nastavené na [Off].

Nastavte [Stream] > [Audio Stream] > [Setting]
na [On] vo webovej ponuke.

Streamovanie bolo odpojené.

Počas streamovania sa
zmenilo nastavenie protokolu
alebo nastavenia
streamovacieho kodeku.

Pred spustením streamovania nastavte
nastavenie protokolu a nastavenia
streamovacieho kodeku.

Veľkosť obrazu [Video Stream 1]
nemožno nastaviť na 4096×2160
alebo 3840×2160.

Veľkosť obrazu je 1920×1080,
keď je [Output Format]
nastavené na HDMI.

Veľkosť obrazu pre streamovanie nemožno
nastaviť na vyššiu hodnotu, ako je veľkosť
obrazu HDMI. Zmeňte veľkosť obrazu HDMI
pomocou [Monitoring] > [Output Format] vo
webovej ponuke.
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Spojenie s externými zariadeniami

Externá synchronizácia

Tally

Príznak Príčina Riešenie

Snímkovú frekvenciu [Video
Stream 1] nemožno nastaviť na 60
FPS alebo 50 FPS.

Snímková frekvencia
streamovania je nastavená na
29.97 alebo nižšiu.

Snímková frekvencia používaná na
streamovanie je obmedzená systémovou
frekvenciou. Zmeňte systémovú frekvenciu
pomocou [Rec Format] > [Frequency] vo
webovej ponuke.

Nedá sa získať prístup k streamu
[Video Stream 3].

[Video Stream 3] nepodporuje
RTSP/SRT/NDI.

Použite [Video Stream 1] alebo [Video Stream
2].

Obrazovka RTSP/SRT sa
neaktualizuje/nezobrazuje
správne.

Číslo portu používané pre
RTSP alebo SRT je filtrované
alebo blokované.

Zmeňte číslo portu RTSP alebo SRT na port,
ktorý nie je filtrovaný ani blokovaný
zariadeniami prijímajúcimi stream. Alebo
zmeňte číslo portu používaného pre RTSP
alebo SRT na jednotke.

Obraz je skreslený alebo trhaný.

Video informácie sa
neprenášajú správne kvôli
preťaženiu komunikačnej
cesty.

Znížte prenosovú rýchlosť streamovania alebo
nastavte kodek [Video Stream 2] ([Codec 2]) na
[Off], aby ste vytvorili rezervu v komunikačnom
pásme.

Poradie video paketov sa
v rámci komunikačného
kanála zmenilo.

Použite rovnakého poskytovateľa internetových
služieb na strane jednotky aj na strane
prijímača.

Nebolo zistené ako zariadenie
NDI.

Streamovací protokol nie je
nastavený na NDI|HX.

Streamovací protokol musí byť nastavený na
NDI|HX, aby bolo možné detegovať jednotku
ako zariadenie NDI. Nastavte [Stream] >
[Stream Setting] na [NDI|HX] vo webovej
ponuke.

Nemožno použiť ako zariadenie
NDI.

Nie je nainštalovaná licencia
NDI|HX.

Nainštalujte licenciu NDI|HX. Môžete
skontrolovať, či existuje licencia NDI|HX
pomocou [Stream] > [Stream] > [Stream
Setting] > [NDI|HX] > [License] vo webovej
ponuke.

Príznak Príčina Riešenie

Nedá sa
synchronizovať
s externým zdrojom.

Neprijíma sa externý synchronizačný
signál vhodný pre nakonfigurovaný
formát video signálu.

Vložte externý synchronizačný signál vhodný pre
nakonfigurovaný formát video signálu.

Jednotka je dvojito ukončená.
Jednotka má zabudovanú 75 Ω koncovku. Pripojte
jednotku priamo k zdroju signálu (jedna k jednej)
alebo použite rozvádzač (rozdeľovač).
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Ovládač objektívu

Súvisiaca téma

Výstup signálu z optického vlákna

Pripojovací blok

Kompenzácia dýchania

Kontrola prepínačov objektívu

Nasadenie objektívu

Resetovanie otáčania/nakláňania

P/T Range Limit

Obnova pamäťových kariet

Pripojenie záznamového signálu

Príznak Príčina Riešenie

Kontrolka
záznamu sa
nerozsvieti.

Jas kontrolky záznamu je nastavený na
Off.

Nastavte vhodný jas pomocou [Technical] > [Tally] >
[Tally Lamp Brightness] vo webovej ponuke.

Kontrolka nahrávania/záznamu je
nakonfigurovaná ako kontrolka
nahrávania.

Nakonfigurujte kontrolku nahrávania/záznamu tak, aby
fungovala ako kontrolka záznamu, ako je popísané
v časti „Pripojenie záznamového signálu“.

RM-IP500 je pripojené a VISCA over IP
je vypnuté.

Nastavte prepínač SETUP 3 do polohy ON na
pripojovacom bloku jednotky.

Zapojenie konektora OPTION je
nesprávne alebo cieľový kolík nie je
skratovaný na GND.

Skratujte kolík 7 alebo kolík 8 konektora OPTION na
GND, ako je popísané v časti „Pripojenie záznamového
signálu“.

Príznak Príčina Riešenie

[Communication Error] sa
zobrazí v   (stav
kamery).

Kamera nemôže
komunikovať
s ovládačom objektívu.

Skontrolujte spojenie medzi jednotkou a ovládačom objektívu,
potom zapnite napájanie jednotky a ovládača objektívu.

[Rotation Error] sa zobrazí
v   (stav kamery).

V ovládači objektívu sa
vyskytla chyba
otáčania.

Uložený rozsah pohybu transfokácie a rozsah pohybu
objektívu sa nemusia zhodovať. Inicializujte ovládač objektívu.
Ak problém pretrváva, obráťte sa na zástupcu výrobcu
ovládača objektívu.

[System Error] sa zobrazí
v   (stav kamery).

V ovládači objektívu sa
vyskytla systémová
chyba.

Skontrolujte pripojenie medzi jednotkou a ovládačom
objektívu, pozrite si návod na obsluhu ovládača objektívu
a inicializujte ovládač objektívu alebo zapnite napájanie
jednotky a ovládača objektívu.
Ak problém pretrváva, obráťte sa na zástupcu výrobcu
ovládača objektívu.

[Unknown Error] sa
zobrazí v   (stav
kamery).

V ovládači objektívu sa
vyskytla neznáma
chyba.

Skontrolujte pripojenie medzi jednotkou a ovládačom
objektívu, pozrite si návod na obsluhu ovládača objektívu
a inicializujte ovládač objektívu alebo zapnite napájanie
jednotky a ovládača objektívu.
Ak problém pretrváva, obráťte sa na zástupcu výrobcu
ovládača objektívu.
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Chybové/varovné správy

Ak sa na jednotke vyskytne varovanie, upozornenie alebo prevádzkový stav, ktoré si vyžadujú potvrdenie, na obrazovom
paneli kamery sa zobrazí hlásenie a kontrolky POWER a NETWORK na prednom paneli a kontrolka
nahrávania/záznamu začnú blikať.

Poznámka

Blikajúca kontrolka nahrávania/záznamu je povolená len vtedy, keď sú obe položky [Technical] > [Tally] > [Tally Control]
nastavené na [Internal] a [Tally Lamp Brightness] nie sú nastavené na [Off] vo webovej ponuke alebo v ponuke kamery.

Chybové hlásenia

Ak kontrolka POWER a kontrolka NETWORK blikajú, ako je popísané nižšie, vykonajte nasledujúce opatrenia.

Jednotka zastaví prevádzku, keď sa zobrazí nasledujúce zobrazenie.

Varovné správy

Ak sa zobrazí nasledujúca obrazovka, postupujte podľa uvedených pokynov.

Kontrolka
POWER

Kontrolka
NETWORK Príčina a riešenie

Pomaly bliká
oranžovo

Pomaly bliká
zeleno

Jednotka nemôže normálne fungovať. Podrobnosti nájdete v časti [Maintenance] >
[System Log] vo webovej ponuke. Ak problém pretrváva aj po prepnutí jednotky do
pohotovostného režimu alebo po vypnutí a opätovnom zapnutí napájania, obráťte sa
na servisného zástupcu spoločnosti Sony.

Rýchlo bliká
oranžovo

Rýchlo bliká
zeleno

Na jednotke sa vyskytla porucha. Obráťte sa na servisného zástupcu spoločnosti
Sony.

Zobrazenie
správy

Kontrolka
nahrávania/záznamu Príčina a riešenie

E + chybový
kód

Rýchle blikanie

Označuje abnormalitu v jednotke. Nahrávanie sa zastaví, aj keď je na
obrazovom paneli kamery zobrazené ●REC.
Vypnite jednotku a skontrolujte, či nie je nejaký problém s pripojenými
zariadeniami, káblami alebo médiami. Ak chyba pretrváva aj po opätovnom
zapnutí zariadenia, obráťte sa na servisného zástupcu spoločnosti Sony.
V závislosti od stavu jednotky sa nemusí zobraziť chybové hlásenie alebo
výstražný zvuk.

Zobrazenie
správy

Kontrolka
nahrávania/záznamu Príčina a riešenie

Temperature High Blikanie
Vnútorná teplota je vysoká.
Pred opätovným použitím kamkordér vypnite a nechajte
vychladnúť.
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Zobrazenie
správy

Kontrolka
nahrávania/záznamu Príčina a riešenie

Media Temperature
High

Blikanie
Teplota karty CFexpress je vysoká.
Kartu vymeňte alebo ju pred opätovným použitím nechajte
vychladnúť.

Voltage Low Blikanie Napätie DC IN je nízke (úroveň 1). Skontrolujte zdroj napájania.

Insufficient Voltage Rýchle blikanie
Napätie DC IN je príliš nízke (úroveň 2). Nahrávanie je zakázané.
Pripojte iný zdroj napájania.

Media Near Full Blikanie Zostávajúca kapacita na pamäťovej karte je nízka.
Vymeňte čo najskôr.

Media Full Rýchle blikanie
Klipy nebolo možné zaznamenať alebo kopírovať, pretože na
pamäťovej karte nie je dostatočná kapacita.
Ihneď vymeňte.

Clips Near Full Blikanie
Počet ďalších klipov, ktoré je možné zaznamenať na pamäťovú
kartu, sa znižuje.
Vymeňte čo najskôr.

Clips Full Rýchle blikanie

Bol dosiahnutý maximálny počet klipov, ktoré je možné
zaznamenať na pamäťovú kartu.
Zaznamenávanie alebo kopírovanie ďalších klipov nie je možné.
Ihneď vymeňte.

Last Clip
Recording

Blikanie
Aktuálny záznam klipu je posledný klip, ktorý je možné
zaznamenať, pretože bol dosiahnutý maximálny počet klipov.
Pripravte si novú pamäťovú kartu.

Media(A) Life Near
End1) Blikanie

Pamäťová karta sa blíži ku koncu svojej životnosti. Vymeňte čo
najskôr.

Media(A) Life
End1) Rýchle blikanie Pamäťová karta dosiahla koniec svojej životnosti. Ihneď vymeňte.

Media(A) Near
Full1) Blikanie Pri použití funkcie Simul Rec

Media(A) Full1) Rýchle blikanie Pri použití funkcie Simul Rec

Media(A) Clips
Near Full1) Blikanie Pri použití funkcie Simul Rec

Media(A) Clips
Full1) Rýchle blikanie Pri použití funkcie Simul Rec

Media(A) Last Clip
Rec1) Blikanie Pri použití funkcie Simul Rec

(Bez zobrazenia) Blikanie

V ovládači objektívu sa vyskytla neznáma chyba.
Skontrolujte stav v stavovom okne kamery vo webovej aplikácii.
Podrobné informácie nájdete v systémovom denníku vo webovej
aplikácii.

Pre kartu v zásuvke B sa zobrazí „(B)“.1)
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Výstražné a prevádzkové správy

V strede obrazovky sa môžu zobraziť nasledujúce výstražné a prevádzkové správy. Pri riešení problému postupujte
podľa uvedených pokynov.

Zobrazená správa Príčina a riešenie

Backup Battery End
Please Change

Zostávajúca kapacita záložnej batérie je nedostatočná.
Pripojte jednotku k zdroju napájania aspoň na 24 hodín, aby sa záložná
batéria nabila.

Unknown Media(A)1)

Please Change

Bola vložená pamäťová karta, ktorá bola rozdelená na partície alebo
pamäťová karta obsahujúca viac klipov, ako dokáže jednotka
spracovať.
Kartu nie je možné v jednotke použiť a je potrebné ju vymeniť.

Cannot Use Media(A)1)

Unsupported File System

Bola vložená karta používajúca iný súborový systém alebo
nenaformátovaná karta.
Kartu nie je možné použiť v jednotke a je potrebné ju vymeniť alebo
naformátovať pomocou jednotky.

Media Error
Media(A) Needs to be Restored1)

Na pamäťovej karte sa vyskytla chyba a karta musí byť obnovená.
Obnovte pamäťovú kartu.

Media Error
Cannot Record to Media(A)1)

Pamäťová karta môže byť poškodená a už nie je možné ju použiť na
záznam.
Prehrávanie je možné, preto sa odporúča vytvoriť kópiu a vymeniť
pamäťovú kartu.

Media Error
Cannot Use Media(A)1)

Pamäťová karta môže byť poškodená a už nie je možné ju použiť na
záznam alebo prehrávanie.
Kartu nie je možné v jednotke použiť a je potrebné ju vymeniť.

Media(A) Error1)

Recording Halted
Playback Halted

Nahrávanie a prehrávanie bolo zastavené, pretože pri používaní
pamäťovej karty došlo k chybe.
Ak problém pretrváva, vymeňte pamäťovú kartu.

Media Reached Rewriting Limit
Change Media(A)1)

Pamäťová karta dosiahla koniec svojej životnosti.
Vytvorte zálohu a kartu okamžite vymeňte. Ak budete s kartou
pokračovať v práci, nemusí byť ďalej možné vykonávať záznam alebo
prehrávanie.
Podrobnosti nájdete v návode na obsluhu pamäťovej karty.

The specified address is invalid.
Zadaná adresa je neplatná.
Skontrolujte, či je nastavenie správne.

Cannot Use Specified Port Number
Zadané číslo portu je neplatné.
Skontrolujte, či je nastavenie správne.

Lens I/F Error(xx:xx)

Pri pripojení objektívu s bajonetom E bola zistená chyba objektívu pri
komunikácii I/F objektívu.
Skontrolujte stav spojenia objektívu s bajonetom E.
Ak problém pretrváva, obráťte sa na servisného zástupcu spoločnosti
Sony s kódom chyby (päť znakov v zátvorkách).

Cannot add auto upload job of Proxy file
because maximum number of upload jobs
was reached.

Bol dosiahnutý maximálny počet prenosových úloh.
Vymažte všetky nežiaduce úlohy. Môže byť tiež nesprávne nastavenie
cieľa automatického nahrávania pre zástupné súbory. Skontrolujte, či je
nastavenie správne.
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Informácie o chybách streamovania RTMP

Na jednotke sa môžu zobraziť nasledujúce chybové informácie. Podľa potreby vykonajte nasledujúce činnosti.

Informácie o chybách pri streamovaní SRT

Na jednotke sa môžu zobraziť nasledujúce chybové informácie. Podľa potreby vykonajte nasledujúce činnosti.

Zobrazená správa Príčina a riešenie

Fan Stopped

Ventilátor prestal bežať.
Skontrolujte, či v ňom nie je prach alebo cudzie časti.
Ak chyba pretrváva aj po odstránení prachu a cudzích častí, obráťte sa
na servisného zástupcu spoločnosti Sony.

Pre kartu v zásuvke B sa zobrazí „(B)“.1)

Chybový kód
Popis Riešenie

RTMP RTMPS

1002
1004

2002
2004

Nemožno sa pripojiť k RTMP
serveru.

Skontrolujte, či je nastavenie adresy URL servera správne.
Skontrolujte sieťové pripojenie.

1003 2003
Nie je možné preložiť názov
domény.

Skontrolujte, či je nastavenie adresy URL servera správne.
Skontrolujte pripojenie k DNS serveru.

–
2005
2008

Chyba CRL
Skontrolujte, či je nastavenie adresy URL servera správne.
Skontrolujte, či je cieľ pripojenia dôveryhodné miesto.

2006 Chyba certifikátu CA
Skontrolujte, či je nastavenie hodín správne.
Skontrolujte, či je certifikát CA správny.

– 2007

Certifikát CA nie je
nainštalovaný.
Chyba overenia certifikátu
servera.

Nainštalujte certifikát CA.
Skontrolujte, či je cieľ pripojenia dôveryhodné miesto.

4002 Relácia RTMP bola prerušená.
Jednotka mohla byť odpojená na strane RTMP servera.
Skontrolujte, či nastavenia zodpovedajú odporúčanému
parametru kodeku služby.

4003
Kvalita sieťového pripojenia je
nízka. Skontrolujte sieťové pripojenie.

Iné Iné chyby.

Chybový
kód Popis Riešenie

SRT-Caller

1001 Neočakávaná chyba
Jednotka nemusí fungovať normálne. Vypnite jednotku
z elektrickej siete.

1002
Odpojenie komunikácie z dôvodu zmeny
nastavení

Komunikácia bola prerušená, pretože boli zmenené
nastavenia.
Obnovte spojenie.
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Chybový
kód Popis Riešenie

SRT-Caller

5001 Neočakávaná chyba
Jednotka nemusí fungovať normálne. Vypnite jednotku
z elektrickej siete.

5005 Zlyhanie pripojenia Skontrolujte, či je cieľové nastavenie pripojenia správne.

5006 Chyba šifrovania Skontrolujte, či je nastavenie šifrovania správne.

5007 Neočakávaná chyba Jednotka nemusí fungovať normálne. Vypnite jednotku
z elektrickej siete.5008 Neočakávaná chyba

5009 Zlyhanie prenosu
Jednotka bola počas komunikácie odpojená.
Skontrolujte sieťové pripojenie.
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Zoznam položiek ponuky

V nasledujúcich tabuľkách sú uvedené položky ponuky jednotky.

Legenda
„Ponuka kamery“ a „Webová ponuka“
●: Dostupné
▲: Niektoré položky sú dostupné
–: Nedostupné

„All File“ a „Scene File“
Áno: Položka uložená v ALL file alebo súbore scény
Nie: Položka nie uložená

„All Reset (except for Network Settings)“
Keď sa [Reset]> [Reset] > [All Reset (except for Network Settings)] vykoná vo webovej ponuke:
Áno: Inicializovaná položka (okrem nastavení siete)
Nie: Nepoužiteľné

„Network Reset“
Keď sa [Reset]> [Reset] > [Network Reset] vykoná vo webovej ponuke:
Áno: Inicializovaná položka (nastavenie siete)
Nie: Nepoužiteľné

„Factory Default“
Áno: Položka bola obnovená na predvolené výrobné nastavenia
Nie: Nepoužiteľné

Shooting

Položka
(úroveň 2)

Ponuka
kamery

Webová
ponuka

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

ISO/Gain/EI ● – Áno Áno Áno Áno Áno

ND Filter ● – Áno Áno*1 Áno Nie Áno

Shutter ● – Áno Áno Áno Nie Áno

Iris ● – Áno Áno Áno Nie Áno

Auto Exposure ● – Áno Áno*2 Áno Nie Áno

White ● – Áno Áno*3 Áno Nie Áno

White Setting ● – Áno Nie Áno Nie Áno

Offset White ● – Áno Nie Áno Nie Áno

Focus ● ▲ Áno Nie Áno Nie Áno

S&Q Motion ● – Áno Nie Áno Nie Áno
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Project

Paint/Look

Položka
(úroveň 2)

Ponuka
kamery

Webová
ponuka

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

LUT On/Off ● – Áno Nie Áno Nie Áno

Noise
Suppression

● – Áno Áno Áno Nie Áno

Flicker Reduce ● – Áno Nie Áno Nie Áno

SteadyShot ● – Áno Nie Áno Nie Áno

[Mode] nepoužiteľné*1

[Clip High light], [Detect Window], [Average Peak Level Ratio], [Custom Width], [Custom H Position], [Custom V Position] nepoužiteľné*2

[Preset White] nepoužiteľné*3

Položka
(úroveň 2)

Ponuka
kamery

Webová
ponuka

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Base Setting ● ● Áno Nie Áno Nie Áno

Rec Format ● ● Áno Nie Áno*1 Nie Áno

Cine
EI/Flex.ISO Set

● – Áno Nie Áno Nie Áno

Simul Rec ● ● Áno Nie Áno Nie Áno

Proxy Rec ● ▲ Áno Nie Áno Nie Áno

Interval Rec ● ● Áno*2 Nie Áno Nie Áno

Picture Cache
Rec

● ● Áno*2 Nie Áno Nie Áno

SDI/HDMI Rec
Control

● – Áno Nie Áno Nie Áno

Assignable
Button

● – Áno Nie Áno Nie Áno

All File – ● Nie Nie Nie Nie Nie

[Frequency] nepoužiteľné*1

[Setting] nepoužiteľné*2

Položka
(úroveň 2)

Ponuka
kamery

Webová
ponuka

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Scene File ● – Nie Nie Nie Nie Nie

Base Look ● ▲ Áno*1 Nie Áno*1 Nie Áno*1

Reset Paint
Settings

● – Nie Nie Nie Nie Nie
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Pan-Tilt

TC/Media

Položka
(úroveň 2)

Ponuka
kamery

Webová
ponuka

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Black ● – Áno Áno Áno Nie Áno

Knee ● – Áno Áno Áno Nie Áno

Detail ● – Áno Nie Áno Nie Áno

Matrix ● – Áno Áno Áno Nie Áno

Multi Matrix ● – Áno*2 Áno*2 Áno Nie Áno

údaje LUT importované ako základný vzhľad nie sú použiteľné*1

[Axis] nepoužiteľné*2

Položka
(úroveň 2)

Ponuka
kamery

Webová
ponuka

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

P/T Speed – ● Nie Nie Áno Nie Nie

P/T
Acceleration

● ● Nie Nie Áno Nie Nie

P/T Range
Limit

– ● Nie Nie Áno Nie Nie

P/T Direction – ● Nie Nie Áno Nie Nie

P/T Preset – ● Nie Nie Áno Nie Nie

Položka
(úroveň 2)

Ponuka
kamery

Webová
ponuka

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Timecode ● – Áno*1 Nie Áno Nie Áno

TC Display ● – Áno Nie Áno Nie Áno

Users Bit ● – Áno*1 Nie Áno Nie Áno

HDMI TC Out ● – Áno Nie Áno Nie Áno

Clip Name
Format

● – *2 Nie Áno Nie Áno

Update
Media

● – Nie Nie Nie Nie Nie

Format
Media

● – Nie Nie Nie Nie Nie

Media Life ● – Nie Nie Nie Nie Nie

[Setting] nepoužiteľné*1

[Auto Naming] použiteľné, [Camera ID] nepoužiteľné*2
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Monitoring

Audio

Thumbnail

Technical

Položka
(úroveň 2)

Ponuka
kamery

Webová
ponuka

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Output
Format

● ● Áno Nie Áno Nie Áno

Output
Display

– ● Áno Nie Áno Nie Áno

Display
On/Off ● – Áno Nie Áno Nie Áno

Video Signal
Monitor

● – Áno Nie Áno Nie Áno

Marker ● – Áno Nie Áno Nie Áno

Položka
(úroveň

2)

Ponuka
kamery

Webová
ponuka

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Audio
Input

● ▲ Áno Nie Áno Nie Áno

Audio
Output

● ▲ Áno Nie Áno Nie Áno

Položka
(úroveň 2)

Ponuka
kamery

Webová
ponuka

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Display Clip
Properties

● – Nie Nie Nie Nie Nie

Set Clip Flag ● – Nie Nie Nie Nie Nie

Lock/Unlock
Clip

● – Nie Nie Nie Nie Nie

Delete Clip ● – Nie Nie Nie Nie Nie

Transfer Clip ● – Nie Nie Nie Nie Nie

Transfer Clip
(Proxy)

● – Nie Nie Nie Nie Nie

Filter Clips ● – Nie Nie Nie Nie Nie

Customize View ● – Áno Nie Áno Nie Áno
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Network

Stream

Položka
(úroveň

2)

Ponuka
kamery

Webová
ponuka

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Color
Bars

● – *1 Nie *1 Nie Áno

Genlock ● – Nie Nie Nie Nie Nie

Tally ● ● Áno Nie Áno Nie Áno

Rec
Review

● – Áno Nie Áno Nie Áno

Zoom ● – Áno Nie Áno Nie Áno

IR
Remote

– ● Nie Nie Áno Nie Áno

Lens ● – Áno Nie Áno Nie Áno

APR ● – Nie Nie Nie Nie Nie

[Type] použiteľné, [Setting] nepoužiteľné*1

Položka
(úroveň 2)

Ponuka
kamery

Webová
ponuka

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Camera Name – ● Nie Nie Nie Nie Áno

User – ● Nie Nie Nie Áno Áno

Wired LAN*1 ▲ ● Nie Nie Nie Áno Nie

File Transfer ● ▲ Áno Nie Áno Áno Áno

FTP Server 1 – ● Nie Nie Áno Nie Áno

FTP Server 2 – ● Nie Nie Áno Nie Áno

FTP Server 3 – ● Nie Nie Áno Nie Áno

SSL – ● Nie Nie Nie Áno Áno

Referer Check – ● Nie Nie Nie Áno Áno

Brute Force
Attack Protection

– ● Nie Nie Nie Áno Áno

Nemožno konfigurovať pomocou ponuky kamery (len displej)*1

Položka
(úroveň 2)

Ponuka
kamery

Webová
ponuka

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Stream
Setting

– ● Nie Nie Áno*1 Nie Áno*1
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Maintenance

5-041-959-13(1) Copyright 2022 Sony Corporation

Položka
(úroveň 2)

Ponuka
kamery

Webová
ponuka

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Video
Stream

– ● Áno Nie Áno Nie Áno

Audio
Stream

– ● Áno Nie Áno Nie Áno

[NDI|HX] > [License] nepoužiteľné*1

Položka
(úroveň 2)

Ponuka
kamery

Webová
ponuka

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Language ● ● Áno Nie Áno Nie Áno

Accessibility – ● Áno Nie Nie Nie Áno

Clock Set ● ● Áno*1 Nie Áno*2 Nie Áno

Reset – ● Nie Nie Nie Nie Nie

Hours Meter ● – Nie Nie Nie Nie Nie

Information – ● Nie Nie Nie Nie Nie

System Log – ● Nie Nie Nie Nie Áno

HTTP Access
Log

– ● Nie Nie Nie Nie Áno

Service – ● Nie Nie Nie Nie Nie

EULA – ● Nie Nie Nie Nie Nie

Software – ● Nie Nie Nie Nie Nie

Informácie o dátume a čase nepoužiteľné*1

[Time Zone], informácie o dátume a čase nepoužiteľné*2
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Prednastavená poloha uložených položiek

„Áno“ označuje nastavenie, ktoré je uložené pre prednastavenú pozíciu, a „Nie“ označuje nastavenie, ktoré nie je
uložené.

Položky otáčania/nakláňania

Položky transfokácie

Položky zaostrenia

Umiestnenie zobrazenia Položka Uložiť cieľ

Ovládací panel orámovania živej prevádzkovej obrazovky
Poloha otáčania/nakláňania Áno

[Pan-Tilt Speed] Nie

[Pan-Tilt] vo webovej ponuke

[P/T Speed] Nie

[P/T Acceleration] Nie

[P/T Range Limit] Nie

[P/T Direction] Nie

[P/T Preset] > [Pan-Tilt] Nie

[P/T Preset] > [Default] > [Pan-Tilt Speed] Áno1)

Hodnoty nastavení pri ukladaní prednastavenej polohy sa uložia ako hodnoty tejto prednastavenej polohy. Po uložení hodnôt je možné meniť
hodnoty pre každú prednastavenú polohu. Podrobnosti nájdete v časti „Zmena rýchlosti prechodu
(otáčanie/nakláňanie/transfokácia/zaostrovanie) prednastavených polôh pomocou webovej aplikácie“.

1)

Umiestnenie zobrazenia Položka Uložiť
cieľ

Ovládací panel orámovania živej prevádzkovej obrazovky

Poloha transfokácie (zaostrovacia
vzdialenosť)

Áno

[Zoom Speed] Nie

[Pan-Tilt] > [P/T Preset] > [Default] vo webovej ponuke
kamery

[Zoom Sync] Áno1)

[Zoom Speed] Áno1)

[Technical] > [Zoom] v ponuke kamery [Zoom Type] Nie

Hodnoty nastavení pri ukladaní prednastavenej polohy sa uložia ako hodnoty tejto prednastavenej polohy. Po uložení hodnôt je možné meniť
hodnoty pre každú prednastavenú polohu. Podrobnosti nájdete v časti „Zmena rýchlosti prechodu
(otáčanie/nakláňanie/transfokácia/zaostrovanie) prednastavených polôh pomocou webovej aplikácie“.

1)
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Súvisiaca téma
Zmena rýchlosti prechodu (otáčanie/nakláňanie/transfokácia/zaostrovanie) pri obnovení predvoľby polohy

5-041-959-13(1) Copyright 2022 Sony Corporation

Umiestnenie zobrazenia Položka Uložiť
cieľ

Obrazový panel kamery živej prevádzkovej
obrazovky

Cieľ sledovania určený pre AF so sledovaním
v reálnom čase

Nie

Určené súradnice pre bodové zaostrenie Nie

Karta  (Focus) na živej prevádzkovej
obrazovke

Prepínač [Touch Focus] Nie

Prepínač [Auto Focus] Áno

Stav tlačidla [Focus Hold] Nie

Stav tlačidla [Push AF/MF] Nie

[Face/Eye Detection AF] Áno

[AF Subj. Shift Sens.] Áno

[AF Transition Speed] Áno

Poloha zaostrenia Áno1)

[Shooting] > [Focus] vo webovej ponuke

[Push AF Mode] (vrátane nastavení s použitím
priraditeľných tlačidiel)

Nie

[Touch Function in MF] Nie

[AF Assist Control] Nie

[Pan-Tilt] > [P/T Preset] > [Default] vo webovej
ponuke kamery

[Focus Recall] Áno2)

[MF Speed] Áno2)

[Shooting] > [Focus] v ponuke kamery

Veľkosť oblasti zaostrenia a poloha nastavená
pomocou [Focus Area]

Áno

Poloha oblasti zaostrenia nastavená pomocou [Focus
Area (AF-S)]

Áno

Neobnoví sa, keď je prepínač [Auto Focus] nastavený do polohy on. Obnovené pri nastavení na off.1)

Hodnoty nastavení pri ukladaní prednastavenej polohy sa uložia ako hodnoty tejto prednastavenej polohy. Po uložení hodnôt je možné meniť
hodnoty pre každú prednastavenú polohu. Podrobnosti nájdete v časti „Zmena rýchlosti prechodu
(otáčanie/nakláňanie/transfokácia/zaostrovanie) pri obnovení predvoľby polohy“.

2)
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Blokové schémy

Audio Input

Audio Output

5-041-959-13(1) Copyright 2022 Sony Corporation
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Aktualizácia softvéru objektívu s bajonetom E

Pomocou jednotky môžete aktualizovať softvér objektívu s bajonetom E.
Informácie o objektívoch, ktoré je možné aktualizovať, a príslušný softvér nájdete na webovej stránke.
Softvér sa aktualizuje pomocou webovej ponuky.

Poznámka

Nevykonávajte nasledujúce akcie, kým sa aktualizácia nedokončí.

Odpojenie siete
Demontáž objektívu
Vypnutie napájania

Ak sa zobrazí hlásenie, že aktualizácia zlyhala, skontrolujte zobrazený popis a skúste aktualizovať znova.

5-041-959-13(1) Copyright 2022 Sony Corporation

Na jednotku pripojte objektív s bajonetom E.1

Nastavte [Maintenance] > [Information] > [Lens] > [Model Name] a [Version Number] vo webovej ponuke.

Číslo verzie softvéru objektívu s bajonetom E je zobrazené na bočnej strane.
Skontrolujte číslo verzie softvéru a potom softvér podľa potreby aktualizujte.

2

Stiahnite si aktualizačný softvérový súbor objektívu pre Windows (prípona .exe) do zariadenia s webovou
aplikáciou.

3

V časti [Maintenance] > [Information] > [Lens] > [Version Up], stlačte tlačidlo [Choose File] a vyberte
stiahnutý aktualizačný súbor.

4

Postupujte podľa pokynov na obrazovke.5
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Pripojenie krytu uvoľňovacieho tlačidla objektívu

Neúmyselnému odstráneniu objektívu môžete zabrániť nasadením krytu uvoľňovacieho tlačidla objektívu dodaného so
stropným držiakom CIB-PCM1 (voliteľné príslušenstvo) na uvoľňovacie tlačidlo objektívu.

Poznámka

To nebráni úplnému vybratiu objektívu.

Súvisiaca téma

Nasadenie objektívu

5-041-959-13(1) Copyright 2022 Sony Corporation

Pripojte objektív.

Podrobnosti o pripojení objektívu nájdete v časti „Nasadenie objektívu“.

1

Posuňte zaisťovaciu páčku otáčania/nakláňania do polohy LOCK, aby ste uzamkli otáčanie/nakláňanie
hlavy kamery.

2

Posuňte blok kamery do polohy, aby bolo možné nasadiť vysúvací kryt objektívu.3

Nasaďte vysúvací kryt objektívu tak, aby zakrýval uvoľňovacie tlačidlo objektívu.4

Zaistite vysúvací kryt objektívu pomocou upevňovacej skrutky vysúvacieho krytu objektívu.5

499



Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Licencie

Licencia na patentové portfólio MPEG-4 AVC

TENTO VÝROBOK JE LICENCOVANÝ NA ZÁKLADE LICENCIE PATENTOVÉHO PORTFÓLIA AVC NA OSOBNÉ
POUŽITIE SPOTREBITEĽOM ALEBO NA INÉ ÚČELY, ZA KTORÉ NEDOSTÁVA ODMENU ZA
(i) KÓDOVANIE VIDEA V SÚLADE SO ŠTANDARDOM AVC („AVC VIDEO“) A/ALEBO
(ii) DEKÓDOVANIE AVC VIDEA, KTORÉ BOLO ZAKÓDOVANÉ SPOTREBITEĽOM ZAPOJENÝM DO OSOBNEJ
ČINNOSTI A/ALEBO BOLO ZÍSKANÉ OD POSKYTOVATEĽA VIDEA S LICENCIOU NA POSKYTOVANIE AVC VIDEA.
NA ŽIADNE ĎALŠIE POUŽITIE SA NEUDEĽUJE ŽIADNA LICENCIA ANI Z NEHO NEBUDE VYPLÝVAŤ. DODATOČNÉ
INFORMÁCIE MOŽNO ZÍSKAŤ OD MPEG LA, L.L.C. NAVŠTÍVTE HTTP://WWW.MPEGLA.COM

Získanie softvéru pod licenciou GPL/LGPL

Tento výrobok používa softvér, na ktorý sa vzťahuje GPL/LGPL. Týmto vás informujeme, že máte právo na prístup,
úpravu a ďalšiu distribúciu zdrojového kódu pre tieto softvérové programy za podmienok GPL/LGPL.
Zdrojový kód je poskytovaný na internete. Použite nasledujúcu adresu URL a postupujte podľa pokynov na stiahnutie.
https://oss.sony.net/Products/Linux/
Boli by sme radšej, keby ste nás ohľadom obsahu zdrojového kódu nekontaktovali.

Zdrojový kód μT-Kernel

Tento produkt používa zdrojový kód μT-Kernel v rámci T-licencie 2.1 udelenej TRON Forum (www.tron.org).

5-041-959-13(1) Copyright 2022 Sony Corporation
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Technické parametre

Všeobecné

Hmotnosť
Približne 4,6 kg (iba teleso)
Približne 6,0 kg (vrátane objektívu SELP28135G)

Rozmery
Pozrite si časť „Vonkajšie rozmery“.

Požiadavky na napájanie
19,5 V =
PoE++ (kompatibilný s IEEE802.3bt , Typ 4 , Trieda 8)

Príkon
19,5 V =: 80,0 W (max.)
PoE++: 71,3 W (max.)　

Prevádzková teplota
0 °C až 40 °C

Skladovacia teplota
−20 °C až + 60 °C

Formát záznamu (video)
XAVC Intra
Režim XAVC-I 4K/QFHD: VBR, prenosová rýchlosť 600 Mb/s (max.), MPEG-4 AVC/H.264
Režim XAVC-I HD: CBG, 223 Mb/s (max), MPEG-4 AVC/H.264

XAVC Long
Režim XAVC-L QFHD: VBR, prenosová rýchlosť 150 Mb/s (max.), MPEG-4 H.264/AVC
Režim XAVC-L HD 50: VBR, 50 Mb/s (max.), MPEG-4 H.264/AVC
Režim XAVC-L HD 35: VBR, 35 Mb/s (max.), MPEG-4 H.264/AVC

Formát záznamu (audio)
LPCM 24-bitový, 48 kHz, 4-kanálový

Záznamová snímkovacia frekvencia

XAVC Intra
Režim XAVC-I 4K: 4096×2160/59.94P, 50P, 29.97P, 25P, 24P, 23.98P
Režim XAVC-I QFHD: 3840×2160/59.94P, 50P, 29.97P, 25P, 23.98P
Režim XAVC-I HD: 1920×1080/59.94P, 50P, 29.97P, 25P, 23.98P

XAVC Long
Režim XAVC-L QFHD: 3840×2160/59.94P, 50P, 29.97P, 25P, 23.98P
Režim XAVC-L HD 50: 1920×1080/59.94P, 50P, 29.97P, 25P, 23.98P
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Režim XAVC-L HD 35: 1920×1080/59.94P, 50P, 29.97P, 25P, 23.98P

Čas nahrávania/prehrávania
XAVC Intra
Režim XAVC-I QFHD: 59.94P, pribl. 30 minút (s použitím CEA-G160T)
Režim XAVC-I HD: 59.94P, pribl. 78 minút (s použitím CEA-G160T)

XAVC Long
Režim XAVC-L QFHD: 59.94P, pribl. 115 minút (s použitím CEA-G160T)
Režim XAVC-L HD 50: 59.94P, pribl. 155 minút (s použitím CEA-G80T)
Režim XAVC-L HD 35: 59.94P, pribl. 210 minút (s použitím CEA-G80T)

Poznámka

Čas nahrávania/prehrávania sa môže líšiť v závislosti od podmienok používania a charakteristík pamäte. Časy nahrávania
a prehrávania sú určené na nepretržité nahrávanie jedného klipu. Skutočné časy môžu byť kratšie v závislosti od počtu
zaznamenaných klipov.

Časť pohonu otáčania a nakláňania

Minimálna rýchlosť otáčania: 0,02 stupňa/s
Minimálna rýchlosť nakláňania: 0,02 stupňa/s
Maximálna rýchlosť otáčania: 60 stupňov/s
Maximálna rýchlosť nakláňania: 60 stupňov/s
Rozsah otáčania: −170 stupňov až +170 stupňov.
Rozsah nakláňania: -−30 stupňov až +195 stupňov.
Hodnotenie hlučnosti: NC35 alebo nižšie
Prednastavené pozície: 100

Kamerová časť

Zobrazovacie zariadenie
35 mm celý rámček (35,6 × 23,8 mm), senzor Exmor R CMOS

Počet pixelov
Približne 12,9 megapixelov (celkový počet pixelov)
Približne 10,3 megapixelov (efektívne pixely)

Automatické zaostrovanie
Metóda detekcie: Fázová detekcia/detekcia kontrastu

Interné ND filtre
CLEAR: OFF
1: 1/4ND
2: 1/16ND
3: 1/64ND
Lineárne variabilný ND: 1/4ND až 1/128ND

Citlivosť ISO
Režim ISO 800/12800 (Cine EI, zdroj svetla D55)

Bajonet objektívu
Bajonet E

Šírka
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15 a viac zastavení

Rýchlosť uzávierky
64F až 1/8000 s (23.98P)

Uhol uzávierky
5,6° až 360°, 2 až 64 snímok

Slow & Quick Motion
XAVC QFHD: 1 fps až 120 fps
XAVC HD: 1 fps až 240 fps
XAVC 4K: 1 fps až 60 fps
XAVC HD (S35): 1 fps až 120 fps

Vyváženie bielej
2000 K až 15000 K

Zosilnenie
−3 dB až +30 dB (1 dB prírastky)

Základný vzhľad
S-Cinetone, Standard, Still, ITU709, 709tone, s709, 709(800%), S-Log3, HLG Live, HLG Natural

Zvuková časť

Frekvencia vzorkovania
48 kHz

Kvantovanie
24-bit

Frekvenčná odozva
Režim XLR vstup MIC: 20 Hz až 20 kHz (±3 dB alebo menej)
XLR vstup režim LINE: 20 Hz až 20 kHz (±3 dB alebo menej)

Dynamický rozsah
Vstup XLR režim MIC: 80 dB (typický)
Vstup XLR režim LINE: 90 dB (typický)

Skreslenie
Režim XLR vstup MIC: 0,08% alebo menej (−40 dBu vstupná úroveň)
Režim XLR vstup LINE: 0,08% alebo menej (+14 dBu vstupná úroveň)

Časť vstup/výstup

Vstupy
DC IN

Vyhovuje EIAJ, 19,5 V =

AUDIO IN

Typ XLR, 5-pólový, zásuvka
LINE / MIC / MIC+48V prepínateľný
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MIC: Referenčné −30 dBu až −80 dBu

GENLOCK IN

Konektor BNC, 1,0 Vp-p, 75 Ω

TC IN

Konektor BNC

Výstupy
SDI OUT

Konektor BNC, 12G-SDI, 6G-SDI, 3G-SDI (Level A/B), HD-SDI

HDMI

Konektor typu A

OPTICAL výstupný konektor

Kompatibilné s SFP+
* Zariadenie nepodporuje optický signálový vstup.

Vstup/výstup
LAN konektor

RJ-45, 1000BASE-T

OPTION konektor

Vstupný/výstupný konektor RJ-45

Časť zásuvka pre médium

Zásuvka na kartu CFexpress Type A/SD (2)

Dodávané príslušenstvo

Sieťový adaptér (1)
Napájací kábel (1)
Infračervené diaľkové ovládanie (1)
Kryt telesa (1) (pripojený k prístroju)
Prídržná doštička kábla HDMI (1)
Pred používaním tohto zariadenia (1)
Záručný list (1)

Vonkajšie rozmery

Rozmery sú približné hodnoty.
Prístroj: mm

Teleso kamery
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Stropný držiak
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Dizajn a technické údaje podliehajú zmenám bez predchádzajúceho upozornenia.

5-041-959-13(1) Copyright 2022 Sony Corporation
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Sprievodca s nápovedou

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Ochranné známky

 je ochranná známka spoločnosti Sony Group Corporation.
XAVC a   sú registrované ochranné známky spoločnosti Sony Group Corporation.
Výrazy HDMI, HDMI High-Definition Multimedia Interface a logo HDMI sú obchodnými známkami alebo
registrovanými obchodnými známkami spoločnosti HDMI Licensing Administrator, Inc. v Spojených štátoch
amerických a ďalších krajinách.
Microsoft a Windows sú ochranné známky alebo registrované ochranné známky spoločnosti Microsoft Corporation
v USA a/alebo iných krajinách.
Mac a macOS sú registrované ochranné známky spoločnosti Apple Inc. v USA a ďalších krajinách.
Logo „Catalyst Browse“ je ochranná známka alebo registrovaná ochranná známka spoločnosti Sony Group
Corporation.
IOS je ochranná známka alebo registrovaná ochranná známka spoločnosti Cisco v USA a ďalších krajinách
a používa sa na základe licencie.
iPadOS, Safari a iPad sú ochranné známky spoločnosti Apple Inc., registrované v USA a ďalších krajinách
a regiónoch.
Android a Google Chrome sú ochranné známky alebo registrované ochranné známky spoločnosti Google LLC.
Wi-Fi je registrovaná ochranná známka spoločnosti Wi-Fi Alliance.
Logo SDXC je ochranná známka spoločnosti SD-3C, LLC.
CFexpress a logo CFexpress Type A sú ochranné známky spoločnosti CompactFlash Association.
NewTek™ a NDI® sú ochranné známky alebo registrované ochranné známky spoločnosti NewTek, Inc.
JavaScript je registrovaná ochranná známka spoločnosti Oracle a/alebo jej pridružených spoločností.
Intel, logo Intel a Intel Core sú ochranné známky spoločnosti Intel Corporation alebo jej dcérskych spoločností.
QR Code je ochranná známka spoločnosti Denso Wave Inc.
Všetky ostatné názvy spoločností a výrobkov sú registrované ochranné známky alebo ochranné známky príslušných
vlastníkov. Položky chránené ochrannou známkou nie sú v tomto dokumente označené symbolmi ™ alebo ®.
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